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1 
Planning the Test

Planning the Test - Concepts

The following topics provide some information that can help you in
planning tests with the Serial BERT:

• “Introduction to the Serial BERT - Concepts ” on page 11 explains
the basics of bit error rates (BER) and BER testing with the Serial
BERT.

• “Which Test is Appropriate? - Concepts ” on page 24 provides you
with some basic information about the types of testing you can do
with the Serial BERT.

• “Connecting the DUT - Concepts ” on page 28 tells you how you
should connect your DUT to the Serial BERT.

Introduction to the Serial BERT

Introduction to the Serial BERT - Concepts

These topics explain some of the basics of BER, Serial BERT, and BER
testing with the Serial BERT.

Important Information about the Pattern Generator Outputs

The pattern generator output ports must be terminated with 50 Ω if they
are not connected:

• Data Out

• Data Out

Agilent J-BERT N4903B High-Performance Serial BERT
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• Clock Out

• Clock Out

• Aux Data Out

• Aux Data Out

• Trigger/Ref Clock Out

• Trigger/Ref Clock Out

Termination of output ports improves the test performance.

Important Information Regarding Security

The Serial BERT is a PC-based instrument with a standard Windows
operating system. As such, it is subject to the same security protection
measures as any other PC.

See the Microsoft web site for more information regarding data security:

http://www.microsoft.com/security/default.mspx

Every user must have administrator privileges to run the Serial BERT
firmware. Otherwise the firmware does not have access to the
instrument's hardware.

In case of any serious malfunction in the operating system, the Agilent
Recovery System can be used to repair the system. See “Agilent Recovery
System - Procedures” on page 511.

Understanding BER

Bit error ratio (BER) is the most fundamental measure of system
performance. It is the ratio of the number of errored bits to the total
number of bits received.

For example, 1 error in 1000 bits corresponds to a BER of 1/1000 or
1x10-3. This would be displayed on the instrument as 1E-3. Refer to the
following table to familiarize yourself with how BERs are displayed.
Notice that smaller exponents correspond to higher BERs, and larger
exponents correspond to lower BERs.

Table 1

Fraction Exponent Instrument Display

1/1 1 x 100 1E+0

1/10 1 x 10-1 1E-1

1 Planning the Test
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Table 1

Fraction Exponent Instrument Display

1/100 1 x 10-2 1E-2

1/1000 1 x 10-3 1E-3

1/10,000 1 x 10-4 1E-4

1/100,000 1 x 10-5 1E-5

1/1,000,000 1 x 10-6 1E-6

1/10,000,000 1 x 10-7 1E-7

Understanding SER

Symbol error ratio (SER) is the symbol ratio of the number of errored
symbols to the total number of symbols received.

For example, a single error will result in a one symbol error in 1000
symbols where each symbol consists of 10 bits that corresponds to a
SER of 1/1000 or 1x10-3. This would be displayed on the instrument as
1E-3. Refer to the following table to familiarize yourself with how SERs
are displayed. Notice that smaller exponents correspond to higher
SERs, and larger exponents correspond to lower SERs.

Table 2

Fraction Exponent Instrument Display

1/1 1 x 100 1E+0

1/10 1 x 10-1 1E-1

1/100 1 x 10-2 1E-2

1/1000 1 x 10-3 1E-3

1/10,000 1 x 10-4 1E-4

1/100,000 1 x 10-5 1E-5
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Table 2

Fraction Exponent Instrument Display

1/1,000,000 1 x 10-6 1E-6

1/10,000,000 1 x 10-7 1E-7

Understanding the Serial BERT

The Serial BERT, also referred to as a Bit Error Ratio Tester (BERT), is
a powerful instrument that enables you to analyze systems and
components in the telecommunication and enterprise communication
industries. It is an essential tool for designing and troubleshooting
communications systems, high-speed integrated circuits (ICs), and
photonic components. Its intuitive operation and leading edge
performance will help you quickly verify error performance.

The Serial BERT comes with advanced jitter generation capabilities for
jitter tolerance testing (J-BERT). The instrument provides:

• Excellent waveform performance

• Outstanding rise times and jitter performance

• A choice of logic family interfaces

• Easy object-oriented programming with the IVI-COM interface

• Remote commands similar to HP/Agilent 71603B

• A variety of ways in which to accumulate and view test results

• A collection of example patterns

• Convenient online documentation

• Automatic setup of optimum sampling point

• A variety of powerful advanced analysis tools

• Special support for jitter analysis and characterization

Which Features are Available?

The Serial BERT is available with different options. They differ in the
range of provided bit rates and in the available features.

Depending on the options you bought or upgrated, you can have the
following installed:

• C07

1 Planning the Test
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Bit rate range: 150 Mbit/s to 7 Gbit/s pattern generator and error
detector with built-in clock data recovery (CDR)

• C13

Bit rate range: 150 Mbit/s to 12.5 Gbit/s pattern generator and error
detector with built-in CDR

• A01, U01

Bit Recovery Mode (measures BER without expecting a particular
pattern)

• J10

Option/Upgrade for jitter injection. Total jitter can be composed
from random, periodic, sinusoidal, and bounded uncorrelated
sources.

• J11, U11

Spread Spectrum Clock (SSC) and residual Spread Spectrum Clock
(rSSC) generation.

• J12, U12

Option/Upgrade for automated jitter tolerance compliance tests. Use
this test to ensure that the jitter tolerance of the device under test
complies with a certain standard.

• J20

User-installable hardware module "Interference Channel" for
simulating intersymbol and sinusoidal interference.

• 003/U03

Option/Upgrade for half-rate clocking with variable duty cycle.

• A02

Option for Symbol Error Ratio (SER) to analyze 10 bit symbols as
coded data to measure SER.

• 002

Option for N4876A 28 Gb/s Multiplexer 2:1 and Second Output
Channel.

To check the options of your Serial BERT, press About in the Help menu.
The About dialog shows the installed options.

De-Emphasis Signal Converter

An external optional instrument which is used to convert the output of
the pattern generator to a de-emphasized signal, as required by many

Planning the Test 1
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standards such as PCI Express®, SATA 3 Gb/s, USB3, fully buffered
DIMM, Hypertransport, CEI, or 10 GbE.

The following De-Emphasis Signal Converter can be used:

N4916A De-Emphasis Signal Converter

The N4916A is a 2-tap de-emphasis signal converter.

Following are the features and benifits of N4916A:

• Generates 2-tap de-emphasis

• Support data rates from 1 to 13.5 Gb/s

• Transparent to data jitter

• Small size

• Programmable via J-BERT N4903B or stand-alone

• USB and LAN connectivity

N4916B De-Emphasis Signal Converter

The N4916B is a 4-tap de-emphasis signal converter with optional clock
multiplier. It is intended to accurately characterize your multi-gigabit
serial interfaces.

Following are the features and benifits of N4916B:

• Generates 4-tap de-emphasis with variable de-emphasis levels

• Supports data rates from 660 Mb/s to 10.5 Gb/s

• Tolerates non-balanced patterns

• Transparent to jitter

• Optional clock multiplier (Option 001)

1 Planning the Test
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• Small size

• Programmable via J-BERT N4903B or stand-alone

• USB and LAN connectivity

Once the N4916A/B is connected, it can be conveniently controlled via
the Serial BERT.

N4876A 28 Gb/s Multiplexer 2:1

The Agilent's N4876A is a 2:1 multiplexer with an output data rate of
up to 28.4 Gb/s.

Following are the features and benifits of N4876A:

• 2:1 multiplexer driven by Serial BERT data and aux data or by
ParBERT Data rate up to 28.4 Gb/s

• DC coupled, tolerates unbalanced patterns

• Transparent to Serial BERT generated jitter

• Small box, can be located closely to DUT

• Controlled via the local user interface of Serial BERT

• Remote Programming is transparently done via Serial BERT

Navigating the Serial BERT GUI

Navigating the Serial BERT GUI - Concepts

The Serial BERT GUI provides a central launching point for its various
controls. The following picture illustrates the GUI layout of the Serial
BERT.
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For understanding, the Serial BERT GUI can be divided into three
panes; namely the upper, middle and the lower pane.

The following picture illustrates the upper pane of the Serial BERT.

The upper pane provides access to the Navigation Menu which allows
you to launch the different controls and dialogs of the Serial BERT. For
more information on the Navigation Menu, refer to the section “How to
use the Navigation Menu” on page 20. In addition, this pane also
displays the following controls, buttons and indicators:

• BER Status Bar: Displays the calculated BER.

• Elapsed Time Indicator: Displays the progress of the current
accumulation period. If a measurement is running, it displays the
measurement progress.

• Show Error Message Button: Displays error messages. The Show Error
Message button uses the following color codes to indicate different
states:

• No error messages: The button will be in disabled state.

• New/unread errors: The triangle icon on the button will turn red.

• No new errors: The triangle icon on the button will remain yellow.

• Minimize Button: Minimizes the GUI to the Taskbar.

1 Planning the Test
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• Remote Indicator: If the GUI is in remote state, the remote indicator
turns blue and the mouse is catched within.

• Control’s Title: Displays the title of the control window.

The following picture illustrates the middle pane of the Serial BERT.

The middle pane allows you to launch the different controls and dialogs
of the Serial BERT. These will be described in detail in the subsequent
sections.

The following picture illustrates the lower pane of the Serial BERT.

The lower pane provides information about the Pattern Generator and the
Error Detector, this include:

• Setup information like Bit Rate and Selected Pattern.

• State information like Outputs ON or Jitter/ISI/SSC (Indicated by
green LED).

• Error indicators like Error, Sync Loss, Data Loss, Clock Loss (Indicated
by red LED).

N O T E Two additional error indicators "Symb Lock" and "8b10b Error"will appear, if you
select the error ratio as 8B/10B Symbol Comparison from the Error Detector - Error
Ratio's window. For more details, see “Symbol Lock Indicator” on page 179 and
“8b10b Error Indicator” on page 180.

• Warning indicators like Output Protection (Indicated by orange LED
at the Outputs ON indicator).
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• Temperatur warnings (Only visible if the temperature exceeds a
certain threshold value). For more information, see “Overheat
Protection” on page 472.

How to use the Navigation Menu

The navigation Menu comes with a pull down menu which provides a
central launching point for the various controls of the Serial BERT.

N O T E The availability of the menu items depends on the available hardware and licenses.

The navigation Menu includes single menu items like File, Utility and
Help and group menu items like External Instument(s), Pattern, PG
Setup, ED Setup, Analysis, Jitter and Results. Each menu entry on the
Menu button has a separator (|) and an arrow sign (>>) on it. While the
separator indicates that the menu item can be directly opened by
clicking on the group menu item, the arrow sign indicates a horizontally
expanding submenu associated to it.

The following figure explains the usage of the navigation menu.

1 Planning the Test
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Each group menu items has an image assigned to it. The image displayed
on the menu item indicates the image of the last used control, which
means, if you click somewhere on left of the seperator, it will directly
open the last used control.

Each pull down menu and its option are described in the following
section:

The File menu allows you to perform the following tasks:

• Generate a new pattern file

• Open the existing Instrument State/Pattern/Sequence/
Measurement

• Save the Instrument State/Pattern in Editor/Screen Capture in
Editor Sequence/Measurement

• Preset Instrument State

• Print the screen

• Exit the application

Planning the Test 1
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The External Instrument(s) menu allows you to control the external
instruments that are connected to Serial BERT.

The Pattern menu allows you to:

• Select a pattern

• Edit a pattern

• Launch the Sequence Editor

The PG Setup menu allows you to launch the following controls:

• Bit Rate Setup

• Data Output

• Clock/Trigger Output

• Trigger/Ref Clock Setup

• Aux Data Setup

• Error Add Setup

• Alt Pattern and Aux In Setup

For more information on PG Setup, refer to the section “Setting up the
Pattern Generator - Concepts ” on page 113.

The ED Setup menu allows you to launch the following controls:

• Clock Setup

• Error Ratio

• Sampling Point Setup

• Trigger and Aux Setup

• Pattern Sync

• Accumulation Setup

• Start Accumulation

• Stop Accumulation

• BER Location

• Audio

For more information on ED Setup, refer to the section “Setting up the
Error Detector - Concepts ” on page 155.

The Analysis menu allows you to launch the following controls:
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• Eye Diagram

• Output Timing

• Output Levels

• Error Location Capture

• Fast Eye Measurement

• Spectral Jitter

• Eye Opening

In addition, the Analysis menu also allows you to perform following
operations:

• Save Measurement

• Load Measurement

• Export Data

For more information on Analysis, refer to the section “Advanced
Analysis - Concepts ” on page 215.

The Jitter menu allows you to launch the following controls:

• Jitter Setup

• Interference Channel

• Jitter Tolerance Characterization

• Jitter Tolerance Compliance

• Generate HTML Report

For more information on Jitter, refer to the section “Jitter Tolerance
Tests - Concepts ” on page 387.

The Results menu provides the following:

• BER Results

• Accumulated Results

• Eye Results

For more information on Results, refer to the section “Evaluating Results
- Concepts ” on page 355.

The Utility menu allows you to adjust the instrument as per your
personal preferences. Using this menu, you can:

• Use Edit submenu for the cut, copy and paste functionality.

• Set Date and Time

Planning the Test 1
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• Minimize GUI

• View the SCPI output window

• Set the touchscreen feature on/off

• Change the GPIB address

• Set the onscreen keyboard feature on/off

• Open the Self Test Option dialog

• Get information on the Licenses

• Provides help to activate Web Control

For more information on Utilities, refer to the section “ Customizing the
Instrument - Concepts ” on page 511.

The Help menu launches the online help which provides information on
a particular GUI item. You have the following possibilities for opening
this Help from the Serial BERT user interface:

• Context-sensitive Help for all elements of the GUI

To get quick information on the meaning of a particular GUI item,
select What's This? from the Help menu of the GUI and click on the
item in question.

• Help on a Serial BERT window

If you need more information on one of the Serial BERT windows,
select Help On... from the Help menu. This Help opens with information
on the current Serial BERT window.

• Switching to the Help

Select Contents from the Help menu to switch to this Help. The last
topic you visited is displayed.

In addition, the About button on the Help displays the license information
of the Serial BERT.

Which Test is Appropriate?

Which Test is Appropriate? - Concepts

These topics help you to decide on the appropriate test setup for your
device.
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Determining How to Test Your Device

The Serial BERT can help you test the performance of components and
systems for high-speed digital transmission equipment.

An important parameter of a digital system is the rate at which errors
occur in the system. The analyzer will compare the bits sent to your
device with the bits received from your device. It will record the number
of bit errors and display results such as the bit error ratio (BER). In
addition, accumulated results can be analyzed to help you determine
what caused the bit errors.

The analyzer can be set up to work with your device in many different
ways. To determine the best measurement setup, you must first decide
how you want to test your device. Before actually setting up and making
measurements, you may want to consider the following questions:

• What is the purpose of your test?

• What are the testing requirements of your device?

What is the Purpose of Your Test?

Does the purpose of your test fall under one of the following categories?

• To monitor instantaneous BER during measurement setup,
experiments, and adjustments. See “Instantaneous Measurements -
Concepts ” on page 355.

• To measure and log error performance over time. See “Accumulated
Measurements - Concepts ” on page 369.

• To measure the eye height and width of the incoming data signal at
specific alignment BER thresholds. See “Eye Measurements -
Concepts ” on page 383.

The following references may also be helpful in determining how to test
your device.

• For a list of recommended patterns for your device and application,
see “When to Use Which Pattern?” on page 54.

• For a list of recommended connection diagrams for your device and
application, see “Connecting the DUT - Concepts ” on page 28.

What are the Testing Requirements of Your Device?

Considering the requirements of your device will help you choose which
instrument functions to use during the test setup and when making
measurements.

• Do you need to use a custom test pattern?
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If you have a long series of 1's or 0's in your custom pattern, be sure
to avoid false sync. See “What is False Synchronization?” on page
196

• Do you want to use alternating patterns?

Then you must first import or create a custom pattern that contains
an A half (pattern A) and B half (pattern B). See “Pattern Alternation
- Concepts ” on page 148.

• Are you aware of how custom pattern size can affect the pattern
output?

See “Why the Serial BERT Repeats Memory-Based Patterns” on page
60.

• Do you need more than two patterns or a mix of custom patterns and
PRBS?

• Does your device change the input pattern it receives?

If your device inverts logic, then select Data Inverted in the Sampling
Point Setup window. If your device changes patterns in other ways,
then you must know the expected output pattern and select it as the
error detector reference pattern.

• What logic family is your device compatible with?

The pattern generator has preset voltage levels to work with ECL,
SCFL, LVPECL, LVDS, and CML. Be sure to select the correct logic
family. See “Understanding how the Serial BERT Uses Logic Families
and Terminations” on page 119.

• What is the input termination voltage of your device?

Make sure it is the same voltage as displayed in the pattern generator
termination list.

• What termination voltage is the output of your device designed to
work with?

Make sure it is set for the error detector's data port termination. See
“Data In Port Termination” on page 158.

• What bit rate do you need to test your device at?

The Serial BERT allows you to run tests from 150 Mb/s up to 12.5Gb/
s (depending on the options with which you bought the instrument).
See “Error Detector Bit Rate” on page 167 for more information.

• Does your device require differential inputs?

As complementary outputs, Data/Clock Out and Data/Clock Out may
satisfy this requirement. See “Diagram 2. Connections for
Differential Inputs” on page 30.

• Is the output of your device noisy or very small in amplitude?
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You may need to manually set up a sampling point. See “Sampling
Point Setup - Concepts ” on page 180.

• Do you want to check the BER in bursts (for example, for loop testing
applications)?

The Serial BERT provides capabilities that help you set up and run
burst tests. See “Introduction to Burst Sync Mode” on page 198.

• Are you aware of how the sync mode setting can affect the way errors
are measured and displayed?

See “What Type of Synchronization Should You Use?” on page 195.

Test Times and Confidence Levels

A true BER measurement must be statistically valid. Because it is not
possible to predict with certainty when errors will occur, your device
must be tested long enough to have confidence in its BER performance.
The table below lists the test times required for different BERs at
specific bit rates.

N O T E The test times in this table are valid for continuous measurements. If measurements
are made in bursts, the test times will be longer (continuous test time divided by
the burst duty cycle times the burst sync ratio). See “Introduction to Burst Sync
Mode” on page 198 for background information.

The test times for 95% confidence level are:

Table 3

BER STM-64/
OC-192
(9.95328 Gb/
s)

STM-16c/
OC-48c
(2.48832 Gb/
s)

STM-4c/
OC-12c
(622.08 Mb/s)

STM-1/OC-3
(155.52 Mb/s)

1E-14 ~ 8.4 hours ~ 1.4 days ~ 5.6 days ~ 22.4 days

1E-13 ~ 50 minutes ~ 3.3 hours ~ 13 hours ~ 2.2 days

1E-12 ~ 5 minutes ~ 20 minutes ~ 80 minutes ~ 5.3 hours

1E-11 ~ 30 seconds ~ 2 minutes ~ 8 minutes ~ 32 minutes

1E-10 ~ 3 seconds ~ 12 seconds ~ 48 seconds ~ 3.2 minutes

The formula for confidence level is as follows:
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C = 1 - e^-nb

Where:

C = degree of confidence (0.95 = 95%)

e = natural base number

n = number of bits examined without error

b = desired residual BER

You may want to prove that your device has a certain residual BER. If
you know this desired BER and the desired confidence level, you can
calculate the number of bits that must be measured without error. The
number of bits, in turn, can be translated into a period of time at a
certain bit rate. That is what is done in the above table.

The following example shows how to calculate the number of bits if the
desired BER (b) is 1E-10 and the desired confidence level (C) is 95%:

1 Change formula "C = 1 - e^-nb" to solve for the number of bits (n)

n = -ln(1-C)/b

2 Replace variables C and b

n = - ln(1 - 0.95)/1E-10

3 Calculate the number of bits

n = - ln(1 - 0.95)/1E-10 = 2.99/1E-10 = 2.99E+10 bits

4 Calculate the time period at the STM-16/OC-48 bit rate (2.48832 Gb/
s)

2.99E+10 / 2.48832E+9 = 12.016 seconds

Connecting the DUT

Connecting the DUT - Concepts

This section provides information on how to connect your DUT for
several common test scenarios.

N O T E The pattern generator's Data Out, Aux Data Out, Clock Out and Trigger/Ref Clock
Out ports must be terminated with 50 Ω if they are not connected.
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N O T E The error detector's Clock In connector must be terminated with 50 Ω if they are
not in use.

The following procedure is recommended when setting up a test:

1 If your DUT can handle 0V, press the 0V (Disable) button in the PG
Setup  - Data Output  or  PG Setup - Clock/Trigger Output screen.

The pattern generator's Data Out, Aux Data Out, Clock Out and
Trigger/Ref Clock Out outputs are set to 0V. This is indicated in the
PG Setup - Data Output or PG Setup - Clock/Trigger Output  screen.

2 Connect the DUT as necessary.

3 Terminate any non-connected Data Out, Aux Data Out, Clock Out
and Trigger/Ref Clock Out ports (normal and complementary).

4 If the outputs are disabled, press the 0V (Disable) button to enable
them.

To avoid damaging your device, set up the devices properly before
making connections.

C A U T I O N ESD can damage or destroy electronic components. Coaxial cables with both ends
unconnected may store electrostatic charges. Before connecting any coaxial cable
of this sort to a device or instrument, momentarily short the center and outer
conductors of the cable. When making connections, ensure the proper use of a
grounded, resistor-isolated wrist strap.

Connect your device according to the diagrams below:

Diagram 1. Connections for Different In/Out Data Rates

Often used for multiplexers, or when the data rate received by the device
is not equal to the data rate sent from the device.
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Diagram 2. Connections for Differential Inputs

Application is the same as in Diagram 1. Illustrates how to connect to
a device requiring differential signals.

Diagram 3. Connections for an Amplifier

Often used for amplifiers.
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Diagram 4. Connections for a Flip-Flop

Often used for flip-flops.

Diagram 5. Connections for a MUX/DEMUX Pair

Used to test multiplexer/demultiplexer (MUX/DEMUX) pairs. For
accurate measurement results, the timing of data signals between the
MUX/DEMUX pair must be set properly.
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Diagram 6. Connections for a DCA or Oscilloscope (PGonly)

Used for measuring the output waveform of your device. For the least
amount of jitter, the clock output signal may be used as a trigger for the
oscilloscope.

Diagram 7. Connections for a SONET/SDH Receiver (PGonly)

Often used with network equipment, such as SONET/SDH receivers.
The device shown may or may not require a clock signal.
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Diagram 8. Connections for an External Data Source (EDonly)

Used when the device is stimulated by another data source. Illustrates
the use of an oscilloscope in addition to the error detector.

N O T E As in all setups, the pattern sent to the error detector must be the same as the
internal reference pattern of the error detector. Dynamic patterns and/or patterns
with live payloads cannot be used.

N O T E Diagrams 1 through 8 can use an external clock reference connected to the Clock
In port of the pattern generator, if desired.

Diagram 9. Connections of the De-Emphasis Signal Converter

The Data Output of the Pattern Generator is connected to the Input of
the N4916A/B. The unused output of the Pattern Generator has to be
terminated with 50 Ohm.

The N4916A/B provides a differential signal to the DUT.

The N4916A/B is controlled by the Serial BERT via a USB cable
connected to ports at the rear of the instruments.
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Diagram 10. Connections of the N4876A 28 Gb/s Multiplexer

The Data In, Aux Data In and Aux Clk In of N4876A has to be connected
to Data Out, Aux Data Out and Aux Clk Out ports of the Serial BERT's,
respectively. The connections should be made using the matched cable
kit with the part number N4915A-011. The Data Output has to be
connected to the device under test.

The unused output of the Pattern Generator has to be terminated with
50 Ohm.

The N4876A provides a differential signal to the DUT.

The N4876A is controlled by the Serial BERT via a USB cable connected
to ports at the rear of the instruments.
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2 
Setting up External Instrument(s)

Setting up External Instrument(s) - Concepts

The External Instrument(s) menu allows you to enable external
instruments conneted to Serial BERT through a user interface.
Currently, the following external instruments can be connected to Serial
BERT:

1 N4916A De-Emphasis Signal Converter

For more details, refer “N4916A De-Emphasis Signal Converter” on
page 16.

2 N4916B De-Emphasis Signal Converter

For more details, refer “N4916B De-Emphasis Signal Converter” on
page 16.

3 N4876A 28 Gb/s Multiplexer 2:1

For more details, refer “N4876A 28 Gb/s Multiplexer 2:1” on page
17.

Understanding the De-Emphasis Signal Converter

The De-Emphasis Signal Converter can be connected between the Data
Out port of the pattern generator and the DUT. It converts the generated
rectangular NRZ signal to a de-emphasized differential signal.

N O T E The de-emphasis functionality is supported by both N4916A and N4916B.

N O T E N4916B De-emphasis box is supported for Aux Data Out channel of the pattern
generator as well in second channel mode.
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The figure below shows the N4916A De-Emphasis Signal Converter
connected between the Data Out port of the pattern generator and the
DUT

The figure below shows the N4916B De-Emphasis Signal Converter
connected between the Data Out port of the pattern generator and the
DUT

De-emphasized signals are used to adapt the signal waveform to the
characteristics of real transmission lines as found on printed circuit
boards. They can considerably reduce the impact of Intersymbol
Interference (ISI) and hence allow longer signal paths. De-emphasized
signals are prescribed by a couple of popular standards for high-speed
data transmission.
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De-emphasis is a method that reduces the voltage of a digital signal if
the generated level is high or low for more than one clock period. The
principle is illustrated in the figure below.

0 0 0 0 01 1 1 1 1 1

Output
Amplitude

(Vpp)
De-emphasis

Amplitude

Input
Signal

The de-emphasis amplitude is specified as a fraction of the output
amplitude (in percent or dB).

The figure above refers to a so-called post-cursor de-emphasis. You may
wish to know how that is generated.

The De-Emphasis Signal Converter splits the incoming signal into two
branches:

• One branch has a programmable amplifier to produce the desired
output voltage (Vpp).

• The other one has an adjustable delay (automatically set to one signal
clock period) and a programmable inverting attenuator/amplifier to
produce the delayed signal with a lower voltage swing.

Finally, the signals of both branches are added. This means, the delayed
signal voltage is subtracted from the specified peak-to-peak amplitude.

It is also possible to convert the input signal to a pre-cursor de-
emphasized signal.

This can be done by setting the output voltage swing to the desired de-
emphasis amplitude and specifying a negative amplitude ratio (an
amplification). This inverts the roles of the two branches. The delayed
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signal has now a larger amplitude than the direct signal. A waveform
example is illustrated in the following figure.

0 0 0 0 01 1 1 1 1 1

Output
Amplitude

(Vpp)
De-emphasis

Amplitude

Input
Signal

When pre-cursor de-emphasis is generated this way, the complementary
Output of the De-Emphasis Signal Converter becomes the normal
output and vice versa.

C A U T I O N Be very careful if you set the de-emphasis ratio to amplification! In this case, there
is no indication of the peak-to-peak voltage applied to the DUT.

You need to calculate or measure the output signal voltage precisely. Otherwise
you might damage your device.

The following example illustrates the output of the differential signal
with variable de-emphasis on pre-cursor and 2 post-cursors generated
by De-Emphasis Signal Converter N4916B.
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Understanding the Clock Multiplier

The clock multiplier option enables error counting and error analysis
of devices using half-rate clocking. The full-rate clock is needed to use
the error, eye or jitter analysis capabilities of Serial BERT.

N O T E The clock multiplier functionality is only supported by N4916B.

Understanding the N4876A 28 Gb/s Multiplexer 2:1

The Agilent Technologies N4876A is a 2:1 multiplexer with an output
data rate of up to 28.4 Gb/s.

The N4876A multiplexer doubles the pattern generator data rate by
multiplexing two pattern generator channels. It extends the variable
generator data rate of J-BERT N4903B up to 28.4 Gb/s.

The Data In of N4876A has to be connected to Data Out of the PG, Aux
Data In to Aux Data Out of PG and Aux Clk In to Aux Clk Out of PG
using the using the matched cable kit with the part number N4915A-011.
Its Data Output has to be connected to the device under test.

Setting up External Instrument(s) - Procedure

This section describes how to use the External Instrument(s) menu to
enable external instruments connected to the Serial BERT.
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N O T E Before continuing to next step, make sure that the physical connection among the
Serial BERT and the external instruments are properly done and then turn them on.
Also ensure that you have properly installed the external instruments. For a
complete list of external instruments and their installation, see “ Installing External
Instrument(s) - Concepts ” on page 524.

Now since the physical connections are OK, you can enable the external
instruments through the Serial BERT's Config window.

1 Click Config menu item from the External Instrument(s) submenu. The
Config window shows the list of externally connected instruments
(Ensure that the external instruments are properly connected and
installed). For more information on Config window, refer “Config
Window” on page 46. Here are few examples:

Example - 1

The following image shows the Config window when the N4916B de-
emphasis signal converter is connected to the Serial BERT.

Example - 2

The following image shows the Config window when the N4876A
28Gb/s Multiplexer is connected to the Serial BERT.
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2 Choose the external instrument from the instrument list shown on
the Config window.

N O T E Use Refresh button to reload the external instruments list, in case, if you are not
able to see them in the instrument list.

3 Click Update button to update the software revision of external
instrument (If required).

N O T E This button will be in the disable state if any updates are not required.

4 On the System Setup area, perform the calibration/adjustment
settings (depends upon the external instument selection).

For more information on calibration settings, refer “Loading
Calibration Settings” on page 474.

For more information on adjustment settings, refer “N4876A System
Setup Adjustment” on page 484.

5 Enable the function by selecting the corresponding check boxes.

– To enable de-emphasis function, refer “How to Enable/Disable
De-Emphasis Function” on page 42.

– To enable clock multiplier function, refer “How to Enable/Disable
Clock Multiplier Function” on page 43.

– To enable multiplexer function, refer “How to Enable/Disable
Multiplexer Function” on page 44.

Setting up External Instrument(s) 2

Agilent J-BERT N4903B High-Performance Serial BERT 41



6 Set the parameters for de-emphasis, clock multiplier and multiplexer
functions.

– To set the parameters for de-emphasis function, refer
“Controlling the De-Emphasis Signal Converter” on page 123.

– To set the parameters for clock multiplier function, refer
“Controlling Clock Multiplier” on page 45.

– To set the parameter for multiplexer function, refer “Controlling
Multiplexer” on page 45.

How to Enable/Disable De-Emphasis Function

To enable/disable the de-emphasis function:

1 From the Config window, select the De-Emphasis function check box.
It opens the Deemphasis Signal Converter Connection dialog.

The following image shows the an example of N4916B.

2 Click Enable button. It enables the de-emphasis signal converter that
is connected between Data Out of Serial BERT and the DUT.
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Once the de-emphasis function is enabled you can see the de-
emphasis parameters in the PG-Data Output screen. For more
information, see “Controlling the N4916B De-Emphasis Signal
Converter” on page 124.

3 To disable the de-emphasis function, clear the De-Emphasis function
check box present on the Config window. It will disable the de-
emphasis function and the respective parameters from the PG-Data
Output screen also disappears.

How to Enable/Disable Clock Multiplier Function

To enable/disable the Clock Multiplier function:

1 Select the Clock Multiplier function from the given list. It opens the
Clock Multiplier Connection dialog.

The following image shows the an example of N4916B.

2 Click Enable button. It enables Clock Multiplier function that is
connected between Clock Out of PG of Serial BERT and Clock In of
ED of Serial BERT.
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Once the clock multiplier function is enabled, a Clock
Multiplier(DATAOUT) menu entry is added to the External
Instrument(s) sub-menu.

3 To disable the Clock Multiplier function, clear the Clock Multiplier
function check box present on the Config window. It will disable the
clock multiplier function and the Clock Multiplier(DATAOUT) menu
item disappears.

How to Enable/Disable Multiplexer Function

To enable/disable the multiplexer function:

1 Select the Multiplexer function from the given list. It opens the
Multiplexer Connection dialog.

The following image shows the an example of N4876A.

2 Click Enable button. It enables multiplexer function that is connected
between Data and Aux Data Output of Serial BERT's Pattern
Generator and the input of the N4876A.

2 Setting up External Instrument(s)

44 Agilent J-BERT N4903B High-Performance Serial BERT



Once the multiplexer function is enabled, a Multiplexer (4876A) menu
entry is added to the External Instrument(s) sub-menu.

3 To disable the multiplexer function, clear the Multiplexer function
check box present on the Config window. It will disable the
multiplexer function and the Multiplexer (4876A) menu item
disappears.

N O T E Ensure that the timing adjustment has to be run at least once when either the
N4903B, N4876A or the cables connecting both are being exchanged in the test
setup.

Also, ensure that the timing adjustement has to be repeated whenever the operating
temperature differs by more than 5o Celsius from the temperature at the previous
timing adjustment.

Controlling Clock Multiplier

After the Clock Multiplier function has been enabled through the
Config window, the following parameters are visible in Clock Multiplier
(DATAOUT) window.

1 Select Track PG Clock Frequency check box to toggle between frequency
and multiplier provided by Pattern Generator and the input
frequency and multiplier provided in the Clock Multiplier window.

If the Track PG Clock Frequency check box is selected, the frequency
and multiplier text boxes will be disabled and the values will be
provided by Pattern Generator.

If the Track PG Clock Frequency check box is not selected then you can
provide the values of the input frequency and multiplier.

For more information, see “Track PG Clock Frequency” on page
48.

2 If necessary, change the termination voltage by enterning a new
value. You can use the front panel knob to change the value.

For more information, see “Termination” on page 49.

Controlling Multiplexer

After the multiplxer function has been enabled through the Config
window, the following parameter are visible in Multiplexer (N4876A)
window.

1 Provide f/2 Jitter  between -10 ps to 10 ps.

For more information, see “f / 2 Jitter” on page 50
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Setting up External Instrument(s) - Reference

Config Window

The Config window provides an inferface which allows you to enable the
functionality of the external instruments connected to the Serial BERT.

The Config window contains the following elements:

The Refresh button allows you to reload the external instruments list, in
case, if you are not able to see them in the instrument list.

The instrument list contains the following columns:

The Identify button (containing instrument's name) allows you to enable
and disable the identification LED on the external instrument(s). This
is simply required to help you to connect the right things at the right
connector.
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N O T E For N4916A, a text showing the instrument's name will be shown instead of LED
button as this version does not supports the Identify LED feature.

The connection type defines the connection. For example, if N4916B is
connected to the Data Out, it will show DATA_OUT.

The Enable Function allows you to select and accordingly enable/disable
the selected functions provided by the externally connected instrument.
The N4916A provides the De-Emphasis function while the N4916B
provides De-Emphasis and optional Clock Multiplier functions.

The Update button allows you to update the software revision of external
instrument(s).

N O T E This button will be in the disable state if any updates are not required.

The Visa Resouce Name displays the unique symbolic name of external
instrument(s).

The System Setup area allows you to perform the following settings:

• Load Calibration Settings - when the Serial BERT is connected to
N4916A/B.

• Input Timing Adjustment (Adjustment...) - when the Serial BERT is
connected to N4876A.

The Load Calibration Settings button allows you to provide input timing
setup and load calibration settings.

N O T E The Load Calibration Settings is applicable for N4916B.

For more information, refer “Loading Calibration Settings” on page
474.
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The Adjustment has to be done once for a dedicated setup of Serial
BERT, N4876A and the cable kit being used, whenever one of these
components in the setup is changed, or if the operating temperature
changes by more than 5o Celsius, compared to the previous adjustment.
Click Adjustment... to start adjustment if there is any change in the
connection.

N O T E The Input Timing Adjustment is applicable for N4876A.

For more information, refer “N4876A System Setup Adjustment” on
page 484.

Clock Multiplier Window

The Clock Multiplier enables BER measurements using the forwarded
clock as sampling clock for Serial BERT.

The Clock Multiplier window contains the following elements:

You can use the Track PG Clock Frequency check box to toggle between
frequency and multiplier provided by Pattern Generator and the Input
frequency and multiplier provided in the Clock Multiplier window.

If the Track PG Clock Frequency check box is not selected, then you can
provide the values of the clock multiplier. Following are the valid values:

• Multiplier: 1 Freq Range : 1GHz to to 13.5GHz
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• Multiplier: 2 Freq Range : 1GHz to to 6.75GHz

If the Track PG Clock Frequency check box is selected, then the firmware
will control both frequency as well as the multiplier value. In this case
the de-emphasis box (Clock Multiplier) is clocked by a Half Rate Clock
(DataRate/2) provided by the Pattern Generator. So the two parameters
of the Pattern Generator have now influence on the clock multiplier’s
frequency and multiplier. First it’s the data rate of the instrument (can
be changed from the Pattern Generator – Bit Rate Setup dialog) and the
Half Rate Clock check box (can be changed from the Pattern Generator
Clock/Trigger Output).

• If the Half Rate Clock check box is selected, the multiplier of the clock
multiplier will be set automatically to 2 and the frequency sent to
the clock multiplier is Data Rate/2.

• If the Half Rate Clock check box is not selected, the multiplier of the
clock multiplier will be set automatically to 1 and Data Rate itself is
sent to the box.

You can use the Termination check box to toggle between true differential
DC coupling and center tapped termination. In center tapped mode, you
can specify the termination voltage. The Termination fields are used to
set the termination voltage.

Multiplexer (N4876A) Window

The N4876A multiplexer doubles the pattern generator data rate by
multiplexing two pattern generator channels. It extends the variable
generator data rate of J-BERT N4903B up to 28.4 Gb/s.

The Multiplexer (N4876A) window contains the following elements:
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The f/2 jitter defines how much 'mismatch' the period of odd/even bits
at the output of the MUX have.

If f/2 jitter is at 0, then the observed output period at the multiplexer is
half the input period.
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3 
Setting up Patterns

Setting up Patterns - Concepts

The purpose of data patterns is to simulate the type of data that your
device might receive in the real world. Different patterns present
different data loads to your device, which can cause variations in the
bit error ratio. A bit pattern is sent from the pattern generator to your
device. At the same time, the expected output pattern of your device is
internally generated in the error detector (to provide a reference).

Selecting a pattern is the first step in setting up a BER measurement.
The Serial BERT provides various patterns to fulfill most standard
testing needs.

N O T E In 8B/10B Symbol Comparision mode, only twelve different user patterns (UPAT1 ...
UPAT12) and user pattern files are allowed as analyser pattern.

How does the Serial BERT Generate Patterns?

The Serial BERT has two possibilities for generating patterns: either by
directly generating them from the hardware, or by loading patterns into
the memory and generating the output according to the pattern in the
memory. These memory-based patterns can be either user patterns (file-
based), or software-generated patterns.

The hardware-generated patterns available with the Serial BERT are
PRBS 2^n -1 patterns. They provide long, high-speed, random traffic
patterns that can be used for testing a wide range of devices. These
patterns cannot be manipulated in any way.

The memory-based approach is more flexible. It makes it possible to
define any pattern (within the physical limits of the memory) for
defining the output. The Serial BERT provides two possibilities for

Agilent J-BERT N4903B High-Performance Serial BERT
User Guide

s Agilent Technologies 51

S

Hardware-Generated Patterns

Memory-Based Patterns



defining the output: by defining user patterns or by selecting a software-
generated pattern.

User patterns are file-based, editable patterns. These may be patterns
that you set up using the Serial BERT's Pattern Editor, or any of the
patterns delivered with the Serial BERT. You can easily define your own
patterns for any special requirements.

The Serial BERT can also generate various PRBS 2^n patterns with a
range of polynomes from 7 to 23. These patterns can be further modified
by setting special mark densities (ratio of 1's to total bits) or by defining
the zero substitution.

It is possible to combine several patterns in a sequence. A sequence
consists of up to 120 blocks that can be looped. The sum of blocks and
counted loops must not exceed 120. For example; if 100 blocks are used,
a maximum number of 20 counted loops can be defined. Each block can
generate a pause signal (constant 0 or 1), a divided clock, a 2^n -1 PRBS,
or a user pattern.

What Patterns are Available?

The Serial BERT offers various industry standard and customized
patterns for many BER testing scenarios.

The following graphic illustrates what patterns are available on the
Serial BERT. Note that there are two main branches, corresponding to
the hardware-generated and memory-based patterns, and the memory-
based patterns are further broken down into software-generated
patterns and user patterns.

Pattern Family Tree

User Patterns

Hardware-Generated
Patterns

Custom User
Patterns

Example Patterns
in C:\N490X\Pattern\Demo

2^n-1 PRBS

FDDI Fiber-Channel
Gigabit Ethernet 2^n PRBS 2^n PRBS

Mark Density SDH SONET

Industry Standard Pattern or
modified Industry Standard Pattern

PRBS

Software-Generated Patterns

Zero Substitution Mark Density

Memory-Based Patterns

See “Example Patterns” on page 61 for a complete listing of the
example patterns.
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What is PRBS?

The most common type of industry-standard pattern is the Pseudo-
Random Binary Sequence (PRBS). PRBSs have a number of desirable
properties, including the ability to simulate random data with a
balanced number of 1's and 0's.

They are referred to by their pattern lengths, which are powers of 2.
Longer pattern lengths give a better approximation of random data and
provide a more rigorous test for the device. However, the pattern
repetition time is significantly longer.

PRBS patterns provide a means to simulate the type of traffic that a
system is likely to see: random traffic. They also enable you to stress
your system to its limits, because large patterns that include long strings
of 1's or 0's are more stressful.

The patterns are easy to generate and can measure at high speeds,
because they are sent repeatedly and can be predicted. Pattern
synchronization, for example, is very fast. When you compare the
sequence with itself, you get 50% errors in all positions, except when
the pattern is exactly aligned.

Hardware-generated PRBSs are non-inverted PRBS 2^n -1 patterns that
allow high-speed measurement of random traffic. They enable stressful
testing of devices, because large patterns contain long strings of 0's and
1's.

Software-generated PRBSs are non-inverted PRBS 2^n patterns. They
are also called PRBN patterns. These patterns are useful for
applications where the pattern length must be an even number. The
Serial BERT provides variations of software-generated PRBS patterns,
allowing you to set a pattern's mark density (ratio of 1's) and zero
substitution. These features make it easier for you to run specific stress
tests on your DUT.

The following figure illustrates the PRBS-based patterns available with
the Serial BERT:

PRBS

2^n-1 PRBS
Hardware-Generated

2^n PRBS
Software-Generated

Pure
2^n PRBS

2^n PRBS Mark
Density

2^n PRBS
Zero Substitution
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Digital non-return to zero (NRZ) data has a (sin x/x)^2 characteristic
frequency spectrum. The PRBS frequency spectrum follows this
envelope, with line spectra of spacing related to the sequence repetition
rate. The longer the sequence before it repeats, the narrower the line
spacing (closer to a continuous spectrum).

Line spacing = bit rate/sequence length

The closer to a continuous spectrum, the more the test signal looks like
an analog noise source. The benefit of this is that such a stimulus shows
any frequency-dependent effects in a device under test. For example, a
clock recovery circuit designed to lock onto a single frequency may have
a tendency to lock onto harmonics. A long PRBS may uncover such
undesirable behavior.

When to Use Which Pattern?

Selecting the appropriate pattern and test setup for your application is
important. Below is a list of recommendations that may be helpful.

• To simulate random traffic, choose PRBS.

• For functional and alarm testing, choose alternating memory
patterns.

• If the test pattern requires a header, choose one of the “Example
Patterns” on page 61 or use a custom pattern.

• To stress lightwave transmitters and receivers, vary the mark
density of the pattern with a modulator or e/o converter.

• To induce baseline wander for margin testing, vary the mark density
and use alternating patterns.

• For pattern dependency testing, choose one of the “Example
Patterns” on page 61 or use a custom user pattern; vary the mark
density.

• For eye diagram measurements and mask analysis, use the Serial
BERT with a digital communication analyzer or oscilloscope.

• For receiver sensitivity or eye contour measurements, use the Serial
BERT with a digital communication analyzer or oscilloscope.

• For a clock recovery circuit stress test, vary the mark density or use
CID (Consecutive Identical Digit) patterns that contain long runs of
1's and 0's.

Alternatively, use the Serial BERT or a DCA with an ITU-T specified
pattern for testing STM-n systems. This pattern is to verify the
adequacy of timing recovery and low frequency performance of STM-
n systems. It consists of a user pattern that is comprised as follows:
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The first row of overhead bytes for the STM-n system, all ones (zero
timing content, high average signal amplitude), pseudo-random data
with 50 % mark-density ratio. This is followed by a repeat of the
pattern overhead, all zeros (zero timing content, low average signal
amplitude), and the PRBS. For full details, see ITU-T
Recommendation G.958.

• For a regenerator test, set up the bit rate according to the device
specification.

T I P If your device converts the input pattern, the error detector needs a different pattern
than the pattern generator. See “Loading Patterns to the Pattern Generator and
Error Detector” on page 64 for details.

User Patterns

User Patterns - Concepts

User patterns are user-editable patterns that are written to the Serial
BERT's memory for pattern generation (see “How does the Serial BERT
Generate Patterns?” on page 51 for details). User patterns can contain
up to 32Mbit of any arbitrary data pattern. They may be generated by
the Serial BERT software or defined in a pattern file and loaded into
the memory. The Serial BERT reads the memory bit by bit, and generates
the output accordingly.

The following topics explain how the Serial BERT works with user
patterns, and also explain how user patterns are generated.

N O T E The way software-generated patterns (distorted PRBS, PRBN) are output is
identical to that of user patterns: The patterns are written to the memory, and the
output is generated from there. Some of the information in these topics covers how
the patterns are actually generated, and thus also applies to software-generated
patterns.

When to Test with User Patterns

Creating or editing patterns is necessary for quality testing because
different patterns present different data loads to the device. This can
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cause variations in the bit error ratio. With user patterns, you can define
exactly the pattern used in the test.

Supported Pattern Types

The Serial BERT can import the following pattern types:

• HP/Agilent 71612A series patterns (*.dat file type).

• Patterns (binary, hex, symbol, "01") saved as ASCII files by the Serial
BERT or the Agilent 86130 (*.ptrn and *.txt file type).

These are described in detail in “Pattern File Specifications” on page
56.

The Serial BERT can save files as either *.dat, *.ptrn or *.txt files.

N O T E Downloading a text format pattern into your instrument may take significantly longer
than a binary pattern.

N O T E If you save a modified text format pattern to the same file name, it is always saved
in binary format. If you wish to preserve the original text format file, use the Save
As file command and save the data to a different file.

Pattern File Specifications

For your instrument to download a pattern file, the pattern must be
composed of at least 7 lines. The first 6 lines start with a keyword to
identify the field, followed by an '=' sign. There should be no spaces
around the '=' sign and no blank lines.

Use the following keywords and examples to construct your ASCII file.
Note that the keywords must appear in the given order.

The version field is used to identify different file versions. For this
software version, the field should be set to EPA 2.0. An exact match for
this field is required for the pattern to load correctly.

Syntax: Version=EPA 2.0

The format field identifies whether the pattern is in dual, hexadecimal,
or binary format.

Syntax: Format=<Dual | Hex | Text | Bin | Symbol>

Hex and text formats are identical.
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This is the creator's description of the pattern. The data after the '=' sign
is read until the end of the line and used directly as the pattern
description. The maximum number of characters is 256.

This identifies standard and alternating patterns. Standard patterns
have a value of 1; alternating patterns have a value of 2. Any other value
is not valid.

Syntax: Count=<1 | 2>

This is the length of the pattern in bits. For a standard pattern of 128
bits, for example, the value is 128. For an alternating pattern, it is the
length of one of the patterns only.

The "Data" tag identifies the start of the pattern data itself. For standard
patterns, there is only one "Data" tag. Alternating patterns require two
"Data" tags. Note that the actual data starts on the line after the tag.

Syntax: Data=<CR/LF><data contents>

• In dual format, each character represents one bit-only the numbers
'1' and '0' are allowed.

• In hex or text format, each character represents four bits-only the
characters '0' to '9' and 'A' to 'F' are allowed (not case-sensitive).

• In binary format, each character represents eight bits-all ASCII
characters are allowed.

• In symbol format, each symbol represents 10 bits.

Example:

'X' in binary format or '88' in hex or text format produce the same bit
sequence as 10001000 in dual format.

In hex or text format, the data must be separated by one white space.
The white space can be a tab, a space, or a new line.

In hex or text format: For pattern lengths that are not multiples of 8
bits , the data has to be padded to provide the correct number of hex
characters. The extra bits are ignored.

In symbol format: Patterns lengths must be a multiple of 10 bits.

ASCII Pattern Files Examples

Version=EPA 2.0
Format=Hex
Description=This is a simple standard pattern
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Count=1
Length=128
Data=
01 02 03 04 10 20 40 80
ff 00 ff 00 ff 00 ff 00

Version=EPA 2.0
Format=Text
Description=This is a simple alternating pattern
Count=2
Length=96
Data=
01 02 03 04 10 20 40 80 ff 00 ff 00
Data=
01 02 03 04 10 20 40 80 ff 00 ff 00

Pattern Resolutions and Lengths

The Serial BERT has 32Mbits (8 MB) RAM for storing patterns. As
discussed in “How the Serial BERT Generates Memory-Based Patterns”
on page 59, all patterns are loaded into the RAM until a 512-bit
boundary is reached. If the pattern is an odd number of bits long, it is
loaded into the RAM 512 times. Because of the restricted memory space,
there are also restrictions to the pattern lengths.

For example, a user pattern that is 256,001bit bit long would have to be
loaded into the RAM 512 times to reach the 512-bit boundary. Such a
pattern would occupy more than 128 Mbits in the RAM.

The Serial BERT handles such patterns by rounding them off to the
nearest length that would fit in the memory. For the above example, the
length would be rounded off to 256,000 bits. This rounding-off factor is
known as the pattern's resolution. The following table lists all pattern
resolutions.

Table 4

Pattern length (standard) Pattern length (alternate) Resolution

≤ 64 kbit ≤ 32 kbit 1 bit

> 64 kbit > 32 kbit 2 bit

> 128 kbit > 64 kbit 4 bit

> 256 kbit > 128 kbit 8 bit
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Table 4

Pattern length (standard) Pattern length (alternate) Resolution

> 512 kbit > 256 kbit 16 bit

> 1 Mbit > 512 kbit 32 bit

> 2 Mbit > 1 Mbit 64 bit

> 4 Mbit > 2 Mbit 128 bit

> 8 Mbit > 4 Mbit 256 bit

> 16 Mbit > 8 Mbit 512 bit

N O T E The above table is not valid for 8B/10B Comparison mode. In 8B/10B Comparison
mode, the error message is generated if a pattern occupies more than 32 Mbits after
reaching 512-bit boundary.

How the Serial BERT Generates Memory-Based Patterns

The basic concept of how the Serial BERT generates memory-based
patterns is relatively simple: The Serial BERT has 32Mbits of internal
RAM memory used to store data patterns. The RAM is organized in 64k
of 512-bit blocks.

During test run, the pattern generator reads this memory bit by bit and
generates the corresponding voltage at the output port (1=high, 0=low).
The error detector compares the incoming signal voltage (=data bits)
with the bits in the memory and counts the errors.

The Serial BERT has actually three RAM memory locations where
patterns are stored: in the Pattern Editor memory, in the pattern
generator, and in the error detector. When you modify patterns with the
pattern editor, the patterns in the pattern generator and error detector
are not automatically updated.

For this, you need to write the pattern to the pattern generator and/or
the error detector. There the pattern is saved in the RAM of the
respective module.
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Why the Serial BERT Repeats Memory-Based Patterns

To generate output signals, the Serial BERT can send only complete 512-
bit blocks of data. To maintain predictability of the output signal, it is
necessary to send complete patterns. This applies to user patterns,
alternating patterns, memory-based PRBN patterns, mark density
patterns, and zero substitution patterns.

Therefore, when the Serial BERT loads a pattern into its internal
memory, it repeats the pattern as necessary until the pattern reaches a
block boundary. For example, if a 1023-bit pattern is loaded, this is
repeated in the RAM 512 times, and thus occupies 1023 blocks. Or, if a
192-bit pattern is loaded, this is repeated 8 times, and occupies 3 blocks,
as indicated in the following figure. This applies to all memory-based
patterns available to the Serial BERT.

During test run, the Serial BERT always sends out all blocks of a pattern.
In the case of the 192-bit pattern mentioned above, the pattern is
repeated 8 times when sent out (in effect, making it a 1536-bit pattern).

The same behavior of repeating a pattern to fill up complete blocks also
applies to alternating patterns. In this case, each half of the pattern is
loaded into a separate location in the RAM. When an alternating pattern
is generated, first all blocks of pattern A are sent, then all blocks of
pattern B are sent, and so on.

A0 A1 A2 B0 B1 B2 A0 A1 A2

A A A A A A A A B B B B B B B B A A A A A A A A

Implications of Using Memory-Based Patterns

There are several implications to the way Serial BERT handles memory-
based patterns, a few of which are:

• If you set up an alternating pattern where pattern B is a replica of
pattern A except for the addition of one error, and the pattern is an
odd number of bits long, the error will be repeated 512 times when
B is sent (because pattern B is sent 512 times before switching back
to A).
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• If you want to send a periodic pattern, you only have to define a
single repetition. For example, if you want to send alternating 1's
and 0's, you only have to define the first two bits. This pattern is
automatically loaded 256 times to fill up a complete block of RAM.

• If you set up a trigger to be generated whenever a pattern is sent, the
trigger is sent whenever all blocks that store this pattern have been
sent (and not every time the pattern is sent).

So, for example, if you have a standard pattern that is 384 bits long,
this pattern must be loaded into the memory four times to reach the
512-bit boundary. A trigger would then be generated every
4x384bits, or 1536bits.

Example Patterns

The Serial BERT provides a set of example user patterns. These patterns
mimic real data packets and standard stress patterns.

The directory for the example user patterns is:

C:\<instrument model>\Patterns\Demo

C A U T I O N Any changes you make to the patterns in this folder are non-recoverable (there is
no backup folder). To avoid inadvertent changes, it is recommended that you copy
the demo files to a different directory before loading them.

For a complete list of available patterns and their description, see

C:\<instrument model>\Patterns\Demo\Description.pdf

For more information on the recommeded pattern for specific purposes,
see “When to Use Which Pattern?” on page 54.

User Patterns - Procedures

You can do the following tasks in the Edit Pattern window:

• “Creating New Patterns” on page 62

• “Opening Existing Patterns” on page 62

• “Editing Patterns” on page 63

• “Saving Patterns” on page 63

• “Loading Patterns to the Pattern Generator and Error Detector” on
page 64
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• “Loading Patterns Directly from the Pattern Editor” on page 65

Creating New Patterns

To start a new pattern:

1 Click Edit Pattern on File menu item from the Pattern submenu.

2 In the toolbar, click the New icon.

This opens the Pattern Properties dialog box, where you can:

– Enter a Description for the pattern

– Specify the pattern's Length in Bits

– Specify the pattern's Pattern Type (Standard or Alternate)

3 After you have entered these parameters, click OK.

The pattern is then opened in the Edit Pattern window.

4 You can now continue with modifying the pattern according to your
needs.

Opening Existing Patterns

To open an existing user pattern:

1 Click Edit Pattern on File menu item from the Pattern submenu.

2 In the toolbar, click the Open icon.

The Select User Pattern dialog box opens.

3 Use this dialog box to locate and open the desired pattern. You can
select files of the following types:

– 71612A BERT Pattern Files (*.dat)

– 86130A Pattern Files (binary, hex, symbol, "01") (*.ptrn)

– ASCII Text Pattern Files (*.txt)
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See “ Supported Pattern Types” on page 56 for descriptions of these
files.

Click New File to create new pattern.

Editing Patterns

To edit a user pattern:

1 Click Edit Pattern on File menu item from the Pattern submenu.

2 If no pattern is loaded in the editor, first open a pattern file as
described in “Opening Existing Patterns” on page 62 or create a new
one as described in “Creating New Patterns” on page 62.

3 To change the pattern length or description or to switch between
standard and alternating patterns, press the Properties button.

The Pattern Properties dialog box appears.

4 Define the pattern length, whether it is alternate or standard, and
give it a description. Click OK when finished.

5 Edit the pattern as required. For the function of the different tool
buttons, see “Edit Pattern Window” on page 67.

Saving Patterns

To save the current user pattern:

• In the toolbar, click the Save icon.

If the pattern has already been saved earlier, the saved file is
updated. Otherwise, the Windows standard Save As dialog box opens,
where you can define the file's path and name.

The available file formats to save the file in are:

• Pattern File (*.ptrn) in binary (8 bits/byte), hex (4 bits/byte), 01 (1
bit/byte), or symbol format

• ASCII Pattern Files (*.txt)
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See “Pattern File Specifications” on page 56 for descriptions of these
file types.

If you want to save the pattern file in one of the 12 memory slots, use
the file names from UPAT1.ptrn through UPAT12.ptrn respectively.

Loading Patterns to the Pattern Generator and Error Detector

The recommended way to load the data patterns to the pattern
generator and error detector is to use the Pattern Select Form dialog box.

1 Click Pattern Select menu item from the Pattern submenu.

The Pattern Select Form dialog box opens.

2 Select one of the following pattern types for the pattern generator,
and follow the next required action as listed below.

Table 5

Pattern Type Next Required Action

User Pattern Browse for the desired pattern file.

Memory User Pattern Select memory slot (1 - 12).

2^n -1 PRBS Select the pattern size.

2^n PRBS Select the pattern size.

Mark Density Select the pattern size and the mark
density ratio.

Zero Sub Select the zero substitution rate.

Sequence Enable this checkbox if you intend
to download a user-defined
sequence. Patterns generated
within a sequence are defined in
the Sequence Editor.
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N O T E Your instrument also contains user patterns that mimic real data packets and are
designed to stress specific characteristics of your device. For more information, see
“Example Patterns” on page 61.

3 If you want to select a different pattern for the error detector, clear
the checkbox Error Detector Pattern tracks the Pattern Generator Pattern.
The Error Detector Pattern tab appears. Switch to this tab and repeat
step 2.

4 If you have selected "8B/10B Symbol comparison" as an error ratio,
then ensure that the following conditions are met when the checkbox
Error Detector Pattern tracks the Pattern Generator Pattern is selected or
cleared:

• Condition 1: When pattern tracking check box is selected

– Only user pattern or memory pattern that contains valid 10B
symbols can be loaded in the Pattern Generator.

– Error Detector will follow the Pattern Generator's pattern.

• Condition 2: When pattern tracking check box is cleared

– Any pattern can be loaded in Pattern Generator

– Only user pattern or memory pattern that contains valid 10B
symbols can be loaded in the Error Detector.

5 Click OK to finish.

The selected patterns are immediately loaded to the pattern generator
and error detector. The types of patterns that are currently loaded to
the pattern generator and the error detector are always displayed in the
status bar at the bottom of the screen.

Loading Patterns Directly from the Pattern Editor

After you have finished editing a pattern in the pattern editor, you can
load this pattern directly to the pattern generator and error detector.

N O T E Keep in mind that your modifications in the Pattern Editor do not affect the pattern
at the pattern generator or error detector until you download the pattern to the
pattern generator/error detector.
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1 First determine whether the pattern generator and error detector
should use the same pattern. Click Pattern Select menu item from the
Pattern submenu.

The PatternSelectForm dialog box opens.

2 Select Error Detector Pattern tracks the Pattern Generator Pattern if you
want both modules to receive the same pattern.

3 Click OK to close this dialog box.

4 The pattern editor now displays the following buttons in the toolbar:

If you chose that both the error detector and pattern generator use
the same pattern:

Loads the current pattern to both
the pattern generator and error
detector.

If you allowed different patterns for the two modules:

Loads the current pattern to the
pattern generator.

Loads the current pattern to the
error detector.

Captures data of specified length
from the error detector.

N O T E Once the pattern of a specific length is captured from the error detector , it can be
sent back to the error detector and the pattern generator. For later use of this
captured pattern it should be saved using "SaveAs" option. The user will be
prompted to save the captured pattern if a new pattern is loaded, and the same
pattern is recaptured.
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User Patterns - Reference

The elements of the pattern editor and all dialog boxes that can be
opened from the pattern editor are described below:

Edit Pattern Window

The Edit Pattern window provides the following convenient pattern
editing functions:

Table 8

Icon Name Description

Toolbar Ctrl Click this icon to switch
the toolbar from two rows
to a single row
appearance, leaving more
space for the pattern data.

New Click this icon to create a
new pattern. See
“Creating New Patterns”
on page 62 for details.

Open Click this icon to open a
pattern from a file. See
“Opening Existing
Patterns” on page 62 for
details.

Save Click this icon to save the
current pattern. If it was
not previously saved, a
Save As dialog box opens
for you to specify name
and path for the file.

Export Click this icon to to open
Export Trace dialog. See
“Export Trace” on page
110 for details.
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Table 8

Icon Name Description

To PG Click this icon to send the
pattern from the editor to
the pattern generator.

To ED Click this icon to send the
pattern from the editor to
the error detector.

Capture Click this icon for Pattern
Capture. See “Pattern
Capture Dialog Box” on
page 74 for details.

To PGED Click this icon to send the
pattern from the editor to
the pattern generator and
the error detector.

Cut/

Copy/

Paste/

Delete/

Undo

These functions follow
Microsoft Windows
conventions.

Go To Click this icon if you want
to jump to an arbitrary bit
position. See “GoTo Bit
Dialog Box” on page 73
for details.
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Table 8

Icon Name Description

INS/

OVR

Click this icon to toggle
among the insert, dynamic
insert and overwrite
editing mode:

With Insert mode you
insert bits at the cursor
position, shifting the rest
of the pattern to the right.
The pattern length is not
changed on insertion. For
every inserted bit at the
cursor position, one bit at
the end of the pattern will
be removed.

With Dynamic Insert
mode you can change
(insert or delete) bits at the
cursor position, without
deleting previous bits. This
will either increase or
decrease the length of the
pattern by the number of
entered bits. In case of
deleting the bits, atleast
one symbol(10bits)/4bits/
1 bit should be present.

With Overwrite mode you
overwrite the bits at the
cursor position.

Bin/

Hex/

Symbol

Click this icon to open Bin/
Hex/Symbol
Configuration dialog. See
“Bin/Hex/Symbol
Configuration Dialog Box”
on page 71 for details.

Properties Click this icon to change
the properties of the
current pattern. See
“Pattern Properties Dialog
Box” on page 73 for
details.
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Table 8

Icon Name Description

Find Click this icon to open the
Find Pattern Segment
dialog box and perform the
search and replace
operation for a specified
segment in the pattern.
See “Find Pattern
Segment Dialog Box” on
page 75 for details.

Block Edit Click this icon to insert a
block of data in the pattern
at the current cursor
position. See “ Block Edit
Configuration Dialog Box”
on page 76 for details.

Select

All

Click this icon to select all
the bits in the pattern.

Alt Pat

View

Click this icon repeatedly
to view alternating
patterns in the following
ways:

- Pattern A only

- Patterns A and B in
interleaved rows

- Patterns A and B in
horizontally split windows

If only a standard pattern is
selected, this icon has no
function.

Pat

Sel

Click this icon to open the
Pattern Select Form
dialog box. For more
information, see “Loading
Patterns to the Pattern
Generator and Error
Detector” on page 64.
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T I P If you are working on a remote PC, you can use the keyboard shortcuts for Cut, Copy,
and Paste. Also, you can use the clipboard function to copy strings in either binary
or hex format to and from other applications. When pasting them into the pattern
in binary view, a 1 sets a single bit, in hex view, a 1 sets 4 bits.

Bin/Hex/Symbol Configuration Dialog Box

Patterns can be viewed in Binary, Hexa-Decimal and Symbol format.
The Bin/Hex/Symbol Configuration dialog box provides option to view the
patterns in Bin/Hex/Symbol format.

For Symbol format, this dialog allows you to configure how the pattern
editor handles the running disparity. You can allow the editor to
automatically maintain a correct running disparity while you edit by
enabling the Automatic maintains running disparity checkbox. In this case,
the Running Diparity will be applied on the full pattern (i.e. for alternate
patterns, it will be applied on both A and B patterns). You can also set
the Starting Running Disparity to either Automatic or Manual (+1 or -1).

Pattern Editor Canvas and Status Bar

The pattern editor canvas displays the pattern and offers you to edit it.
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In case of symbols, the pattern editor canvas displays the symbols as
following:

The symbols marked with "+" & "-" denotes symbol disparity, while the
symbols without signs denotes neutral disparity. The symbols with red
color signifies the error in runnning disparity. The symbols with "N/A"
signifies an invalid symbols (Not a valid 8B/10B symbol).

The status bar below the editor canvas provides the following
information from left to right:

• Status Offline, indicating that this is the display of the editor, not the
pattern generator nor the error detector

• Current Position in bits of the cursor in the pattern

• Editing mode (Overwrite / Dynamic Insert / Insert)

• Display mode (Bin / Hex / Symbol)

• Mark Density of the pattern(s)

• Total Length of the pattern (in bits)

• Error Indicators:

Disparity Error (D): This indicator turns red if there is any disparity
error in the pattern. In case of alternate patterns, the indicator will
indicate the disparity error of individual pattern trace.
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Loop Disparity Error (LD): This indicator turns red if the pattern
causes any disparity errors when being looped.

The available functions to change the view and to modify the pattern
are described in “Edit Pattern Window” on page 67.

GoTo Bit Dialog Box

This function allows you to set the cursor to an arbitrary position in the
pattern. Enter the bit position (=address) and click Go!. The cursor is
placed in front of the character with the selected bit. You can continue
editing the pattern while this dialog box is still open.

Pattern Properties Dialog Box

The Pattern Properties dialog box is used to view or change the attributes
of the currently selected pattern.

T I P You can use your instrument's software keyboard to enter text in the dialog box.
For more information, see “Using the On-Screen Keyboard” on page 519.

This text field allows you to enter a description of the pattern's
characteristics or purpose. It can be up to 256 characters long.

This text field allows you to enter the pattern length.

To find out more about appropriate pattern lengths, see “Pattern
Resolutions and Lengths” on page 58.

Select Standard if you want to use this pattern as a standard pattern.
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Select Alternate if you want to define two alternating patterns A and B.

On changing the pattern type, you have the conversion options given
below.

For converting an Alternate Pattern to a Standard Pattern:

• Discard A -  Discard the A part of the Alternate pattern and use the
B part for the Standard pattern.

• Discard B -  Discard the B part of the Alternate pattern and use the
A part for the Standard pattern.

• Multiplex ABAB... - Multiplex the Alternate pattern into the
Standard pattern starting with A.

• Multiplex BABA... - Multiplex the Alternate pattern into the
Standard pattern starting with B.

By default, the pattern length is not changed when selecting one of the
Multiplex conversions. If the created Standard pattern shall contain all
of the bits of the Alternate pattern, then the Length in Bits has to
changed manually.

For converting a Standard Pattern to an Alternate Pattern:

• A=Pattern, fill B with 0 -  The content of the Standard pattern is
copied to the A part of the Alternate Pattern. The B part is filled with
0.

• B=Pattern, fill A with 0 -  The content of the Standard pattern is
copied to the B part of the Alternate Pattern. The A part is filled with
0.

• Demultiplex -  The even bits of the Standard pattern will be used for
pattern A and the odd bits of the Standard pattern will be used for
pattern B.

The pattern length will not be adopted automatically when selecting
Demultiplex, By default the pattern length will be kept at the original
value and the pattern is being filled with 0 bits. In case that the
converted Alternate pattern shall only contain bits of the original
Standard pattern, set the Length in Bits to half the pattern length
before clicking OK.

Pattern Capture Dialog Box

The pattern capture screen has four fields as shown in the screen below.
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Description for the captured Pattern.

Pattern capture length in bits.

Captures the entire pattern length of currently loaded pattern in the
error detector.

Captures the maximum (32Mbit) pattern length of currently loaded
pattern in the error detector.

Find Pattern Segment Dialog Box

The Find Pattern Segment dialog box allows you to search for a specified
bit sequence or symbols in the pattern. If you click Next, the next
occurrence of this bit sequence or symbol is highlighted.
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The search pattern can be entered in binary/hex/symbol format,
depending on currently selected mode in pattern editor. You can
continue editing the pattern while this dialog box is still open.

In addition, The Find Pattern Segment dialog box also allows you to replace
the searched pattern segment with the desired pattern segment.

Looks for the next occurrence of the pattern from the current position
to the end. If there is no further occurrence, the current selection does
not change.

N O T E Make sure the search patterns entered in symbol format are seperated by one white
space.

Click this button to replace the searched pattern segment with the
desired pattern segment.

Click this button to replace all occurrences of the searched pattern
segment with the desired pattern segment.

Click this button to close the dialog box.

Takes you to the respective section of the Online Help.

Block Edit Configuration Dialog Box

The Block Edit Configuration dialog box provides an easy way to modify
parts of the pattern or the entire pattern at once. This can be used when
setting up a new pattern. It can also be used as an optional technique
for editing existing patterns. The Block Edit Configuration dialog box is
shown in the figure below.
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With the Block Edit Configuration dialog box, you define the Range that is
to be modified. The available options for the Range are:

• Select All

Choose this option to select the entire pattern for editing.

• Range

Choose this option to select the range of bits specified by the bit
positions entered in the From and To fields.

• Fill From Cursor to End

Choose this option to select the bits from the cursor location to
pattern end.

• Fill From Start to Cursor

Choose this option to select the bits from pattern start to the cursor.

The line, at the bottom, displays to which part of pattern the current
range applies.

The Block Edit Configuration dialog contains the following tabs:

N O T E All the 5 tabs are visible in Symbol and OOB symbol mode. In Bin/Hex mode, the
Recode and 8b/10B tab are not available. In PAM4, the 8b/10b tab is not available.

1 Fill
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This tab allows filling the given range in the pattern with the
specified value. The available options for the Fill are:

• Fill with Zeros

• Fill with Ones

• Invert. The Invert does the following functions:

Symbol Mode off: Invert the bits.

Symbol Mode OOB: 0 becomes 1, 1 becomes 0, Z remains
unchanged.

Symbol Mode PAM4: Invert bits on per channel basis.

• Clock Pattern 0101…0101

• Clock Pattern divide by

• Symbol

N O T E All the above options are not available in all modes. The Symbol fill is available if
the Symbol Mode is enabled.

N O T E In PAM4 mode the symbol that is used for a ‘0’ is ‘00’ and for a '1' it is ‘11’. This
will be used for Fill with 0, Fill with 1 and for the Clock pattern Fills.

2 Recode

This tab is used to change the coding of a selected range in the
pattern.
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The button Convert undefined to Z provides an easy access to fix all
undefined symbols to the coding of a Z symbol. It is only accessible
when symbol mode is set to OOB, as there is no undefined symbol in
PAM4 mode.

N O T E The Recode tab is not accessible if Symbol Mode is set to OFF.

3 Traces

This tab provides the following options:

– Copy

Choose this option to copy data from one trace to another.

– Swap Traces

Choose this option to swap data between the traces.

N O T E The Copy and Swap features are enabled only when there are two traces (Pattern
A and Pattern B when alternate pattern is used for single channel or Data and Aux
Data pattern for second channel). For normal pattern or when PG is in multiplexer
mode, Copy and Trace will be disabled as there will be only one pattern/trace
available.

– Reverse Traces

Choose this option to reverses the data in the selected range.

4 Rotate

This tab provides the following options:
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– Rotate Left

Treats the pattern data in the specified range as a circular buffer
and rotates the bits to the left by the specified amount. No data
will be lost and what is at the start of the buffer will be at the end
of the buffer after the rotation.

– Rotate Right

Treats the pattern data in the specified range as a circular buffer
and rotates the bits to the right by the specified amount. No data
will be lost and what is at the end of the buffer will be at the start
of the buffer after the rotation.

– Align to Sequence

Aligns the pattern data in the specified range to a specified
pattern sequence.

5 8B/10B

This tab provide you an option to either Invert Running Disparity or
Auto Correct Disparity in the patterns.

N O T E The 8B/18B tab will be only be available if the Symbol Mode is enabled.

Status Bar

The types of the patterns that are currently loaded to the pattern
generator and the error detector are always displayed in the status bar
at the bottom of the screen.
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Select Pattern Dialog Box

This dialog box lets you define the pattern you want to use for testing.
It contains the following elements:

N O T E The Error Detector Pattern in the Select Pattern dialog box allows the user patterns
from file or memory user pattern.

With this checkbox you can determine whether both pattern generator
and error detector use the same data pattern.

If you clear this checkbox, the Error Detector Pattern tab appears, where
you can select a different pattern for the error detector.

The checkbox is automatically cleared when you load a user-defined
sequence to the pattern generator. See “Sequence Mode Characteristics”
on page 90 for details.

You can choose between the following types of patterns:

• User Pattern from File

With this option, you can load a pattern that is stored in a file. Use
the Browse button to select the desired file.

• Memory User Pattern

The Serial BERT supports 12 so-called memory slots for storing user
patterns. The slots are stored in files named Upat1.ptrn to
Upat12.ptrn. To load a pattern that is stored in one of these memory
slots, choose this option and select the desired slot from the list.

• 2^n -1 PRBS

Select this option to use a hardware-generated pattern of length
2^n-1. See “How the Hardware Generates PRBS” on page 85 for
details.

• 2^n PRBS

Select this option to use a memory-based pattern of length 2^n.
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• Mark Density PRBS

Use this options to generate memory-based 2^n PRBS patterns with
specified mark densities. Select the desired value from the list. The
available values are 1/8, 1/4, 1/2, 3/4, and 7/8.

• Zero Sub PRBS

Use the Zero Substitution function to insert a longer row of zeros
into a memory-based 2^n PRBS pattern. The length of the zero row
can be freely specified up to the length of the pattern.

You can select the pattern size according to your needs. The pattern
lengths available depend on the type of signal you have selected.

Enable this checkbox if you wish to use a user-defined sequence. The
patterns used in a sequence are defined in the Sequence Editor (see also
“User-Defined Sequences - Concepts ” on page 87).

Only available on the Error Detector Pattern page. Enables the error
detector's bit recovery mode. For details see “Understanding Bit
Recovery Mode” on page 182.

Software-Generated PRBS

Software-Generated PRBS - Concepts

Software-generated patterns are PRBS patterns that can be modified.
They are calculated by the Serial BERT software and then loaded to the
memory, from which the necessary output is generated. As such, they
are closely related to user patterns, with the exception that they cannot
be edited in the Pattern Editor window.

When to Test with Software-Generated PRBS

You can use these patterns for any application where random data and
an even number of bits is required.

In addition, you can vary the mark density or zero substitution to test
the influence on the BER. This allows potential problems like baseline
wander, for instance, to be fully characterized.
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How the Software Generates PRBS

When you set up a software-generated pattern, the Serial BERT
calculates the required pattern and loads this into the memory. From
here, the memory is read bit by bit (identically as for memory-based
patterns), and the corresponding output is generated.

See also “How the Serial BERT Generates Memory-Based Patterns” on
page 59.

Range of Software-Generated PRBS Patterns

The Serial BERT supports the following 2^n PRBS patterns:

Table 9

n Sequence Length Longest Run of 1's Longest Run of 0's

7 128 7 7

10 1,024 10 10

11 2,048 11 11

13 8,192 13 13

15 32,768 15 15

23 8,388,608 23 23

Zero Substitution Patterns

A potential risk to bit errors are longer rows of zeros within a data
stream. The longest run of zeros in a 2^n PRBS consists of n zeros.

The Zero Substitution function can be used to stress the DUT
additionally by inserting a longer row of zeros in the data stream. The
length of the zero row can be freely specified, up to the length of the
pattern.

The following figure shows an example, where a run of 10 zeroes is
inserted into a PRBS 2^7 pattern.
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*ZRUNRun of 0s

0000000 101000100

0000001000000 110PRBN

ZSUB

* Closing bit

Mark Density Patterns

The mark density of a pattern is the portion of bits that are ones.

A pure PRBS pattern contains an equal number of ones and zeros and,
thus, has an average voltage in the center between high and low level.
Therefore, the mark density of such a pattern is 1/2.

Some devices may have problems processing data streams with
different mark density as this results in other average voltages and,
thus, different electrical conditions.

The ones (mark) density can be varied to put the pattern out of balance
in a randomly distributed way. This may be useful for systems that are
AC-coupled. This helps to check for effects such as baseline wander.

To test these cases, the Serial BERT provides PRBS patterns with the
mark densities 1/8, 1/4, 1/2, 3/4, and 7/8.

Software-Generated PRBS - Procedures

The recommended way to load the data patterns to the pattern
generator and error detector is to use the Pattern Select Form dialog box.

See “Loading Patterns to the Pattern Generator and Error Detector” on
page 64 for details.

Software-Generated PRBS - Reference

Use the Pattern Select dialog box to select the pattern(s) you want to
write to the pattern generator and the error detector. See “Select Pattern
Dialog Box” on page 81 for details.
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Hardware-Generated PRBS

Hardware-Generated PRBS - Concepts

This section describes the basics of hardware-generated PRBS 2^n -1
patterns.

When to Test with Hardware-Generated PRBS Patterns

You can use the Serial BERT's hardware-generated PRBS patterns if you
require simple random traffic for testing your device. The 2^n -1 odd
pattern lengths are not related to the divided clock rate. When using an
oscilloscope, this will ensure that the random contents of the bit stream
is sampled.

The spectral contents of PRBS 2^n -1 patterns and the special property
of decimation may also be useful in many applications (for example, for
multiplexer or demultiplexer testing).

How the Hardware Generates PRBS

2^n -1 PRBS is an inverted, hardware-generated pattern that is created
by a series of shift registers with adjustable feedback. The example
below shows the register configuration for a 2^7 -1 (127-bit) pattern.

The following table describes the operation of XOR'ing two points for
the different patterns.

Table 10

Sequence Length Shift-Register Configuration

27-1 D7 + D6 + 1 = 0, inverted

210-1 D10 + D7 + 1 = 0, inverted
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Table 10

Sequence Length Shift-Register Configuration

211-1 D11 + D9 + 1 = 0, inverted

215-1 D15 + D14 + 1 = 0, inverted

223-1 D23 + D18 + 1 = 0, inverted

223-1 (223-1p) D23 + D21 + D18 + D15 + D7 + D2 + 1 = 0,
non-inverted

231-1 D31 + D28 + 1 = 0, inverted

N O T E 223-1p (using D23 + D21 + D18 + D15 + D7 + D2 + 1 = 0) produces the same bit sequence
like the PCIe 3.0 scrambler when fed with zeroes only. The PCIe 3.0 scrambler is
using D23 + D21 + D16 + D8 + D5 + D2 + 1 = 0, with bit numbering being reverse
compared to the N4903B.

Range of Hardware-Generated PRBS Patterns

The following table lists the hardware-generated 2^n -1 PRBS pattern
lengths that correspond to different n values. This is before the pattern
is finally inverted.

Table 11

n Sequence Length Longest Run of 1's Longest Run of 0's

7 127 7 6

10 1,023 10 9

11 2,047 11 10

15 32,767 15 14

23 8,388,607 23 22

31 2,147,483,647 31 30
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Decimation of PRBS Patterns

A special property of 2^n -1 PRBS patterns is that they can be
demultiplexed into the same patterns at slower speeds with different
phases. This is also true for multiplexing. The demux or mux must have
n ports.

Hardware-Generated PRBS - Procedures

The recommended way to load the data patterns to the pattern
generator and error detector is to use the Pattern Select Form dialog box.

See “Loading Patterns to the Pattern Generator and Error Detector” on
page 64 for details.

Hardware-Generated PRBS - Reference

Use the Pattern Select dialog box to select the pattern(s) you want to write
to the pattern generator and the error detector. See “Select Pattern
Dialog Box” on page 81 for details.

User-Defined Sequences

User-Defined Sequences - Concepts

This section describes the basics of user-defined sequences.

A sequence is created and maintained by means of the Sequence Editor
that can be enabled from the Pattern window.

A sequence consists of up to 120 blocks than can be looped. Each block
can generate a pause signal (constant 0 or 1), a divided clock signal, a
2^n -1 PRBS, or a user pattern.

Single or multiple blocks can be looped. The sum of the blocks and the
counted loops must not exceed 120. An overall loop restarts the
sequence after it has come to its end.
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When to Use a Sequence

You may wish to test a device that uses a certain protocol for processing
data.

For example, the device might expect synchronization data, a preamble,
payload data, and a suffix.

All this can be provided by a user-defined sequence.

How a Sequence is Defined

The sequence is defined by a SequenceExpression which is formulated
in its own language, checked by the Sequence Editor.

The SequenceExpression specifies:

• the sequence start (and break) conditions

• the blocks, their contents, and trigger output

• the loops

You can inspect the contents of the SequenceExpression in the
Properties dialog of the Sequence Editor.

The SequenceExpression uses the following keywords:

Version= optional

Description= optional

Start= optional

Block #= repeated for each block, numbered

Loop= repeated for every loop, not numbered

Example of a SequenceExpression:

(Version= 1.0
Start= IMM
Block 1= PRBS11, 1024, TrigOn
Block 2= C:\<Instrument Model>\Pattern\Upat10.ptrn
Block 3= P0, 512, TrigOff
Loop= B1, B1, 2)

A sequence is in common for both channels, Data Out (Channel 1) and
Aux Data Out (Channel 2). However, the sequence for both channels will
have a different version and pattern in a block specification.
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Example of a SequenceExpression for both channels:

(Version= 1.1
Start= IMM 
Block 1= P0, P1, 311040, TrigOn 
Block 2= c:\n4903b\pattern\sdh_stm-16_hp-bip_alt.ptrn,B,
c:\n4903b\pattern\sdh_stm-16_hp-bip_alt.ptrn,A,
TrigOff Loop= B1, B1, INF)

Default is IMM = immediately after downloading the sequence to the
pattern generator. Other options are:

• AuxInHi | AuxInLo: Sequence starts when Auxiliary Input is high or
low.

• AuxInRising | AuxInFalling: Sequence starts with a rising or falling
edge at the Auxiliary Input.

• Manual: Sequence starts when the Start button is clicked.

Default is pattern P0 (Pause0), a length of 512 bits, and Trigger/Ref
Clock On. Other options are:

• Patterns: P1 (Pause1), undistorted PRBS, a user pattern from a file,
or a fraction of the clock pulse (divider range: 2 ... 127).

• Length: Must be 512 bits or a multiple thereof. Shorter or longer user
patterns are automatically repeated until the next 512-bit boundary
is reached (see also “How the Serial BERT Generates Memory-Based
Patterns” on page 59).

N O T E Length is related to master channel (Data Out) while the other channel (Aux Data)
will always follow this length.

• Trigger: Refers to the pattern generator's Trigger/Ref Clock Out port.
If the Trigger/Ref Clock Out is set up to generate a divided clock
pulse, the block setting is ignored.

But if the Trigger/Ref Clock Out is set to "Sequence Trigger" and the
block to TrigOn, a trigger pulse is generated whenever the block
starts or restarts. No trigger is sent if the block is set to TrigOff.

See “Trigger/Ref Clock Output - Procedures” on page 136 for
information on how to set the mode of the Trigger/Ref Clock Out
port.

Default is one overall endless loop for the whole sequence.

• Bn, Bm: Define the start and end block of a user-defined loop.

Loops always define the transition from the end of a block to the
beginning of the same or a previous block. It is not possible to jump
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into an existing loop. It is also not possible to specify loops within
loops (exept the default overall loop).

• Loop end condition: Default is an INFinite (endless) loop. Other
options are:

– AuxInHi | AuxInLo: Loop continues until Auxiliary Input is high
or low.

– AuxInRising | AuxInFalling: Loop continues until Auxiliary
Input receives a rising or falling edge.

– Manual: Loop continues until the Break button is clicked.

– Counted loop: Loop repeats a specified number of times.

Sequence Mode Characteristics

When a sequence is executed, the pattern generator is in "Sequence
Mode".

This mode differs from usual "Pattern Mode":

• Pattern-related triggers cannot be generated. In sequence mode, the
Trigger/Ref Clock Out port can produce either a continuous pulse (a
fraction of the current clock pulse) or a trigger spike at the beginning
of each block that is set to TrigOn. The duration of that spike depends
on several conditions and is therefore undefined.

• Software-generated PRBS with polynomial 2^n cannot be referenced
in a sequence.

• If several PRBS patterns shall be included, all have to use the same
polynomial.

• Every sequence has to be downloaded to the pattern generator
before it can be executed.

• Every sequence can be stored in a file and recalled from that file.
However, the SequenceExpression does not include user patterns.
Recalling a sequence from its file may fail if the referenced user
patterns are not available.

A recalled sequence is not automatically downloaded to the pattern
generator.

• In sequence mode, the function "Error Dector Pattern tracks the
Pattern Generator Pattern" is automatically disabled. You have to
download the expected (payload) pattern to the error detector.

• During initialization of the sequence, pure zeros are sent.
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User-Defined Sequences - Procedures

You can create a new sequence, save it in a file, or load a saved sequence
from its file.

Creating a New Sequence

If you wish to create a new sequence:

1 Click the Sequence Editor. menu item from the Pattern submenu.

By default, the Sequence Editor shows one block that is automatically
repeated. It has a length of 512 bits and generates Pause0 data (pure
zeros).

2 Click the Properties icon.

In the Properties window, set:

– the sequence start condition

– the number of blocks contained in the sequence (1 to 4)

3 Click Ok to close the Properties window.

4 Specify the data to be generated during execution of a block.

– Click the Edit button of the block.

– Choose from the list. For example, you can select a PRBS
polynomial or browse for a pattern file. A "None" block is
completely ignored.

– If necessary, change the block length. The block length of user
patterns is derived from the file. Remember that such patterns
are automatically repeated until a multiple of 512 bits is reached.

– Decide on Trigger On or Off. This setting becomes effective if the
Trigger/Ref Clock Out port is set to Sequence Trigger (trigger at
block begin). See “Sequence Trigger ” on page 138

5 Create loops (if desired):

– Click the out-arrow of a block. A loop condition box labeled INF
appears.

– Click the in-arrow of the same or a previous block. This closes the
loop.
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– Click the condition box and choose the appropriate break
condition.

6 Download the sequence to the pattern generator and test it.

7 Save the sequence in a file for later re-use.

Saving the Sequence in a File

To save the present sequence under a new name:

1 In the toolbar, click the Save As icon.

2 Select a suitable directory, for example C:\<instrument model>
\Sequences.

3 Enter a file name.

The filename extension is .seq by default.

If the present sequence was loaded from a file and edited, you can also
click the Save icon. In this case, the saved file is updated.

Loading a Sequence From a File

To recall a sequence from a file:

1 In the toolbar, click the Open icon.

The Open Sequence dialog box opens.

2 Use this dialog box to locate and open the desired sequence. The
browser shows all files with the suffix .seq in the selected directory.

N O T E The sequence is shown in the Sequence Editor, but NOT automatically downloaded
to the pattern generator. In contrast to loading a pattern from file, the download of
a sequence requires an additional command.

3 Setting up Patterns

92 Agilent J-BERT N4903B High-Performance Serial BERT



User-Defined Sequences - Reference

The elements of the Sequence Editor and the dialog boxes that can be
opened from the Sequence Editor are described below:

Sequence Block Display

A new sequence consists of one block that is infinitely repeated
(looped). By default, this block has a length of 512 bits and generates a
Pause0 signal (a continuous stream of zeros). All this is shown on the
display.

The vertical waveform at the left-hand side of the block indicates the
setting of the pattern generator's Trigger/Ref Clock Out port. By default,
it generates a pulse, a subrate of the present clock. For information on
how to change the trigger behavior, see “Sequence Trigger at Block
Begin” on page 94.

Number of Blocks

In the Blocks field, you can directly specify the number of blocks (up to
120).
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In this example, the number of blocks has been set to three. A "None"
block generates no pattern and is completely ignored (indicated by a
straight vertical blue line).

Sequence Trigger at Block Begin

After downloading the sequence to the pattern generator, you can also
change the behavior of the Trigger Out port (for details see “Sequence
Trigger ” on page 138).

In the example above, the Trigger Out port has been set to Sequence
Trigger mode, and TrigOn is set for each block (as shown by the vertical
trigger indicator).

Edit Button of a Block

To change the contents of a block, click its Edit button. This opens the
Set Data Block Parameter dialog.

Sequence Block Parameters

The Set Data Block Parameter dialog allows you to change the contents
and the trigger generation of a sequence block.

N O T E If you select the Second Channel mode from the PG Aux Data Output dialog, the
same parameters for the Aux Data channel will also appear.
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Choices are:

• None: The block may be present in the sequence but is completely
ignored.

• Pause0: Pure zeros are generated when the block is executed. You
can change the block length, if desired.

• Pause1: Pure ones are generated when the block is executed. You
can change the block length, if desired.

• Block Marker: The block starts with 256 1s and 0s until block length.
You can use it to mimic the sequence marker functionality of the
trigger output.

• PRBS: You can choose a PRBS of polynomial 2^n -1. The range of "n"
is 7, 10, 11, 15, 23, or 31. You can change the block length, if desired.

• Divided Clock: You can use this option to generate the signal at every
nth clock pulse.

• Pattern: You can click Browse to launch Select User Pattern dialog.
This dialog opens a browser and search for the file that contains the
pattern. You can open a browser and search for the file that contains
the pattern. You can search for files with the
extentions .ptrn, .txt, or .dat.

If the pattern file contains two alternate patterns, you can also
specify whether the A or B pattern shall be generated (see also
“Pattern File Specifications” on page 56). If the pattern file contains
just one pattern, your choice is ignored.

You cannot change the block length. It shows the length of the pattern
as stored in the file.

If the pattern length is not 512 bits or a multiple of 512 bits and this
single block is looped, the behavior depends on the loop end
condition.

If the loop end condition is INFinite or determined by the Aux In
port, then the pattern is automatically repeated until 512 bits or a
multiple thereof is reached.

In this case, the duration of the block will be longer than indicated.
For example, a pattern containing 17 bits will be repeated 512 times
and the actual block length will be 8704 bits. This has an impact on
the trigger at block start.

You can also use the Select User Pattern dialog to create new pattern.

If this checkbox is enabled, a trigger spike will be output at the pattern
generator's Trigger Out connector whenever the execution of the block
begins, provided that the Trigger Out port is set to Sequence Trigger mode
(see also “Sequence Trigger ” on page 138).
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Click this button to launch Create New Pattern dialog. See “Create New
Pattern” on page 108 for details.

Click this button to open the Edit Pattern Window for Sequencer-Pattern
Editor. See “Edit Pattern Window for Sequencer-Pattern Editor” on page
102 for details.

Loops Within a Sequence

A loop defines the transition from the end of a block to the beginning of
the same or a previous block. It is not possible to jump into an existing
loop. It is also not possible to specify loops within loops (exept the
default overall loop).

For information on how to create a loop, see “Creating a New Sequence”
on page 91.

Every loop has a delete button [×] and a loop condition button.

Clicking the delete button [×] removes the loop from the sequence.

The initial (default) setting of the loop end condition is INF(inite), which
means, this loop will continue until the instrument is switched off.
Clicking the loop end condition button allows you to specify the loop
end condition.

Choices are:

• Counted: The loop ends after the specified number of repetitions.
Sequence execution continues with the next block.
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• Infinite: An infinite loop can be broken by:

– Aux In High | Aux In Low: The loop ends when Auxiliary Input is
high or low. Sequence execution continues with the next block.

– Aux In Rising | Aux In Falling: The loop ends when a rising or falling
edge at the Auxiliary Input is detected. Sequence execution
continues with the next block.

– Manual: The loop ends when the Break button of the Sequence
Editor is clicked. Sequence execution continues with the next
block.

N O T E The pattern generator reacts on the end condition as soon as the pattern has
finished.

Sequence Editor Toolbox

The Sequence Editor toolbox provides the following functions:

Table 13

Icon Name Description

New Click this icon to create a
new sequence. This opens
the Properties dialog. See
“Creating a New
Sequence” on page 91 for
details.

Open Click this icon to open a
sequence from a file. See
“Loading a Sequence From
a File” on page 92 for
details.

Save Click this icon to save the
current sequence in its
original file.
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Table 13

Icon Name Description

Save As Click this icon to save the
current sequence in a new
file. A Save As dialog box
opens for you to specify
name and path for the file.
See “Saving the Sequence
in a File” on page 92 for
details.

To PG Click this icon to download
the sequence from the
Sequence Editor to the
pattern generator. This
icon appears green if the
sequence has not been
sent to the PG. For
instance, if the sequence
had been loaded from file
or been changed since last
sent to PG.

From PG Click this icon to upload
the present sequence from
the pattern generator to
the Sequence Editor. This
allows you to inspect and
edit a sequence that has
been loaded with a
program.

Properties Click this icon to change
the properties of the
current sequence. See
“Setting Sequence
Properties” on page 99
for details.

Break Click this icon to terminate
an infinite loop that is set
to "manual" break
condition. Sequence
execution continues with
the next block.
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Table 13

Icon Name Description

Reset Click this icon to interrupt
and re-initialize a running
sequence.

If the sequence start
condition is IMMediate,
the sequence restarts
immediately.

If the sequence start
condition is a signal at the
Aux In port, the sequence
restarts upon the specified
signal.

If the sequence start
condition is "Command",
sequence execution starts
when the Start button is
clicked.

CrossTalk Click this icon to open the
CrossTalk  dialog. Use this
dialog to fill every
sequencer block of the
second channel (Aux Out)
with a selected PRBS
automatically.

Note: This icon will only
appear in the second
channel mode.

Setting Sequence Properties

For a sequence, you can specify the following:

Choices are:

• Immediate: Sequence starts immediately after downloading it to the
pattern generator.

• Aux In High | Aux In Low: Sequence starts when Auxiliary Input is high
or low.
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• Aux In Rising Edge | Aux In Falling Edge: Sequence starts with a rising
or falling edge at the Auxiliary Input.

• Command: The Sequence Editor shows a Start button. Sequence
execution starts when this button is clicked.

A sequence consists of up to 120 blocks than can be looped.

A field for entering and editing descriptive text.

A window that shows the present SequenceExpression (for details see
“How a Sequence is Defined” on page 88).

You can edit the SequenceExpression in this field. Any changes override
the previous settings.

N O T E If you edit the SequenceExpression manually, take care to adhere to the syntax and
order of the keywords.

Remember that you must download the updated sequence to the pattern generator
if your changes shall take effect.

Start Button

The Start button of the Sequence Editor indicates that the sequence has
been set up for manual start.

Click this button to start the sequence execution.

Sequencer-Pattern Editor

Sequencer-Pattern Editor - Concepts

The sequencer-pattern editor displays the pattern for Data Out and/or
Aux Data Out Channel and offers you to edit it.

N O T E There is no dedicated main menu entry to open sequencer-pattern editor. Access
to this editor is only possible from within the sequence editor.
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Sequencer-Pattern Editor - Procedure

You can do the following tasks in the sequencer-pattern editor window:

Creating New Patterns in Sequencer-Pattern Editor

To create a new pattern (standard or alternate):

1 Click Sequence Editor menu item from the Pattern submenu.

By default, the Sequence Editor shows one block that is automatically
repeated. It has a length of 512 bits and generates Pause 0 data (pure
zeros).

2 Click Edit to launch Set Data Block Parameter dialog for second channel.

3 Click Create Pattern to launch Create New Pattern dialog. Use this dialog
to create new patterns. See “Create New Pattern” on page 108 for
details.

Opening Existing Patterns in Sequencer-Pattern Editor

To open an existing user pattern:

1 Click Sequence Editor menu item from the Pattern submenu.

2 Click Edit to launch Set Data Block Parameter dialog for second channel.

3 Select Pattern from the provided options and then click Browse to
launch Select User Pattern dialog.

4 Use this dialog box to locate and open the desired pattern. You can
select files of the following types:

• 71612A BERT Pattern Files (*.dat)

• 86130A Pattern Files (binary, hex, symbol, "01") (*.ptrn)

• ASCII Text Pattern Files (*.txt)

Editing Patterns in Sequencer-Pattern Editor

To edit a user pattern for second channel:
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1 Click Sequence Editor menu item from the Pattern submenu.

2 Click Edit to launch Set Data Block Parameter dialog for second channel.

3 If no pattern is loaded in the editor, first open a pattern file as
described in “Opening Existing Patterns in Sequencer-Pattern
Editor” on page 101 or create a new one as described in “Creating
New Patterns in Sequencer-Pattern Editor” on page 101.

4 Click Edit Pattern(s) to launch Pattern Editor for second channel.

5 Use the standard keyboard functions to edit patterns at the position
of the cursor.

6 In the toolbar, click Apply to confirm the new changes.

7 In the toolbar, click Discard to reject all the new changes.

Exporting Patterns in Sequencer-Pattern Editor

To export the current pattern under a new name:

1 In the toolbar, click Export icon.

The Export Trace dialog opens.

2 Use this dialog to locate and save a copy of the current pattern. See
“Export Trace” on page 110 for details.

Sequencer-Pattern Editor - Reference

The elements of the pattern editor and all dialog boxes that can be
opened from the sequencer-pattern editor are described below:

Edit Pattern Window for Sequencer-Pattern Editor

The Edit Pattern window for sequencer-pattern editor provides the
following convenient pattern editing functions:
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Table 14

Icon Name Description

Toolbar Ctrl Click this icon to switch
the toolbar from two rows
to a single row
appearance, leaving more
space for the pattern data.

Export Trace Click this icon to open
Export Trace dialog. See
“Export Trace” on page
110 for details.

Apply Click this icon to apply the
pattern to the hardware (in
case the sequence is
already active), or simply
update the corresponding
pattern file(s) if the
sequence is not yet active.
Applying closes the editor
and brings the user back to
the sequence editor.

Discard Click this icon to close the
editor without updating
anything and bringing the
user back to the sequence
editor.

Cut/

Copy/

Paste/

Delete/

Undo

These functions follow
Microsoft Windows
conventions.
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Table 14

Icon Name Description

Properties Click this icon to view/
change the properties of
the current pattern(s). See
“Pattern Properties” on
page 111 for details.

Find Click this icon to open the
Find Pattern Segment
dialog box and perform the
search and replace
operation for a specified
segment in the pattern.
See “Find Pattern
Segment Dialog Box” on
page 75 for details.

Block Edit Click this icon to edit a
block of data in the
pattern(s). See “ Block Edit
Configuration Dialog Box”
on page 76 for details.

Select

All

Click this icon to select all
the bits in the pattern.
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Table 14

Icon Name Description

INS/

OVR

Click this icon to toggle
among the insert, dynamic
insert and overwrite
editing mode:

With Insert mode you
insert bits at the cursor
position, shifting the rest
of the pattern to the right.
The pattern length is not
changed on insertion. For
every inserted bit at the
cursor position, one bit at
the end of the pattern will
be removed.

With Dynamic Insert
mode you can change
(insert or delete) bits at the
cursor position, without
deleting previous bits. This
will either increase or
decrease the length of the
pattern by the number of
entered bits. In case of
deleting the bits, atleast
one symbol(10bits)/4bits/
1 bit should be present.

With Overwrite mode you
overwrite the bits at the
cursor position.

Go To Click this icon if you want
to jump to an arbitrary bit
position. See “GoTo Bit
Dialog Box” on page 73 for
details.

Bin/

Hex/

Symbol

Click this icon to open Bin/
Hex/Symbol
Configuration dialog. See
“Bin/Hex/Symbol
Configuration Dialog Box”
on page 71 for details.
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Table 14

Icon Name Description

Symbol Codings Click this icon to open
Symbol Settings dialog.
See “Symbol Settings” on
page 108 for details.

Pattern View Click this icon repeatedly
to view patterns in the
following ways:

- Normal Mode: Data Out
or Aux Data Out or Both
(when symbol mode is
enabled) pattern only

- Interleaved Mode: Data
Out and Aux Data Out
patterns in interleaved
rows

- Split Mode: Data Out and
Aux Data Out patterns in
horizontally split windows

This icon will only work
when both the channels
are using pattern files.

Pattern Editor Canvas and Status Bar for Sequencer-Pattern Editor

The pattern editor canvas for sequencer-pattern editor displays the
pattern for Data Out and/or Aux Data Out Channel and offers you to
edit it. Access to this editor is only possible from within the sequence
editor.

The pattern editor canvas for sequencer-pattern editor is shown in the
figure below.
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It uses a different set of background color to distinguish between the
two channels.

The RED background denotes the pattern for Data Out chanel while the
BLUE background denotes the pattern for Aux Data Out channel.

N O T E If any of the channel has anything beside pattern file, the corresponding channel
would not be visible in the canvas.

The status bar below the editor canvas provides the following
information from left to right:

• Status Offline, indicating that this is the display of the editor, not the
pattern generator nor the error detector

• Current Position in bits of the cursor in the pattern

• Editing mode (Overwrite / Dynamic Insert  / Insert)

• Display mode (Bin / Hex / Symbol)

• Mark Density of the pattern(s)

• Total Length of the pattern (in bits)

• Error Indicators:

Disparity Error (D): This indicator turns red if there is any disparity
error in the pattern. In case of alternate patterns, the indicator will
indicate the disparity error of individual pattern trace.

Loop Disparity Error (LD): This indicator turns red if the pattern
causes any disparity errors when being looped.

The available functions to change the view and to modify the pattern
are described in “Edit Pattern Window for Sequencer-Pattern Editor”
on page 102.
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Create New Pattern

The Create New Pattern dialog is shown in the figure below.

Using this dialog, you can:

• Choose Select Trace as Data Out/Aux Data Out to create a Standard
pattern or as Both to create an Alternate pattern.

• Enter a Description for the pattern

• Provide a File Name and click Browse to locate the new pattern

• Specify the pattern's Length in Bits

Symbol Settings

The Symbol Settings dialog is used to select the symbol mode. It displays
the calculated output levels based on the current Data Out and Aux Data
Out levels.

The Symbol Settings dialog is shown in the figure below.
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This dialog contains a drop-down list which provides the following
options.

• Off Mode: Displays the pattern editor without any symbol coding.

• OOB Mode: Displays bit combinations of both channels as shown in
the table below.

Table 15

Symbol Data Out Aux Data Out

0 0 0

Z 0 1

1 1 1

N O T E The OOB Mode is only valid in 'Bin' and 'Symbol' representations. The 'Hex'
representation is disabled in this mode.

N O T E If the bit combinations are not matched in the table, then 'U’ will be shown in red.

• PAM4 Mode: Displays bit combinations of both channels as shown
in the table below.
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Table 16

Symbol Data Out Aux Data Out

0 0 0

1 0 1

2 1 0

3 1 1

N O T E The PAM4 Mode is only valid in 'Bin' representation. The 'Hex' and 'Symbol'
representations are disabled in this mode.

N O T E You need to press the described keys to configure 'Z' in the hardware front panel
for OOB Mode.

Export Trace

The Export Trace dialog saves a copy of the currently edited pattern.

The Export Trace dialog is shown in the figure below:

N O T E The Export Trace dialog will look different for the different cases in respect to the
selection of what shall be exported (Data Out, Aux Data Out, Both Pattern A, Pattern
B, Both Even Bits, Odd Bits, All Bits).

This dialog provides the following options:
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• Select Trace: Depending on the type of the pattern that is currently
being edited, the Export Trace dialog is offering different options:

• Standard (single) pattern:

Export either only the even, or odd bits in the pattern, or all bits
in the pattern.

• Alternate pattern:

Export either Pattern A or B as standard pattern, or pattern A
and B as an Alternate pattern.

• Dual channel pattern editing from sequencer:

Export either Data Out or Aux Data Out as Standard pattern, or
both as an Alternate pattern.

• Description: Add a description for the captured Pattern.

• File name: Provide a name to the file.

• Export: Click this button to export the file at the given location.

Pattern Properties

The Pattern Properties dialog is used to view/change the properties of the
current pattern(s).

This dialog provides the following options:
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• Description: Description of the pattern. This text field allows you to
enter a description of the pattern's characteristics or purpose. It can
be up to 256 characters long.

• Pattern Type: Pattern type of pattern. This field is non-editable.

• Length in Bits: Pattern length in bits. This field is editable.
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4 
Setting up the Pattern Generator

Setting up the Pattern Generator - Concepts

The Serial BERT's pattern generator generates an output signal based
on a data pattern. It has the following possibilities for generating an
output signal:

• Providing a wide range of clock frequencies

You can use the pattern generator's internal clock or an external
clock for defining the frequency of the outgoing stream.

• Distorting the signal by adding jitter

You can connect an external delay control device (for example a
function generator) to add jitter to the generated signal.

• Adding errors to the output stream

The Serial BERT can be set up to insert errors into the outgoing
stream either internally, according to an external signal, or manually
(from the operator).

• Run-time switching between two patterns

You can set up two patterns and switch between them during
runtime either automatically, according to an external signal, or
manually.

• Suppressing the output stream

The output signal can be suppressed according to an external signal.

The pattern generator also provides output ports that let you connect
an external instrument, such as an oscilloscope.
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Input and Output Ports

Input and Output Ports - Concepts

The pattern generator's input ports are used to set the pattern
generator's clock frequency and to manipulate the output signal with
respect to jitter, error insertion and signal output.

The pattern generator's output ports are used to supply a clock signal
and trigger for another device (for example, for the Serial BERT's error
detector), and an arbitrary data signal for testing your device.

Understanding the Pattern Generator's Input Ports

The pattern generator provides the following input ports:

• 10 MHz Ref In

This connector allows you to connect a 10 MHz reference clock. The
Serial BERT has a 10 MHz Ref In and Out port at the rear (two BNC
connectors).

• Clock In

Allows you to connect a clock signal from another device.

• Error Add
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Allows you to connect a device that generates a trigger for inserting
a single bit error in the output stream. In addition, it also allows you
to control the electrical idle state of Data Out and/or Aux Data Out.

• Delay Control In

Allows you to connect a signal for generating jitter in the data
outputs.

• Aux In

The signal at the Aux In port can be used to switch between patterns
A and B or to "blank" (suppress) the output signal. When a user-
defined sequence is executed, it can also be used to control the
sequence execution.

Understanding the Pattern Generator's Output Ports

The pattern generator provides the following output ports:

• Data Out and Data Out

The data outputs serve as device stimuli and can be set up so that
they are compatible with a variety of logic families. With respect to
Data Out, Data Out has inverted logic.

• Clock Out and Clock Out

The clock outputs serve as frequency (bit rate) references and can
be set up so that they are compatible with a variety of logic families.
With respect to Clock Out, Clock Out has inverted logic.

• Trigger/Ref Clock Out and Trigger/Ref Clock Out

This port allows you to connect a trigger for another device (for
example, an oscilloscope) and can be set up so that they are
compatible with a variety of logic families. With respect to Trigger/
Ref Clock Out, Trigger/Ref Clock Out has inverted logic.

• Aux Data Out and Aux Data Out

This port allows you to generate a pulse with a frequency that is a
fraction of the present clock and can be set up so that they are
compatible with a variety of logic families. With respect to Aux Data
out, Aux Data Out has inverted logic. Note that this output is not
phase-synchronized with the clock.

• Aux Clk Out

This output port is intended as clock input for N4916B De-Emphasis
signal converter.

The complementary outputs can be used when:

• additional output capability is needed for an instrument such as an
oscilloscope or digital communication analyzer.
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• your device requires differential inputs.

N O T E The pattern generator's Data Out, Clock Out, Aux Data Out, Trigger/Ref Clock Out
and Aux Clk Out ports must be terminated with 50 Ω if they are not connected.

Understanding the Output Protection Circuit

The generator module offers a huge flexibility for external termination
schemes and external termination voltages to address common
technologies. For details, please refer to the Technical Data Sheet.

An internal protection circuit continuously monitors the voltages of
clock, data, aux data and trigger output. It becomes active if the
termination voltage is wrongly adjusted.

The output protection circuit may become active if the output voltage
Vout becomes higher than Vhi+0.5V or lower than Vlo-0.5V.

N O T E The output protection circuit is shared among two output drivers each. Data Out
and Clock Out as well as Aux Data Out and Trigger/Ref Clock Out are supervised
by one circuit together. As a consequence, if an output voltage violation occurs,
both outputs are disabled together for a short period of time.

If an output voltage violation occurs, the output voltages Vhi, Vlo and
Vterm are re-programmed to safe values, typically to the externally
measured termination voltage. Afterwards the output drivers are re-
enabled.

The GUI shows an error message, listing the effected outputs and
highlights the Outputs On status indicator:

In the corresponding Output screen of the PG Setup, the output settings
that currently don’t match the electrical output settings are highlighted
in yellow.
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The parameters can be changed to configure the output according to the
DUT’s termination requirements. Be aware that the changes are not
applied immediately but only when the output protection circuit button
is clicked.

Understanding the Output Level Parameters

The following figure shows the parameters of a Data, Aux Data, Clock,
or Trigger/Ref Clock output signal.

As shown in this figure, the signal output levels have the following
components:

• Vhi is the upper voltage level of the signal.

• Vlo is the lower voltage level of the signal.

• Vof is the offset of the average voltage level from 0 V.

• Vampt is the amplitude of the signal.

When adjusting the output levels, it is important to understand the
concept of how the Serial BERT handles voltages.

Typically, during tests, when you adjust the amplitude, you want to keep
the offset constant. This keeps the ideal sampling point within the eye.
The Serial BERT handles this by keeping Vof constant when Vampt is
changed.
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On the other hand, you may want to adjust the output voltage level
without changing the amplitude. The Serial BERT handles this by
keeping Vampt constant when Vof is changed and Vhi/Vlo are accordingly
adjusted.

The Serial BERT cannot generate a signal that has voltage levels out of
range. If you try to enter a value for one parameter that would put
another parameter out of limits, the Serial BERT rejects the change. This
could happen, for example, if Vlo is already at the minimum, and you try
to lower either of Vhi or Vof, or increase Vampt.

Understanding Delay and Crossover

The Serial BERT provides the possibility of modifying the output data
signal by varying the signal's delay to the clock signal, and the signal's
crossover.

The exact time delay through a test setup can vary. The delay function
allows you to compensate for this by adjusting the frequency reference
for the data outputs. This varies the phase relationship of the data and
clock outputs (causes the data pulse to have a certain time delay after
the clock pulse). The higher the delay, the greater the time difference
between the clock signal and the data signal.

N O T E Note that the delay is on Data and Aux Data.

Crossover is the voltage level where the overlapped rising and falling
edges of the logic levels intersect. This adjustment varies the widths of
the logic highs and lows.
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The following figure shows examples of crossover at 50 %, 80 %, and
20 %:

Understanding how the Serial BERT Uses Logic Families and
Terminations

The clock and data inputs of your device have load impedances (or
terminations). Clock and data terminations refer to the voltage levels at
the end of these loads. These voltage levels are related to the logic family
of your device. Your device should usually only receive signals that are
compatible with its termination voltage and logic family.

When you change a logic family for the Data, Aux Data, Clock or Trigger/
Ref Clock outputs, the termination voltage normally associated with the
logic family is automatically selected. This is assumed to be the
termination of your device, and will be used to determine the actual
output voltage levels of the pattern generator.

C A U T I O N If you manually change the termination, a warning message is shown, indicating
that the termination is not typically appropriate for the logic family. If you answer
No, the warning message closes with no changes to the terminations. If you answer
Yes, the data termination voltage is applied and the Logic Level is changed to
CUSTOM.

See also “Why Incorrect Terminations Could Damage Your Device” on page 120.

The following table lists the characteristics generally associated with
some logic families. All values are nominal.

Table 17

Logic Family Vhigh[V] Vlow[V] Ampl. [mV] Term. [V]

ECL - 0.95 - 1.7 750 - 2

SCFL 0 - 0.9 900 0

LVPECL + 2.35 + 1.6 750 + 1.3

LVDS + 1.425 + 1.075 350 + 1.250
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Table 17

Logic Family Vhigh[V] Vlow[V] Ampl. [mV] Term. [V]

CML 0 - 0.4 400 0

Terms:

• ECL

Emitter Coupled Logic

• SCFL

Source Coupled FET Logic

• LVPECL

Low Voltage Positive Emitter Coupled Logic (PECL Lite)

• LVDS

Low Voltage Differential Signaling

• CML

Current Mode Logic

Why Incorrect Terminations Could Damage Your Device

Choosing wrong terminations may cause your device to output voltage
levels that are not as expected. It may also cause excessive current or
current flow in the wrong direction, which can damage your device.

Note that an internal protection circuit becomes active if the
termination voltage is wrongly adjusted. The protection circuit sets the
output voltages to safe levels, typically:

Vhi = Vlo = Vterm = externally measured termination voltage.

AC Coupling and Bias Tees

The pattern generator's outputs are normally DC-coupled; even when
AC termination is selected. For this reason, extreme caution must be
taken when connecting your instrument to a device or test setup.

The diagram below shows a device that is AC coupled. Notice that the
capacitor is part of the test setup.
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You can use an external bias network (also known as a bias tee) to power
your device. You must ensure, however, that the network is oriented
correctly. If it is not, damage may occur to your device or instrument.

The diagram below shows a bias tee that is positioned correctly. Notice
that the pattern generator's outputs are protected by the blocking
capacitor.

Input and Output Ports - Procedures

You have to do the following to set up the pattern generator's output
ports:

Setting Logic Levels and Terminations

Before you can start sending signals to your device, you have to set the
logic levels and terminations:

1 From the PG Setup submenu, click the Data Outputmenu item to modify
Data and Aux Data and the Clock/Trigger Output menu item to modify
Clock and Trigger.
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2 In the Data Logic Level list, select the logic family that is appropriate
for the data input of your device.

3 In the Clock Logic Level list, select the logic family that is appropriate
for the clock input of your device.

When you modify the  Logic Level of an output, the instrument
automatically sets the appropriate voltage levels and the
Termination voltage and enables termination.

4 If necessary, change the termination voltage by entering a new value.
You can also use the front panel knob to change the value.

The logic level automatically changes to Custom.

C A U T I O N Selecting the wrong terminations may damage your device. See “Why Incorrect
Terminations Could Damage Your Device” on page 120.

5 Connect the DUT's input ports to the Serial BERT's output ports.

C A U T I O N Do not apply external voltages to the pattern generator outputs. For more
information, see “AC Coupling and Bias Tees” on page 120.

Output ports of the pattern generator that are not connected to another device must
be terminated with 50 Ohm to prevent the Serial BERT from damage.

Note that for unconnected ports, an internal protection circuit automatically
reduces the output voltages to safe levels.

Adjust Output Levels (optional)

Data, Aux Data, Clock and Trigger/Ref Clock offset and voltage levels
can be adjusted. This is typically done when you want to tune your BER
measurement or stress the device.

You can use the knobs on the Serial BERT's front panel to fine-tune the
data and clock amplitudes and offsets. If you want to set a specific value,
you can use the numeric keyboard.

To enter specific values for the outputs from the keyboard:

1 From the PG Setup menu, press PG Data Setup to modify Data and Aux
Data, and PG Clock/Trig Setup to modify Clock and Trigger.

2 Click into the field you want to change.
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3 Enter the desired voltage using the numeric keyboard or the
respective front panel knob (only for Data and Clock).

N O T E If the termination voltage is wrongly adjusted or the output ports are not connected,
an internal protection circuit automatically sets the output voltage levels to safe
levels. Connect the output ports or change the termination voltage before adjusting
the output levels.

See “Understanding the Output Level Parameters” on page 117 for
information about how the Serial BERT works with output level
parameters.

Controlling the De-Emphasis Signal Converter

After the De-Emphasis function has been enabled using the External
Instrument(s) - Config menu, the following parameters are visible in PG
Data Output screen.

Controlling the N4916A De-Emphasis Signal Converter

For N4916A, you have de-emphasis amplitude (post–cursor) and the
corresponding unit.

To change the de-emphasis amplitude ratio value (for details see
“Understanding the De-Emphasis Signal Converter” on page 35), click
inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to set the value.

You can toggle between dB and percent. Toggling does not change the
value.

N O T E It is possible to set the de-emphasis ratio to a negative dB value (amplification).
This allows you to generate a pre-cursor de-emphasis for N4916A.

C A U T I O N In this case there is a risk that you damage your device!

If you intend to generate a pre-cursor de-emphasized signal, refer to for the
characteristics and dangers.
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Controlling the N4916B De-Emphasis Signal Converter

For N4916B, you have two (post–cursor), one pre-cursor and the
corresponding unit.

Set the values as following:

• Post-Cursor1: -12.04db to 0db

• Post-Cursor2: -8db to 0db

• Pre-Cursor: 0db to 12.04 db

To change any of the cursor's value (for details see “Understanding the
De-Emphasis Signal Converter” on page 35), click inside the text field
and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to set the value.

You can toggle between dB and percent. Toggling does not change the
value.

N O T E When N4916A/B De-Emphasis Signal Converter is connected then the X offset and
Output Blanking will not be visible in the PG-Data Output window.

N O T E Once you have connected the pattern generator to the N4916A/B De-Emphasis
Signal Converter, the Output Levels and Termination shown on the screen refer to
the outputs of the N4916A/B.

Check the indicated signal levels. The output voltage range of the N4916A/B is
lower than the range of the Serial BERT. The N4916A/B is first of all meant for low
voltage amplitudes. If the N4916A/B cannot generate the specified signal voltages,
they are reduced to safe levels. If this happens, you need to change the levels or
the termination.

C A U T I O N Do not remove the connection cable between the pattern generator and the
N4916A/B while the N4916A/B is in connected state (except for troubleshooting).
In this mode, the output levels of the pattern generator are not shown on the screen
and may present a hazard to your DUT (they have an amplitude of 1.2 V).
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Controlling De-Emphasis Mode

For De-Emphasis mode, you have de-emphasis amplitude (either pre-
cursor or post-cursor) and the corresponding unit.

To change the de-emphasis amplitude value (for details see
“Understanding the De-Emphasis Signal Converter” on page 35), click
inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob on the hardware front panel to set the value.

You can toggle between dB and percent. Toggling does not change the
value.

The following topics tell you how to use the pattern generator's input
ports:

• “Bit Rate - Procedures” on page 132

• “Delay Control Input - Procedures” on page 143

• “Manually Inserting Errors” on page 144

• “Setting Up a Periodical Output” on page 150

Input and Output Ports - Reference

The pattern generator produces clock and data outputs that serve as
frequency reference and device stimulus for the device under test.

N O T E The Serial BERT will not allow you to adjust a voltage beyond its limits. The limit is
determined by the Serial BERT's internal hardware. If a limit is encountered, the
Serial BERT sends a message to the status bar. For more information about voltage
limits, see the pattern generator's technical specifications.

Vhi

This text field allows manual entry of the logic high voltage level and
displays the current value.
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To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

See “Understanding the Output Level Parameters” on page 117 for
information about how the Serial BERT modifies the output levels.

Vof

This text field allows manual entry of the voltage level halfway between
logic high and logic low (the offset) and displays the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

T I P You can also adjust Data and Clock Vof with the Data Offset and Clock Offset knob
on the front panel.

See “Understanding the Output Level Parameters” on page 117 for
information about how the Serial BERT modifies the output levels.

Vlo

This text field allows manual entry of the logic low voltage level and
displays the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

See “Understanding the Output Level Parameters” on page 117 for
information about how the Serial BERT modifies the output levels.

Vampt

This text field allows manual entry of the voltage amplitude and displays
the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.
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T I P You can also adjust Data and Clock Vampt  with the Data Amplitude  and  Clock
Amplitude  knob on the front panel.

See “Understanding the Output Level Parameters” on page 117 for
information about how the Serial BERT modifies the output levels.

Delay

This text field allows manual entry of Data and Aux Data output delay
and displays the current value in picoseconds.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

T I P You can also adjust delay with the Data Out Delay knob on the front panel.

Half Rate Clocking and Clock Duty Cycle

A checkbox allows to enable half rate clocking: the clock at the clock
output runs at half the bit rate. In half rate clocking mode, the duty cycle
of the clock can be adjusted in the range of 40 to 60%.

Xover

This text field allows manual entry of the data's crossover percentage,
and displays the current value. To modify the value, click inside the text
field and enter the desired value directly with the numeric keyboard or
use the front panel knob to fine-tune the value.

Data Polarity Inverted

Select this checkbox to invert the logic of both data outputs (Data Out
and Aux Data Out).

Data, Aux Data, Clock and Trigger/Ref Clock Logic Levels

You can quickly set up an output signal that is compatible with your
device by selecting a logic family from the Logic Level list.
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Select the logic family you want to use for the Data, Aux Data, Clock and
Trigger/Ref Clock outputs. When you select a family, the corresponding
signal voltage levels and the Termination for this family is automatically
selected.

N O T E When you select Custom, there are no changes in the expected terminations.

See “Understanding how the Serial BERT Uses Logic Families and
Terminations” on page 119 for additional information.

Terminations for Data, Aux Data, Clock and Trigger/Ref Clock

Use the Termination checkboxes to toggle between true differential DC
coupling and center tapped termination. In center tapped mode, you
can specify the termination voltage.

The Termination fields are used to set the termination voltage. When
you select a Logic Level, the terminations are set accordingly. It is
recommended that you keep the default values of the terminations.

See “Understanding how the Serial BERT Uses Logic Families and
Terminations” on page 119 for additional information.

0V (Disable)

C A U T I O N Before clicking this button, ensure that your device's inputs tolerate ground
potential.

Use this button to clamp the pattern generator's output ports (Data,
Clock, Aux Data and Tigger/Ref Clock) to ground. You can see the status
of the outputs in the display area of the pattern generator.

Note that you can also use the buttons present below the display, to
enable or disable the output ports.

This function can be useful in case you want to connect or disconnect
a device to any of the output ports to prevent any damage.

Output Blanking

When the generator is set up to generate a pattern, use this checkbox to
activate the Aux In port of the pattern generator. You can then connect
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a signal to this port and operate the pattern generator in output
blanking mode.

If a logic low signal is supplied to the Aux In port, pattern A is sent to
the output port. If a logic high is supplied, no data is sent to the output
port.

This function is the same as the output blanking function in the Alternate
Pattern Control dialog box (see “Aux In” on page 153 for details).
However, this function also works with standard patterns.

When the generator is set up to generate a sequence, this checkbox is
disabled. You can connect a signal to the Aux In port of the pattern
generator. The reaction on this signal (for example, start sequence
execution, or break loop) is defined in the SequenceExpression. For
details see “User-Defined Sequences - Concepts ” on page 87.

Electrical Idle

Use this checkbox to activate Electrical Idle (Out Of Band Signaling;
OOB). Electrical Idle is controlled via the existing Error Add Input,
which will loose its error insertion functionality when used for
Electrical Idle.

N O T E The "Electrical Idle" checkbox is invisible when the N4876A Multiplexer is
connected to the N4903B Serial BERT.

De-Emphasis

Use this text box to enter the pre-cursor value. The value is interpreted
as dB or % depending of the specified mode.

N O T E This is applicable ony for N4916B.

Use this text box to enter the pre-cursor value. The value is interpreted
as dB or % depending of the specified mode.

Use this text box to enter the pre-cursor value. The value is interpreted
as dB or % depending of the specified mode.
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N O T E This is applicable ony for N4916B.

Use this text box to toggle between db and percent. Toggling does not
change the value.

Bit Rate

Bit Rate - Concepts

Bit rate is defined as bits per second. The pattern generator's clock rate
sets the bit rate and serves as the frequency reference for the Data, Aux
Data, Clock and Trigger/Ref Clock outputs, your device, and the error
detector (if it receives its clock from the pattern generator). It can be
generated internally or supplied from an external source.

When to Use an External Clock Source?

The Serial BERT's internal clock can be used for most testing purposes.
There are some circumstances, however, when an external clock source
is required:

• Synchronization with an external clock

The Serial BERT can be connected to an external clock to allow it to
run as part of a larger external system.

• Use of a modulated clock

A frequency- or delay-modulated clock can be used to provide a small
amount of jitter to the clock signal.

• Use of a precision clock

A precision clock with very low phase noise can be used to enhance
the instrument's performance. This is especially interesting for long-
term measurements.

• Testing at bit rates < 620 Mb/s

The Serial BERT's internal clock cannot be used for bit rates below
620 Mb/s.
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Bit Rate Range

The Serial BERT provides bit rates from 150 Mbit/s up to 12.5 Gbit/s,
depending on the instrument's options.

However, several specific properties and limitations need to be taken
into account when working at low bit rates. The limitations apply to the
instrument according to the following hysteresis curve:

• If the bit rate falls below 615 Mbit/s, the limitations apply.

• If the bit rate exceeds 620 Mbit/s, the limitations no longer apply.

The following figure clarifies the behavior in the range between
615 Mbit/s and 620 Mbit/s:

615 Bitrate [Mbit/s]

620

Limitations do not apply
in this range

Limitations apply
in this range

For the pattern generator the following rules apply:

• Below 620 Mbit/s, the pattern generator can only be operated with
an external clock source, because the internal clock source can only
produce signals higher than 620 Mbit/s.

• The trigger output cannot be set up to trigger on certain pattern
positions or pattern sequences. If this option is enabled (for example
in the user interface), the trigger is sent once for each pattern, but
the bit position cannot be specified.

The option to trigger on the divided clock signal is supported as
usual.

• There are restrictions to the available clock to data delay values.

The pattern generator can vary the clock to data delay only within a
range of -750 ps to 750 ps (relative to the clock signal). For
frequencies above 666 Mbit/s, this range is sufficient to cover the
complete clock cycle (= 1 unit interval).

For lower frequencies, the valid data delay range is smaller than the
clock cycle. The pattern generator cannot generate signals with a
delay outside this range. Therefore, the data delay cannot be set to
all values within the clock cycle.
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Clock 500 Mbit/s

Valid Range for
Data Delay

2 ns

Valid Data Delay

0 750 ps-750 ps

Spread Spectrum Clocking

A Spread Spectrum Clock (SSC) is widely used for reducing the peak
electromagnetic radiation at the nominal clock frequency. With SSC, the
clock pulse is modulated with a relatively low-frequency triangle
waveform. This broadens the clock signal spectrum and reduces the
peak energy.

The Serial BERT has a built-in SSC generator. This is a licensed option.
For information on how to enable this feature, see “Installing Hardware
Options - Procedures” on page 523.

For more information on SSC, see “Jitter Setup - Concepts ” on page
397.

Bit Rate - Procedures

You can use an external clock source or the Serial BERT's internal clock
to control the bit rate.

To set the bit rate:

1 If the external clock source has a frequency of 10 MHz, connect the
clock source to the pattern generator's 10 MHz Ref In port. If the
clock has another frequency, connect it to the Clock In port.

2 Click Bit Rate Setup menu item from the PG Setup submenu.

3 Select the appropriate clock source:

– Internal Clock Source

This setting uses the internal clock oscillator.

– 10 MHz Reference Clock

4 Setting up the Pattern Generator

132 Agilent J-BERT N4903B High-Performance Serial BERT



This locks the clock generator to an external 10 MHz reference.

– External Clock Source

This connects the external clock directly to the clock generator.

4 If you have chosen an External Clock Source, decide between manual
or automatic mode.

– In automatic mode, the clock rate of the external source is
automatically measured and used. If the source frequency varies,
the generated clock varies as well.

– In manual mode, you can measure and set the rate of the external
clock source by clicking the respective button. If the source
frequency varies, you will be alerted.

– If you need SJ and SSC simultaneously, use an external
modulated SSC signal from 6.75Gb/s to 12.5Gb/s and use the J-
BERTs SJ for additional jitter generation. To generate data rates
below 6.75Gb/s, the external clock must be divided.

5 Select a clock rate:

– For Internal Clock Source, you can either select a clock rate from
the Presets list, or enter a clock rate in the Value and Units field.

– For 10 MHz Ref Clock Source, the clock rate connected to the 10 MHz
Ref In port must be 10 MHz.

The selected clock rate applies to the pattern generator. This is also
the clock rate generated at the pattern generator's Clock Out port.

If the error detector receives its clock from the pattern generator, it
runs at the same clock rate.

Bit Rate - Reference

The Bit Rate Setup window contains the following elements:

Clock Source

Clock source can be one of the following:

• Internal: The clock generator uses the internal oscillator.

• 10 MHz Ref: The clock generator uses the 10 MHz Reference that must
be connected to the 10 MHz Ref Input.

• External: The pattern generator uses the external clock that must be
connected to the Clock Input. You can choose between “Automatic
and Manual Mode” on page 134.
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• External PLL: The pattern generator uses the external clock that
must be connected to the Clock Input. This clock is routed internally
through a PLL. You can choose between “Automatic and Manual
Mode” on page 134.

Automatic and Manual Mode

The Manual Adjustment checkbox is available if you have chosen an
external clock source.

In automatic mode, the external clock frequency is continually
measured. When the external clock frequency changes, the bit rate
changes as well.

In manual mode, you can enter the expected frequency or press the
Measure & Set button. Measure & Set requires that the external clock
generator is connected and active. Its frequency is measured once and
determines the bit rate. When the external clock frequency changes, PG
Clock Loss is signaled.

External Clock Divider

The internal clock (i.e. the bitrate) is the external clock divided by the
value specified in the clock divider field. The external clock divider field
is available if you have closen an external clock source.

External PLL Clock Divider and Multiplier

The internal clock (i.e. the bitrate) is the external PLL divided by the
value specified in the divider field and multiplied with the value
specified in the multiplier field. The external PLL clock divider and
multiplier field are available if you have chosen an external PLL clock
source.

Value and Units

This text field allows manual entry of the clock rate value. Click inside
this text field and use the numerical keypad or front panel knob to enter
a clock rate value. Complete the entry with a frequency unit by pressing
the G/n, k/m, M/µ, or X1 front panel key.
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Preset List

The Preset list contains clock rate values that are commonly used by the
pattern generator.

Click a preset to select it for the pattern generator clock rate.

User presets can be modified. To do so, double-click the preset. System
presets can not be modified.

Add Preset Button

Click this button to open the Enter Bit Rate dialog box and add a new clock
rate to the preset list. In this dialog box you can enter a value, unit and
text description of the new clock rate.

Delete Preset Button

Select a preset clock rate in the Preset list and click this button to remove
it from the list. You can only delete presets that are user-defined.

Clock Rate Indicators

The PG (Pattern Generator) and ED (Error Detector) bit rate indicators
shown in the lower pane display their current bit rate.

The ED bit rate is measured from the incoming clock signal or derived
from the data signal.
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Trigger/Ref Clock Output

Trigger/Ref Clock Output - Concepts

The pattern generator's Trigger/Ref Clock Out port can be used to send
a reference signal (or trigger) to external devices like an oscilloscope or
digital communication analyzer.

In pattern mode, the pattern generator sends a trigger signal that is at
least 32 bits long. See also “How the Serial BERT Generates Memory-
Based Patterns” on page 59 for details.

In sequence mode, the pattern generator can send a trigger signal
whenever a block of the sequence starts or restarts. See also “Sequence
Block Parameters” on page 94 for details.

Several options are available for the trigger signal. As an example, you
can send the trigger as a divided clock signal or as an indicator when
the data pattern starts.

Trigger/Ref Clock Output - Procedures

To set up the pattern generator's Trigger/Ref Clock Output port:

1 Connect the external instrument to the Trigger/Ref Clock Out port.

2 Click  Trigger/Ref Clock Setup menu item from the PG Setup submenu.

3 Select the trigger pattern that you want to be generated.

See “ Trigger/Ref Clock Output - Reference” on page 137“ Aux Data
Output - Reference” on page 141 for descriptions of the available
trigger signals.

N O T E If you have downloaded a user-defined sequence of patterns to the pattern
generator, the pattern-related settings are ignored. In this case, you can either set
up the Trigger/Ref Clock Out port to generate a subrate of the present clock or to
signal the beginning of a sequence block (see also “Sequence Block Parameters”
on page 94 for details).
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Trigger/Ref Clock Output - Reference

You can always generate a divided clock signal at the Trigger/Ref Clock
Out port. But if you wish to use the Trigger/Ref Clock Out port for
controlling external equipment, please note that you can also generate
a divided clock signal at the pattern generator's Aux Data Out port.

The alternate trigger signals refer to patterns and are not generated in
sequence mode.

To support the generation of a trigger spike at the beginning of a
sequence block, the Trigger/Ref Clock Output can be put into
Sequence mode.

Clock Divided by n

Select this option to send a trigger signal from the Trigger/Ref Clock Out
port at every nth clock pulse. Note that the trigger signal itself consists
of n/2 bits high followed by n/2 bits low. For example, Clock divided by
8 works as shown below.

Clock

Trigger Out

N O T E If the Divider Factor n is uneven (For example 3), the clock's duty cycle will not be
50%, but the signal will stay high for (n+1)/2 and low for (n-1)/2. This results in a
Duty Cycle Distortion (DCD) of 0.5 UI.

Alternate Pattern Trigger Level

N O T E This option applies for alternating patterns only.

Select this option to set the trigger level high whenever alternate pattern
B is sent.

The trigger output for 1024-bit patterns looks as follows:

Data Out A A B A B B A

Trigger Out
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N O T E This pattern must be at least 1024 bits long.

Alternate Pattern Trigger Pulse

Select this option to send a trigger pulse whenever the pattern being
sent changes (A to B or vice versa). For patterns with a length divisible
by 512, there is one trigger pulse sent for every pattern repetition.

Data Out

Trigger Out

A B A B B

If the length of the pattern is not divisible by 512, a trigger is sent
whenever the pattern reaches a 512-bit RAM boundary.

Sequence Trigger

This checkbox becomes available after a user-defined sequence has been
downloaded to the pattern generator.

Click this checkbox to switch the Trigger/Ref Clock Out port to
Sequence mode.

In Sequence mode, the Trigger/Ref Clock Out can generate a spike
whenever the execution of a block starts or restarts. Whether that
happens for a particular block or not is defined for each block
individually in the SequenceExpression. See also “Sequence Block
Parameters” on page 94.

Pattern Trigger Position

N O T E This option is not available for alternate patterns.

Select this option to send a trigger signal that is synchronized to a
certain position in the pattern. Depending on the type of pattern
currently loaded in the pattern generator, you have to specify the trigger
position either according to Bit Position or N-bit Trigger Pattern:

• Bit Position

If a memory-based pattern is loaded in the pattern generator, you
have to specify the bit in the pattern that sends the trigger. The bit
position can be in the range from 0 to Pattern Length - 1.

4 Setting up the Pattern Generator

138 Agilent J-BERT N4903B High-Performance Serial BERT



For pattern lengths that are divisible by 512 (such as 2^n PRBS
patterns), the trigger repetition rate is one pulse per pattern
repetition.

Data Out

Trigger Out

Bit Pos.

A A A

For pattern lengths that are not divisible by 512 (such as some
memory-based patterns), a trigger signal is sent once at the
corresponding bit when the pattern reaches the 512-bit boundary. If,
for example, the pattern is 384 bits long, a trigger signal is sent every
4th pattern repetition.

Data Out

Trigger Out

Bit Pos.

A0 A1 A2

A A A A A A A A A A A A

If the bit position is outside the pattern (i.e. the entered number
greater than the pattern length - 1), the entry is adjusted to the
pattern length - 1, i.e. the trigger is set to the last bit in the pattern.
If you load a pattern that is shorter than the entry in this field, the
trigger will be set to the last bit in the pattern.

• N-bit Trigger Pattern

This option is used for hardware-generated PRBS patterns. You can
specify a pattern with n bit length. A trigger pulse is sent when this
pattern is found in the PRBS. The trigger repetition rate is one pulse
per 512 pattern repetitions.

Example:

Pattern length: 2^7-1 (127) bits

N-bit pattern: 1110001

Data Out

Trigger Out

10 1 . . . .1 1000100 10 11 1000100 . . . .

• Shift Trigger Position

Clicking the left and right buttons will move the bit trigger position
back and forward by one bit.
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Aux Data Out

Aux Data Output - Concepts

The Aux Data Output port on the Pattern Generator's Output ports
allows you to generate a pulse with a frequency that is a fraction of the
present clock. Note that this output is not phasesynchronized with the
clock.

Aux Data Out - Procedures

To setup the pattern generator's Aux Data Output port:

• Click Aux Data Setup in the PG Setup menu. A PG Aux Data Output dialog
opens as shown in the figure below.

• Select the mode for the Aux Data Output. You can select from the
following options:

• Clock Divider

• Second Channel

• Multiplexer mode

• De-Emphasis
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N O T E The options on the Aux Data Output dialog are disabled when the N4876A
Multiplexer is connected to the N4903B Serial BERT.

N O T E The De-Emphasis option works only if there is no external De-Emphasis box
connected to the N4903B Serial BERT.

Aux Data Output - Reference

If you wish to use the pattern generator's Aux Data Out port, set the
mode from the following options:

• Set the Aux Data Out divider to a suitable value (between 2 and 128).

• Set the Second Channel

• Set the Multiplexer mode

• Set the De-Emphasis

N O T E If the Divider Factor n is uneven (e.g. 3), the clock's duty cycle will not be 50%, but
the signal will stay high for (n+1)/2 and low for (n-1)/2. This results in a Duty Cycle
Distortion (DCD) of 0.5 UI.

Aux Data Clock Divider

This setting controls the pattern generator's Aux Data Out port.

The Aux Data Out port is differential, always active, and generates a
fraction of the current clock. The range of the divider is 2, 3, 4, 5, ... 128.

Second Channel

In Second Channel mode, Data Out and Aux Out data channel can be
setup with an independent selection of data and PRBS patterns
(including free choice of PRBS type and polynomial).

Multiplexer Mode

In multiplexer mode, Aux Data Out no longer generates a Sub-Rate
Clock signal, but instead generates the required second data stream for
a multiplexer that is connected to Data Out and Aux Data Out.
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N O T E The multiplexer mode is automatically selected when N4876A is connected and the
Multiplexer is enabled from the Config window.

Once the multiplexer is enabled, it is necessary to perform system setup
adjustment before it is practically used. For more information, see
“N4876A System Setup Adjustment” on page 484.

In multiplexer mode, the pattern for the PG is automatically split
between Data Out and Aux Data Out. This mode is intended to stimulate
multiplexing devices without having to care for the correct setup of the
required data streams. The PG pattern is considered to be the serialized
output of the connected multiplexer.

De-Emphasis

In De-emphasis mode, an external connected passive resistor network
adds two bit streams. The bit streams provided at ‘Data Out’ and ‘Aux
Out’ are identical except for the bit stream at Aux Out which is shifted
by one bit. The bitshift value can only be -1 (Pre-Cursor) or +1 (Post-
Cursor). For more information, see “Controlling De-Emphasis Mode” on
page 125.

Delay Control Input

Delay Control Input - Concepts

The Serial BERT features a wide bandwidth voltage controlled delay
line in its pattern generator data path, which can be used to delay the
data relative to the clock. The delay is controlled by an external signal
connected to the Delay Ctrl In connector on the pattern generator front
panel.

The delay control input is intended primarily for jitter tolerance testing,
where a data signal with a defined amount of jitter is needed. Random
jitter (RJ) can be created by applying high bandwidth white Gaussian
noise, periodic deterministic jitter (DJ) with sinusoidal (SJ) or
rectangular/triangle signals (PJ).

The delay control input is most useful for the generation of high
frequency, low amplitude jitter. Higher amounts of jitter at lower
frequencies (wander) can be generated by supplying an FM modulated
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clock to the pattern generator's clock input (Clk In) in external clock
mode.

N O T E With a Serial BERT on which the calibrated and integrated jitter injection option J10
is installed, the delay control input is rarely used as explained above. The option
J10 includes all the jitter sources required for jitter tolerance tests. For details see
“Jitter Tolerance Tests - Concepts ” on page 387.

The delay control input is equipped with overvoltage protection. If the
applied voltage is too high, the input is automatically disabled, and the
following dialog appears:

You can enable the input after reducing the voltage to a safe level.

Delay Control Input - Procedures

N O T E The following procedure does not apply to Serial BERT on which the calibrated and
integrated jitter injection option J10 is installed. For such instruments refer to “Jitter
Setup - Procedures” on page 400.

To set up a jitter tolerance test on an instrument without option J10:

1 Press PG Data Setup in the PG Setup menu.

2 Disable the Delay Control In port by clearing the Delay Control Input
checkbox.

3 Connect the device that supplies the jitter signal to the Delay Control
In port.

4 Enable the port again by selecting the Delay Control Input checkbox.
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T I P While monitoring the BER you can use this checkbox to switch jitter on and off and
view the effect on the BER.

Delay Control Input - Reference

This checkbox in the PG Data Setup window is used to disable or enable
the Delay Control In port, where you can supply an external signal to
add jitter to the output signal.

N O T E This checkbox is not available on instruments on which the calibrated and integrated
jitter injection option J10 is installed. On such instruments, the Delay Control In port
is enabled or disabled from the Jitter Setup window.

Error Addition/Insertion

Error Addition/Insertion - Concepts

To test error correction algorithms, alarms and other functions that are
imbedded in the data pattern, you can insert logic errors (flipped bits)
into the pattern.

The instrument provides several options (in the pattern generator's
Error Add dialog box) for inserting error bits manually or automatically.

Error Addition/Insertion - Procedures

You have the following options for inserting errors into the output data
stream:

Manually Inserting Errors

To manually insert a single error into the output stream:

1 Click the Error Add button at the top of the screen to insert one single
bit error in the output stream.
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This button is active unless you define a fixed internal error rate.
The maximum number of errors that this function supports, is one
error per 128-bit block.

2 If you want to disable all other error insertion functions, so that
only manual error insertion is possible, click Error Add Setup menu
item from the PG Setup submenu to open the Error Add Setup dialog
box.

3 Select Off and click OK to close the dialog box.

Using an External Signal for Inserting Errors

To configure the Serial BERT to insert a single error into the output
stream according to an external signal:

1 Connect an external instrument to the Error Add port.

The signals received at this port must be TTL-compatible.

2 Click Error Add Setup menu item from the PG Setup submenu.

3 Select External (Error Add) and click OK to close the dialog box.

Now, upon a rising edge of the signal at the Error Add port, an error
will be generated in the output stream by flipping a single bit within a
bit block of 128 bits (resulting in a maximum BER of 1/128 or 10-2).

T I P You can use an external signal to set up a bit error rate to fit your needs. The
frequency of the external signal can be calculated by multiplying the desired bit
error rate by the clock frequency.

If, for example, you want a bit error rate of 3x10-7 and you are running a test at 12.5
䠠 Gb/s, the frequency of the external signal is:

3x10-7 x 12.5x109 = 3750 Hz
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Using the Serial BERT to Insert Errors

To configure the Serial BERT to automatically insert errors in the output
stream to achieve a desired bit error rate:

1 Click Error Add Setup menu item from the PG Setup submenu.

2 Select Internal.

3 Use one of the following options to define the Error Insertion Rate:

– Error Rate allows you to select a BER from a list.

– Bits between Errors allows you to specify how many regular
(correct) bits are sent without errors before inserting the next
error.

4 Click OK to close the dialog box.

T I P To find out how your DUT reacts on very small bit error rates, set up the pattern
generator to enter errors once every 10-12 bits and run a longer accumulative test.
You can then find the DUT's true error rate by calculating the difference between
the bit error rate set up in the pattern generator and the accumulated bit error rate
found by the error detector.

N O T E If you set up too high an error rate, the error detector will not be able to synchronize
to the incoming pattern. When setting up an error rate, always make sure that the
synchronization threshold is higher than the bit error rate.

Error Addition/Insertion - Reference

The following functions are available to insert errors in the bit stream:

Error Add Button

The Error Add button in the top right corner is used to insert a single bit
error in the data stream.
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This button is always active, even if other error insertion mechanisms
are running. The maximum number of errors that this function supports
is one error per 128-bit block.

Error Add Setup Dialog Box

The Error Add Setup dialog box provides the following configuration
options:

Channel Select

With this option, you can apply the error insertion either on Data, Aux
or Both channel(s).

N O T E Aux and Both options will be disabled in single channel mode.
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External (Error Add)

With this option selected, when a rising edge is detected at the Error
Add port, an error will be generated in the output stream by flipping a
single bit within a bit block of 128 bits.

The signals received at this port must be TTL-compatible.

Internal

Select this option to use internal error insertion functions:

• Error Rate

Allows to select from a preset bit error ratio from 1.000E-02 to
1.000E-09. Errors will be added to the output pattern to produce this
error ratio.

• Bits Between Errors

Allows you to enter the number of valid bits between two errors. This
is the inverse of the bit error ratio.

Off

Select this option turn off all internal add rates and external error
inputs. This allows you to manually add single errors by pressing Error
Add on the main display. This flips a single bit in the output stream.

Pattern Alternation

Pattern Alternation - Concepts

This section explains the basic purpose of alternating patterns. Two
alternate patterns can be stored in one pattern file.

Note that you can also generate a sequence of up to four alternating
patterns (see “User-Defined Sequences - Concepts ” on page 87).
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Standard and Alternating Patterns

With the Serial BERT, you have full control on the data stream that is
sent by the pattern generator to your device under test. You can use
standard patterns to specify a test data pattern that is sent to your DUT
repeatedly.

Or, you can use alternating patterns to specify two patterns that are
sent to the DUT alternately. To implement alternating patterns, the
instrument's user pattern memory is split into two portions; one for
pattern A and one for pattern B.

The differences between these patterns are:

• Standard patterns consist of one single pattern that is repeatedly
sent. Any arbitrary pattern up to 32Mbit length can be set up.
However, there are no further configuration possibilities. This
pattern is sent as long as the output port is enabled.

See “Setting up Patterns - Concepts” on page 51 for more details.

• Alternating patterns consist of two patterns, one of which is pattern
A (the A half), the other is pattern B (the B half). Both patterns are
of equal length, each up to 16Mbit.

The Alternate Pattern Control dialog box lets you control when which
pattern is sent. See “Pattern Alternation - Procedures” on page 150.

When to Use Alternating Patterns

Alternating patterns can be used:

• To systematically insert errors in the bit stream at particular
positions.

The error detector expects pattern A only. If you set up pattern B so
that there are only minor differences, when you run the test, the
error detector will detect the changed bits as errors.

• To see how long it takes your DUT to settle.

You can set up an easy-to-process output stream as the standard
pattern, and a difficult output stream as the alternate pattern (for
example, all 0s for the standard pattern, and alternating 1s and 0s
as the alternate pattern). You can then track how long it takes for
your DUT to recover after the alternate pattern has been sent.
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Pattern Alternation - Procedures

The Alternate Pattern Control dialog box controls how the output stream
switches between the standard pattern and the alternate pattern.

You have the following possibilities for setting up alternating patterns:

Setting Up a Periodical Output

To configure the pattern generator to generate periodical data output:

1 Click Alt. Pattern and Aux In  menu item from the PG Setup submenu to
open the Alternate Pattern Control dialog box.

2 Select one of the following options:

– Continuous A

Only pattern A is output repeatedly.

– Continuous B

Only pattern B is output repeatedly.

– Alternate AB

The output stream switches between pattern A and pattern B.

– Single Shot B

With this option selected, the Insert B button is enabled.

3 Select OK when your selection is complete.

Manually Inserting Pattern B into the Output Stream

You can insert a single shot of pattern B into the continuous stream of
pattern A:

1 Click Alt. Pattern and Aux In  menu item from the PG Setup submenu to
open the Alternate Pattern Control dialog box.

2 Select Single Shot B and click OK to close the dialog box.

3 During the test run, press the Insert B button on the screen.
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This inserts a single occurrence of pattern B into the output stream of
pattern A.

Inserting Pattern B via External Signal

You can configure the Serial BERT to insert pattern B into the
continuous output stream of pattern A according to an external signal:

1 Connect an external instrument to the Aux In port.

The signals received at this port must be TTL-compatible. The
granularity for the insertion of pattern B via external signal is 512
bits.

2 Click Alt. Pattern and Aux In menu item from the PG Setup submenu to
open the Alternate Pattern Control dialog box.

3 In the Aux In section, define whether the Serial BERT should insert
pattern B in Level Sensitive or Edge Sensitive mode.

See “Aux In” on page 153 for more information on the different
available modes.

4 Click OK to close the dialog box.

Suppressing the Outputs via External Signal

You can configure the Serial BERT to suppress the output according to
an external signal:

1 Connect an external instrument to the Aux In port.

The signals received at this port must be TTL-compatible. The
granularity for the insertion of pattern B via external signal is 512
bits.

2 Click Alt. Pattern and Aux In menu item from the PG Setup submenu to
open the Alternate Pattern Control dialog box.

3 In the Aux In section, select Output Blanking.

See “Aux In” on page 153 for more information on the different
available modes.
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4 Click OK to close the dialog box.

Pattern Alternation - Reference

The Serial BERT offers the following options for alternating between
pattern A and pattern B:

N O T E These functions are only available if Alternate Pattern is selected in the Pattern
Properties dialog box.

Continuous A

Select this option to send out only pattern A repeatedly.

A0 A1 A2

A A A A A A A A A A A AData Out

Continuous B

Select this option to send out only pattern B repeatedly.

B0 B1 B2

B B B B B B B B B B B BData Out

Alternate AB

Select this option to alternately send out patterns A and B (A, B, A, B...).

Data Out

B0

B B B B

A0 A0

A A A A A A A A

B0

B B B B

Single Shot B

Select this option in the Alternate Pattern Control dialog box to enable the
Insert B button on the main display.
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When you press the Insert B button, pattern B is inserted into the
continuous output of pattern A.

Data Out A A A A A A A A B B B B A

A0 A0 B0 A0

A A A

Insert B pressed

Aux In

In this section you can enable the Aux In port to control the output
pattern. Aux In can receive signals that control alternate patterns or
blank the output.

The signals received at this port must be TTL-compatible. The
granularity for signals at this port is 512 bits.

The following options are available for Aux In:

• Disable

With this option selected, the signal at the Aux In port will be
ignored.

• Level Sensitive

– If Aux In is logic high, pattern B is sent.

– If Aux In is logic low, pattern A is sent.

Aux In

Data Out A A B A B B B

• Edge Sensitive

Pattern A is sent out until a rising edge at Aux In is detected. Then,
at the next complete repetition of pattern A, a single occurrence of
pattern B is inserted into the output.

Aux In

Data Out A A B A B A A

• Output Blanking

Pattern A is sent when the signal at Aux In is low. Pattern B is not
sent in this mode.

Data Out

Aux In

A A A A
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If Aux In is pulled to logic high and a standard pattern is selected, no
output pattern will be sent.

N O T E Due to the pattern generator behavior, the patterns may be repeated up to 512 times
before alternating. See “How the Serial BERT Generates Memory-Based Patterns”
on page 59 for details.
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5 
Setting up the Error Detector

Setting up the Error Detector - Concepts

The error detector analyzes an incoming bit stream, compares it to the
expected pattern, and locates any inconsistencies. The error detector
requires the following settings to work correctly:

• The expected pattern

The error detector needs to "know" which data to expect so that it
can detect bit errors.

• Correct input and output terminations to the DUT

This ensures that your DUT cannot be damaged due to incorrect
terminations.

• Correct clock frequency

Required to recognize the bit rate in the data stream.

• Appropriate sampling point

The sampling point defines where the error detector tries to
differentiate between 0s and 1s in the data stream. This is necessary
so that the error detector recognizes the data bits correctly.

• Synchronization to the incoming pattern

The expected pattern must be synchronized to the incoming pattern
so that the error detector can find any discrepancies.

The error detector provides the following functions to enable you to
perform tests:

• Automatic pattern synchronization

The error detector shifts the incoming data stream bitwise to match
it to the expected data pattern. A correct BER can only be measured
with matching patterns.

• Error accumulation
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You can specify whether a test runs for a specified time or until a
specific number of errors has occurred. This lets you carry out longer
tests while logging the results to a file.

• BER location mode

You can specify whether all errors are counted or only the errors
that occurred on a particular bit position or range of positions.

• Audio warnings

You can set up the audio warnings so that the instrument beeps when
a certain BER is exceeded.

• Trigger output for external measurement instruments

This allows you to connect other devices for further error analysis.

N O T E When the Bit Recovery Mode (BRM) option is installed, the error detector is able
to detect bit errors without expecting any particular pattern. This feature allows you
to investigate the behavior of the DUT when the sampling point is moved.

Inputs and Outputs

Inputs and Outputs - Concepts

The error detector (ED) provides input and output ports for running
tests and for connecting external equipment.

The error detector has the following inputs and outputs:
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Understanding Error Detector Input Ports

The error detector has the following input ports:

• Clock In

This port needs to be connected to a clock signal unless you use the
error detector in Clock Data Recovery (CDR) mode, where it derives
the clock frequency from the data port. See “Clock Setup - Concepts ”
on page 162 for more details.

• Data In and Data In

This port is connected to the data signal and the inverted data signal.

• Gate In

This port has two different functions.

– In normal mode it can be used to enable and disable the error
counter. Errors are only counted when this signal is low.

The error counter can only count errors in 128-bit data blocks.
Thus, the signal at the Gate In port must be low for at least 128
bits to enable the counter. The following figure illustrates the
effect of error gating. Errors are only counted in the gray blocks.

Gate In

Expected Data on
Data Input

minimum signal
length not matched

only 128bit
granularity

A A

– The burst sync mode is a special operating mode for measuring
data in bursts of bits, rather than one continuous stream of bits.

In this case, the signal at the Gate In port controls the timing of
synchronization and error counting for each burst.

Understanding Error Detector Output Ports

The error detector provides several output ports that are used to
connect it to other devices for further error analysis:

• Trigger Out

Use this port to send a trigger signal to another connected device,
such as an oscilloscope.

• Error Out

This signal can be used to trigger an external instrument to help in
error analysis. When any number of errors are located within a 128-
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bit data block, a single trigger pulse is sent. If continuous errors are
detected, the error out signal would be a clock signal.

Error Out

Error
detected

Data IN A

n Errors within
128bit granulation

(n<128)

single error
marking

A

n Errors exceeding 128bit
granulation (n>128)

• Aux Out

This port can be used to output the clock signal or the data signal to
another connected device.

The following figure shows how the clock signal is directed to Aux
Out in Clock mode:

CLK IN

DATA IN

AUX OUT

CDR

CLOCK MODE

Recovered CLK

Comparator

0/1 Threshold

internal
Signal

Analyzer

Data In Port Termination

To ensure a valid setup and to protect the devices from damage, proper
termination must be specified for both Data In connections. You can
specify the termination by entering the termination voltage in the
respective field.

C A U T I O N Selecting the wrong termination may damage your device.
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Why Can Wrong Terminations Damage Your Device?

Choosing wrong terminations may cause your device to output voltage
levels that are not as expected. It may also cause excessive current or
current flow in the wrong direction, which can damage your device.

N O T E The clock termination is set to 50 Ohm, AC-coupled, and cannot be changed.

Inputs and Outputs - Procedures

To select the termination for the error detector:

N O T E Prerequisite: You must know the termination voltage of the data signal that your
DUT sends to the error detector.

1 In the ED Setup menu, press Sampling Point Setup to access the Sampling
Point Setup window.

2 Click the Edit button. This opens the ED Input Setup dialog.

3 In the Termination field, enter the termination voltage that is
appropriate for the incoming data signal.

You can use the front panel knob or the numeric keypad to enter the
value.

C A U T I O N Selecting the wrong termination may damage your device.

4 Select the Data Inverted checkbox if your device inverts data.

You can now physically connect the DUT to the error detector.
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Data Input Setup - Reference

The ED Input Setup dialog is accessed from the Sampling Point Setup
window. It is used to set up the error detector's data input port:

Input

The selection in this list defines how the signals arriving at the Data In
and Data In connectors are interpreted. The following options are
available:

• Differential

If differential mode is selected, both input ports need to receive a
signal. The actual data signal is measured as the voltage difference
between the two incoming signals.

• Normal

In normal mode, only the Data In port receives the data signal, the
Data In port is inactive.

• Complement

In complement mode, only the Data In port receives the data signal,
the Data In port is inactive.

Data Inverted

Activate this checkbox to invert the polarity of the error detector
reference pattern. This function is required if your device inverts data.

Threshold

Only available, if the input is set to normal or complement mode.

Choices are:

• Averaging: The 0/1 threshold voltage is derived from the input signal
via a low-pass filter. This will work fine for most applications.

• Manual input: Enter a value for applications that do not provide a
continuous data stream at the input (for example, any application
using bursts), because the averaged 0/1 threshold voltage will drift
from the correct level when there is no input. The manually set
threshold voltage must of course be within the input range.
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Termination

In this field, enter the termination voltage that is appropriate for the
incoming data signal. This selection should be made before the device
is connected to the analyzer.

If the input is set to differential mode, a termination voltage can only
be set for a device that is DC-connected.

C A U T I O N Selecting the wrong terminations may damage your device.

The Data In port is connected to a 50 Ohm load impedance (or
termination) within the error detector. Data termination refers to the
voltage level at the end of this load. The logic output from a device
requires any connected equipment, including the error detector, to have
a specific termination voltage.

Input Range

Before you can synchronize the error detector to the incoming data
stream, you need to define the voltage range within which the eye is
located.

Both the high and low level of the data signal must be within this range
to find the eye.

N O T E The input voltage range is 2V. When you modify either the high or low voltage, the
other voltage is automatically adjusted.

N O T E See “Sampling Point Setup - Reference” on page 185 for a complete description of
all parameters of the Sampling Point Setup window.

Setting up the Error Detector 5

Agilent J-BERT N4903B High-Performance Serial BERT 161



Clock Setup

Clock Setup - Concepts

To measure the Bit Error Rate with the error detector, the bit rate of
the data stream must be known. Depending on the options the
instrument is delivered with, you could use either an external clock
source for the error detector (for example, the clock from the pattern
generator), or extract the clock signal from the incoming data (CDR
mode).

CDR mode does not work for all kinds of data patterns. For example, if
the device under test sends only blocks of ones and zeros, there are no
transitions in the data stream and the Serial BERT cannot recover the
clock.

Also, if you are testing bursts, there are some special considerations for
setting up CDR. See the following sections for details.

How does Clock Data Recovery Work?

In CDR mode, the CDR has to recover the clock from the incoming data.
To do this, the hardware has to decide whether the voltage at the input
connector is a logical '1' or '0' and then recover the clock from the
detected transitions.

Clock Data Recovery (CDR) is a special kind of Phase Locked Loop
(PLL), which recovers clock signal from of a data stream. It is a
regulatory loop, which synchronizes the local oscillator with an external
reference, in this case the incoming data stream.

Phase Locked Loop

A PLL has three parts: a phase detector, a loop filter, and a voltage
controlled oscillator (VCO). The phase detector has two inputs, and one
output, which is proportional to the phase difference of the inputs. The
loop filter is a low pass filter which attenuates the higher frequencies
from the output of the phase detector. The VCO is an adjustable
oscillator which changes the output frequency depending on its input
voltage. The diagram below shows a simple PLL.
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One of the most important characteristics of a PLL is its loop transfer
function.The loop bandwidth is defined as the integrated magnitude of
the PLL’s frequency transfer function over the entire frequency
spectrum. The loop bandwidth describes how the regulatory loop tracks
the VCO to a sine wave FM modulated input signal. Above the bandwidth
the loop cannot track such a modulation completely, and thus, the
response to the modulation is attenuated.

The other loop parameter is peaking. This describes how much a
modulation is exaggerated (mostly close to the loop bandwidth).

N O T E The “frequency” is the modulation frequency, and “amplitude” is the tracking of
the PLL.

Data rate and loop parameters

The data stream contains multiple frequencies, and the CDR needs to
know the expected data rate. The user entered information is necessary
to lock the CDR, and to detect a loss in lock condition. The entered
frequency should be accurate, and better than 100 ppm.

N4903B provides a CDR which has additional input parameters: loop
bandwidth, transition density, peaking, and SSC deviation.

Loop bandwidth is the input parameter to set the characteristics of the
loop.

Additionally, the Peaking can be chosen from a drop down list.
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Transition density affects the loop parameters, and it must be either
entered, or measured. Some standards define a loop bandwidth for a
specific transition density.

The SSC deviation parameter widens the window for loss in lock
detection, and detunes the center of detection, because SSC is generally
asymmetric (down-spread).

N O T E CDR is not available together with Bit Recovery Mode (BRM) at data rates above
11.5GHz.

Threshold

The regular threshold voltage is not only used to determine the optimum
sampling for the data, but also to perform measurements such as eye
diagram or output level measurements, it is not possible to use it for the
clock recovery.

For this reason, the clock recovery circuitry has it's own comparator for
the incoming data. This comparator also needs to know the threshold
voltage (0/1 decision threshold).

The threshold voltage can be derived from the input signal via a low-
pass filter. This will work fine for most applications. But applications
that do not provide a continuous data stream at the input (for example,
any application using bursts) cannot use this low-pass filter, because
the threshold voltage will drift from the correct level when there is no
input. In such cases, the threshold can be specified manually. It is then
no longer derived from the input signal (see the following figure). The
manually set threshold voltage must of course be within the input range.

The difference between the data path and the CDR path is that the
comparator of the CDR is always single-ended. Thus, this comparator
always needs a threshold voltage that lies between the high and low
levels of the incoming signal.

The differential threshold of the data path comparator has no relation
to the single-ended threshold of the CDR path comparator. This means
that in differential mode, the two thresholds will be different and in
single-ended mode (either normal and complement) they will/can be
equal (except during measurements).

The following figure shows a simplified block diagram. It does not reflect
the different input modes (especially the differential case), but it
matches both single-ended cases.
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Bit Rate Range

The Serial BERT provides bit rates from 150Mbit/s up to 12.5 Gbit/s,
depending on the instrument's options.

However, several specific properties and limitations need to be taken
into account when working at low bit rates. The limitations apply to the
instrument according to the following hysteresis curve:

• If the bit rate falls below 615 Mbit/s, the limitations apply.

• If the bit rate exceeds 620 Mbit/s, the limitations no longer apply.

The following figure clarifies the behavior in the range between
615Mbit/s and 620 Mbit/s:

615 Bitrate [Mbit/s]

620

Limitations do not apply
in this range

Limitations apply
in this range

For the error detector the following rules apply:

• For low frequencies, you cannot use the automatic data alignment
functions (Auto Align and Data Center). Instead you need to align the
error detector manually. For instructions, please refer to the Online
Help, go to the Error Detector Setup section, select Sampling Point
Setup, and switch to the Procedures information.

• There are restrictions to the available sampling point delay values.

The error detector can vary the sampling point delay only within a
range of 0ps to 1.6129ns (relative to the clock signal). For frequencies
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above 620 Mbit/s, this range is sufficient to cover the complete clock
cycle (= 1 unit interval).

For lower frequencies, the maximum sampling point delay is smaller
than the clock cycle. Therefore, the sampling point cannot be set
everywhere within the clock cycle.

Clock 500 Mbit/s

Valid Range for
Sampling Point

2 ns

Valid Sampling Point

0 1.6129 ns

If you cannot find the optimum sampling point in the valid range of
sampling points, you can switch from the rising to the falling clock
edge. For this purpose activate the Clock Falling Edge checkbox on the
Sampling Point Setup screen of the error detector setup.

Clock 500 Mbit/s

Rising Edge
Sampling Point Delay

Falling Edge
Sampling Point Delay

2 ns

Covered Range

With this method you can still place the sampling point anywhere in
the clock cycle to find the optimum sampling point, even at low
frequencies.

Clock 310 Mbit/s

Covered Range

3.226 ns

However, if the bit rate falls below appr. 310 Mbit/s, even with this
method gaps occur in the range of possible sampling points.

Clock 150 Mbit/s

Covered Range
with Gaps

6.66 ns

Gap Gap Gap Gap Gap

As a result, you might not be able to find the optimum sampling
point, if it falls in one of the gaps.
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Clock Setup - Procedures

To set the clock rate:

1 Press Clock Setup in the ED Setup menu.

2 Specify whether you are using an External Clock Source or Clock Data
Recovery (CDR).

3 If you are using CDR, you need to approximately specify the clock
rate in the Clock Rate field (with an accuracy of 0.01%).

4 If you are measuring bursts, deactivate Auto Threshold and set the
threshold manually. You can also press the Measure button to
measure the current DC level at the CDR input and set the measured
value as CDR threshold.

5 Clock rates that are frequently used can be saved as presets in the
Preset list.

To select a clock rate from the Preset list, click on it. The clock rate
appears in the Clock Rate field.

6 Specify the Loop Bandwidth within the range of 100 KHz to 12MHz.
Specify the CDR Fine Adjust and  Peaking values. When using a Preset,
this is only required when you want to change these values.

7 Enable Spread Spectrum; and adjust the deviation (%) and deviation
type as required.

8 Either enter the transition density manually, or run a measurement to
update this value.

Clock Setup - Reference

The Clock Setup window contains the following elements:

Error Detector Bit Rate

The bit rate of the data reaching the error detector is displayed in the
lower right corner of the user interface.

The bit rate of the error detector is set by the clock signal received by
the error detector. If the output bit rate of your device is not equal to
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its input bit rate, the pattern generator and error detector will be
operating at different frequencies.

Clock Mode

The error detector supports two different clock modes:

• External Clock Source

If this mode is selected, the Serial BERT uses the clock signal that is
connected to the Clock In port.

• Clock Data Recovery

If this mode is selected, the Serial BERT derives the exact bit rate
from the incoming data stream. To make this function work, the
approximate clock rate must be specified in the Clock Rate field (with
an accuracy of 0.01%).

Clock Rate

This field is used to specify the approximate clock rate for CDR mode.
Serial BERT needs this value to be about 0.01% accurate to find the
actual bit rate in the data stream.

Use the numeric keypad to enter the value followed by the unit that you
can select with the G/n, M/μ, k/m, and X1 keys on the front panel.

Alternatively, you can select a value from the Preset list.

Preset List

The Preset list contains clock rate values that are commonly used by the
error detector.

These presets also modify the loop parameters of the tunable CDR
according to the selected standard. The factory presets consider the
parameters as given in the selected standard.

Click a preset to select it for the error detector clock rate.

Double-click a preset to modify it.

Add Preset

Use the Add Preset button to add a new preset to the Preset list. You can
then enter a value, a unit, and a short description for this new preset.
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N O T E Changes made in this dialog are effective immediately. So, if you press Cancel, the
settings are still valid.

Delete Preset

Use the Delete Preset button to delete the currently selected preset from
the list. You can only delete presets that are user defined.

Transition Density

The transition density is defined by the number of transitions in the
incoming data divided by the total number of bits transmitted. In this
field enter the transition density in (%). Click 'measure' to measure and
update the transition density.

This parameter affects the loop bandwidth, and thus must be either
entered correctly or measured. Some standards specify the loop
bandwidth for a given transition density. In such a case enter the value
given in the specification, so that the CDR behaves according to the
standard. If a standard from the preset list is selected, this field is
preset.

Loop Bandwidth

This is the range of the CDR loop bandwidth. In this field the user should
enter the loop bandwidth value; the range is within 100 KHz to 12MHz.
If a standard from the preset list is selected, this field is preset.

When the BERT error detector is used to characterize a data stream
instead of a receiver, the loop parameters should be set according to the
used standard.

If the CDR is used to recover the bit stream from a receiver to be
characterized due to a lack of a clock output, choose the loop bandwidth
significantly higher than the receiver’s bandwidth. To characterize a
DUT’s CDR it is the best practice to use its recovered clock output
instead of the BERT’s built in CDR. Choose a low loop bandwidth to
measure the jitter on an incoming data stream as the CDR will track the
incoming jitter up to the loop bandwidth and thus make it invisible to
the error detector.

Fine Adjust

Fine Adjust allows you to tweak the response of the CDR according to
transition density changes. This control can be used to reduce jitter in
pattern with high changes in transition density.
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Peaking

The drop down list provides a maximum of three peaking values. If a
standard from the preset list is selected, this field is preset. A low value
reduces the peaking near the loop bandwidth while, a higher value
improves the SSC response.

Auto Threshold

If the Auto Threshold option is selected, the Serial BERT continuously
analyzes the incoming data stream to detect the voltage level that is
optimal for the derivation of the clock signal.

This function is recommended for all applications where a valid data
stream is continuously arriving at the error detector.

For measurements with partly invalid data, such as burst tests, this
function may cause a clock loss. In such cases, deactivate Auto
Threshold and

• enter a fixed voltage level manually, or

• press the Measure button to measure the voltage level of the incoming
signal while a burst signal is applied.

Once the level is defined, it remains fixed for the following
measurements.

Note that the entered voltage level has to be within the input range of
the error detector. If the value lies outside this range, the change is
rejected and an error message is displayed.

CDR Spread Spectrum Clocking

This control is used to adapt the CDR to an input bit stream with SSC.
Enable widens the loss of lock detection window, and sets the peaking
to optimum SSC performance. Enter the Expected Deviation and the
type of deviation (Upspread, Downspread or Centerspread) to set the
locking window to an optimum.

SSC is mostly used “down-spread” which means, the clock signal is
modulated to a lower frequency and back. Thus the average frequency
is lowered by half of the maximum deviation. The CDR is adapted to
that value. Enter the maximum deviation as most standards specify.

N O T E Although the CDR will lock even without the presence of SSC, it is strongly
recommended to uncheck this box when SSC is not present; otherwise the CDR will
unnecessarily loose performance in lock detection and lock time.
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Error Ratio

Error Ratio - Concepts

The Serial BERT provides the enhanced capability to perform a receiver
(RX) jitter tolerance test where it analyses 10 bits symbols as coded data
to measure Symbols Error Ratio (SER), Frame Error Ratio (FER), Filler
Symbol Ratio (FSR), Illegal Symbol Ratio (ISR), Disparity Error Ratio
(DER) along with the calculated BER (cBER).

You need to set the error ratio mode from the J-BERT's Error Detector -
Error Ratio window. For more information, see “Setting up Error Ratio”
on page 172.

N O T E All measurements (except Jitter Measurement) in 8B/10B Symbol Comparision
mode automatically switch to BER mode and work in Bit Recovery Mode. These
changes are reflected in GUI too. Jitter measurements works in 8B/10B Symbol
Comparision mode also and uses calculated BER (cBER) to check against Target
BER.

In case of Jitter Measurement, the auto re-sync automatically switches to manual
sync mode and then restores it back when the measurement is finished/aborted.

Understanding the Error Free Receiving in 8B/10B Symbol
Comparision

When RX detects incoming data correctly, the pattern looped back has
the “same” content and number of symbols except for filler primitives.
These can be removed or inserted by DUT to compensate for the speed
differences of the clock domains. Furthermore, 8B/10B coding defines
two different (bitwise complementary) 10B symbols for the majority of
8bit words based on a running disparity.

It may therefore happen that the data looped back by the DUT is
transmitted with a different than the incoming disparity, depending on
the DUT’s starting disparity. Both effects represent desired operation
of the DUT and the pattern looped back, although bit-wise different in
content and number of bits, is an indicator for error free data detection
of the RX-under test, so that consequently in order to report this
different bit stream as error free the ED has to recognize the 10B Data
and filler symbols (of both disparities) and to ignore the insertion or
deletion of filler symbols.

The following figure shows the functional block diagram of Option A02.

Setting up the Error Detector 5

Agilent J-BERT N4903B High-Performance Serial BERT 171



Error Ratio - Procedures

This section explains how to set up an Error Ratio.

Setting up Error Ratio

Follow the below steps to set up an Error Ratio:

1 Load the appropriate patterns in Pattern Generator and Error
Detector. For more information, see “User Patterns - Procedures” on
page 61.

N O T E Patterns with Invalid symbol(s) when loaded in ED display an error message.
However, if the same pattern in loaded in PG, the "8b10b Error" indicator turns red
and no error message is displayed.

Patterns with Illegal runing disparity when loaded in ED will turn the respective
symbol red when current running disparity is same as previous running disparity. If
same pattern is loaded in PG it will turn "8b10b Error" indicator red.

2 If you want to test your device in CDR mode, then set the Clock Data
Recovery (CDR) from the Clock Setup window. For more information,
see “Clock Setup - Procedures” on page 167.

3 From the main menu, choose ED Setup and then click Error Ratio from
the list of menu items.
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This will launch an Error Ratio window.

4 Choose whether you want the error ratio based on bit comparison
or 8B/10B symbol comparison.

N O T E The Bit Comparison option is selected as default.

If you select error ratio based on bit comparison, skip steps 5 to 11
and go to step 12.

However, if you select error ratio based on 8B/10B symbol
comparison, follow the below steps.

5 Click cBER Setup.

It opens a cBER Setup dialog. This dialog offers the choice to calculate
cBER based on either SER, FER, FSR, ISR, or DER with either
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automatic conversion factor or manually specified conversion
factor.

C A U T I O N When cBER is calculated from FSR, DER, ISR, in this case the cBER might be lower
than the sync threshold, even if the cBER based on SER or FER is higher than sync
threshold. This affects the automatic re-sync behavior and a manual "Sync Now"
is required.

6 Select the predefined standards listed in the Setup window.

N O T E In order to achieve Symbol Lock, the pattern loaded in PG must have the same
Comma Symbol as selected from the standard.

7 Click Add Preset button to open 8B/10B Presets dialog. It allows you
to add a new preset to the Setup list. You can then enter a short
description, values for filler symbols and align symbols for the new
preset. For more details, see “Error Ratio - Reference” on page 177.

N O T E Changes made in this dialog are effective immediately. So, if you press Cancel, the
settings are still valid.

8 Select a preset in the Setup list and click Delete Preset button to
remove it from the list. You can only delete presets which are defined
by the user.

9 You can view the details of the selected presets. To do so, either click
View/Edit Preset button or double-click the preset. Remember, the
details of the system presets will be in the disable mode.
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User presets can be modified. To do so, either click View/Edit Preset
button or double-click the preset. System presets can not be
modified.

10 If you choose error ratio based on 8B/10B symbol comparison, then
use the drop down list to specify whether you want to show the 8B/
10B symbol comparison results as SER/FER/cBER/FSR/DER/ISR.

N O T E Two additional error indicators "Symb Lock" and "8b10b Error"will appear at the
lower pane of GUI, if you select the error ratio as 8B/10B Symbol Comparison from
the Error Detector - Error Ratio's window. For more details, see “Symbol Lock
Indicator” on page 179 and “8b10b Error Indicator” on page 180.

N O T E Depending upon the selection (SER/FER/cBER/FSR/DER/ISR), the Status
Indicator at the upper pane of the GUI will change. For more details, see “Status
Indicators” on page 365.

N O T E Depending upon the selection (SER/FER/cBER/FSR/DER/ISR), the Results sub-
menu will now show either SER Results/FER Results/cBER Results/FSR Results/
DER Results/ISR Results as instantaneous measurements.

11 Set the symbol alignment mode. You have the following options:

• Select "Automatic" mode to enable automatic alignment. In
automatic mode the conversion factor for SER, ISR, and DER is
10. For FER and FSR, the automatic conversion factor is the
specified block length or if not specified the expected pattern
length including filler symbols.

• Select "Manual" mode to disable the automatic alignment and
initiate re-alignment if alignment is not already done or lost.

• Click ReAlign button to re-align the symbols again, in case, if the
symbol alignment is lost.
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N O T E The "Automatic" mode is selected by default for symbol alignment.

The "ReAlign" button is disabled in "Automatic" mode.

During the Jitter Tolerance Characterization/Compliance measurement, the
"Automatic" symbol alignment mode switches to "Manual" mode and restore back
to "Automatic" mode when the measurement is finished/aborted.

12 From the Sampling Point Setup window, set the sampling point. For
more information, see “Sampling Point Setup - Procedures” on page
183.

13 For SER as an error ratio mode, achieve the Symbol Lock condition.
The successful symbol alignment is indicated by a green Symb Lock
indicator present at the lower pane of the Serial BERT's GUI. For
more information, see “Symbol Lock Indicator” on page 179.

14 If required, use the Pattern Sync Setup dialog to synchronize the
incoming pattern to the expected pattern. For more information, see
“Pattern Synchronization - Procedures” on page 204.
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Evaluating Results

The BER results can be viewed in the BER Results window. For more
information, refer “BER Results Window” on page 359.

The symbol comparison results can be viewed in the Symbol Comparison
Results window. For more information, refer “8B/10B Comparison
Results Window” on page 360.

Error Ratio - Reference

8B/10B Presets Dialog

The 8B/10B Presets dialog allows you to enter a short description, values
for Filler Primitives definition and Alignment Symbol for the new
preset. This dialog contains the following elements:

Filler Primitives Definition

Filler Primitives are inserted or deleted for clock tolerance
compensation. These are not compared and therefore cannot be
counted as errors. Filler Primitives contain filler symbols. A maximum
of 4 alternative filler primitives can be used. Each filler primitive can
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consist of upto 4 filler symbols. Filler symbols are separated by a comma
(,).

Example: For SAS we have 4 filler primitives each consisting of 4 filler
symbols.

K28.5,D10.2,D10.2,D27.3

K28.5,D7.0,D7.0,D7.0

K28.5,D1.3,D1.3,D1.3

K28.5,D27.3,D27.3,D27.3

The following are the supported standards along with their filler
symbols:

Table 18

Standard Filler Symbols

USB3.0 Skip: K28.1, K28.1

10B Symbol alignment: K28.5

SATA Align: K28.5, D10.2, D10.2, D27.3

10B Symbol alignment: K28.5

MIPI MPhy Filler: K28.1

10B Symbol alignment: K28.5

Display Port Filler: Empty String ("")

10B Symbol alignment: K28.5

SAS Align:
K28.5, D10.2, D10.2, D27.3

K28.5, D7.0, D7.0, D7.0

K28.5, D1.3, D1.3, D1.3

K28.5, D27.3, D27.3, D27.3

10B Symbol alignment: K28.5
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Table 18

Standard Filler Symbols

PCle 1&2 Skip:K28.5, K28.0; K28.0

10B Symbol alignment: K28.5

Wild Cards for Filler Primitives

The wild cards allow you to set one or more out of the maximum of four
symbols of a filler primitives as don’t care. In this case, all allowed D
and K symbols will match and are removed from incomming DUT data.

For example:
K28.1, *
Here the asterisk (*) symbol will be treated as don't care.

10B Alignment Symbol

The 10B Alignment Symbol contains the K28.1, K28.5 and K28.7 symbol
for 10B alignment. You can use the drop-down list to specify symbols.

All standards supported by Serial BERT use the K28.5 symbol for 10B
alignment. However, the standards differ in the way if the K28.5 is only
used during some training sequence or if it comes also later in the data
stream. In SATA for instance, K28.5 also comes in the Filler Primitive
("Align Symbol"), which occurs regularly and makes it easy to achieve
10B alignment. In other standards like USB 3.0, K28.5 is not present in
the Filler Primitive. In USB 3.0 a pair of two K28.1 symbols is used as
filler primitive ("SKP ordered set"). This means a special initial 10B
alignment phase must be done. To achieve 10B alignment for all cases
we can configure the 10B alignment symbol also as K28.1 symbol.

Symbol Lock Indicator

In the automatic symbol alignment mode, 10B alignment is constantly
done to achieve symbol alignment. However, if 10B symbol alignment
is not done or is lost then this status is indicated by Symb Lock indicator
present at the lower pane of the Serial BERT's GUI.
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In the manual mode, symbol alignment is done only once if alignment
was not done before or is lost. Subsequent manual re-alignment can be
done by pressing "Re-Align" button.

The Symb Lock indicator uses the following colors to indicate the
different states:

• Symbol alignment not done: (Default indicator) The indicator
appears grey.

• Symbol alignment done: The indicator appears green.

• Symbol alignment lost: The indicator appears red.

8b10b Error Indicator

If the incomming data have some disparity errors or contains an invalid
symbols, it is indicated by the 8b10b Error indicator.

Invalid Symbols in ED are shown as N/A in pattern editor. Running
disparity errors in ED data mark the corresponding symbol with red
color in the pattern editor.

Sampling Point Setup

Sampling Point Setup - Concepts

This section provides basic information on the sampling point setup and
eye diagrams.

How Does the Sampling Point Setup Work?

The sampling point of a data signal is defined by two values: a point in
time and a voltage level. Each bit of the data signal is sampled at this
point in time and in reference to this voltage level. The point in time (in
reference to the clock signal) is referred to as the data input delay, and
the voltage level is referred to as the 0/1 decision threshold.

The location of the sampling point is the decision factor as to whether
the incoming bits are identified as logic 0's or 1's. To measure the
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accurate bit error ratio at the input port, false readings of logic 0's or
1's must be avoided. Therefore, the sampling point must be set to the
optimum location within the data eye.

The functions within the Sampling Point Setup window allow you to:

• Prepare the error detector for the incoming data signal regarding the
connector termination.

• Graphically display the eye diagram in terms of voltage, input delay
and a BER threshold.

• Adjust the location of the sampling point.

What is an Eye Diagram?

An eye diagram provides a way to view all possible transitions between
adjacent bits of a data stream by overlaying them on the display of a
high-speed oscilloscope. It is typically produced by triggering the
oscilloscope with a synchronous clock signal.

When the oscilloscope is triggered by a clock signal, data patterns will
not be examined. Instead, if persistence is set high enough, the shape of
an "eye" will be observed. The eye is bounded by overlaid logic 1 and 0
voltages (top and bottom) and multiple 0 to 1 and 1 to 0 transitions (left
and right).

Different portions of the bit pattern

Eye diagram
Overlay of all

portions of the bit pattern

The sampling point of the error detector must be set within the data eye.
The error detector uses the eye diagram to graphically display the
location of the sampling point. Additionally, the appearance of the eye
is useful for determining the quality of the data signal.

The height and width of the eye in the eye diagram are also displayed
in the diagram. Rise time, overshoot, and jitter are not displayed in the
diagram. Note that the diagram does not reflect the different shapes of
signals in RZ or R1 pulse format.
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What is an Eye Edge?

In the eye diagram, the eye has 4 edges. An eye edge is defined as a data
input delay value or 0/1 threshold voltage value in the data eye that
meets the following conditions:

• The instantaneous bit error ratio (BER) is greater than or equal to
the alignment BER threshold.

• An adjacent point has an instantaneous BER that is less than the
alignment BER threshold.

Understanding Bit Recovery Mode

In bit recovery mode (BRM), the error detector does not expect any
particular pattern. Nevertheless, it detects bit errors.

In bit recovery mode, the error detector uses two sampling points. The
second sampling point is not visible. Both are set to the expected
optimum position when the Auto Align button is pressed (with respect
to clock rate, signal voltages and offset, decision threshold, and so on).

The bits received at this sampling point are considered to be correct.

You can now move the visible sampling point and investigate the
behavior of the DUT in detail. The error detector compares the bits at
your sampling point with the bits recognized at the hidden sampling
point. As you move the visible sampling point, the indicated BER will
increase.
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N O T E The indicated BER is a relative BER. It approaches the absolute BER if the error ratio
at the initial sampling point is very low. It is identical with the true BER if the signal
at the initial sampling point is error free.

In bit recovery mode, some restrictions apply:

• Synchronization is impossible, because no particular data is
expected. Sync now and auto synchronization functions are disabled.

• Burst mode is disabled.

• Error Location Capture cannot be used.

• The function Error Detector Pattern tracks the Pattern Generator Pattern is
disabled. This function is not re-enabled when the BRM is
terminated.

• BRM does not work above 11.5 Gb/s when the CDR is enabled.

BRM indicators:

• The mode is indicated in the status panel and in the BER Bar.

• The mode is indicated in all screen dumps and log files.

• The Measurement User Interface shows when this mode is used.

Sampling Point Setup - Procedures

In most cases you will set up the sampling point automatically. Even if
you wish to make some manual adjustments, it is recommended to start
with automatically aligning the sampling point.

N O T E Before adjusting the sampling point, make sure the pattern synchronization mode
is set up properly. See “Pattern Synchronization - Procedures” on page 204 for
details.

How to Set the Optimum Sampling Point Automatically

1 Click Sampling Point Setup menu item from the ED Setup submenu.

2 Select an appropriate BER threshold from the BER Threshold list.

3 Press Auto Align to automatically set the optimum sampling point.

You can stop the search for the optimum sampling point at any time by
pressing Cancel.
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How to Adjust the Data Input Delay

1 Click Sampling Point Setup menu item from the ED Setup submenu.

2 Select the Avg. 0/1 Threshold checkbox to use a good start point on the
vertical voltage axis.

3 Click Data Center to move the sampling point horizontally towards
the center of the eye at the selected voltage. You may click Cancel at
any time.

4 Now you can use the numeric keypad or front panel knob to manually
adjust the value in the Data Delay field.

The Sample Point in the eye diagram moves horizontally as you change
the value.

T I P While adjusting the data input delay, you can monitor the BER bar on the analyzer
display, or listen to the BER warning tones. Higher BERs may indicate that you are
measuring at the edges of the data eye.

N O T E Pattern synchronization can be lost during sampling point adjustment. If Auto
Sync is enabled, the Serial BERT will resynchronize the patterns automatically. If
the manual synchronization mode is selected, you need to synchronize the error
detector by clicking the Pattern Sync icon and then the Sync Now button.

How to Adjust the 0/1 Decision Threshold

1 Click Sampling Point Setup menu item from the ED Setup submenu.

2 Clear the Avg. 0/1 Threshold checkbox.

3 Click 0/1 Threshold Center to move the sampling point vertically
towards the center of the eye at the selected delay. You may click
Cancel at any time.

4 Now you can use the numeric keypad or front panel knob to manually
adjust the value in the 0/1 Threshold field.

The Sample Point in the eye diagram moves vertically as you change
the value.

T I P While adjusting the 0/1 threshold, you can monitor the BER bar on the analyzer
display, or listen to the BER warning tones. Higher BERs may indicate that you are
measuring at the edges of the data eye.
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N O T E Pattern synchronization can be lost during sampling point adjustment. If Auto
Sync is enabled, the Serial BERT will resynchronize the patterns automatically. If
the manual synchronization mode is selected, you need to synchronize the error
detector by clicking the Pattern Sync icon and then the Sync Now button.

How to Enable the Bit Recovery Mode

The bit recovery mode (BRM) allows you to measure the relative BER
without knowing the incoming data pattern.

To enable the bit recovery mode:

1 Click Sampling Point Setup menu item from the ED Setup submenu.

2 Click the Bit Recovery Mode button.

The Sync Now button is no longer available.

Note that you can also enable the bit recovery mode from the
Pattern window. Click the Pattern Select icon and then the Error Detector
Pattern tab. If this tab is not available, disable the checkbox Error
Detector Pattern tracks the Pattern Generator Pattern.

3 Click the Auto Align button.

Sampling Point Setup - Reference

N O T E Depending on the options of your Serial BERT, some of the following functions may
not be valid for your instrument. See “Introduction to the Serial BERT - Concepts ”
on page 11 and “Which Features are Available?” on page 14 for a description of the
available options.

The Sampling Point Setup window provides the following elements:

0/1 Threshold

The 0/1 decision threshold is the reference voltage level for the
evaluation of the incoming data signal. At the sampling point, the data
signal voltage ist compared to the 0/1 decision threshold. Signals
greater than this threshold will be measured as a logic 1; signals below
this threshold will be measured as a logic 0.

N O T E 0/1 Threshold cannot be used while Avg. 0/1 Threshold is selected.
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The 0/1 Threshold field allows the manual entry of the 0/1 threshold, and
displays the current value.

You can adjust the 0/1 threshold in the following ways:

• Click inside the text field and use the numeric keypad or front panel
knob to enter a value.

• Click anywhere in the sampling point display. The sampling point
will be moved to that location.

• Turn the Decision Threshold knob on the front panel. A small window
appears, displaying the threshold value. This knob can be used at
any time, while in any window.

Data Delay

The data input delay defines the point in time (in reference to the clock
signal) at which the incoming data signal is measured. Specifically, it is
the time delay from the active clock edge to the time at which the data
is actually sampled.

This field allows the manual entry of the data input delay, and displays
the current value in picoseconds. This delay can be set as high as 1 bit
period or 10 ns (10,000 ps), whichever is less.

You can adjust the data input delay in the following ways:

• Click inside the text field and use the numeric keypad or front panel
knob to enter a value.

• Click anywhere in the sampling point display. The sampling point
will be moved to that location.

• Turn the Data In Delay knob on the front panel. A small window will
appear, displaying the delay value. This knob can be used at any time,
while in any window.

Clock Falling Edge

Activate this checkbox to move the sampling point from the rising edge
to the falling edge of the clock signal. This function is useful when the
maximum data input delay adjustment is not large enough to move the
sampling point to the desired location. This occurs at very low
frequencies only. See “Bit Rate Range” on page 165 for more
information.

Auto Align

Click this button to automatically set the optimum sampling point.
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This routine will not stop if the optimum sampling point cannot be
found. If no optimum sampling point is found after a reasonable time,
you can click Cancel. The status message bar will indicate if this function
is unsuccessful.

The following settings may affect the result of the auto align function:

• Data Inverted

• BER Threshold

N O T E In SER mode, the Auto Align with CDR enabled supports the ED frequency above
11.5 Gb/s and performs Data Centre with appropriate threshold settings.

T I P Alternatively, you can also press the Auto Align button on the front panel.

Sync Now

Click this button to manually start a pattern synchronization. See “What
Type of Synchronization Should You Use?” on page 195 for information
on when you should use this function.

Note that this button is not available in bit recovery mode.

0/1 THReshold Center

Starts an auto-search function that sets the 0/1 threshold to the
optimum point of the incoming data eye on the vertical voltage axis
without changing the data input delay. This function can be used for
determining the optimum 0/1 threshold for asymmetric data eyes, or
for patterns with an unequal mark density.

The status message bar will indicate if this function is unsuccessful. This
function clears the Avg. 0/1 Threshold checkbox.

N O T E This function uses the alignment BER Threshold to determine the top and bottom
eye edges.

Data Center

This button starts an auto-search function that aligns the data signal
with the clock signal so that the error detector samples at the optimum
point of the data eye in the time axis. This automatically compensates
for delays in the clock/data paths, preventing unnecessary errors. The
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0/1 decision threshold is not changed. The status message bar will
indicate if this function is unsuccessful.

N O T E Ensure that the received clock frequency is stable before using Data Center.

T I P The clock/data alignment process time is pattern dependent, and with some large
user patterns the alignment can take several minutes. If you encounter such a long
time with a user pattern, it may be possible to first perform clock/data alignment
on a pure PRBS pattern. This generally does not affect alignment accuracy, and can
minimize measurement time.

This tip does not apply in cases of severe pattern dependent jitter or with devices
that do not work with PRBS patterns.

N O T E This function uses the alignment BER threshold to determine the left and right eye
edges.

Cancel

Click this button to cancel the Auto Align, 0/1 Threshold Center, or Data
Center functions while they are in progress. The following parameters
will be returned to their previous value or status:

• Auto Align Canceled

– Data Delay and 0/1 Threshold values returned to previous.

– Status of Data Inverted and Avg. 0/1 Threshold checkboxes returned
to previous.

• 0/1 Threshold Center Canceled

– 0/1 Threshold value returned to previous.

– Status of Avg. 0/1 Threshold checkbox returned to previous.

• Data Center Canceled

– Data Delay value returned to previous.

BER Threshold

In this list, select an alignment BER threshold that is appropriate for
your application.

The alignment BER threshold is the pre-defined threshold used by the
Data Center, 0/1 Threshold Center, and Auto Align functions to define the
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edges of the data input eye in the time and voltage axes. You may wish
to change the threshold for the following reasons:

• Choosing smaller alignment BER thresholds will cause the auto-
search functions to set more accurate sampling points. However, if
the BER threshold is set lower than the residual BER of the
measurement, the auto-search functions will fail. 1E-7 is the smallest
BER threshold available.

• Running the auto-search functions and viewing eye results at
different BER thresholds will allow you to see the eye margin at
specific BERs. You can also construct basic eye contour information.

Avg. 0/1 Threshold

Activate this checkbox to make the error detector continuously set the
0/1 threshold level to the average DC voltage level of the incoming data
signal.

N O T E Manual 0/1 threshold changes are impossible while this function is selected.

This function is useful for providing a "starting point" for sampling
somewhere within the data eye on the vertical voltage axis. It is
recommended to use this prior to clock/data alignments.

When used with the following patterns, this function may provide a 0/1
threshold that requires no further adjustment:

• 2^n-1 PRBS patterns

• Patterns with 50% mark densities (large amplitudes and no excessive
noise)

Bit Recovery Mode

Click this button to put the error detector in bit recovery mode (BRM).
For details on BRM see “Understanding Bit Recovery Mode” on page
182.

Then, click Auto Align to set the sampling point.

Sampling Point Display

This area of the Sampling Point Setup window graphically illustrates the
parameters of the current sampling point and data eye. Click anywhere
in the sampling point display to set the sampling point to that location.
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A green area in the display indicates the voltage range specified in the
Input Range fields for non-differential modes (Normal and Complement).
The Serial BERT is searching this range to find the eye when calculating
the optimum sampling point.

Return to Results

Click this button to return the 0/1 Threshold and Data Delay to the values
measured during the last auto alignment. The Data Inverted and Avg. 0/1
Threshold checkboxes will be returned to their previous state.

Trigger and Aux Output

Trigger and Aux Output - Concepts

The error detector has a Trigger Out and an Aux Out port that you can
use to send signals to other external devices such as an oscilloscope.

The Trigger Out can be set up to send a trigger to an external device
either according to the clock, or according to the data pattern being
generated.

The Aux Out can be set up to either send the error detector's clock signal
directly from Clk In port, or the error detector's clock signal recovered
from Data In port, or the input data passed over a comparator.
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Trigger and Aux Output - Procedures

To set up the trigger and auxiliary outputs:

1 Press Trigger and Aux Out in the ED Setup menu.

2 For the Trigger, select one of the two options:

– Clock Divided by n

Sends a trigger signal every 4, 8, 16, 20, 32, 64, or 128 bits.

– Pattern

A trigger is sent, every time the complete pattern was received.

3 For the Aux Out, select whether the Clock signal or the Data signal is
supplied.

If Clock is selected, the clock signal used by the error detector is
output directly at Aux Out.

If Data is selected, the input data is output over a comparator at Aux
Out.

The comparator is controlled by the 0/1 threshold. This lets you use
an oscilloscope to determine if the 0/1 threshold is correctly set. If
the 0/1 threshold is set below or above the data eye, the output at
Aux Out will be constant high or low, respectively.

4 Click OK to finish the Trigger and Aux Out setup.

Trigger and Aux Output - Reference

The available options in the ED Trigger & Aux Output window are:

Trigger

You have two options to configure the signal at the Trigger Out port:

• Clock Divided by n

The trigger is set every n bits.

Clock

Trigger Out

• Pattern
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The trigger signal is sent every time when the complete pattern has
been received. This refers to the single pattern repetitions, not the
512-bit blocks.

Note, that the length of the trigger signal is at least 40 bits and divisible
by 4.

Aux Out

You have two options to set up the signal at the Aux Out port:

• Clock

This option supplies the clock signal to the Aux Out port.

• Data

This option supplies the data signal via a comparator to the Aux Out
port.

The comparator is controlled by the 0/1 threshold. This lets you use
an oscilloscope to determine if the 0/1 threshold is correctly set. If
the 0/1 threshold is set below or above the data eye, the output at
Aux Out will be constant high or low, respectively.

Pattern Synchronization

Pattern Synchronization - Concepts

The Serial BERT calculates bit error rates by comparing the received
data with the expected data patterns. To do this, it needs to know where
the start of the pattern is located in the data stream.

Introduction to Pattern Synchronization

Pattern synchronization (sync) refers to aligning the incoming data
pattern with the internal reference pattern. This is accomplished in one
of two ways:

For 2^n-1 PRBS patterns, bits from the incoming data pattern "seed" the
error detector's pattern generator, causing it to generate a precisely
aligned internal reference pattern.
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For software-generated and user patterns, a 48-bit pattern from the
pattern is used as a detect word. Optimally, this detect word should be
unique within the entire pattern. The error detector searches for this
detect word within the incoming data stream, and uses the point in the
data stream as a reference, and compares all following bits with the
pattern. If the measured BER is better than the synchronization BER,
the error detector is synchronized.

There are thus three possible outcomes for a synchronization:

• Single instance of the detect word in the data stream

Detect Word
48 bits

Detect Word
48 bits Detect Word

48 bits

Reference
Point

Correct Sync

Expected
Pattern

Incoming
Bit stream

• Multiple instances of the detect word with correct synchronization

Setting up the Error Detector 5

Agilent J-BERT N4903B High-Performance Serial BERT 193

Memory-Based Patterns



Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Reference
Point

Correct Sync

Expected
Pattern

Incoming
Bit stream

• Multiple instances of the detect word with false synchronization

Expected
Pattern

Detect Word
48 bits

Detect Word
48 bits

Incoming
Bit stream

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Reference
Point

False Sync

If the error detector attempts to synchronize on the incorrect detect
word, the BER will be unacceptably high, and, if automatic
synchronization is selected, the error detector attempts another resync.
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The detect word on which the error detector attempts to resync is
chosen strictly by chance. So if there are two instances of the detect
word in the pattern, the error detector has a 50% chance of selecting the
correct one.

The more instances of the detect word exist in the pattern, the higher
are the chances for incorrect synchronization. The software attempts in
any case to identify a 48-bit pattern that occurs as seldom as possible
in the pattern. For very large patterns, this can unfortunately take a
very long time, and the software ends the search if it expects that it
would take longer to find an adequate detect word than it would to
attempt to synchronize. If the search for a detect word is ended, the
most unique detect word identified is used.

Patterns must always be synchronized in order to do accurate BER
testing. If patterns are out of alignment by just one bit, errors can be as
high as 50% (5E-1) for PRBS patterns, and 100% (1E+0) for custom
patterns.

By default, the error detector is in automatic sync mode with a sync
threshold of 1E-3. This setting is recommended for most applications,
and usually allows the synchronization function to be "transparent",
requiring no attention. However, for special applications, changes can
be made to the sync mode and sync threshold.

What Type of Synchronization Should You Use?

The type of synchronization you use affects how errors are measured
and displayed. A Sync Loss is recognized when the BER is greater than
the sync threshold. This can be caused by a high error rate, pattern
misalignment, or clock loss. Choose the sync mode setting that is
appropriate for the type of errors you anticipate.

• Automatic Sync with a sync threshold BER of 1E-3 is recommended
for most applications.

With this mode selected, the synchronization algorithm starts
whenever the BER exceeds the threshold. However, it is not possible
to make accurate BER measurements higher than the sync threshold.

• Manual sync can be used for synchronizing once, confirming proper
pattern alignment, and then measuring BERs higher than the sync
threshold. This is useful for the following applications:

– To monitor the integrity of clock signals. You may wish to
measure BERs that exceed the sync threshold to confirm clock
slip.

– To collect data for constructing eye contour information. You may
wish to move the sampling point to locations in the data eye that
have BERs exceeding the sync threshold.
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This mode doesn't allow the analyzer to automatically synchronize
if the BER becomes greater than the sync threshold. For example,
the analyzer will not re-synchronize after momentary clock loss.

N O T E Adjusting the data input delay may cause momentary clock loss. If you select
Manual Sync mode, this may also result in sync loss.

• Burst sync mode is a special operating mode for measuring data in
bursts of bits, rather than one continuous stream of bits.

For more information, refer to “Introduction to Burst Sync Mode” on
page 198.

N O T E If the error detector is in Manual Sync mode, it is recommended that you keep an
eye on the SYNC LOSS light at the top of the instrument. There are various actions
that can lead to loss of synchronization. Check the SYNC LOSS any time you make
changes to the instrument.

What is False Synchronization?

For patterns other than PRBS, the error detector may gain sync at a
point in the pattern that meets the sync threshold, but is not the correct
point where the internal reference pattern and the received data
pattern match. This is called false synchronization.

N O T E False synchronization cannot occur with PRBS patterns because a 1 bit
misalignment would cause a measurement of 50% or more errors. Thus, the BER
during a misalignment would always be greater than the sync threshold BER.

For example, consider a pattern of 1000 ones and 1000 zeros as shown
in the following figure. With reference alignment 1 the patterns are
totally out of phase and the error detector is measuring 100% errors.
But as the reference moves closer to optimum alignment, the percentage
of errors gradually approaches zero (reference alignment 2 and 3). For
exact alignment, the sync threshold must be set lower than the BER
caused by a 1 bit misalignment, in this case 1E-3.
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How Can You Tell if Your Synchronization is False?

You may suspect false synchronization under the following conditions:

• You are using a pattern other than PRBS and the error detector gains
sync, but it measures a constant, fixed error ratio.

• You are using a pattern other than PRBS and the error detector gains
sync, but auto-search functions (Auto Align, Clock/Data Center, 0/1
Threshold Center) repeatedly fail.

In a false sync, the sync threshold BER of 1E-3 may be met, but eye
edges at BER 1E-3 (required by an auto-search function) may not be
found. This is because BERs less than 1E-3 do not exist within the
data eye.
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If you suspect a false sync, try re-synchronizing at a sync threshold
BER lower than the fixed error ratio. If sync is acquired without the
problems listed above, then your previous sync was false. Your
current sync should be on an exact pattern alignment.

N O T E While auto-search functions are in progress, the sync threshold BER is changed to
the same value as the alignment BER threshold. If you are using these functions
and want to consistently re-synchronize at a lower sync threshold, you must set the
alignment BER threshold to the same value as the sync threshold BER.

Introduction to Burst Sync Mode

The burst sync mode is a special operating mode for measuring data in
bursts of bits, rather than one continuous stream of bits.

The burst sync mode measures bit error rates for each burst of data after
the error detector synchronizes to the incoming pattern. The signal at
the Gate In port controls the timing of synchronization and error
counting for each burst.

This function is useful, for example, to analyze recirculating loop data.
With a recirculating loop you can simulate very long cable connections
like transoceanic cables. Data is sent into a looped cable drum and after
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a certain number of loops it is diverted into the error detector. This way,
only a short burst of valid data reaches the Serial BERT followed by a
long break. Therefore, the error detector needs to be synchronized at
the beginning of every burst.

N O T E The burst sync mode is disabled in the 8B/10B Comparison mode.

How Burst Sync Mode Works

The following figure presents the basic order of events that make up a
burst mode measurement. It also illustrates how the instrument
operates while in burst mode.

Gate In?

no

CDR?

yes

yes

Sync?

CDR Settling Time

Synchronization Time

no

BER
OK?

success

failed

Total Burst + 1

Bad Burst +1

Incr. Bit Counters

yes

no

Register Incoming Bits

Gate In?

no

yes

1

2

3

45

6

7

N O T E Burst mode requires a complete measurement setup, including an external input
for the Gate In port. This input is used for the sync alignment.

1 Burst sync is started when the Gate In signal goes low, indicating
that a burst is arriving at the Data In port.
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2 If the error detector is in CDR mode, it first tries to generate a clock
from the data. A short time interval is required to stabilize the clock
(the CDR settling time).

Note that if the error detector is in CDR mode, it is necessary to set
a CDR threshold. This is the BER threshold that the error detector
uses to verify that the input pattern is synchronized. See “How does
Clock Data Recovery Work?” on page 162 for more information.

If an external clock is used, there is no delay. The clock signal must
however be continuous.

3 The error detector can then synchronize to the incoming signal. For
PRBS, the first received bits are used to seed the synchronization. If
there is an errored bit in this phase, the synchronization fails (bad
burst).

For memory-based patterns, a unique 48-bit detect word is used for
the synchronization. This pattern should be available one time only
in the pattern. If the detect word is not found, synchronization fails
(bad burst).

4 If synchronization has been established, the received data is
analyzed until the signal at Gate In goes high, indicating the end of
the burst. The data should continue arriving at Data In slightly longer
than the Gate In signal.

5 In case of failed synchronization, the total burst counter and bad
burst counter are incremented. The bit counters (total count, error
count, etc.) are not incremented.

6 At the end of the burst, the data is analyzed: the bits are counted, as
are the errors (total, errored 0s, errored 1s).

If the BER is higher than the Burst Sync Threshold (in the Pattern Sync
Setup dialog box), the burst is considered a bad burst, and the total
burst count and bad burst count are incremented.

7 For good bursts, the total burst count is incremented, and the bits
are analyzed (bits and errors counted). The BER is also shown in the
user interface.

Timing of the Signal at Gate In

The timing of the signal at Gate In is critical to the successful use of
burst mode. If the signal is not timed optimally, the resulting BER will
be either too high, or the sync ratio (good bursts / total bursts) will be
too low.

The signal at Gate In has to start early enough for the error detector to
get the clock (the CDR settling time) and synchronize to the pattern.
And it has to stop before the burst ends, but should stay low as long as
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possible without hitting the maximal length limitation (to extend the
time where bits can be counted).

The following figure illustrates how the duration of the Gate In signal
can influence the bit count time (the time where bits are actually
counted).

Data Input

Gate Input

CDR Settling Time
Synchronization Time

Bit Count Time

Burst

Gate Active

Valid after Gate

Begin Margin End Margin

Gate
Passive

Gate Active is the interval in which the Gate In signal is active.

The Bit Count Time is the part of the burst from which the bits can
actually be counted. The remainder of the burst is covered by the Begin
Margin and End Margin.

The CDR Settling Time is the time that the error detector requires in
CDR mode to get the clock from the data stream.

The Synchronization Time is the time the error detector requires to
synchronize to the pattern. This time depends on the pattern type
(PRBS or memory-based).

The Valid after Gate indicates the minimum length of data that has to
arrive at Data In after the Gate In signal is deactivated.

There is no requirement how long a signal should be available at Data
In before gating starts (the data should simply be stable). A pause is
however required after the gating to allow the error detector to evaluate
the results. This time is known as Gate Passive.

The following is a summary of the values of these parameters for the
Serial BERT:

Table 19

Parameter Values

Bit Count Time Min.: 1536 bits

Max: 4 Gbits

The optimal length is dependent on the
BER threshold.
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Table 19

Parameter Values

CDR Settling Time CDR mode: 2 microseconds

Non-CDR mode: 0

Synchronization Time Hardware PRBS: 1536 bits

Memory-based patterns: Min. 15 kbits
(depends on when and how often the
unique word occurs)

Valid after Gate CDR mode: 1.5 microseconds

Non-CDR mode: 1536 bits

Gate Passive CDR mode: 2560 bits or 1.5 microseconds
(whichever is larger)

Non-CDR mode: 2560 bits

The following values can be derived from these parameters:

Table 20

Parameter Values

Begin Margin CDR Settling Time + Synchronization
Time

End Margin Valid after Gate

Bit Count Time Burst Length - Begin Margin - End Margin

Gate Active Begin Margin + Bit Count Time

Optimizing the Timing

There are three things to watch when optimizing the timing for burst
sync mode:

• BER

The bit error rate increases when the gate closes too late. The
duration of the signal should typically be reduced.

• Burst sync ratio
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The burst sync ratio is an indication of how much of the burst signal
is in synchronization (and can therefore be used for counting bit
errors). The higher the value, the better.

• Bad burst count

The bad burst count counts the number of bursts that are invalid (for
example, because synchronization failed or the BER of a
synchronized burst exeeds the sync threshold).

The following describes how changing the Gate In start and end points
can affect the evaluation of bursts.

Starting too soon: If the Gate In signal is applied too soon, the error
detector will either not be able to recover the clock or synchronize the
pattern, and will thus mark the burst as a bad burst (thus increasing the
bad burst count). You can typically reduce the bad burst count by
starting the gating period later.

Burst

Attempted Settling Time ends here

Start too soon
CDR Settling Time

Synchronization Time

Settling/Synchronization fail hereGate Input

Data Input

Starting too late: If the Gate In signal is applied too late, the Bit Count
Time will be shortened, and thus the burst sync ratio will be low (which
forces the measurement of more bursts to obtain the necessary level of
reliability).

Data Input

CDR Settling Time
Synchronization Time

Burst

Gate Input

Start too late

Bit Count Time
End
Margin

Ending too soon: If the Gate In is deactivated too soon, the same
problems will occur as with starting the gate too late (see previous
point).

Setting up the Error Detector 5

Agilent J-BERT N4903B High-Performance Serial BERT 203

Gate In Start

Gate In End



Data Input Burst

Gate Input

End too soon
CDR Settling Time

Synchronization Time

Bit Count Time
End
Margin

Ending too late: If the Gate In signal is deactivated too late, the last
received bits will not be part of the burst. Thus, the BER will increase.
If the BER is higher than the Burst Sync Threshold, the burst will be
considered a bad burst.

Data Input Burst

Gate Input

End too late
CDR Settling Time

Synchronization Time

Bit Count Time

Pattern Synchronization - Procedures

To synchronize the incoming pattern to the expected pattern:

1 Press Pattern Sync in the ED Setup menu.
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2 Select the synchronization mode (Normal or Burst sync mode).

N O T E The burst sync mode is disabled in the 8B/10B Comparison mode.

3 If you selected Normal synchronization mode, choose whether you
want Automatic or Manual synchronization.

4 Specify the Sync Threshold at which the pattern will be recognized at
synchronized.

5 In Manual synchronization mode use the Sync Now button to start the
pattern synchronization. This is recommended whenever you did
changes to the pattern setup, the voltage levels or the hardware
connections (for example, altered cable lengths).

6 Select the Mask Resync Errors option to enable the masking high error
counts prior to re-synchronization of the error detector feature. For
more details, see “Mask Resync Errors” on page 206. Unselecting the
Mask Resync Errors option disables the Mask Resync Errors feature.

N O T E By default, the Mask Resync Errors feature is enabled.

7 Press OK to confirm your settings.

Pattern Synchronization - Reference

The error detector can synchronize the data patterns in the following
ways:

• In Normal Sync Mode, you can choose between

– Automatic Sync

With this option selected, the error detector constantly tries to
synchronize the patterns when the BER threshold is exceeded.

– Manual

Manual synchronization can be selected, for example, if the signal
delay is very unstable, and you want to avoid that the re-
synchronization process affects the measurement results.

• Burst Sync Mode

Click this button to enable the Burst Sync Mode. Burst mode operates
as follows: For each burst of data, BER measurements are only made
after the error detector synchronizes to the incoming pattern. The
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signal at the Gate In port controls the timing of synchronization and
error counting for each burst.

N O T E The burst sync mode is disabled in the SER/FER mode.

The Sync Threshold defines when the error detector assumes the patterns
to be synchronized. The Serial BERT shifts the received pattern bitwise
until the measured BER is below this threshold.

Mask Resync Errors

The masking feature is available in the both error ratio modes (BER and
8B/10B Symbol Comparison mode).

Some DUTs may drop bits respectively symbols due to high stress during
receiver test. For example; SATA drops complete symbols if the received
symbol is illegal (because of a bit error). Other cases of unexpected more
data are added symbols because of a bit error in a filler symbol so that
the filler won’t be recognized anymore. All cases of dropped or
additional bits causes the error detector to lose synchronization.

If the error detector loses synchronization it keeps counting bit, symbol,
frame errors and generally the measurement won’t reflect the DUT’s
performance anymore. Also test results would not correlate with other
error counters such as protocol testers anymore.

The high error ratio also serves as a trigger to perform an automatic re-
synchronization. So on one hand automatic pattern re-synchronization
is desired during receiver testing but it will be necessary to mask
respectively do not account the high error count (which was caused by
the not synchronized error detector) into the measurement. Side by side
comparisons with other error counters show that the loss of
synchronization is usually caused by only one single bit error.

Error counting is performed in 200ms intervals. If the error ratio
triggers a re-synchronization of the error detector the current interval
must not account into the results. Furthermore, it is very likely that the
previous 200ms interval(s) also showed many errors due to lost
synchronization but just did not raise the error ratio to the specified
trigger level. In later case, we check for errors in 201th ms and if the
errors are more than threshold, we discard these errors.

The measurement pauses until the ED successfully reached pattern
sync again.

Furthermore, counters must be updated:

• The Re-Synchronization counter is incremented by one. This counter
is also incremented if high error ratio masking is turned off.
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• In BER mode, one bit error shall be counted and the number of bits
is advance by one as well. As it would not be possible to identify the
cause of the synch loss, it may not be possible to account this into
either errored 0’s or 1’s. However, displaying the re-synch counter
also in BER mode is essential and clarifies the mismatch of error
count and sum of errored 0’s and 1’s.

• In 8B/10B Symbol Comparison mode, the frame error counter and
symbol error counter are advanced by one. Since an error is counted
also one received frame is counted. The compared symbol counter is
to be advanced by the block length (in symbols) without fillers.
Received symbols is incremented by pattern length (in symbols) with
fillers.

Other counters such as disparity error, illegal symbol counter and filler
symbol counter are discarded for 200ms during re-synchronization of
the error detector.

Error Accumulation

Error Accumulation - Concepts

The Serial BERT instantly starts measuring the BER when the error
detector receives data. However, to perform tests that can be repeated
and compared, you can collect the measurement data in several ways
and save it to a log file.

The available options are to test:

• for a specified time,

• until a certain number of errors occurred,

• until a specified number of bits have been sent,

• until you stop it manually.
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Error Accumulation - Procedures

To set up the Serial BERT for error accumulation:

1 Click the Accumulation Setup menu item from the ED Setup submenu

2 Select the desired Activation Mode for the type of test you want to run
(Manual, Single, or Repeat test).

3 If you selected a Single or Repeat test, you need to specify the
accumulation Period (Time, Number of Errors, or Number of Bits).

4 Use the Measurement Logs area to specify whether you want save the
results in a log file.

5 The log files will be saved in the Log Directory displayed at the bottom
of the dialog box. Use the Browse button to select a different
directory.

6 Click OK to apply your selections and close the Accumulation Setup
dialog box.

For more information on how to run error accumulation tests, see “How
to Run Accumulated Measurements” on page 370

Error Accumulation - Reference

The Accumulation Setup window contains the following elements:

Activation Mode

• Manual

Activate this option to configure the error detector to start and stop
accumulation when the front panel buttons are pressed.

• Single

Activate this option to configure the error detector to accumulate
over one accumulation period and then stop.

• Repeat

Activate this option to configure the error detector to accumulate
over repeated accumulation periods, whereby one period follows
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another immediately. There is no "dead time" between the end of one
period and the start of the next.

N O T E Repeat will not create multiple measurement log files. The data for all repeating
periods will be saved to the same log file.

The accumulation mode cannot be changed while accumulation is running.

Measurement Log

• Prompt for File Name

Click this option if you want to be prompted for a measurement log
file name before each accumulation period begins. With this option
you can select a new file name for each test run.

• File Name

Click this option if you want to enter a file name for measurement
logs before starting the accumulation. With this option you will
overwrite the measurement log file with each new test run. However,
in Repeat mode, the results of all repetitions will be appended to this
file and no information is lost.

• No Logging

Click this option to turn off measurement logging. Serial BERT will
not save the test results.

Period

The accumulation period cannot be specified for Manual tests.

• Time

Select this option to configure the error detector to accumulate bit
errors for a specific period of time.

You can enter the desired time period in the Days, Hr (Hours), Mn
(Minutes), and Sec (Seconds) fields. You may use the numeric keypad
or front panel knob. The minimum value is 1 second and the
maximum value is 99 days, 23 hours, 59 minutes, and 59 seconds.
When the selected time has elapsed, the accumulation ends.

• Number of Errors

Select this option to configure the error detector to accumulate bit
errors until a specified number of errors has been measured.

The number of errors can be set to 10, 100, or 1000. When the selected
number of errors has occurred, the accumulation ends after the next
full second.
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• Number of Bits

Select this option to configure the error detector to accumulate bit
errors until the specified number of bits have been examined.

The number of bits can be set from 1E7 to 1E15. When the selected
number of bits have been exceeded, the accumulation ends.

N O T E The actual test period may contain more bits than specified.

N O T E The accumulation period cannot be changed while accumulation is progress.

Browse

Click this button to browse for the directory where you wish to save the
measurement log files.

N O T E Changes to the parameters of the accumulation setup do not take effect until the
start of the next accumulation.

BER Location

BER Location - Concepts

The Serial BERT can be run in BER location mode. In this mode, the
errors are not counted on all bits of the data signal, but on a particular
bit or block of bits in the pattern. You can specify which bit position(s)
are considered during the measurement.

This allows, for example, to calculate the BER for the header bits or the
payload of a data stream exclusively.
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BER Location - Procedures

To set up the BER location mode, do the following:

1 Click the BER Location  menu item from the ED Setup submenu.

2 Select whether you want to locate errors on All Bits, on a particular
Block of bits, or on a Single Bit in the pattern.

N O T E In the SER/FER mode, the Single Bit option is disabled.

If you select Block or Single Bit, enter the bit positions in the
respective fields.

3 Click OK to finish the BER location mode setup.

BER Location - Reference

The Bit Error Location Mode dialog box offers the following options:

N O T E In the SER/FER mode, the Single Bit option is disabled.

With this option, all errors are counted.

With this option, only errors occuring in the block between the specified
Start Bit and Block Length are counted.

With this option, only errors occuring at the specified position are
counted.
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The following legend applies for the above graphics:

Evaluated bits
Not evaluated bits

Audio Signals

Audio Signals - Concepts

The use of warning tones is convenient when you want to monitor the
instantaneous BER over a longer time without constantly watching the
display.

With the Audio dialog box, you can adjust the sound volume as well as
some conditions when to play a sound.

Audio Signals - Procedures

To set up the warning sounds, do the following:

1 Click Audio menu item from the ED Setup submenu.

2 Check the Audio on checkbox to switch on the sounds.

T I P To switch the audio signals on and off, you can also use the Audio On/Off front
panel button.

3 Use the Main Volume slider to adjust the volume.

After adjusting the slider, a test tone is played at the new volume.
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N O T E If no sound is heard, please check whether the system volume is muted.

4 Click the respective radio button if you want to play the sound

– whenever the BER exceeds the threshold specified in the BER
Alarm Threshold field. Enter an appropriate value in this field.

T I P You can always adjust the BER Alarm Threshold by clicking and dragging the small
yellow marker in the BER bar in the top left corner.

– on All Error Rates greater than zero.

5 Click OK to finish the audio setup.

Audio Signals - Reference

The Audio dialog box contains the following elements:

Audio on

Select this checkbox to enable the audio function.

Clear this checkbox if you want to switch off the audio function.

You can also use the Audio On/Off button on the front panel to accomplish
the same function.

Main Volume

Click any point on the slider or drag it to change the main volume level.
You will hear a test tone at the new volume level.

Audio on BER Alarm

Click this option to make the analyzer play warning tones when a
specific BER is exceeded.

The BER Alarm Threshold is the threshold at which tones are produced.

Enter the BER threshold in the following format:
(number)E(exponent). For example, 1.5E-3.
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T I P You can always adjust the BER Alarm Threshold by clicking and dragging the small
yellow marker in the BER bar in the top left corner.

Tones on All Error Rates

Click this option to make the analyzer produce warning tones when any
BER greater than zero is measured. The pitch will increase or decrease
as the BER increases or decreases.
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6 
Advanced Analysis

Advanced Analysis - Concepts

The Serial BERT offers several different kinds of advanced
measurements for various purposes:

This type of measurement is used to measure the timing and jitter
behavior for a device under test (DUT). It uses a bit error rate (BER)
measurement to evaluate the shape of the eye for the output signal of
the DUT. It also analyzes the jitter, separates the random jitter and
deterministic jitter components, and estimates the total jitter.

A direct result is the determination of the optimum sampling point delay
for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter measurement
that can be used to measure the total jitter for devices which generate
a very low error density in a reasonable time span.

The Output Levels measurement allows you to characterize the behavior
of the output levels of a device under test (DUT). The sampling delay is
fixed. The error detector's decision threshold is automatically swept
within a user-defined range.

A direct result is the determination of the optimum decision threshold
level for receiving data from the DUT with maximum confidence.

The Eye Opening measurement generates a three-dimensional bit error
rate (BER) diagram as a function of the sample delay and the sample
threshold. With this measurement, the complete eye of the DUT output
signal is measured. The results comprise the voltage and timing of the
eye opening and the optimum sampling point.

The Error Location Capture measurement allows to capture the actual
position of errored bits in a memory-based pattern. The instrument
searches for the first bit errored in the incoming bitstream and marks
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it in the pattern. The address of the errored bits can be displayed after
the error is located.

The Fast Eye Mask measurement is first of all meant for production and
screening tests. It allows to determine very quickly whether the eye
opening seen at the output signal of a device is within specifications,
that means, within certain timing and voltage limits.

This is achieved by measuring the bit error rate at a limited number of
test points.

The Eye Diagram allows a quick check for the DUT’s signal output, and
determines the signal quality. Due to the higher sampling depth of a
BERT value, the eye contour lines display the measured eye at a deeper
BER level, for accurate results.

The Spectral Jitter measurement allows you to analyze the jitter
inherent in the output signals of your device under test (DUT) as a
function of the frequency. This measurement can be used for
investigating the behavior of the DUT, for example to identify crosstalk
effects.

Before you can run any of these advanced measurements you have to
properly set the required parameters. After the test is complete you can
view the results.

General Requirements

For any measurement to yield reasonable results the following
requirements apply:

• The error detector must be correctly set up and synchronized with
the pattern sent from the DUT output port.

• Ideally, the sampling point should be aligned to the optimum
sampling point (for example, with the Auto Align function).

• For low bit rates below appr. 620 Mbit/s only the Error Location
Capture measurement works.

Please refer to “Bit Rate Range” on page 165 for a detailed
explanation of the limitations at low bit rates.

If the Serial BERT's pattern generator is used to send a data pattern to
the DUT, then also the following two conditions must be met:

• An appropriate pattern is selected.

• The pattern generator is correctly set up.
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For examples, refer to the descriptions of the different measurements.

Optimizing Parameters

If the presented measurement results do not answer your questions
adequately, you can easily modify the setup parameters in the
Properties dialog box. When changing the measurement settings after the
measurement has been run, please note:

• Parameters that affect the data capture.

Changes on the Parameters page take only effect if you run the
measurement again.

• Parameters that change the display of the measured data.

Changes on the Pass/Fail, View, Graph, and Color tabs only affect the
display of the results. There is no need to repeat the measurement.

Saving Measurements for Later Analysis

You can save a completed measurement for later analysis. This includes
the settings you selected for the measurement and the measured data.
This allows you to load the measurement at a later stage and inspect all
data in detail. You can also change display parameters to evaluate this
data even more thoroughly.

N O T E When saving the measurement, the following settings are not saved:

• selected pattern

• settings of the pattern generator

• settings of the error detector

To save these settings, see “Saving Instrument States” on page 543.

Besides saving a measurement as a file, you can also export the data to
any spreadsheet application.

Advanced Analysis - Procedures

This section describes some basic functions that apply to all
measurements.

If you want to store the measurement results for later use, you can either
save them as an .mcp file (to be opened in the Serial BERT software) or
as a .txt file for spreadsheet applications.
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How to Save Measurements

To save a measurement as an .mcp file for later use in the Serial
BERT user interface:

1 After your measurement has finished and the results are displayed,
select Save Measurement from the Analysis menu.

2 Select a proper file name and location and press the Save button.

How to Export Measurements

To export the measurement data into a .txt file for later use in external
spreadsheet applications:

1 After your measurement has finished and the results are displayed,
select Export Data from the Analysis menu.

2 In the Export dialog box, select the path and file name for the .txt file.

Alternatively, you can activate the Clipboard checkbox to copy the
data to the clipboard. In this case you can then paste it into any other
application.

3 Press the Format Options button to open the Export/Logfile Format dialog
box.

4 Make further selections for the format of the exported data. Press
OK to close the dialog box.

5 Press OK to export the data to the specified destination.

How to Compare Measurement Results

If you intend to repeat a measurement with different settings, you may
wish to preserve the current results for easier comparison. This can be
done with all measurements (except Error Location Capture) by
copying the results.

1 In the lower left-hand corner of the measurement window, select the
measured terminal by tipping on it.

2 Select Copy from the Edit menu.

If you have a mouse connected to your Serial BERT, you can directly
copy the measurement via the context menu.

3 Open the Edit menu (or context menu) once more and select Paste.

This inserts a copy of the chosen measurement results. For an Output
Levels measurement, this looks as shown below:
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4 Repeat the measurement with modified parameters and observe the
new results.

5 To distinguish the two graphs, change the color of one graph by
tipping the red Color field.

You can now directly compare the graphical and numerical results
of the two Output Levels measurements.

How to Rename Copied Measurements

To rename a copied measurement for easy distinction:

1 Highlight the copied measurement.

2 Press Enter (or choose Rename from the context menu).

3 Change the name and press Enter.

How to Load Measurements

To load previously saved measurements:

1 Select Load Measurement from the Analysis menu.

2 Use the file dialog box to locate the desired .mcp file and press
Open to load the measurement.

The respective screen of the Analysis panel opens and you can view the
measurement.
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How to Change Measurement Properties and the Graphical Display

The various tabs in the Properties dialog box allow you to specify the
parameters for the measurement. The available options are not the same
for all measurements. See the Reference information of the respective
measurement type for details.

To modify the measurement properties:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

– Parameters tab

The settings made on the Parameters tab define how the data is
collected. If you make changes here, you need to run the
measurement again.

– Pass/Fail tab

On the Pass/Fail tab, you can specify the conditions that must be
met by the DUT to pass a test. Changes here do not require a new
test run. The data will be newly calculated and the results will be
displayed.

– View tab, Graph tab, and Color tab

With the functions on these tabs, you can modify the graphical
display of the results at any time without rerunning the
measurement. This allows you to analyze the results in different
ways and with different preferences.

3 After you have made your changes on the various tabs, press Apply
to employ the settings without leaving the Properties dialog box. Or
press OK to confirm the modifications and close the Properties dialog
box.

How to Change the Colors of the Graph

You can customize the colors of the graphical display. This function is
common to all measurements:

1 In the Properties dialog box, switch to the Colors tab.
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Depending on the current measurement type, you can change:

– BackColor: The background color of the graphs (default is white)

– BERMarkerColor: The color of the BER Threshold indicator (default
is red)

– ForeColor: The foreground color of the scales and frame of the
graphs (default is black)

– FreqRangesColor: Color of the selected frequency ranges (default
is light yellow)

– GridColor: The color of the dashed grid lines (default is gray)

– PowerMarkerColor: The color of the Noise Threshold marker (default
is red)

2 Select the color that you want to change from the list of used colors
to the left.

3 Use the Color Set and the Color Palette to select the new color.

4 To view the results of your changes, press Apply.

This immediately updates the measurement window, where you can
see the new colors.

5 Press OK to close the Properties dialog box.
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Advanced Analysis - Reference

This section covers reference information such as definitions of
important parameters and the descriptions of supplementary functions.

Exporting Result Data

If you want to use the measurement results with other applications, you
can export the data to a file via Analysis - Export Data....

The contents of the resulting file may look as follows:

Date:;02/11/05 03:33:17
Version:;1.0
Type:;TM Fast Eye Mask SB-Electrical
UI:;9.6969E-011

Threshold Units:;Volts
Delay:;Relative
[1:1] SerialBERT;;;
Delay;Threshold;BER(All);
 
-3.878757E-011;1.504954E-001;2.497699E-001;
3.878757E-011;1.504954E-001;2.499503E-001;
-1.551503E-011;3.504954E-001;4.922570E-001;
1.551503E-011;3.504954E-001;4.952636E-001;
-1.551503E-011;-4.950459E-002;0.000000E+000;
1.551503E-011;-4.950459E-002;0.000000E+000;
 ;;;

This file can be imported into spreadsheet applications such as
Microsoft Excel, for example. Use the semicolons as delimiters for the
rows or columns.
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Timing Unit Definitions

The timing unit specifies the timebase for the measurements. It is
possible to switch between the unit interval (UI) or seconds for the time
scale. The timebase is set on the View page of the Properties dialog box.

The following figure and table shows the relationship between UI and
seconds for a 500MHz signal:

An example of the measured range of time expressed in the different
units is listed below:

Table 21

Timebase Earliest
Sampling

Optimum
Sampling
Point

Latest
Sampling

Time rel. -1.5 ns 0 ns +1.5 ns

abs. 54.2 ns 55.7 ns 57.2 ns

Unit interval rel. -0.75 UI 0 UI +0.75 UI

abs. 27.1 UI 27.85 UI 28.6 UI

The Unit Interval

Unit interval values are a convenient way to express time values in a
dimensionless form. One unit interval is the equivalent of one clock
period. To convert a time value to a unit interval value, divide it by the
pulse period or multiply it by the clock frequency.
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At 100MHz, the pulse period is 1/100 × 10-6s = 10-8s = 10ns; this is the
unit interval (UI). For example, a value - in fact, any parameter that is
specified in time units - of 37ns is equivalent to 37ns/10ns=3.7UI (time
values are expressed as multiples of the unit interval).

This makes it easy to analyze measurements at different frequencies: If
the measured phase margin is 8ns at 100MHz (1UI=10ns), and 4ns at
200MHz (1UI=5ns): The phase margin is 0.8UI in both cases, and it is
immediately obvious that it does not depend on the system frequency.

The same is true for the delay resolution parameter in the DUT Output
Timing/Jitter and Eye Opening measurements: If you specify the delay
resolution as 0.01UI, the measurement software will always measure
150 points across the bathtub, no matter what system frequency you
choose (only if edge optimization is switched off, of course). However,
if you specify the resolution in time, the number of measured points will
change inversely proportional to the system frequency (doubling the
frequency results in half the number of measured points).

Syntax Requirements

All time-related entries understand both time and unit interval
notation, regardless of the UI/time selection made in the View tab of the
Properties dialog box. You can enter 17s, 5ns or 0.01UI at any time. On
run, the Serial BERT will automatically convert all entries to time
values, using the current unit interval. So, the UI is handy if you want
to set values independently from the system frequency.

All voltage-related entries understand 23mV, 0.01V, and so on.

All power-related values can be entered as 50mW, 0.04W, 6dBm,and so on.

All dimensionless quantities understand decimal notations (e.g.
10000000, 0.0003) and scientific/engineering notation (e.g. 1e9,
1.7e-3).

Marker Definitions

Markers are available for all measurements except of the Fast Eye Mask.
They make the analysis and tracing of the results more comfortable.
Markers can be switched on or off at any time when results are available
in the graphical view. For the DUT Output Timing/Jitter measurement,
the software provides two types of markers.

The following illustration shows the definitions for the markers and the
values that can be derived from the marker position.
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The following values are displayed for the current marker positions:

Table 22

Value Description

Upper Right Time and BER of the upper right
intersection of the displayed marker lines
(X2 and BER1)

Lower Left Time and BER of the lower left
intersection of the displayed marker lines
(X1 and BER2)

Delta Distance between the two vertical
marker lines on the time axis (X2-X1) and
distance of the two horizontal marker
lines on the BER axis (BER1-BER2)

The markers can be moved to keep track of the data.

A Gaussian marker is available for the following measurements:

• DUT Output Timing/Jitter measurement

• Output Levels measurement

The Gaussian marker allows to measure the normal distribution of
measurement results.
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The distribution of random values is called normal, if it can be described
by the following formula:

This formula describes a bell-shaped Gauss curve. If μ is zero and σ
varied, you would get the curves illustrated in the figure below:

The height and position of a normal distribution can be specified in
terms of two parameters: μ and σ. The parameter μ is the mean, the
parameter σ is the standard deviation.

The Gaussian marker shows such a curve. Position, height, and width
of this curve can be changed by dragging the handles, and the actual
parameter values are displayed.

The marker has three handles that can be dragged: two for adjusting its
width, one for changing its height and position.

The following figure shows an exemplary DUT Output Timing/Jitter
measurement result with a Gaussian marker.
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The marker readout provides the following information:

Table 23

Parameter Symbol Meaning

Mu μ Mean.

DUT Output Timing/Jitter
measurement:

The position of the marker
center on the time scale.

Output Levels
measurement:

The position of the marker
center on the vertical
threshold scale.

Sigma σ Standard deviation. The
RMS value of the marked
area.

Kappa κ Linear scaling factor.

A Gaussian marker is used when the jitter graph is displayed. It is most
useful if deterministic jitter is present. In this case, the jitter graph
shows more than one peak (see also “Estimated Total Jitter” on page
233).

The jitter values Mean, RMS, and Peak-Peak refer to the whole jitter. The
Gaussian marker allows to measure the normal distribution of
individual jitter peaks. You can thus determine how parts of the jitter
histogram contribute to the overall jitter values.

You may have measured a bathtub curve like the one shown below:
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As the bathtub borders are not uniform (both have two edges), the linear
derivative (the jitter) will show two peaks:

If you switch to linear scale and enable the marker, you can see its bell
shape.

You can measure the random jitter distribution of each peak as well as
the distance between the peaks, which means the deterministic jitter.

You can also use the marker with logarithmic scale. In this case, it
appears as a parabolic curve:

A Gaussian marker is used when the dBER vs. Threshold Graph is
displayed. This graph shows the relationship between the decision
threshold and the absolute values of the derivative of the bit error rate
(dBER/dTh). A linear scale reveals the distribution more clearly than a
logarithmic scale (see “dBER vs. Threshold Graph” on page 263).

In the example below, μ (Mu) and σ (Sigma) will be the same as the Level
and Standard Deviation results calculated by the measurement.
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But your dBER distribution may also look like this:

The measurement will calculate the Level and Standard Deviation
results from all data points. The marker allows you to measure the μ
(Mu) and σ (Sigma) of the individual peaks.

DUT Output Timing/Jitter

DUT Output Timing/Jitter - Concepts

This type of measurement is used to measure the timing and jitter
behavior for a device under test (DUT). It uses a bit error rate (BER)
measurement to evaluate the shape of the eye for the output signal of
the DUT. It also analyzes the jitter, separates the random jitter and
deterministic jitter components, and estimates the total jitter.

A direct result is the determination of the optimum sampling point delay
for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter measurement
that can be used to measure the total jitter for devices which generate
a very low error density in a reasonable time span.
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Output Timing Characteristics

The sampling point is swept automatically within a 1.5 clock period to
generate a "bathtub" curve. The resulting graph is centered around the
optimum sampling point of the port.

In addition, the results are available in a tabular view. If a clock signal
is defined, the software measures the data to clock alignment and
displays the absolute delay.

Jitter Characteristics

The DUT Output Timing/Jitter measurement calculates the jitter
histogram as the absolute of the derivative of the measured bit error
rate (jitter=䠠 dBER/dt).

The jitter histogram allows to separate and calculate the different
components making up the jitter:

• Random Jitter (RJ)

• Deterministic Jitter (DJ)

• Estimated Total Jitter (TJ)

The peak-to-peak, RMS, and mean values are displayed in the result
table. They can also be displayed graphically.

“Jitter Measurement Parameters” on page 248 describes how these
components are calculated.

A dedicated Gaussian marker allows to investigate the jitter graph in
detail and to measure the contribution of certain sections or jitter peaks
to the overall results.

You can set several signal parameters, the values to be displayed and
the output format according to your needs.

Fast Total Jitter Measurement Characteristics

This measurement is an alternative to the standard jitter measurement.
It can be used to measure the total jitter at very low bit error ratios.

Whereas usual jitter measurements at a BER around 10-12 can take days
(due to the huge number of bits that has to be compared for each
measurement point), the Fast Total Jitter measurement can, for
example, determine the total jitter at a BER of 10-12 in less than 20
minutes (at a data rate of 10 Gbit/s).

For details refer to “Explanation of the Fast Total Jitter Measurement”
on page 234.
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Example Results

The following illustration shows the resulting graph of a typical DUT
Output Timing measurement:

The following figure shows a typical jitter histogram with two peaks
indicating the presence of random and deterministic jitter:

For a detailed explanation of the Fast Total Jitter measurement results
see “Explanation of the Fast Total Jitter Measurement Results” on page
250.

Understanding the Jitter Calculation

After the output timing behavior of the DUT is measured, the Serial
BERT calculates the different jitter components:

To understand the RJ and DJ results, it is helpful to first understand
how the software generates the results:

1 The bathtub curve is measured.
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2 All measurement points that have BER between the BER Threshold
and Minimum BER for RJ/DJ Separation are transformed into Q-space.

The Q-factor describes the signal-to-noise ratio at the decision
circuit. It is described in “Understanding the Q-Factor Results” on
page 272.

3 Linear regression is performed for both the left and right edges.

4 The mean and sigma are calculated for both lines:

– RJ is calculated as the mean of the two sigmas.

– DJ is calculated as the period minus the difference of the two
means.

5 The estimated TJ is calculated:

– Linear regression is used to extrapolate the bathtub curve to
lower BER values.

– The intersections of the resulting lines with the Residual BER for
RJ/DJ Separation are located.

– The eye opening is calculated.

The estimated TJ is the period minus the width of the eye opening.

The illustration below shows a jitter curve where both RJ and DJ are
present. It also shows how the TJ peak-to-peak and RMS are calculated.
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The Estimated Total Jitter (TJ) allows you to predict the jitter expected
for very low bit error rates that would take a long time to measure. It is
obtained by extrapolating the measured BER curves.

The TJ is estimated by extending the BER curves (based on the points
detected between the BER Threshold and the Minimum BER for RJ/DJ
Separation) to the Residual BER for RJ/DJ Separation level. The estimated
TJ is the period minus the width of the measured eye.

N O T E The following graphic is not available from the measurement software. It is inserted
here to show how the TJ period is calculated.

Advanced Analysis 6

Agilent J-BERT N4903B High-Performance Serial BERT 233

Estimated Total Jitter



Explanation of the Fast Total Jitter Measurement

The Fast Total Jitter measurement is an optimized method to determine
the total jitter for devices that generate a very low error density (BER
well below 10-10).

To measure (not estimate) the total jitter for a device with a BER of
10-12 with conventional methods, one usually needs to compare more
than 1012bits for each sample point. To measure a full eye opening this
way with appropriate timely resolution takes time (maybe days or
weeks, depending on the data rate), and the probability of seeing one
or no error in 1012 bits is not higher than 37%.

If one would compare 1013 bits for the same device, the probability of
seeing ten errors is even lower (12 %), but the probability of observing
no error is almost zero.

The Fast Total Jitter measurement implements a method that reduces
the measurement time considerably and provides a higher accuracy. It
is based on statistical and probability calculations.

The method was presented at the DesignCon 2005 and is described in
"Total Jitter Measurement at Low Probability Levels, using Optimized BERT Scan
Method", included as 5989-2933EN.pdf.

We will not go into the details but provide an introduction.
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Quite often, we do not need to measure the exact BER, but can stop the
measurement if we are sure that the BER is above or below a threshold.
In a jitter tolerance test, for example, we need just to assure that the
device under test operates with a BER better than let us say 10-12;
whether the true BER is 1.1 × 10-13 or 2.7 × 10-15 is irrelevant.

To abort the measurement for a single point and proceed to the next,
we need two limits that tell us whether the BER is above or below the
given threshold.

These limits have been calculated from the error probability density
functions applicable to BER measurements. The equations were solved
for a level of confidence of 95%. The calculations have led to the
following table:

Table 24

95% confidence level lower limits, BER
> 10-12

95% confidence level upper limits, BER
< 10-12

Min number of
errors

Max number of
compared bits (×
1012)

Max number of
errors

Min number of
compared bits (×
1012)

1 0.05129 0 2.996

2 0.3554 1 4.744

3 0.8117 2 6.296

4 1.366 3 7.754

5 1.970 4 9.154

6 2.613 5 10.51

7 3.285 6 11.84

The BER threshold of 10-12 and hence the setting of the multiplication
factor to 1012 is just an example-by changing the exponent, the table
applies analog to other thresholds.

The following figure shows a plot of this table.
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Note that there is a gap where the BER is so close to 10-12 that we cannot
decide. For example, if we compared 3 × 1012 bits and got two errors (a
measured BER of 0.667 × 10-12), we are in the "uncertain" white area on
the graph.

In such a case, we need to transmit more bits until the number of bits
either reaches the upper limit (6.296 × 1012), or until we see more errors.
If the actual BER is very close to 10-12, however, we are unable to apply
a lower or upper limit to the BER, no matter how many bits we transmit.
Whether such a test fails or passes depends entirely on the application.

Once we are able to decide for a measured point whether its BER is
above or below the BER threshold, we can determine the total jitter at
the intersection of the BER threshold with the bathtub curve.

Since we are unable to find a single point on the slope where the BER
is exactly 10-12, we search for an interval that brackets the point at which
the BER is equal to 10-12. This is illustrated for the left-hand slope in the
following figure.
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We do not need to know the exact BER values at x+ and x-. It is sufficient
to assure that BER(x-) is greater than 10-12 and BER(x+) is lower than
10-12 at a confidence level of 95 %.

The algorithm then assumes that xL (for the left-hand slope of the
bathtub curve) is in the middle of the bracketing interval. After
repeating the procedure to determine xR (for the right-hand slope), it
calculates the total jitter peak-to-peak like in the standard timing/jitter
measurement.

The duration of a Fast Total Jitter measurement depends on:

• the BER threshold

• the bit rate

• the sample delay step size

• the contribution of random jitter

• the contribution of deterministic jitter

Compared to a conservative bathtub measurement, the Fast Total Jitter
measurement can reduce the measurement time by more than a factor
of 40.

Typical test times are approximately 20 minutes at 10Gbit/s and slightly
more than one hour at 2.5 Gbit/s for a measurement at the 10-12 BER
threshold with an overall confidence level better than 90%.
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DUT Output Timing/Jitter - Procedures

This section shows how to set up and use the DUT Output Timing/Jitter
measurement. As an example, we measure the output timing and jitter
behavior of a shielded cable.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the DUT Output
Timing/Jitter Measurement” on page 238)

• Executing the measurement (see “How to Execute the DUT Output
Timing/Jitter Measurement” on page 239)

• Optimizing the view of the results (see “How to Optimize the View of
the Results” on page 239)

How to Prepare the DUT Output Timing/Jitter Measurement

To use the DUT Output Timing/Jitter measurement to test a shielded
cable:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

5 Switch to the Pattern menu and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both the
pattern generator and the error detector.

6 For the pattern generator setup you need to specify the logic levels
and the bit rate. Select LVPECL levels and Gb Ethernet (1.06250Gb/s)
as clock speed. See “Setting up the Pattern Generator - Concepts ”
on page 113 for more information.

7 Set up the error detector so that the input range and the termination
matches the pattern generator's levels:

– Select an Input Range from 1V to 3V

– Set the Data Termination to 1.3V

– Set the Clock Setup to Clock Data Recovery to get the error detector's
clock from the incoming data stream.
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8 Enable the pattern generator outputs by pressing the 0V (Disable)
button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators at the top of the user
interface should show red and the resulting BER should be zero.

How to Execute the DUT Output Timing/Jitter Measurement

To run the DUT Output Timing/Jitter measurement:

1 Switch to the Analysis area. If the Output Timing screen is not yet
displayed, press the Output Timing icon.

2 Press the Start button to execute the measurement.

The measurement software runs the measurement and displays the
results. The following illustration shows the bathtub curve of the
measured bit error rate and-in the tabular view-the calculated results
for the Optimal Sampling Delay, the Skew and the Phase Margin.

How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results, you
can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:
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– Parameters tab

These settings are used for data collection. Changes here require
the test to be run again. See “Parameters Tab” on page 240 for
details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on page
242 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is displayed.
You do not need to run the measurement again. See “View Tab”
on page 244, “Graph Tab” on page 246, and “How to Change the
Colors of the Graph” on page 220 for details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

DUT Output Timing/Jitter - Reference

The DUT Output Timing/Jitter measurement returns the results in a
graphical and in a numerical form. The following sections describe the
results:

• They provide explanations of the measured parameters and the
display options that are specific to this measurement.

• Additionally, some information is provided to explain the theoretical
background behind the jitter calculations.

T I P You have access to the user documentation (including User's Guide) over the
instrument's Start menu: Start->Programs->N4900 Series Documents.

Properties that can be specified on the various tabs of the Properties
dialog box:

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.
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Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for the
current sample point and moves to the next one.

• Number of Errors

After this number of errors, the measurement stops for the current
sample point and moves to the next one. This allows you to speed up
the measurement. You can switch off this option if only the number
of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Both numbers are ignored if the Fast Total Jitter measurement is selected.

Set the criteria for the sample delay:

• Resolution

Specifies the time distance between sampling points. A smaller value
yields more sampling points in a unit interval. You can enter the
resolution in UI or ps, ns, s, .... The timebase of the display is set on
the View tab.

If the resolution used for the measurement is not high enough, the
bathtub curve does not clearly show the edges. For example, you may
wish to change the Resolution from 0.01 to 0.005 and run the
measurement again.

• Optimization

You can choose between Edge Resolution Optimization, Fast Total Jitter
at BER, or None.

– Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is
enabled, the Serial BERT intelligently sets a resolution so that
there are more sampling points at the edges. This can greatly
improve the results without dramatically increasing the duration
of the test.

The following illustration shows a diagram with default
resolution and no edge resolution optimization:
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The following illustration shows a diagram with high resolution
and edge resolution optimization. For the areas of the diagram
with edges, additional sampling points are taken, resulting in a
much better display of the signal shape:

– Fast Total Jitter at BER

This enables the Fast Total Jitter measurement. Before enabling
this measurement, you need to know the BER floor of the device
and to specify a BER threshold that is above that floor. For details
see “Explanation of the Fast Total Jitter Measurement” on page
234.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify the
criteria to decide whether the DUT passes or fails the test. You can
change pass/fail criteria without rerunning a test. The software only
uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.

You can set pass/fail limits individually for the output timing
parameters and the jitter measurement parameters:

• For information on the DUT Output Pass/Fail criteria, see also “Output
Timing Measurement Parameters” on page 248.
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• For information on the Jitter Pass/Fail criteria, see also “Jitter
Measurement Parameters” on page 248.

N O T E If the results of a Fast Total Jitter measurement are displayed, only the appropriate
parameters are compared and flagged:

• Phase Margin

• Optimal Sample Delay

• Total Jitter Peak to Peak

• Fast Total Jitter Uncertainty

Other pass/fail limits may be enabled but are ignored.

In the tabular view, each of the calculated values will be marked with
an

icon if it failed the test.

The following illustration shows a DUT Output Timing/Jitter
measurement that has failed the criterion for the phase margin.
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View Tab

The graph shows either the bathtub curve or the jitter distribution vs.
time.

The BER graph (the bathtub) shows the BER vs. sample delay.

The BER graph can be viewed in either linear and logarithmic view. The
logarithmic view is shown above.

The DUT Output Timing/Jitter measurement calculates the jitter
histogram as the absolute of the derivative of the measured bit error
rate (jitter=dBER/dt).

6 Advanced Analysis

244 Agilent J-BERT N4903B High-Performance Serial BERT

Bit Error Rate Graph

Jitter Histogram



N O T E Because the right-hand slope of the tub does not provide additional information on
the jitter, the measurement's jitter display shows only the portion at the left-hand
side of the optimum sampling point.

The jitter histogram allows you to visually inspect the jitter components:

• Random Jitter (RJ)

• Deterministic Jitter (DJ)

• Estimated Total Jitter (TJ)

“Jitter Measurement Parameters” on page 248 describes how these
components are calculated.

A Gaussian marker is available in this view to help analyze the jitter
components. See “The Gaussian Marker” on page 225 for details.

Furthermore, the following parameters can be set on the View tab of the
Properties dialog box:

You can analyze for:

• All Errors

To calculate the BER values from all bits/errors.

• Errors if 0s Expected

To calculate the BER values if "0" is expected, but "1" received.

• Errors if 1s Expected

To calculate the BER values if "1" is expected, but "0" received.

You can calculate measurement parameters for:

• 0 Errors

To calculate the parameters for 0 errors.
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If this is selected, RJ/DJ separation is not available.

• BER Threshold

To calculate the parameters for the given BER threshold. This is the
BER level for which output timing numerical values (phase margin,
skew, etc.) are calculated. It is also the upper limit of the BER range
for RJ/DJ separation.

The BER threshold influences some of the parameters of the DUT
Output Timing measurement. You can also drag and drop the
horizontal BER threshold in the graphical display to change this
value.

• Min BER for RJ/DJ Separation

Lower limit of the BER range for RJ/DJ separation.

• Residual BER for Estimated Total Jitter

BER level for which the estimated total jitter is calculated. See
“Estimated Total Jitter” on page 233 for details on how it is used.

You can select the number of Decimal Places to be displayed in the table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Unit Interval and Seconds to select the timebase for the
display's x-axis.

Choose between Logarithmic and Linear to select the scale for the display's
y-axis.

For example, a DUT Output Timing measurement displayed on a linear
scale may look like this:
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To analyze the graphs at a particular point, you can use the markers.
Additionally, you can display all related values for the markers in the
marker readout.

Pressing the Reset Markers button will set the markers back to the default
positions.

Several zoom factors are available. When you show the zoom graph, you
can also allow the zoom graph to track the mouse (or your finger, if you
are working directly on the Serial BERT).

If you want to see the points that have actually been measured, choose
Show Measured Points.
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Explanation of the Numerical Results

The measurement provides numerical results for:

The output timing measurement parameters are defined in the following
table:

Table 25

Parameter Description Definition

Optimal Sample Point
Delay

The average of the left (A)
and right (B) bathtub/BER
threshold intersections.

(A+B)/2

Phase Margin The period of time where
the bit error rate is lower
than the BER threshold.

B-A

The A and B values are the left and right intersections of the bathtub
curves with the BER threshold. Obviously, all values change if the BER
threshold is modified.

The following illustration shows an example for a measurement.

N O T E This graphical view is not available in the measurement software.

The jitter measurement parameters are defined in the following list.

N O T E All jitter measurement parameters (except the Total Jitter RMS and Total Jitter
Mean) change with the BER threshold.
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• Total Jitter RMS

The average of the left and right jitter histogram root mean squared
values.

• Total Jitter Peak-to-Peak

Peak-to-peak value for total jitter. Calculated as the pulse period
(unit interval) minus the Phase Margin.

• Jitter Mean

Mean value for total jitter. Calculated as the weighted average of the
left edge jitter histogram.

• Random Jitter RMS

The total jitter component with Gaussian distribution. After
transforming a contiguous range of measured points into Q space
and performing a linear regression, it is calculated as the mean of
the sigmas of the two straight lines. The contiguous range is limited
by the the BER Threshold and the Min. BER for RJ/DJ Separation
threshold.

• Deterministic Jitter

The total jitter component with non-Gaussian distribution. After
transforming a contiguous range of measured points into Q space
and performing a linear regression, it is calculated as the period
minus the difference between the means of the two straight lines.

• Estimated Total Jitter

A forecast of the expected jitter for very low bit error rates. After
extrapolating the measured BER curves, it is calculated as the period
minus the expected width of the eye opening.

• No. of points

This is the number of points that has been measured between the
BER Threshold and the Min. BER for RJ/DJ Separation threshold. It is
displayed for both slopes. This number has to be greater than 2 for
the RJ, DJ, and estimated TJ values to be applicable.

• R^2 values

The R^2 values are calculated for both slopes of the bathtub curve.
They are a measure of how well the transformed points between BER
Threshold and Min. BER for RJ/DJ Separation fit to the linear regression.
They have to be greater than 0.75 for the RJ, DJ, and estimated TJ
values to be applicable.
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Unavailable Values

Under certain circumstances, some numerical results are not available.
This is indicated by <invalid> or <not applicable> in the numerical results
table below the measurement graphic.

• <invalid>indicates that the value could not be calculated. This is the
case, for example, for phase margin, when the BER threshold is set
to high values and does not intersect with the bathtub curve.

• <not applicable> indicates that the value could be calculated, however
is not shown because quality criteria are not met. This is the case,
for example, for RJ/DJ results, when the r^2 value of one or both
edges is <0.75. Even though RJ/DJ values can be calculated in this
case, they are not shown because confidence in the results is too low.

Explanation of the Fast Total Jitter Measurement Results

The Fast Total Jitter measurement provides both graphical and
numerical results:

The example below shows a copied result, and the display of measured
points was enabled.

The results of the recent measurement are disabled, because they refer
to a standard "bathtub" measurement that provides many more results.
By actuating the Show indicator, you can inspect both alternatively.

The result graph shows you the points in time that have been
investigated and whether the actual BER at these points was higher or
lower than the BER threshold specified for the measurement. The grey
area in the middle indicates the uncertainty band (see “Explanation of
the Fast Total Jitter Measurement” on page 234).
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N O T E The test will fail, if the BER floor is not well below the BER threshold specified for
the measurement.

The Fast Total Jitter measurement result parameters are summarized
in the following list:

• Phase Margin

The period of time where the bit error rate is lower than the Total
Jitter BER Threshold.

• Total Jitter Peak-Peak

Peak-to-peak value of the total jitter. Calculated as the pulse period
(unit interval) minus the Phase Margin at the Total Jitter BER
Threshold.

• Total Jitter Uncertainty

The maximum of the uncertainties of both slopes. Measured as the
time between a point with a BER greater than the specified Total Jitter
BER Threshold and the next point with a BER less than the specified
Total Jitter BER Threshold (left slope) and vice versa (right slope).

• Total Jitter BER Threshold

The BER threshold specified for the measurement.

• Optimal Sample Point Delay

The mean value of the left and right bathtub/Total Jitter BER
Threshold intersections.

Output Levels

Output Levels - Concepts

The Output Levels measurement allows you to characterize the behavior
of the output levels of a device under test (DUT). The sampling delay is
fixed. The error detector's decision threshold is automatically swept
within a user-defined range.

A direct result is the determination of the optimum decision threshold
level for receiving data from the DUT with maximum confidence.
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Three Available Views

The Output Levels measurement provides three different graphical
views to visualize the calculated results:

• BER versus Threshold

This graph shows the relationship between the analyzer decision
threshold and the resulting BER. It presents the raw data.

• dB Histogram versus Threshold

This graph shows the relationship between the analyzer decision
threshold and the derivative of the bit error rate (dBER/dTh). A
Gaussian marker allows you investigate the peaks of this graph.

• Q from BER versus Threshold

This graph shows the extrapolation of the Q-factor and the optimum
threshold level from a limited number of measured points.

Example Results

The following illustration shows the BER versus Threshold graph of a
simple Output Levels measurement:
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Changing Properties

If you change the measurement settings after the measurement has been
run, please note:

• Parameters that affect the data capture.

Changes on the Parameters tab take only effect if you run the
measurement again. To remind you that the present results have not
been obtained with the modified settings and that you should repeat
the measurement, the result display shows a yellow bar.

• Parameters that change the display of the measured data.

Changes on the Pass/Fail, View, Graph, and Color tabs only affect the
display of the results. There is no need to repeat the measurement.

Variable Decision Threshold Method

The method used by this measurement is commonly known as Variable
Decision Threshold Method. It provides a "vertical" analysis of the eye
opening seen by the receiver. This method allows you to determine more
than just the actual levels.

The Output Levels measurement also calculates the Q-factor (a measure
that describes the quality of the received signal) and derived values.
These results can assist you in characterizing the device. They can also
enable you to predict very low bit error rates that would take a long time
to be measured.
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Output Levels - Procedures

This section shows you how to set up and perform an Output Levels
measurement. As an example, we measure the output level behavior of
a shielded cable.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the Output Levels
Measurement” on page 254)

• Executing the measurement (see “How to Execute the Output Levels
Measurement” on page 255)

• Improving the Display (see “How to Improve the Output Levels
Display” on page 257)

• Changing the Properties (see “How to Change the Output Levels
Properties” on page 258)

• Using the different views (see “How to Use the Different Views” on
page 258)

How to Prepare the Output Levels Measurement

To prepare an Output Levels measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output  screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

5 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern for this test. We use a pure 2^23-1 PRBS
segment.

6 For the pattern generator setup you need to specify the logic levels
and the bit rate. Select ECL levels and a clock speed of 1250MHz in
this example. This corresponds to a clock period of 0.8ns. See
“Setting up the Pattern Generator - Concepts ” on page 113 for more
information.

7 Set up the error detector so that the input range and the termination
matches the pattern generator's levels:

– Select an Input Range from -2V to 0V
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– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.

– Set the Clock Setup to Clock Data Recovery to get the error detector's
clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V (Disable)
button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.

How to Execute the Output Levels Measurement

To run the Output Levels measurement:

1 Switch to the Analysis panel and then press the Output Levels icon.

2 Press the Properties button to open the Properties dialog box.

3 On the Parameters tab, set the Sample Threshold parameters to suitable
values that fit to the expected signal levels, for example, -1.85V to
-0.85V. Set the Resolution to 10 mV.
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In this example, we expect the signal voltages to be between -1.75V
and -0.95V. The Sample Threshold values proposed above cover this
range well.

The Resolution is the distance between the measurement points when
the threshold moves from the low to the high level. A resolution of
10mV results in 100 measured points per Volt.

Note that we have disabled the Edge Resolution Optimization.

4 Press OK to close the Properties dialog box.

5 Press the Start button to execute the measurement.

The measurement is run, and the result window shows the bit error
rates measured at 100 threshold levels from -1.85V up to -850mV.
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How to Improve the Output Levels Display

You can change the display of an existing measurement, for example, if
you wish to see more details to investigate the graph.

This can be done on the Graph tab of the Properties dialog box:

1 Press the Properties button. If you have a mouse connected to your
Serial BERT, you can also click the right mouse button on the graph
and select Properties from the context menu.

2 Switch to the Graph tab.

3 As an example, select Show Measured Points.

With this option selected, all measured points are indicated in the
graph with small squares.

The headline of the graph tells the number of data points included
in the display: 101. This corresponds to the chosen threshold
resolution of 100 steps per Volt. With this number of measured
points, you do not get very precise results during the measurement,
but it is quickly finished.

Depending on your personal needs, you can trade measurement
precision against test time.

4 Several more options are provided on the Graph tab for you to adjust
the display as you want. For instance, you can use markers for
analyzing the graph or open a zoom window for viewing the details.
To find more information, refer to “Graph Tab” on page 265.
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How to Change the Output Levels Properties

In the example measurement, we have set the focus on speed: 100
threshold levels and 1,000,000 compared bits per measuring point. You
may wish to obtain more precise results.

1 Press Properties and switch to the Parameters tab.

2 Increase the Number of Compared Bits to 100,000,000.

Remember: One failure per 1 million bits yields a BER resolution of
10-6. One failure per 100 million bits yields a BER resolution of 10-8.

3 Decrease the Resolution (the threshold step size) to 2mV.

This gives us 500 steps per Volt.

4 Press OK to confirm your changes.

5 Press the Start button to repeat the measurement with the new
parameters.

The measurement now takes more time than the previous, but it is
also much more precise.

When you move the BER Threshold bar, you will see that some of the
calculated values change. This is explained in “Explanation of the
Numerical Results” on page 266.

How to Use the Different Views

To switch between the different views of the Output Levels
measurement:

1 Press Properties and switch to the View tab.

2 Select dB Histogram versus Threshold.

This gives you another view of the measured data.

3 Switch to the Graph tab and select Linear Scale.

The data remains the same, but a linear scale makes it easier to see
the distribution.
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This graph shows the absolute values of the derivative of the bit error
rates over the thresholds (dBER/dTh). It visualizes the data that forms
the basis for the calculations of the level and noise values.

The graph provides a special marker that allows you to estimate the data
distribution by approximating it by means of a Gaussian normal
distribution.

The Output Levels measurement provides a third graphical display: the
Q from BER versus Threshold graph. This graph refers to the Q-factor
calculations. For details on these calculations see “QBER vs. Threshold
Graph” on page 264 and “Understanding the Q-Factor Results” on page
272.

Output Levels - Reference

The Output Levels measurement returns the results in a graphical and
in a numerical form. The following sections provide explanations of the
measured parameters and the display options that are specific to this
measurement. Additionally, some information is provided to explain
the theoretical background behind.

The properties of the Output Levels measurement can be specified on
the various tabs of the Properties dialog box.

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for the
current sample point and moves to the next one.
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• Number of Errors

After this number of errors, the measurement stops for the current
sample point and moves to the next one. This allows you to speed up
the measurement. You can switch off this option if only the number
of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria for the sample threshold:

• Resolution

Specifies the distance between the sampling points. The lower this
value is, the more sampling points you have in the selected voltage
range. The minimum step width is hardware-dependent. At the time
being, the minimum is 1 mV.

• Low Level

This is the lower end of the measured voltage range.

• High Level

This is the upper end of the measured voltage range.

• Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is enabled,
the Serial BERT intelligently sets a resolution so that there are more
sampling points at the edges. This can greatly improve the results
without dramatically increasing the duration of the test.

In the following example, a step width of 2 mV was used. This has
led to 502 data points per Volt.

If Edge Resolution Optimization is enabled, the software first scans the
threshold range in relatively coarse steps and determines the areas
where the signal produces no edges-that means, where the BER is
nearly constant.
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Then, the algorithm uses the specified step width for measuring the
regions where the BER changes, and a much lower resolution (about
one tenth) for measuring the regions where the BER is constant.

This reduces the number of data points to 145, as shown in the figure
below.

As you can see from the figures above, Edge Resolution Optimization
does not sacrifice the precision of the measurement. But it can
reduce the measurement duration considerably, especially if you
compare a large number of bits at a low data rate.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify the
criteria to decide whether the DUT passes or fails the test. You can
change pass/fail criteria without rerunning a test. The software only
uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.

You can set pass/fail limits individually for level, noise, and Q-factor
parameters.

• To set the Level Pass/Fail criteria, see also “Level Results” on page
266.

• To set the Signal/Noise Pass/Fail criteria, see also “Noise Results” on
page 267.

• To set the Q Factor Pass/Fail criteria, see also “Q-factor Results” on
page 268.

Your setup may finally look as shown below:
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In the following figure, you can see how errors are flagged.
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If you compare the Low Level result with the limit we have set on the
Pass/Fail tab, you will find that the measured result fails the upper pass/
fail limit for this parameter.

View Tab

The graph shows either the BER vs. Threshold, the dBER vs. Threshold, or
the QBER vs. Threshold.

This graph shows the relationship between the analyzer decision
threshold and the measured BER.

The BER considers all errors. It is calculated as:

This graph shows the relationship between the analyzer decision
threshold and the absolute values of the derivative of the bit error rate
(dBER/dTh).

It is recommended to view this graph with a linear scale because a linear
scale reveals the distribution more clearly:

This distribution can often be approximated by a Gaussian normal
distribution. With a Gaussian marker you can measure the mean and
standard deviation of the normal distribution (see also “The Gaussian
Marker” on page 225 and “Graph Tab” on page 265).
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This graph shows the extrapolation of the optimum Q-factor and the
optimum threshold level from a limited number of measured points.

The measured data points to be used for the calculation have to be
within a contiguous BER range. This range is defined by specifying the
Min BER for Q (lower threshold) and the BER Threshold (upper threshold).
Both thresholds can be set in the lower section of the View tab.

The Q-factor can only be calculated if for both high and low level rails
two or more points fall within the defined BER range. For reliable
results use at least five measured points.

To ensure proper settings, activate the Show Measured Points function on
the Graph tab and switch to the BER vs. Threshold graph. Move the upper
BER threshold marker (vertical line) so that a sufficient number of
measured points is included for the calculation:

From these points, the following QBER vs. Threshold graph is generated:

This graph illustrates the calculation of the Q-factor (65 in the figure
above) as the best fit line through the calculated points. This method
makes the calculation reproducible. For details see “Q-factor Results”
on page 268.

Furthermore, the following parameters can be set on the View tab of the
Properties dialog box:

You can calculate measurement parameters for:

• BER Threshold
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This is the bit error rate threshold at which the Threshold Margin is
determined. It is also the upper threshold for the Q-factor
calculations.

The BER Threshold is displayed in the BER vs. Threshold graph. There,
it can be positioned with the mouse (or your finger, if you are
working directly on the Serial BERT).

• Min BER for Q

This is the lower threshold for the Q-factor calculations.

You can select the number of Decimal Places to be displayed in the table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Logarithmic and Linear to select the scale for the display's
x-axis.

The scale of the QBER vs. Threshold graph is always linear.

Ratios in the numerical results (such as SNR) can be displayed linearly
or logarithmically in dB.

To analyze the graphs at a particular point, you can use the markers.
Optionally, you can display all related values for the markers in the
marker readout.

Pressing the Reset Markers button will set the markers back to the default
positions.

Linear markers are available for the BER vs. Thresholdgraph and the QBER
vs. Threshold graph. A gaussian marker is available for the dBER vs.
Threshold graph. See “Marker Definitions” on page 224 for details.

Several zoom factors are available. When you show the zoom graph, you
can also allow the zoom graph to track the mouse (or your finger, if you
are working directly on the Serial BERT).

If you want to see the points that have actually been measured, choose
Show Measured Points.
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N O T E If you have a mouse connected to your Serial BERT, you can access many
parameters and display options conveniently from the context menu. This looks as
shown below:

Explanation of the Numerical Results

The result parameters are divided into three groups:

The level result parameters are summarized in the following table:

Table 26

Parameter Name Pass/Fail

High Level min/max

Low Level min/max

Mean Level min/max

Amplitude min/max

Threshold Margin min

For all parameters, pass/fail limits can be set, as indicated in the table.

The level parameters are defined as follows:

• High Level

The High Level is the mean of the upper dBER/dTh distribution. It
is calculated as:

6 Advanced Analysis

266 Agilent J-BERT N4903B High-Performance Serial BERT

Level Results



• Low Level

The Low Level is the mean of the lower dBER/dTh distribution. It is
calculated as:

• Mean Level

The Mean Level is the middle between the High and Low Levels,
calculated as:

• Amplitude

The Amplitude is the difference between its High and Low Levels.

• Threshold Margin

The Threshold Margin is the distance between the upper and the
lower BER curves at the position given by the BER Threshold setting.

The noise result parameters are summarized in the following table:

Table 27

Parameter Name Pass/Fail

High Level Std. Dev

Low Level Std. Dev

Peak Peak Noise max

Signal/Noise Ratio (RMS) min

Signal/Noise Ratio (Peak Peak) min

For some of these parameters, pass/fail limits can be set, as indicated
in the table.

The noise parameters are defined as follows:

• High Level Std. Dev.

The standard deviations are derived from the dBER/dTh histogram.

The High Level Standard Deviation is calculated as:
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where Mean is the High Level of the terminal.

• Low Level Std. Dev.

The Low Level Standard Deviation is calculated as:

where Mean is the Low Level of the terminal.

• Peak Peak Noise

The peak-to-peak Noise is calculated as:

Note that the Threshold Margin depends on the position of the BER
Threshold.

• Signal/Noise Ratio (RMS)

The RMS Signal-to-Noise Ratio is calculated as:

• Signal/Noise Ratio (Peak Peak)

The peak-to-peak Signal-to-Noise Ratio is calculated as

Note that the Peak Peak Noise depends on the position of the BER
Threshold.

The Q-factor result parameters are summarized in the following table:

Table 28

Parameter Name Pass/Fail

Q Factor min

Q Optimum Threshold min/max

Q Residual BER max
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Table 28

Parameter Name Pass/Fail

Q High Level

Q High Level Std.Dev

Q High Level Nr. Points

Q High Level R^2

Q Low Level

Q Low Level Std.Dev

Q Low Level Nr. Points

Q Low Level R^2

For some of these parameters, pass/fail limits can be set, as indicated
in the table.

The numerical Q-factor parameters are defined as follows:

• Q Factor

The Q-factor is calculated as:

where μ1,0 is the mean level of the 1 and 0 rails, respectively, and
σ1,0 is the standard deviation of the noise distribution on the 1 and
0 rails.

• Q Optimum Threshold

The Q Optimum Decision Threshold is calculated as:

Optimum Decision Threshold =
s0m1 + s1m0

s1 + s0

• Q Residual BER

The Q Residual BER is the expected BER at the Optimum Decision
Threshold. It is calculated as:
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Qopt  2p

-(Q 2/2)
BER =

Numbers below 1e-255 are expressed as zero.

• Q High Level

The Q High Level is the mean, calculated from the linear regression
curve for the high level data:

m =
-A
B

• Q High Level Std.Dev

The Q High Level Standard Deviation is the σ (Sigma), calculated
from the linear regression curve for the high level data:

s =  -
1
B

• Q High Level Nr. Points

This is the number of data points used for the calculation of the Q
High Level value. It depends on the setting of the BER Threshold and
also on the setting of the Min BER for Q parameter.

The minimum for calculating Q-factor values is two points. It is
recommended to use more than 5 points.

• Q High Level R^2

The R2 parameter is an indicator that shows how well the converted
data points fit to the straight line. It is calculated as:

R2 =
SXY -

(SX)(SY)
n

2

SX 2 - (SX)2

n SY 2 - (SY)2

n

The R2 parameter should be examined before trusting the Q-values.
Its maximum value is 1.0. It must be seen in conjunction with the
number of data points.

For example: Two data points always fit perfectly well, but the
resulting Q-factor calculations are not reliable. On the other hand,
50 data points may reveal a poor R2 value. This tells you that the
linearization is prone to errors.
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If the R2 value falls below 0.75, the Q-factor calculations are not
applicable.

• Q Low Level

The Q Low Level is the mean, calculated from the linear regression
curve for the low level data:

m =
-A
B

• Q Low Level Std.Dev

The Q Low Level Standard Deviation is the σ (Sigma), calculated
from the linear regression curve for the low level data:

s =  -
1
B

• Q Low Level Nr. Points

This is the number of data points used for the calculation of the Q
Low Level value. It depends on the setting of the BER Threshold and
also on the setting of the Min BER for Q parameter.

The minimum for calculating Q-factor values is two points. It is
recommended to include more than 5 points.

• Q Low Level R^2

See the definition of "Q High Level R^2".

Unavailable Values

Under certain circumstances, some numerical results are not available.
This is indicated by <invalid> or <not applicable> in the numerical results
table below the measurement graphic.

• <invalid>indicates that the value could not be calculated. This is the
case, for example, for phase margin, when the BER threshold is set
to high values and does not intersect with the bathtub curve.

• <not applicable> indicates that the value could be calculated, however
is not shown because quality criteria are not met. This is the case,
for example, for RJ/DJ results, when the r^2 value of one or both
edges is <0.75. Even though RJ/DJ values can be calculated in this
case, they are not shown because confidence in the results is too low.
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Understanding the Q-Factor Results

The variable decision threshold method used by the Output Levels
measurement makes it possible to determine the Q-factor of a signal.

N O T E The Q-factor method and the related calculations have been published under Margin
Measurements in Optical Amplifier Systems by Neal S. Bergano, F. W. Kerfoot, and
C. R. Davidson in IEEE Photonics Technology Letters, Vol. 5, No. 3, March 1993.

Mathematical Background

Bit errors are caused by noise, and the Q-factor describes the signal-to-
noise ratio at the decision circuit.

It is possible to calculate the Q-factor from a limited number of
measured BER vs. threshold data points. It is also possible to calculate
expected bit error rates from the Q-factor. This is a method for
predicting very low bit error rates (typically below 10-11) that would take
a long time to measure.

The Q-factor is calculated as:

where μ1,0 is the mean level of the 1 and 0 rails, respectively, and σ1,0 is
the standard deviation of the noise distribution on the 1 and 0 rails.

The μ1,0 and σ1,0 values are calculated from a selected range of data
points. This calculation is correct if the noise distribution has Gaussian
characteristics. Then, the bit error rate can be expressed as:

where D is the decision threshold, μ1,0 and σ1,0 are the mean and
standard deviation of the 1 and 0 rails, and erfc (x) is the
complementary error function.

This formula is the sum of two terms. It considers the probabilities of
deciding that a "0" has been received when a "1" was sent, and that a "1"
has been received when a "0" was sent.

For the following calculations, the assumption is made that the BER is
dominated by only one of the terms noted above, depending on whether
the threshold is closer to the 1 or 0 rail.

For the complementary error function
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1
2p

erfc(x) =
x

8

-b 2/2
e db 1

x   2p
-x 2/2e

an inverse logarithmic approximation exists:

erfc(x)1
2

Log
-1

1.192 - 0.6681x - 0.0162 x2

where x = Log(BER).

This function, applied to the high level and low level data points, yields
new threshold vs. value combinations.

In the area of low BER (typically below 10-4), these new data pairs
should fit to two straight lines, although a couple of assumptions and
approximations have been made.

To determine the gradient and offset of these lines, a linear regression
is performed. This is illustrated in the figure below.

A straight line can be expressed as:

Y = A + BX

where Y is the inverse error function of BER, and X is D, the decision
threshold.

The following calculations are performed for the high and low level data:

SXY - (SX)(SY)
n

SX2 - (SX)2

n
B =
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SY
nA = - B S X

n
where n is the number of respective data points.

The results of the linear regression are displayed in the QBER vs.
Threshold graph.

This graph shows two straight lines. The intersection of these lines
marks the Q-factor and the Q optimum Threshold.

Mathematically, the standard deviation and mean values are calculated
as:

s =  -
1
B

m =
-A
B

This calculation leads to the values of μ1,0 and σ1,0.

Notes on the Q-Results

You can specify the range of data points used for these calculations by
means of the Min BER for Q and BER Threshold parameters (see also “View
Tab” on page 263).

For example, you can calculate the Q-factor from relatively few data
points with measured bit error rates between 1e-10 and 1e-5. The
calculation tells you the optimum decision threshold and also the BER
expected when the error detector uses this threshold.
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To measure such small bit error rates, you have to compare an adequate
number of bits. Depending on the DUT characteristics, you may also
have to use a very fine step size for the threshold variation.

On the other hand, such a comparison may make it easier to understand
the dependencies.

If you set the BER Threshold to a position that gives you only a few data
points, you will find:

• The Q-factor is relatively high.

• The R2 values are excellent (greater than 0.95).

• The mean levels and standard deviations returned by the Q-factor
calculations differ from the measured values.

The QBER vs. Threshold graph may look as shown below:

If you increase the BER Threshold to include more points, you will find:

• The mean levels and standard deviations returned by the Q-factor
calculations approach the measured values.

• The Q-factor decreases.

• The R2 values deteriorate.

The latter is caused by increasing nonlinearity. This can be inspected
in the QBER vs. Threshold graph.
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N O T E The Q-factor calculations are disabled and flagged as "not applicable" if the R2 value
falls below 0.75.

The R2 value can also be seen as an indicator of how well the noise
distribution fits to Gaussian shape. It will not fit, for example, if the
received signal is dominated by cross-talk or modal noise.

Eye Opening

Eye Opening - Concepts

The Eye Opening measurement generates a three-dimensional bit error
rate (BER) diagram as a function of the sample delay and the sample
threshold. With this measurement, the complete eye of the DUT output
signal is measured. The results comprise the voltage and timing of the
eye opening and the optimum sampling point.

To get the result, the sampling delay and the input threshold of the
signal are shifted within 1.5 signal periods and a user-defined voltage
range. The results comprise the voltage and timing of the eye opening
and the optimum sampling point.

An example, that illustrates the general principle of the Eye Opening
measurement is shown in the figure below.
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In detail, the measurement is not that simple and more precise as it
derives the contour of the eye from the bit error rates that have been
measured.

Three Available Views

The Eye Diagram can be visualized in three different ways:

• Contour Plot

The contour plot shows discrete lines of equal bit error rate - just
like the contour lines on a map. The color of a line indicates the
respective BER value. This graph is useful to visualize in which areas
the BER changes - a homogeneous BER field will give you no lines at
all.
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• Pseudo Color Plot

This plot visualizes the BER by a continuous color gradient. It uses
different colors for the regions between the lines of equal BER. This
is useful to get an immediate visual impression of the distribution of
the BER in the eye diagram.

• Equal BER at BER threshold

This graph displays only one curve for the chosen bit error rate
threshold.

6 Advanced Analysis

278 Agilent J-BERT N4903B High-Performance Serial BERT



Example Results

The following figure shows the graphical result of a typical Eye Opening
measurement:

Eye Opening - Procedures

This section shows how to set up and perform an Eye Opening
measurement. As an example we measure the eye diagram of a shielded
cable.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the Eye Opening
Measurement” on page 280)
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• Executing the measurement (see “How to Execute the Eye Opening
Measurement” on page 281)

• Optimizing the view of the results (see “How to Optimize the View of
the Results” on page 281)

• Using the color bar (see “How to Use the Color Bar” on page 282)

• Adding or changing colors (see “How to Add or Change Colors” on
page 283)

• Changing the BER threshold (see “How to Change the BER
Threshold” on page 283)

• Changing the BER range of a color (see “How to Change the BER
Range of a Color” on page 284)

How to Prepare the Eye Opening Measurement

To prepare an Eye Opening measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output  screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both the
pattern generator and the error detector.

5 For the pattern generator setup you need to specify the logic levels
and the bit rate. Select ECL levels and a clock speed of 1250 MHz in
this example. This corresponds to a clock period of 0.8ns. See
“Setting up the Pattern Generator - Concepts ” on page 113 for more
information.

6 Set up the error detector so that the input range and the termination
matches the pattern generator's levels:

– Select an Input Range from -2V to 0V

– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.

– Set the Clock Setup to Clock Data Recovery to get the error detector's
clock from the incoming data stream.

7 Enable the pattern generator outputs by pressing the 0V (Disable)
button.
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8 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.

How to Execute the Eye Opening Measurement

To run the Eye Opening measurement:

1 Switch to the Analysis panel and then press the Eye Opening icon.

2 Press the Start button to execute the measurement.

The measurement is run and the display is continually updated. The
following illustration shows the eye diagram of the measured bit error
rate and-in the tabular view-the calculated results for the Time Eye
Opening, the Threshold Eye Opening, the Optimal Sample Delay and the Optimal
Sample Threshold.

How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results, you
can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

– Parameters tab
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These settings are used while the measurement is running.
Changes require to run the test again. See “Parameters Tab” on
page 285 for details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on page
286 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is displayed.
You do not need to run the measurement again. See “View Tab”
on page 288, “Graph Tab” on page 290, and “How to Change the
Colors of the Graph” on page 220 for details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

How to Use the Color Bar

The color bar at the right-hand side of the diagram shows the
assignment of BER thresholds to colors. These colors can be changed.
In addition, the color bar provides some useful options for controlling
the display.
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How to Add or Change Colors

If you have a mouse connected to your Serial BERT, you can add a color
to the color bar or change a color:

• From the context menu of the color bar, choose from the following
display options:

Table 29

Option Description

Gradient

Add color... To add an additional color to the
color gradient at the cursor
position. The BER range for this
new color will be assigned
automatically.

Update Plots Dynamically

Rainbow To display a large variety of colors
for the bit error ranges.

Yellow-Blue To display a color gradient from
color1 to color2 for the bit error
ranges.Green-Blue

Red-Green

Black-White

White-Black

How to Change the BER Threshold

The red slider indicates the present BER threshold. To use another value
as threshold:

• Move the slider with the mouse (or your finger, if you are working
directly on the Serial BERT).

This is particularly useful if you have set the display to show Equal BER
at BER Threshold. By moving the slider, you can investigate the eye
openings at destinct BER thresholds.
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N O T E If no slider for the BER threshold is displayed, make sure that you have enabled the
BER Threshold option on the View tab and that a suitable BER is entered.

How to Change the BER Range of a Color

The bit error ranges are set automatically, but you can change these
areas. To do so:

• Move the handles of a color with the mouse (or your finger, if you
are working directly on the Serial BERT).

This is particularly useful if you have set the display to show the Pseudo
Color Plot.

By default, you may see a graph like the one below:

Now you may wish to know more precisely what happened between
yellow and red. After extending the range of yellow, such information
becomes available.
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Eye Opening - Reference

The Eye Opening measurement returns the results in a graphical and in
a numerical form. The following sections provide explanations of the
measured parameters and the display options that are specific to this
measurement. Additionally, some information is provided to explain
the theoretical background behind.

Properties that can be specified on the various tabs of the Properties
dialog box:

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for the
current sample point and moves to the next one.

The default is 1 million bits. That means, you can measure a bit error
rate down to 10-6 (one error per million).

A smaller number reduces the duration of the whole Eye Opening
measurement. A larger number increases the precision of the
measured bit error rates.

• Number of Errors

After this number of errors, the measurement stops for the current
sample point and moves to the next one. This allows you to speed up
the measurement. You can switch off this option if only the number
of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria for the sample delay:

• Resolution

Specifies the distance between sampling points. The lower this value,
the more sampling points you have in a unit interval. You can enter
the resolution in UI or ps, ns, s, .... The timebase of the display is set
on the View tab.
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The default is 0.01 UI, that means, 100 points per unit interval will
be measured.

• Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is enabled,
the Serial BERT intelligently sets a resolution so that there are more
sampling points at the edges of the eye. This can greatly improve the
results without dramatically increasing the duration of the test.

Set the criteria for the sample threshold:

• Resolution

Specifies how many measurement points are taken within the
sample voltage range. Enter the value in mV.

• Low Level

Specifies the lower limit of the measurement voltage range. Enter
the value in mV. This value should be slightly lower than the lowest
expected signal voltage.

• High Level

Specifies the upper limit of the measurement voltage range. Enter
the value in mV. This value should be slightly higher than the highest
expected signal voltage.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog allows you to specify the criteria
to decide whether the DUT passes or fails the test. You can change pass/
fail criteria without rerunning the test. The software only uses the
criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails one or more of the criteria.

You can set several pass/fail limits. For an explanation of the Eye Opening
Pass/Fail criteria, see “Measurement Parameters” on page 291.
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In the tabular view, each of the calculated values will be marked with
an

icon if it failed the test.

The following illustration shows an Eye Opening measurement that has
failed the criteria for the eye opening voltage.
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View Tab

The graph shows either a Contour Plot, a Pseudo Color Plot, or only one
curve for the selected bit error rate threshold.

The contour plot shows discrete lines of equal bit error rate-just like the
contour lines on a map. The color of a line indicates the respective BER
value. This graph is useful to visualize in which areas the BER changes
- a homogeneous BER field will give you no lines at all.

This plot visualizes the BER by a continuous color gradient. This is
useful to get an immediate visual impression of the distribution of the
BER in the eye diagram.

6 Advanced Analysis

288 Agilent J-BERT N4903B High-Performance Serial BERT

Contour plot

Pseudo Color Plot



It shows the contour line at the BER threshold.

Furthermore, the following parameters can be set on the View tab of the
Properties dialog box:

You can analyze for:

• All Errors

To display all errors.

• Errors if 0s Expected

To display the errors if "0" is expected, but "1" received.

• Errors if 1s Expected

To display the errors if "1" is expected, but "0" received.

You can calculate measurement parameters for:

• 0 Errors

To calculate the parameters for 0 errors.

• BER Threshold

To calculate the parameters for the given BER threshold. The BER
threshold influences all parameters of the Eye Opening
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measurement. You can also drag and drop the horizontal BER
threshold in the graphical display to change this value.

You can select the number of Decimal Places to be displayed in the table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Unit Interval and Seconds to select the timebase for the
display's x-axis.

To analyze the graphs at a particular point, you can use the markers.
Additionally, you can display all related values for the markers in the
marker readout.

Pressing the Reset Markers button will set the markers back to the default
positions.

Several zoom factors are available. When you show the zoom graph, you
can also allow the zoom graph to track the mouse (or your finger, if you
are working directly on the Serial BERT).

If you want to see the points that have actually been measured, choose
Show Measured Points. The MUI uses linear interpolation for the graph.

If you want to display the BER threshold contour line, choose Show BER
Threshold. The BER threshold is set on the View tab or by the slider in
the Color Bar.
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N O T E If no slider for the BER threshold is displayed, make sure that you have enabled the
BER Threshold option on the View tab and that a suitable BER is entered.

Explanation of the Numerical Results

Additionally to the graphical results, the measurement provides
numerical results:

Measurement Parameters

The measurement parameters are defined in the following List:

• Time Eye Opening

This is the maximum extension of the BER threshold contour line in
sample delay direction (eye width).

N O T E This value is different from the horizontal extension of the BER threshold bounding
box.

• Threshold Eye Opening

This is the maximum extension of the BER threshold contour line in
sample voltage direction (eye height).

N O T E This value is different from the vertical extension of the BER threshold bounding
box.

• Optimal Sample Delay

This is the sample delay coordinate of the center of a bounding box
around the BER threshold contour line.

• Optimal Sample Threshold

This is the sample voltage coordinate of the center of a bounding box
around the BER threshold contour line.

Unavailable Values

If you make a measurement that results in an incomplete eye (no closed
contour line at the BER threshold), the numerical results cannot be
calculated. In this case, the software will issue a warning message.
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If this happens, you should first of all check the settings of the low and
high decision threshold voltages.

Understanding the Result Parameters

All result parameters are calculated from the BER threshold contour
line and its bounding box. So, all parameters change with the BER
threshold.

The result display of the Eye Opening measurement shows the
maximum eye opening time, the maximum eye opening voltage, and the
position of the optimum sampling point.

These parameters are derived as illustrated in the figure below:

Error Location Capture

Error Location Capture - Concepts

The Error Location Capture measurement allows to capture the
position of an errored bit in a memory-pased pattern. The instrument
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saves the position of the errored bit and writes a bit sequence
neighbouring the errored bit to a file.

This feature can be used to find rare or random errors. A DUT could
have problems handling long series of zeroes. Error Location Capture
can be used to locate the bit errors in such cases.

N O T E The Error Location Capture is disabled in the SER/FER mode.

N O T E The measurement run is aborted by various actions, like selecting a new pattern or
starting synchronization or alignment.

Example Results

The following figure shows the results of a typical Error Location
Capture measurement:
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Important Requirements

In order to perform Error Location Capture measurements, the
following requirements have to be met in addition to the ones listed in
“General Requirements” on page 216:

• Only memory-based patterns with a unique 48-bit pattern (detect
word) are allowed.

• No alignment features can run during error location capture: Auto
Align, 0/1 Threshold Center, Data Center

• No other advanced measurement (Output Timing, Output Levels,
etc.) can be running.

• Error Location Capture can only run when the BER Location Mode
is set to more than one bit (for example, all bits, or a block with a
length > 1).

Error Location Capture - Procedures

This section shows how to set up and perform an Error Location
Capture measurement. As an example first add a couple of errors to an
alternating pattern and then capture their position.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the Error Location
Capture Measurement” on page 294)

• Demonstrating the measurement (see “How to Demonstrate the
Error Location Capture Measurement” on page 295)

How to Prepare the Error Location Capture Measurement

To prepare an Error Location Capture measurement to detect the
location of an errored bit in an alternating pattern:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output  screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Use a second shielded cable to connect the pattern generator's Clock
Out port and the error detector's Clock In port.

4 Terminate all non-connected pattern generator output ports with
50 Ω.
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5 Make sure to preset the instrument state before running the
measurement: Select Preset Instrument State from the File menu.

6 Enable the pattern generator outputs by pressing the 0V (Disable)
button.

7 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.

How to Demonstrate the Error Location Capture Measurement

To demonstrate the Error Location Capture measurement:

1 Switch to the Pattern panel and press the Open button. Load a Fiber
Channel random data pattern from the demo patterns (Demo > Fiber
Channel > RPAT.ptrn).

Press the Properties button and set the Pattern Type to Alternate. To
display both halves of the alternate pattern, press the Alt pat view
button.

Ensure also that the error detector tracks the pattern generator.

2 Insert two errors into pattern B. To do so, edit bits 80 and 100 of
pattern B in overwrite mode.

3 Write the modified pattern to the pattern generator and the error
detector by pressing the ToPG&ED button.

4 For the pattern generator setup you need to specify the Alternate
Pattern and Aux In. Set the Internal Alternate Pattern Mode to Single Shot
B and disable Aux In.

5 Set up the error detector so that the Clock Setup is set to Clock Data
Recovery to get the error detector's clock from the incoming data
stream.

6 Switch to the Analysis panel and then press the Error Location
Capture icon.

7 Press the Start button to execute the measurement.

Status information is displayed in the lower section of the display.

8 Press Insert B button.

The two captured errors are illuminated red in the captured pattern
grid. In the result list, the 1st Bit-Error Location Capture indicates an
error in bit 80. Use the error navigation buttons (e.g. Next Error, Prev.
Error) to display further bit errors in the captured pattern.
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Error Location Capture - Reference

The Error Location Capture measurement compares the expected
pattern and the pattern that was actually received, and shows the
received pattern with the errored bits marked.

Elements of the User Interface

The following buttons help you to analyze the results:

• Hex / Bin

Choose between a binary or hexadecimal display of the pattern. The
current setting is shown in the status bar below the pattern window.

Note that in hexadecimal view the captured error can only be located
as being one of a group of four bits. To display which of the four bits
is the errored bit, you have to switch to the binary display.

• Exp. / Cap.

(Expected/Captured) Toggle the data view between the display of
the expected data, i.e. the data you defined on the error detector, and
the captured data, i.e. the data that was captured at the error
detector. The current state is displayed in the title bar of the pattern
grid.

• Run Select

Toggle the data view between the current run and the previous run.

After a measurement run is successfully finished, the display is
automatically switched to the current run. The current state is
displayed in the title bar of the pattern grid.

• First Error

Jumps to the first errored bit in the pattern.

• Prev. Error

Jumps to the previous errored bit in the pattern.

• Next Error

Jumps to the next errored bit in the pattern.

• Last Error

Jumps to the last errored bit in the pattern.
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Explanation of the Results

The results are shown in various ways:

The graphic view highlights the located bit errors. The currently
selected bit is highlighted in red, all other errored bits are written in
red.

The status bar below the graphic view provides the following
information:

• Status: The status indicates if the measurement is running or has
ended. If the measurement has ended, it indicates if the
measurement ended successfully or was aborted.

• Position: The position of the current errored bit is shown.

• Hex/Bin: This field indicates how the data is shown (bin or hex
format).

• Length: This field indicates the length of the captured data. Note that
the value here does not equal the length of the pattern.

Compare Pattern File

The captured data is saved as an alternating pattern:

• Pattern A contains the expected data.

• Pattern B contains the errored data:

0s if the expected bits were also received, 1s for errored bits.

To calculate the captured pattern, XOR the bits from pattern A with the
bits from pattern B.

The pattern description contains the first error, the error count, date
and time.

The name of the pattern file is ELOC_RESULT_CURRENT.ptrn for the
current capture and ELOC_RESULT_PREVIOUS.ptrn for the previous
capture. These patterns are saved under C:\<instrument model>
\Pattern on the machine with the firmware server.

The results are displayed in the window below the pattern. You can
compare the results of the Current Run with the results of the Previous
Run:

• 1st Bit-Error Location:

Address of the first captured errored bit.

• Bit Error Count:
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Number of all errored bits captured during the measurement.

Fast Eye Mask

Fast Eye Mask - Concepts

The Fast Eye Mask measurement is first of all meant for production and
screening tests. It allows to determine very quickly whether the eye
opening seen at the output signal of a device is within specifications,
that is, within certain timing and voltage limits.

Measuring the eye openings with an oscilloscope used to be a time-
consuming procedure. With the Fast Eye Mask measurement of the
Serial BERT, pass/fail information can be obtained within seconds.

This is achieved by measuring the bit error rate at a limited number of 
test points. Up to 32 measurement points can be specified, each defined
by a sampling time relative to the actual sampling point (which can be
the optimum sampling point) and a threshold voltage (which is
adaptive). In practice, six measurement points will often suffice to
approximate the shape of the eye. Six measurement points are preset
by default.

N O T E The Fast Eye Mask can be run by using the appropriate SCPI commands, making it
possible to integrate the Serial BERT into a testing environment. See the
Programming Guide for details.

Example Results

The Fast Eye Mask measurement measures the bit error rate at certain
measurement points. These points have to be positioned inside the
expected eye opening.
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The results of a Fast Eye Mask measurement are displayed in numerical
form:

The rows Relative Time and Voltage define the positions of the
measurement points. The last row shows the measured bit error rates
at these points.

• The Relative Time of the measured points refers to the actual sampling
point. If synchronization and auto-alignment were successful, the
current sampling point is the optimum sampling point.

Instead of UI (one Unit Interval is equal to one system clock period),
the relative time can also be specified in seconds.

• The Voltage is the decision threshold voltage at this measurement
point. The voltages of the measurement points can be set as absolute
voltages, as offset voltages, or as percentages. This is done on the
Parameters page of the Properties dialog.

By default, the six measurement points are symmetrically placed, as
illustrated in the figure below:
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These settings can be changed, and up to 32 measurement points can
be defined.

N O T E Critical areas at the error detector are generally close to ±0.5 UI.

Fast Eye Mask - Procedures

This section shows how to set up and perform a Fast Eye Mask
measurement. As an example we measure the eye of a shielded cable.

This requires the following steps:

• Preparing the Fast Eye Mask Measurement. (See “How to Prepare
the Fast Eye Mask Measurement” on page 301 ).

• Executing the Fast Eye Mask Measurement. (See “How to Execute
the Fast Eye Mask Measurement” on page 301 ).

• Optimizing the View of the Results. (See “How to Optimize the View
of the Results” on page 302 ).
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How to Prepare the Fast Eye Mask Measurement

To prepare a Fast Eye Mask measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

5 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both the
pattern generator and the error detector.

6 For the pattern generator setup, you need to specify the logic levels
and the bit rate. Select ECL levels and a clock speed of 1250MHz in
this example. This corresponds to a clock period of 800ps. See
“Setting up the Pattern Generator - Concepts ” on page 113 for more
information.

7 Set up the error detector so that the input range and the termination
matches the pattern generator's levels:

– Select an Input Range from -2V to 0V

– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.

– Set the Clock Setup to Clock Data Recovery to get the error detector's
clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V (Disable)
button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting bit error rate should be zero.

How to Execute the Fast Eye Mask Measurement

To run the Fast Eye Mask measurement:

1 Switch to the Analysis panel and then press the Fast Eye
Measurement icon.

2 Press the Start button to execute the measurement.
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The measurement is run and the result window shows the bit error rates
measured at six measurement points.

The Relative Time refers to the current sampling point.

The Voltages are the decision threshold voltages for measuring the bit
error rate at this measurement point. The voltages of the measurement
points can be set as absolute voltages, as offset voltages, or as
percentages.

How to Optimize the View of the Results

After you have run a measurement, the resulting numerical values are
displayed. To improve the results, you can change the measurement
parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

– Parameters tab

These settings are used for data collection. Changes require to
run the test again. See “Parameters Tab” on page 303 for details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when changes are made here. See “Pass/Fail Tab” on
page 304 for details.

– View tab

All settings on this tab only affect the way the data is displayed.
You do not need to run the measurement again. See “View Tab”
on page 305 for details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

Fast Eye Mask - Reference

The Fast Eye Mask measurement returns the results in a numerical
form. The following sections provide explanations of the measured
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parameters and the display options that are specific to this
measurement.

Properties that can be specified on the various tabs of the Properties
dialog box:

Parameters Tab

Note that if you modify the parameters on this page, you have to rerun
the measurement to update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for the
current sample point and moves to the next one.

The default is 1 million bits. That means, you can measure a bit error
rate down to 10-6 (one error per million).

A smaller number reduces the duration of the whole Fast Eye Mask
measurement. A larger number increases the precision of the
measured bit error rates.

• Number of Errors

After this number of errors, the measurement stops for the current
sample point and moves to the next one. This allows you to speed up
the measurement. You can switch off this option if only the number
of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria how the sampling points of the eye are displayed:

• Timing Unit

Choose between Unit Interval and Seconds to set the timing values for
the measurement points on the Parameters tab. This setting does not
affect the display of results.

• Threshold Type

Choose between Absolute, Offset,or Percentage to set the thresholds for
the measurement points:

– Absolute

You specify the thresholds for the measurement points as
absolute voltages.

– Offset
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You specify the thresholds for the measurement points relative
to the threshold voltage of the actual sampling point.

– Percentage

You specify the thresholds for the measurement points as a
percentage of the current eye opening voltage of the error
detector.

Depending on the quality and characteristics of the eye opening,
the resulting 50% threshold may deviate from the decision
threshold defined in the loaded setting.

• Number of Valid Points

Change the Number of Valid Points, if you wish to use less or more
measurement points for the measurement.

• Relative Time and Voltage

In the table at the bottom of the Parameters tab you can change
measurement points. Enter the Relative Time and Voltage according to
the above settings.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify the
criteria to decide whether the DUT passes or fails the test. You can
change pass/fail criteria without rerunning a test. The software only
uses the criteria to rate the results of a measurement.
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N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails one or more of the criteria.

The Fast Eye Mask measurement has only one pass/fail condition: The
bit error rate. If desired, enable the BER Threshold and set a suitable
threshold.

N O T E The BER Threshold will usually be 0, since you want the measurement to fail if a
single bit was received in error.

The pass/fail threshold applies to all measurement points. An

icon indicates all measurements where the bit error rate is higher than
this threshold, as shown in the figure below:

View Tab

The following parameters can be set on the View tab of the Properties
dialog box:

You can analyze for:

• All Errors

To display all errors.

• Errors if 0s Expected

To display the errors if "0" is expected, but "1" received.

• Errors if 1s Expected

To display the errors if "1" is expected, but "0" received.

You can set the Timing Unit for the display of the relative time of the
measurement points on the Parameters tab. Choose between Unit
Interval and Seconds to select the unit.
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You can select the number of Decimal Places to be displayed in the table.

Eye Diagram

Eye Diagram - Concepts

The Serial BERT provides quick design analysis with the Eye Diagram
capability. The Eye Diagram allows a quick check for the DUT’s signal
output, and determines the signal quality. Due to the higher sampling
depth of a BERT value, the eye contour lines display the measured eye
at a deeper BER level, for accurate results.

The Eye Diagram feature provides the following measurement
capabilities:

• Eye Diagram Waveform

• BER Contour Lines

• Automatic Measurement for the most relevant eye parameters:-

– Eye Height

– Eye Width

– Jitter P-P

– Jitter RMS

– Cross Voltage

• Markers

• Eye Mask

The Eye Diagram generates a three dimensional graph of the bit error
rate (BER). This measurement helps in determining and analyzing the
quality of the DUT’s signal output. The Eye Diagram results comprise
of voltage(y), time(x), and BER(z).

The Eye Diagram, and the table of Automated Eye Parameter
Measurement form simultaneously. They become more precise with the
increasing number of measured bits.
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The following graph shows how the Eye Diagram has been integrated
on the J-BERT N4903A High-Performance Serial BERT.

Methods of Representations

There are two methods of representing the eye diagram:

• Waveform

• Contour

Waveform

Waveform is the shape, and form of a signal. The waveform graph shows
the periodical variation of voltage against time.

The waveform in the Serial BERT is similar to the one in the
oscilloscope. In this case, the waveform initially gives a coarse, but quick
picture of the signal quality; while the ‘smooth waveform’ quickly
generates a high resolution graph. The waveform is displayed in an
incremental way, showing the coarse picture quickly, and then refining
it further.
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The BER Threshold is configurable. The BER Threshold is the level up
to which the signal is represented as waveform, and BER values below
this threshold are represented as contours.

BER Contour

Contour is a curve connecting points where the BER has a same
particular value. The contour graph is plotted within the Eye Diagram,
and it helps to determine the Eye Opening at deep bit error rates, such
as 1e-10, 1e-12, and so forth. Depending upon the user’s requirement
the deep BERs can be calculated. The extrapolated eye contour lines
display the eye opening for lower BER levels, such as 1e-15. The BER is
displayed as a function of sampling delay, and sampling threshold.

The eye opening is one of the main characteristics of a high speed device.

The legend on the right side of the screen represents the contour BER
values in different colors. When you select a BER value from the legend,
it displays the contour for the selected BER in the same color. Initially
all the BER values on the legend are struck across. When the contour is
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measured, the BER value changes into normal font; and when the
contour is extrapolated the BER value changes into italics. A BER value
for which a Contour does not exist is struck across. You can select
multiple BER values. The lower BER values are in red and pink, while
the deep BER values are in green and blue. The screen shot below
displays the contour and the legend.

The outer contour represents the measured BER contour, while the
inner lines are extrapolated. For more details on extrapolation
see“Estimated Total Jitter” on page 233

The Minimum Number of Errors indicates the minimum number of hits
required to plot the contour.

Eye Mask Measurement

Masks are marked regions on the screen. When the mask region and
waveform intersect it is called a violation. The Mask test shows the
quality of the eye.

When the mask measurement begins, the instrument either aligns the
mask as per the eye levels of the waveform, or as per the absolute
voltages specified in the mask file. The position of the mask can be
changed by scaling the mask according to the eye. Once the masks are
positioned the mask test counts the number of times a particular pixel
falling in the mask region has been measured. The mask violations are
marked in green. A consolidated report of the test is available on the
left bottom of the graph. The user can turn off the mask computation by
pressing the “stop” button.
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N O T E The mask test is enabled when "center" is set to "middle of eye", and "persistence"
is set to "infinite" in the Parameter Tab.

Automated Eye Parameter Measurement

Automated Eye Parameter Measurement characterizes an Eye Diagram
by measuring the rise time, the fall time, the eye amplitude, and so forth.
These measurements are called Automated Eye Parameter
Measurement, they display the Eye behavior, and they depend on the
parameters set in the View Tab.

These results are displayed in a tabular form as shown below:

In case you want to see a specific set of Eye Measurements you can select
it on the Eye Measurements tab.
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N O T E The scroll bar at the bottom of the table shows the entire table and its contents.

For more details refer to “Eye Diagram - Reference” on page 324

Eye Diagram - Procedures

This section lists out some of the generic processes to set up
measurements, to run them, and to create Eye Diagrams.

In this section, you will learn about:

• “How to Prepare the Eye Diagram Measurement?” on page 311

• “How to Initiate an Eye Diagram Measurement?” on page 312

• “How to Change the Default Settings of an Eye Diagram?” on page
313

• “How to Set Markers?” on page 317

• “How to Run the Mask Measurement?” on page 318

• “How to Customize Mask Files” on page 319

• “How to Enter Notes?” on page 321

• “How to Save and Recall” on page 322

• “How to Export Fetched Data?” on page 322

How to Prepare the Eye Diagram Measurement?

An example to prepare an Eye Diagram measurement:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output  screen.

2 Connect the DUT to the pattern generator’s Data Out port and the
error detector’s Data In port. Refer to the Getting Started Guide.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Switch to the Pattern panel and click Pattern Select.

5 Select an appropriate pattern, for example a pure 2^15–1 PRBS, for
both the pattern generator and the error detector.
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6 Specify the logic levels and the bit rate for the pattern generator
setup. For example, select ECL levels and a clock speed of 1250 MHz.
This corresponds to a clock period of 0.8 ns.

7 Set up the error detector to match the input range and the
termination with the pattern generator’s levels:

– Select an Input Range from –2 V to 0 V

– Set the Data Termination to –2 V

– Set the Alignment BER Threshold to 1E–6

– Set the Clock Setup to Clock Data Recovery to get the error
detector’s clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V (Disable)
button.

How to Initiate an Eye Diagram Measurement?

To run the eye diagram measurement:

1 Click the Eye Diagram menu item from the Analysis submenu.

2 Click the Start button to execute the measurement.

The measurement runs, and the eye diagram along with the
Automated Eye Parameter Measurement get updated constantly.

The following graph shows the eye diagram.
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3 To stop the measurement click on Abort.

How to Change the Default Settings of an Eye Diagram?

To achieve desired results, you can change the measurement
parameters:

1 Click the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

– Parameters tab

The Parameter settings used for the measurement can be changed
only when the measurement is not running, and if the settings are
changed, then you will have to re-run the measurement. (Refer to
“Parameters” on page 324 for the detailed options).
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– View tab

The view tab options set the parameters to measure, and choose
units for the displayed results in the numerical table. (Refer to
“View” on page 325 for the detailed options)
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– Graph tab

The graph settings give the display parameters like timing units,
waveform, contour, grid and markers.
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– Eye Measurements tab

The Eye Measurements tab lists out all the measurements. The
user can select specific results.
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How to Set Markers?

Markers help in tracking the BER at specific points, so to set the
markers:

1 Click on the Graph tab

2 Select Show Maker Lines

3 Apply Setting

This enables the markers, and a marker readout button appears on
the top left corner. You also have an option to Reset Markers to their
original position.
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The Marker reading is shown on the left side of the graph.

4 Click the marker readout button on the top left corner to see the
detailed marker readout.

How to Run the Mask Measurement?

To run the Mask Measurement, the Eye Diagram measurement must be
running.

1 Click on the Mask tab

2 Click Load button

3 Select a Mask File.

4 Select a Mask Alignment.
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5 Start

This starts the Mask Measurement.You also have options for setting
Mask Margins, and Mask Scaling.

6 Click the mask readout button on the bottom left of the screen to either
see, or close the detailed mask readout.

How to Customize Mask Files

A Mask file can be modified as per requirements. Following are the
sections in a mask file:

Mask File Identifier

The mask file identifier is the first line in a mask file. If the identifier
string is missing or incorrect, the file will not be loaded and an error
dialog box will be displayed.

MASK_FILE_N49xxx

Mask Title

The mask title is a quoted string of up to 15 characters. The title is
displayed on the mask readout when the file is loaded.

Example to Mask Title:

"2xGB Ethernetaa"

Region Number

The region number is an integer that defines a mask violation area (or
polygon).
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You can specify 1 to a maximum of 3 regions in a mask file.

Example to Region Number:

/* Region Number */ 2

Region Type

You can define three types of regions for each region number you have
specified:

• STD defines the actual mask region.

• MARGIN_MAX defines the maximum margin area when test margins
are set to 100%.

• MARGIN_MIN defines the minimum margin area when test margins
are set to -100%.

Example to Region Type:

/* Region Type */ STD

/* Region Type */ MARGIN_MAX

or

/* Region Type */ MARGIN_MIN

Number of Vertices

The number of vertices is an integer that specifies the quantity of X and
Y coordinates needed to define a mask region or polygon.

Example to Number of Vertices:

/* Number of vertices */ 4

X and Y Coordinates

These are the floating-point numbers that define the locations of the
mask polygon vertices for each region and region type defined in the
mask file. Mask Files use a relative coordinate system based on an eye
diagram’s zero level, one level, and crossing point parameters.

Example to X and Y Coordinates:

+0.0, +1.0

Mask Setup

You can list various remote commands in the mask setup area to define
the relative vertical and horizontal positions of the 0 and 1 coordinates
of the mask X and Y-axes. Commands listed in the setup area are
executed as part of the mask data load process.

Example to Mask Setup:

:MTES:SCAL:YTRACK OFF

:MTES:SCAL:Y1 -0.65
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:MTES:SCAL:Y2 +0.65

:MTES:SCAL:XDEL 312.5E-12

:MTES:AMET NRZEYE

:MTES:INP:MODE DIFF

In the above example, the Y1 and Y2 values define the mask with an
absolute voltage value. In some mask files, Y1 and Y2 values are not
specified, and so the voltage value is relative to either Vtop and Vbase,
or to the eye boundaries specified by the user in the GUI.

A mask can be set in two modes, either differential, or single. The above
example, ":MTES:INP:MODE DIFF", sets the mode of the mask file to
differential. The mask mode, when defined, should match the mode set
in 'ED Input Setup Dialog'. In case it doesn't match, an error message
will indicate this mismatch.

How to Enter Notes?

There is a tab on the top left corner of the graph for entering notes.

To enter notes:

1 Click on the Note Tab.

2 Enter your notes in the drop down text box. This gives the
timestamps of the comments entered. It’s a scrollable editor where
your latest comments are entered at the end.
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How to Save and Recall

To Save the following measurements:

• Eye Diagram

• Property Page

• Legend States

• Left Panel Values

• Automated Eye Parameter Measurement

1 Click on the Analysis Menu

2 Click on ‘Save Measurement’

To Recall the measurements:

1 Click on the Analysis Menu

2 Click on ‘Load Measurement’

How to Export Fetched Data?

You can export various counters to an exported file location.

1 Click on Analysis Menu
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2 Click on ‘Export Data’

When you click on ‘Export Data’ the following screen appears:

The Clipboard option saves the data on a clipboard.

The ‘Format Options’ takes you to the following screen.

You can select the ‘Format’, ‘Save to File’ and ‘Error Options’ as per
requirements.
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The ‘Save to File’ option specifies, either saving only the BER values, or
saving the BER, the Compared Bits, and the Errors.

The ‘Error’ option gives the user the choice of saving, the BER, the
Compared Bits, and the Errors, for different combinations of expected
1s, 0s, and all.

Eye Diagram - Reference

The Eye Diagram measurement returns the results in graphical and
numerical forms. The following section explains the measured
parameters, and the displayed options that are specific to these
measurements. Additionally, some information is provided to explain
the theoretical background to these measurements.

Parameters that can be set on the various tabs of the Properties pop-
up:

Parameters

N O T E If the parameters on this page are modified, run the measurement again to update
the results. While the measurement is running the parameter settings cannot be
changed.

Set the criteria for Persistence.

• Infinite

With ‘Infinite’, the eye appears with the Automated Eye Parameter
Measurement, and the results keep on improving in accuracy, as more
number of points get measured and represented on the diagram along
with the deeper BER values. The BER threshold in the Graph Tab
decides how long the measurements will be done at the boundaries of
the eye. Once the measured points exceed the BER Threshold defined
by the user, the measurement is done deep inside the eye.

This is a default setup for persistence.

• Minimum

With ‘minimum’, a reasonably clear eye, with transition, appears along
with all the Automated Eye Parameter Measurement, and automatically
the measurement restarts showing only the refined eye diagram. To stop
the measurements click the abort button.

• Secs
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With ‘Secs’, the measurement runs for the specified time, and the
measurement automatically restarts showing only the refined eye
diagram. To stop the measurement, click the abort button.

Sets the transition of the eye on the plot

• Middle of eye

With ‘middle of eye’, the center of the eye coincides with the center of
the screen.

• Transition

With ‘transition’, the transition of the eye coincides with the center of
the screen.

Set the criteria for the number of eyes.

• 1.5ui

This option displays ‘1.5’ eyes on the graph. The transitions of the
complete eye are placed such, that, they show ‘0.25’ eyes on both sides.
So, the total number of displayed eyes is 1.5.

• 2ui

This option displays ‘2.0’ eyes on the graph. The transitions of the
complete eye are placed such, that, they show ‘0.5’ eyes on both sides.
So, the total number of displayed eyes is 2.0.

View

Set the criteria for calculating the eye width, eye height, JPP, JRMS,
cross voltage according to the BER threshold selected.

• 0 Errors

To see ‘0 errors’ select the option. This gives the results according to the
last measured contour for the current measurement. This is more
significant in the case of deep BERs.

• BER Threshold

Enter the BER threshold at which the five results, eye width, eye height,
JPP, JRMS, and cross voltage, will be calculated.

The show checkbox displays the contour at which the results are
calculated.

Set criteria for transition time

• 10/90
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Measures horizontal scan from 10% to 90% of the signal amplitude.

• 20/80

Measures horizontal scan from 20% to 80% of the signal amplitude.

Set the criteria for eye boundaries. Total is 100% of the display screen.
These are applied for the level related parameters, for example, 0-level,
1-level, Signal to Noise ratio, Eye Amplitude, and so forth.

• Left Boundary

Marks the lower edge of the eye window boundary

• Right Boundary

Marks the higher edge of the eye window boundary

Set the criteria for eye width and eye height.

• Eye width at crossing point

This parameter gives the eye width at the crossover. Total is 100% of the
display screen.

• Eye width custom

This parameter gives the eye width at a specific percent of the eye
amplitude. (Starting from low level to high level).

• Eye height

This parameter gives the eye height at a specific percent of 1ui. (Starting
from left to right).

Set the criteria for the decimal placing in the return values.

• Decimal Places

This parameter sets the decimal placing for the Automated Eye
Parameter Measurement.

Set the criteria for the optical parameters. These are used to convert
level values to optical power values.

"power value" = ("level value" - "dark level") * "conversion gain"

• Dark Level

Internally generated offset signals.

• Conversion Gain

Is used to convert voltage level into power.

• dBm
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Output will be displayed in dBm.

power value[dBm]=10*log(power value[W]/1mW)

• W

Output will be displayed in Watt

Set the criteria for the Extinction Ratio Unit

• Ratio

Ratio of two optical power levels, low level and high level

• dB

Unit for measuring the extinction ratio.

ratio[dB]=10*log(ratio)

• %

Extinction Ratio in percentage

Graph

Set the criteria for the Timing Units:

• Unit Interval

Unit used to measure delay relative to the eye width.

• Seconds

Unit used to measure eye width in absolute terms of time.

Set the criteria for the waveform:

• Show Waveform

This option shows the waveform graphic.

• Smooth Waveform Graphic

The smooth waveform gives a finer waveform output. It logarithmically
interpolates between the measured points to give a finer waveform.

• BER Threshold

The BER Threshold value allows the user to measure around the eye
boundaries first, and then, deeper inside the Eye for BERs beyond the
specified threshold.

Set the criteria for the Contour:

• Show Contour line
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This option plots the contour.

• Show Legend

This shows the list of BER values.

• Show Grid

The 353pxl X 289pxl screen is divided into a 10 X 8 grid. This parameter
adds a grid to the screen.

Set criteria for the markers:

• Show Marker Lines

This option enables the markers on the screen.

• Reset marker

This brings the marker back to its default position.

Mask

• Load Mask File

With Load, a mask file is loaded. Once the file is successfully loaded the
Start button gets activated.

Set Mask Alignment:

• Display

The Display mode aligns the mask using the Vtop and Vbase values of
the displayed waveform. All the threshold coordinates of the mask will
be relative to this voltage. This is the default mode for mask alignment.

• Eye Boundaries

The Eye Boundary mode aligns the mask using the 1 level and 0 level of
the waveform. The 1 level and the 0 level are calculated between the Eye
Boundary 1, and Eye Boundary 2.

Set Mask Margins:

• Margins on

Mask Margins, allows the user to enlarge or shrink a mask in order to
see the margin size, and how much of it is violated. The maximum and
minimum margins are defined within the mask files.
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Set Mask Scaling

With mask scaling the mask can be manually enlarged, shrunk, and
moved around. With the logic levels track selected, the mask regions are
bound together, and move together with a fixed amplitude. Position
(pos) gives the timing displacement, and dT gives the delta time offset.

Set Mask Run Control:

The Mask Run Control aligns the mask, switches it on, starts displaying
the number of waveforms, and the number of mask violations per mask
region, and the worst BER per Mask region.

Exit stops the computation, hides the mask, and the violations.

Automated Eye Parameter Measurement

Table 30

S.No Parameter Description

1 Rise time Measures the mean
transition-time taken by
the data on the rising edge
of the eye diagram. The
data crosses three
thresholds: lower,
crossover point, upper and
the eye transition.
Note: Rise time is
dependent on the
Transition Time of the
View Tab. The two options
are 10/90 and 20/80.
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Table 30

S.No Parameter Description

2 Fall time Measures the mean
transition-time taken by
the data on the falling edge
of the eye diagram. The
data crosses three
thresholds: lower,
crossover point, upper and
the eye transition.
Note: Fall time is
dependent on the
Transition Time of the
View Tab. The two options
are 10/90 and 20/80.

3 Sample Count The number of points
measured for the eye
diagram. If persistence,
‘infinite’, is enabled, the
value will gradually
increase.

4 0-Level Zero level is the
measurement of the mean
value of the logical 0 of an
eye diagram.
Note: This measurement is
made in a section of the
eye referred to, as the eye
window boundaries. The
default value for the NRZ
eye window is the central
20% of the bit period. You
can change the eye
window boundary settings
in the Configure
Measurement dialog box.
These settings determine
what portion of the eye will
be measured.
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Table 30

S.No Parameter Description

5 1-level One Level is a measure of
the mean value of the
logical 1 of an eye diagram.
Note: This measurement is
made in a section of the
eye referred to, as the eye
window boundaries. The
default value for the NRZ
eye window is the central
20% of the bit period. You
can change the eye
window boundary settings
in the Configure
Measurement dialog box.
These settings determine
what portion of the eye will
be measured.

6 Eye Amplitude The difference between
the logic 1 level and the
logic 0 level.

7 Eye Width The horizontal
measurement of the eye
opening at a specified BER
Threshold.
Note: The Eye Width is
calculated according to
the BER Threshold set in
the View Tab. Eye Width is
calculated as per the
selection of either Width
at Crossing Point or
Custom defined Width.
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Table 30

S.No Parameter Description

8 Eye Height Measures the vertical
opening of an eye diagram
with respect to BER
threshold. This determines
“eye closure” due to noise.
Note: The Eye Height is
calculated according to
the BER Threshold set in
the View Tab. Eye Height is
calculated with 'Height at'
in the View tab.

9 Jitter P-P Full width of the histogram
at the eye crossing point
with respect to BER
threshold.
Note: The Jitter P-P is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.

10 Jitter RMS A standard deviation of the
crossing point histogram
with respect to BER
threshold.
Note: The Jitter RMS is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.
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Table 30

S.No Parameter Description

11 Cross Voltage Crossing percentage is a
measure of the amplitude
of the crossing points
relative to the 1 level and 0
level.
Note: The Cross Voltage is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.

12 Signal to Noise Ratio In signal-to-noise, the
"signal" is the information
power of the signal
indicated by the difference
between the ‘1’, and ‘0’
level. The "noise" is the
combined standard
deviations of the ‘1’ level
spread, and the ‘0’ level
spread.

13 Extiction Ratio Extinction ratio is the ratio
of the 1 level power and the
0 level power of an eye
diagram.
Note: The Extinction Ratio
is calculated using the
Dark Level and Conversion
Gain of the View Tab.

14 OMA The Optical Modulation
Amplitude (OMA) is the
difference between the 1-
level power and 0-level
power.
Note: The OMA is
calculated using the Dark
Level and Conversion Gain
of the View Tab.
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Table 30

S.No Parameter Description

15 Duty Cycle Distortion
(DCD)

This value is the difference
between the period of a 1
bit and a 0 bit.

16 Average Power The mean of level 0 power
and the level 1 power.
Note: The Average Power
is calculated using the
Dark Level and Conversion
Gain of the View Tab.

Eye Diagram Screen

This graph gives the picture of the Eye Diagram Screen.
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Spectral Jitter

Spectral Jitter - Concepts

The Spectral Jitter measurement allows you to analyze the jitter
inherent in the output signals of your device under test (DUT) as a
function of the frequency. This measurement can be used for
investigation of the behavior of the DUT, for example to identify
crosstalk effects.

Spectral Jitter Analysis

The Spectral Jitter measurement provides a method for investigating
the spectrum of the jitter, i.e. its power distribution over frequency.

Deterministic jitter can be caused by repetitive data patterns. It can also
be caused by internal or external periodic effects.

The Spectral Jitter measurement detects even small periodic
components that may be hidden in a high level of random noise. It
informs you about the frequencies of such components and measures
their contribution to the total jitter.

This helps to identify jitter sources and to reduce or eliminate their
influence.

Prerequisites for Using the Spectral Jitter Measurement

It is important that the initial sampling point is in optimum position
(i.e. in the middle of the eye opening), because the Spectral Jitter
measurement derives its starting sampling point from that point.

See also “General Requirements” on page 216.

How the Spectral Jitter Measurement Works

The Spectral Jitter measurement performs a capture and compare
operation in the jitter region. The number of compared and captured
bits is adjustable.

By default, the analyzer sampling point is set to an offset of -0.5 analyzer
clock periods or unit intervals (UI) from the optimum sampling delay.
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Capture and compare means that a certain amount of incoming data is
captured and also compared with expected data in real time. The
number of captured data points is adjustable.

While the measurement is running, correct and incorrect data is
captured. The resulting records contain the captured data and the
corresponding error information.

These records are automatically processed. The error information is
subject to a fast Fourier transform (FFT). FFT reveals the spectral
components and their power. Several window algorithms are provided
to reduce the influence of leakage.

Jitter Distribution Over Time

Jitter has a more or less characteristic distribution over time.

The histogram of pure random jitter shows its Gaussian distribution, as
illustrated in the following figure:
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Deterministic jitter periodically adds and subtracts a delay to/from the
received signal.

Jitter caused by a square wave or on/off signal has produced the
following histogram:

Jitter caused by a triangle signal shows an even distribution:

Last, but not least, the histogram of jitter modulated by a sinusoid
exhibits two significant peaks:
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The jitter histogram of a real world signal shows most often a mixture
of these characteristic distributions.

Measurement Results

The Spectral Jitter measurement provides:

• A graphical view of power vs. frequency. This makes it easy to
identify prominent spectral jitter components. You can adjust the
horizontal and vertical axes according to your needs.

• You can switch between linear and logarithmic scales.

• Graphical markers and the zoom function assist you when you are
analyzing the graph visually.

• The numerical results include bit error rate, total power, and noise
power. They provide also frequency and power information about
the dominant peaks in the spectrum.

• Absolute and relative power values are available. Relative values can
be normalized to the total jitter power or the power of a selected tone
(frequency bin).

• Pass/fail limits can be set for the bit error rate, total power and noise
power, and the allowed jitter power in user-defined frequency
regions.
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Periodic Jitter and Bit Error Information

When the incoming signal is sampled at the transition point, periodic
jitter manifests itself in the bit error record. An example may be helpful
to understand the phenomenon.

Let us assume we expect and correctly receive a simple 0, 1, 0, 1, 0, ...
pulse signal. If we would sample this signal one clock period earlier (-1
UI), we would see a bit error rate (BER) of 1.0. This is the maximum
BER for this pattern.

Let us also assume, this signal is overlaid by a periodic jitter source with
sinusoidal characteristics.

Now we sample the incoming signal at the transition point (-0.5 UI from
the optimum sampling point).

The result is illustrated in the figure below.

1

0

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1

1

0

1 0 1 0 1 0 1 0 1 1 0 1 0 1 0 1 0 1

increasing right shift decreasing right shift increasing left shift decreasing left shift

Signal without jitter

Expected and correctly
sampled data

Periodical,
sinusoid jitter

Signal with jitter

Captured data

Error data 1 1 1 1 1 1 1 1 1 0 0 0 0 0 0 0 0 0

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1Expected data

The jitter source moves the received signal to the right and to the left,
but the sampling point is fixed (dotted lines show the undisturbed
signal). Because we are sampling at the transition point, we get errors
when the signal is shifted to the right and no errors when the signal is
shifted to the left.

The error signal shows a very characteristic and reproducible pattern.
The resulting BER for this kind of signal is 0.5. Other jitter frequencies
yield different but also characteristic error patterns and also a BER
which is half the maximum BER.

The maximum BER and hence the actual BER are pattern-dependent.
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Considering the BER bathtub curve, the sampling point is in the middle
of the descending line.

If random data is used, the average bit error rate at the left-hand side
of the jitter region is 0.5.

The bit error rate at the right-hand side of the jitter region is 0. We
therefore expect a bit error rate around 0.25.

N O T E The Spectral Jitter measurement should only be used in conjunction with data that
has an equal distribution of ones and zeros over time. Otherwise, the results are
hard to predict and may be not reproducible.

Signal Processing

If the error signal is obtained as explained above, an analysis in the
frequency domain reveals the absense or presence of deterministic
jitter. Dominant frequency components become visible and their
contribution to the total jitter can be measured.

The modified error signal is subject to a fast Fourier transformation
(FFT).

FFT requires that the data record to be processed has a length that is a
power of two (2n, such as 217, 218, 219, 220, and so on).

From that data record, the FFT calculates pairs of frequency/power
values. The number of pairs is half the number of samples. If you have
chosen a record length of 217 (which means 131,072 bits or 128 Kbit),
the result contains 65,536 pairs. The maximum frequency is half the
data rate used for the test.

The results are displayed in the Spectral Jitter measurement graphical
and numerical result window.
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About FFT

For general information about the Fourier transformation and the
special characteristics of the fast Fourier transform, please refer to the
standard literature. For details, see the following documents:

• Frederic J. Harris, "On the use of Windows in Harmonic Analysis
with the Discrete Fourier Transform", Proceedings of the IEEE, Vol.
66, January 1978

• "The Fundamentals of Signal Analysis", Agilent Application Note
243, Publ. No. 5952-8898E

• "Fibre Channel - Methodologies for Jitter Specifications", National
Committee for Information Technology Standardization (NCITS),
T11.2/Project 1230/Rev. 10, June 1999

• Yi Cai, Bernd Laquai, Kent Luchman, "Jitter Testing for Gigabit
Serial Communication Transceivers", IEEE Design and Test of
Computers, Jan-Feb 2002

The error record contains a bipolar, rectangular signal. If such a signal
is periodic, you can expect a spectrum as illustrated below.

The fundamental frequency and its harmonics appear.

Such spectra have been measured with the Spectral Jitter measurement.

A logarithmic power scale shows the details:
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When the repetition period of the characteristic pattern in the error
record increases, you will also find the typical sine-x-over-x decay of the
spectral power.

FFT assumes that the time record contains a representative section of
an endless periodic signal. It assumes that time records can be
seamlessly concatenated. If this is not the case, a phenomenon called
leakage occurs.

Leakage makes it impossible to detect minor adjacent spectral
components. The following two figures refer to a slightly disturbed sine
wave.
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When you perform a Spectral Jitter measurement, it is likely that some
degree of leakage occurs. The measurement therefore provides a choice
of FFT windows that allow you to detect leakage and to reduce its
impact.

An FFT window is a filter that sets the beginning and end of the time
record smoothly to zero. Such records can be seamlessly concatenated.

When you are using a window, please note:

• No window removes leakage completely.

• Every window reduces the spectral power.

• Results obtained from different devices can only be compared if the
same window is used.

Spectral Jitter - Procedures

This section shows how to set up and use the Spectral Jitter
measurement. As an example, we measure the spectral jitter behavior
of a shielded cable.

This requires the following steps:

• “How to Prepare the Spectral Jitter Measurement” on page 344

• “How to Execute the Spectral Jitter Measurement” on page 344
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How to Prepare the Spectral Jitter Measurement

To use the Spectral Jitter measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V (Disable)
button in the PG Setup -> Data Output  screen.

2 Use a shielded cable to connect the pattern generator's Data Out port
and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Switch to the Pattern menu and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both the
pattern generator and the error detector.

5 For the pattern generator setup, you need to specify the logic levels
and the bit rate. Select:

– Logic levels: LVPECL

– Clock speed: Gb Ethernet (1.06250Gb/s)

See “Setting up the Pattern Generator - Concepts ” on page 113 for
more information.

6 Set up the error detector so that the input range and the termination
matches the pattern generator's levels. Select Normal  as the Active
Input, an Input Range  of 1-3V, and set the Data Termination to 1.3V.

7 Enable the pattern generator outputs by pressing the  0V (Disable)
button.

8 Also make sure that the error detector derives its clock from the
incoming data stream using Clock Data Recovery. See “Clock Setup
- Procedures” on page 167 for details.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red, and the
resulting BER should be zero.

How to Execute the Spectral Jitter Measurement

To run the Spectral Jitter measurement:

1 Switch to the Analysis area. If the Spectral Jitter screen is not yet
displayed, press the Spectral Jitter icon.

2 Press the Start button to execute the measurement.

The measurement software runs the measurement and displays the
results. A total of 65535 points are displayed for this measurement.
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Numerical values are also displayed. The values include Bit Error Rate,
Total Power, and Noise power. Additionally, you can also configure up to
16 frequency/power pairs. The latter are sorted according to descending
power contents. These results are discussed in “Explanation of the
Numerical Results” on page 248.

How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results, you
can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

– Parameters tab

These settings are used for data collection. Changes require to
run the test again. See “Parameters Tab” on page 240 for details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on page
242 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is displayed.
You do not need to run the measurement again. See “View Tab”
on page 244, “Graph Tab” on page 246, and “How to Change the
Colors of the Graph” on page 220 for details.
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3 Press OK when you have made all required changes to close the
Properties dialog box.

Spectral Jitter - Reference

The Spectral Jitter measurement returns the results in a graphical and
in a numerical form. The following sections provide explanations of the
measured parameters and the display options that are specific to this
measurement. Additionally, some information is provided to explain
the theoretical background behind the jitter calculations.

Properties that can be specified on the various tabs of the Properties
dialog box:

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the data acquisition parameters:

• Acquisition Depth

Suitable numbers can be chosen from the drop-down list.

The Acquisition Depth determines the length of the time record used
for the FFT.

A smaller number reduces the duration of the Spectral Jitter
measurement and its precision. A larger number increases the
measurement duration but also the frequency resolution of the
measured spectral components.

The frequency resolution of the measurement is:

data rate / Acquisition Depth

For example: If you have a data rate of 2.5 GHz and an Acquisition
Depth of 128 Kbit, the frequency resolution is 19.0735 kHz.

The relations are illustrated in the following figure:
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N O T E A high Acquisition Depth requires a high degree of computational effort and hence
time.

• Sample Point Offset

By default, the sampling point for the measurement is positioned 0.5
clock periods or UI ahead of the present analyzer sampling point.

If the sampling point is set in the middle of the eye, this corresponds
to the transition point of the incoming signal. If you have set the
sampling delay manually, this is the time offset from that point.

This option allows you to fine-tune the sampling point. The unit is
UI (unit intervals). This makes the setting independent of the present
clock frequency.

Set the FFT window for the FFT Calculation. The following windows are
provided:

• Uniform

• Hanning (sometimes also called Hann)

• Hamming

• Blackman

The "uniform" window is no window at all. This setting supplies the
original error record to the FFT.
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The other windows have the shapes illustrated in the figure below:

You can see from the figure that the Blackman window is the strongest
filter.

The windows are based on the following formulas:

N O T E In case of leakage, FFT windows improve the spectral resolution. FFT windows
generally reduce the measured spectral power.

For an introduction to FFT windows see “Leakage and Windowing” on
page 342.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify the
criteria to decide whether the DUT passes or fails the test. You can
change pass/fail criteria without rerunning a test. The software only
uses the criteria to rate the results of a measurement.
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N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.

The following Spectral Jitter Pass/Fail criteria can be selected for the pass
or fail decision:

• Bit Error Rate

• Total Power (in dB)

• Noise Power (in dB)

You can also define the pass/fail criteria for each of the defined
frequency ranges.

In the tabular view, each of the calculated values will be marked with
an

icon if it failed the test.

The following illustration shows a Spectral Jitter measurement that has
failed the criterion for the Bit Error Rate.
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View Tab

The graph shows the noise versus frequency. The View tab provides you
with various options for analyzing the data and setting frequency ranges
for evaluation.

The linear power scale is well suited for identifying large peaks in the
spectrum.

The View tab allows you to change the power scale from linear to dB.
The dB scale is a logarithmic scale. The dB scale allows you to examine
the whole power range.

The following figure shows an example of a double logarithmic display.
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The figure above shows the absolute power scale and values as
calculated by the FFT. You can also calculate relative values.

Relative values can be normalized to either the total power (True
Relative) or to the power of a selectable frequency bin (Relative).

The following figure shows an example where the scale and the power
values have been normalized to the power measured at 1 MHz.

When you set the power values to relative, this changes not only the
graphical scale but also the calculated results. You can thus calibrate
the power values to any reference.
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The Noise Threshold can be moved with the mouse (or your finger, if you
are working directly on the Serial BERT). It can also be set on the
View page of the Properties dialog.

This threshold is used to separate between total power and noise power.
All components below the Noise Threshold are considered noise. When
the threshold is changed, the calculated Noise Power values change.

If desired, change the Number of Top Frequencies to Show. This determines
the number frequency/power pairs in the numerical section. Up to 16
pairs can be calculated and displayed.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between logarithmic and linear scale for displaying the
frequencies.

Display the power either in a logarithmic (dB) or linear scale.

Show the entire frequency range or zoom in one part of it.

To analyze the graphs at a particular point, you can use the markers.
Additionally, you can display all related values for the markers in the
marker readout.

Pressing the Reset Markers button will set the markers back to the default
positions.

Several zoom factors are available. When you show the zoom graph, you
can also allow the zoom graph to track the mouse (or your finger, if you
are working directly on the Serial BERT).
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Explanation of the Numerical Results

The measurement provides numerical results for:

• Bit Error Rate

• Total Power

• Noise Power

• The Frequency and total power for up to the 16 frequencies with the
highest total power.

You can set the number of top frequencies to be evaluated in the View
tab (see “View Tab” on page 244 for details).
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7 
Evaluating Results

Evaluating Results - Concepts

The Serial BERT offers several different kinds of tests that can be run:

• Instantaneous Measurements

This type of measurements is used to monitor the instantaneous BER
or 8B/10B Error Ratio during measurement setup, experiments, and
adjustments.

• Accumulated Measurements

This type of measurements is used to measure and log error
performance over time. Also, you can capture the location of bit
errors for further analysis.

• Eye Measurements

This type of measurements is used to measure the eye height and
width of the incoming data signal at specific alignment BER
thresholds. This information is displayed on a representation of an
eye diagram.

Instantaneous Measurements

Instantaneous Measurements - Concepts

With instantaneous measurements, you can directly view the current
BER or 8B/10B Error Ratio Comparison results on the screen. The 8B/
10B Comparison includes the following measurements:

• Symbol Error Ratio (SER)
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• Frame Error Ratio (FER)

• Calculated Bit Error Ratio (cBER)

• Filler Symbol Ratio (FSR)

• Disparity Error Ratio (DER)

• Illegal Symbol Ratio (ISR)

In order to stress your device under test, you can then, for example, add
errors to the data stream or switch between different patterns and view
the resulting BER or 8B/10B Comparison. Or you can adjust the output
port parameters or the error detector's sampling point while the
measurement is running and watch the resulting BER or 8B/10B
Comparison immediately.

Such measurements can be used to find out the benchmark data, for
example, for a device prototype.

Test Methods

You can analyze the behavior of your device by employing several test
methods. If the changes in the test setup affect the BER or 8B/10B
Comparison, you can immediately notice it on the screen. The resulting
changes in the BER or 8B/10B Comparison let you learn about the DUT's
behavior and limitations. Some examples of modifications that you can
make are listed below.

• Add errors to the data stream. See “Error Addition/Insertion -
Concepts ” on page 144 for details. You can, for example, perform a
confidence test of your measurement setup. The analyzer should
recognize all errors that you add. If it does not, you may have a
problem with your measurement setup. See “Setup Problems -
Concepts” on page 463 for details.

• Use alternating patterns to switch between different data streams.
For example, if your device is designed to turn off in response to a
high BER or 8B/10B Comparison, you can check if your device
behaves as expected. And you can observe what the BER or 8B/10B
Comparison is prior to data loss. See “Pattern Alternation -
Concepts ” on page 148 for details.

• Manipulate the signal being generated by the pattern generator, as
described in “Setting up the Pattern Generator - Concepts ” on page
113.

• Adjust the sampling point to see the effect on the BER or 8B/10B
Comparison. See “Sampling Point Setup - Concepts ” on page 180 for
details.

• Make modifications to your device setup.

7 Evaluating Results

356 Agilent J-BERT N4903B High-Performance Serial BERT



This can be used to see how changes to your device affect the BER
or 8B/10B Comparison. You can determine what adjustments
improve or degrade the BER or 8B/10B Comparison.

Instantaneous Measurements - Procedures

This section describes how to run, monitor, and analyze instantaneous
measurements.

Running Instantaneous Measurements

The Serial BERT's error detector immediately starts calculating the
error rate as BER or 8B/10B Comparison as soon as it receives a valid
signal at the data ports.

N O T E Both the pattern generator and the error detector must be correctly set up and
connected to the DUT.

To run a BER or 8B/10B Comparison measurement:

1 Check if all the values in the status line are correct: pattern generator
pattern and bit rate, error detector pattern and bit rate.

2 View the BER/SER/FER/FSR/ISR/DER/cBER display in the top left
corner of the GUI.

If the measurement is running properly, a certain BER/SER/FER/
FSR/ISR/DER/cBER should be displayed here. In most cases the
BER/SER/FER/FSR/ISR/DER/cBER is not a constant value but
slightly varying over time. If no BER/SER/FER/FSR/ISR/DER/cBER
is displayed because there are no errors detected, you can manually
insert an error by pressing the Error Add button in the top right
corner of the screen.

When inserting an error, the BER/SER/FER/FSR/ISR/DER/cBER
should increase for a short time and then return to the initial value.
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How to Monitor the BER Results

There are different ways, how you can monitor instantaneous BER
values:

1 Listen to the BER warning tones. See “Audio Signals - Procedures”
on page 212 for details.

2 View the BER Results window, which is described in “BER Results
Window” on page 359.

3 View the BER bar and errors indicator. See “Status Indicators” on
page 365 for details.

How to Monitor the 8B/10B Comparison Results

There are different ways, how you can monitor instantaneous 8B/10B
Comparison values:

1 Listen to the 8B/10B Comparison warning tones. See “Audio Signals
- Procedures” on page 212 for details.

2 View the 8B/10B Comparison Results window, which is described in
“8B/10B Comparison Results Window” on page 360.

3 View the 8B/10B Comparison error indicators. See “Symbol Lock
Indicator” on page 179 and “Symbol Lock Indicator” on page 179for
details.

How to Analyze the BER or 8B/10B Comparison Results

To analyze the behavior of your device, you can do the following
modifications to the test setup and monitor the effect on the resulting
BER or 8B/10B Comparison:

1 Add errors to the data stream. See “Manually Inserting Errors” on
page 144 for details.

2 Use alternating patterns to switch between different data streams.
See “Setting Up a Periodical Output” on page 150 for details.

3 Adjust the parameters of the output port of the pattern generator,
as described in “Setting Logic Levels and Terminations” on page
121.

4 Manually move the sampling point. See “How to Set the Optimum
Sampling Point Automatically ” on page 183 for details.

5 Make adjustments to your device.

This can be used to see how changes to your device affect the BER
or 8B/10B Comparison. You can determine what adjustments
improve or degrade the BER or 8B/10B Comparison.
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Instantaneous Measurements - Reference

This section describes all elements of the BER Results window, 8B/10B
Comparison Results windows and their various status indicators:

BER Results Window

This window displays the actual (BER) or cumulative (AccumBER) BER
results:

• The BER is the current BER, calculated upon a period of 200ms.

• The AccumBER shows either the accumulated BER of the current
accumulation, or - if no accumulation is running - the results of the
most recent accumulation.

This enables you to monitor real-time BER behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between BER or AccumBER results.

This area displays the actual error count or cumulative error count.

N O T E The BER bar below the main menu bar also displays the actual BER. You can drag
the small yellow alarm threshold mark to change the BER Alarm Threshold.
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8B/10B Comparison Results Window

This window displays the actual or cumulative results of the following
measurements:

• Symbol Error Ratio (SER). See “SER Results Window” on page 360.

• Frame Error Ratio (FER). See “FER Results Window” on page 361.

• Calculated Bit Error Ratio (cBER). See “cBER Results Window” on
page 362.

• Filler Symbol Ratio (FSR). See “FSR Results Window” on page 362.

• Disparity Error Ratio (DER). See “DER Results Window” on page
363.

• Illegal Symbol Ratio (ISR). See “ISR Results Window” on page 364.

SER Results Window

This window displays the actual (SER) or cumulative (AccumSER) SER
results:

• The SER is the current SER, calculated upon a period of 200ms.

• The AccumSER shows either the accumulated SER of the current
accumulation, or - if no accumulation is running - the results of the
most recent accumulation.

7 Evaluating Results

360 Agilent J-BERT N4903B High-Performance Serial BERT



This enables you to monitor real-time SER behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between SER or AccumSER results.

This area displays the actual symbol frame error count or cumulative
error count.

FER Results Window

This window displays the actual (FER) or cumulative (AccumFER) FER
results:

• The FER is the current FER, calculated upon a period of 200ms.

• The AccumFER shows either the accumulated FER of the current
accumulation, or - if no accumulation is running - the results of the
most recent accumulation.

This enables you to monitor real-time SER behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between FER or AccumFER results.
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This area displays the actual frame error count or cumulative frame
error count.

cBER Results Window

This window displays the actual (cBER) or cumulative (AccumcBER)
cBER results:

You can click Accumulated/Actual button to toggle between cBER or
AccumcBER results.

The Error Count/Accum Error Count area displays the actual error count or
cumulative error count.

FSR Results Window

This window displays the actual (FSR) or cumulative (AccumFSR) FSR
results:
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• The FSR is the current FSR, calculated upon a period of 200ms.

• The AccumFSR shows either the accumulated FSR of the current
accumulation, or if no accumulation is running, the results of the
most recent accumulation.

This enables you to monitor real-time FSR behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between FSR or AccumFSR results.

This area displays the actual filler symbol error count or cumulative
filler symbol count.

DER Results Window

This window displays the actual (DER) or cumulative (AccumDER) DER
results:
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• The DER is the current DER, calculated upon a period of 200ms.

• The AccumDER shows either the accumulated DER of the current
accumulation, or if no accumulation is running, the results of the
most recent accumulation.

This enables you to monitor real-time DER behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between DER or AccumDER results.

This area displays the actual illegal disparity change count or
cumulative illegal disparity change count.

ISR Results Window

This window displays the actual (ISR) or cumulative (AccumISR) ISR
results:
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• The ISR is the current ISR, calculated upon a period of 200ms.

• The AccumISR shows either the accumulated ISR of the current
accumulation, or if no accumulation is running, the results of the
most recent accumulation.

This enables you to monitor real-time ISR behavior as you do things
such as to manually adjust the sampling point, to add errors, or to make
adjustments to your device.

Click this button to toggle between ISR or AccumISR results.

This area displays the actual illegal symbol count or cumulative illegal
symbol count.

Status Indicators

The BER bar displays the BER calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the BER Alarm
Threshold.

The SER bar displays the SER calculated upon a period of 200 ms.
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You can drag the yellow alarm threshold mark to change the SER Alarm
Threshold.

The FER bar displays the FER calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the FER Alarm
Threshold.

The cBER bar displays the cBER calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the cBER
Alarm Threshold.

The FSR bar displays the FSR calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the FSR Alarm
Threshold.

The DER bar displays the DER calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the DER Alarm
Threshold.

The ISR bar displays the ISR calculated upon a period of 200 ms.

You can drag the yellow alarm threshold mark to change the ISR Alarm
Threshold.

These indicators inform you about the following errors:

• Bit error in the data stream located

• Loss of pattern synchronization

7 Evaluating Results

366 Agilent J-BERT N4903B High-Performance Serial BERT

FER bar

cBER bar

FSR bar

DER bar

ISR bar

Error Indicators



• Complete loss of data

• Loss of the error detector's clock signal

• Loss of the pattern generator's clock signal

• 10B symbol alignment is not done or is lost

• Loaded patterns have some disparity errors or contains invalid
symbols

N O T E The two additional error indicators "Symb Lock" and "8b10b Error"will only appear
if you select the error ratio as 8B/10B Symbol Comparison from the Error Detector
- Error Ratio's window. For more details, see “Symbol Lock Indicator” on page
179 and “8b10b Error Indicator” on page 180.

For troubleshooting information, see “Setup Problems - Concepts” on
page 463.

The LEDs on these indicators turns green if:

• any of Jitter, ISI, or SSC is enabled

• the outputs are enabled (yellow if output protection is active on any
of Data, Clock, Aux Data or Trigger/Ref Clock Output).

This indicator turns blue when the instrument is under remote control.

N O T E The instrument does not enter the remote lock state if the N4917A Optical Receiver
Stress Test Software is running on the instrument. This is because the N4917A
ORST Software also remotely controls the J-BERT.
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The Show Error Messages button displays the error messages. It uses the
color codes to indicate the following possible states:

• No error messages: The button will be in disable state.

• New/unread errors: The triangle icon on the button will turn red.

• No new errors: The triangle icon on the button will remain yellow.

If an error occurs, the detailed error message is displayed for a few
seconds on the top of the status indicator area. You can click the
message to make it disappear immediately.

Click the Show Error Messages button to open an Error Message dialog box
with all error messages.

On this dialog, click Clear & Close button to clear the error messages list
and quit the dialog box. Click the Close button to leave the dialog without
clearing the error messages list.

This dialog box also contains a Help button that takes you to the
respective section of the Online Help.
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This area displays the progress of the current accumulation period. The
accumulation period can be changed in the Accumulation Setup dialog
box. For more information, see “How to Run Accumulated
Measurements” on page 370.

The PG and ED pattern types are displayed here for your reference.

The PG and ED measured bit rates are displayed here for your reference.

Accumulated Measurements

Accumulated Measurements - Concepts

Accumulation refers to collecting measurement data over a specific
period. This can be used to create test scenarios that are reproducible
and comparable. Also, you can let tests run over long times and then
evaluate the results afterwards. Furthermore, you can use the log files
to determine the location of occurring bit errors for further root cause
analysis.

N O T E While accumulation tests are running, you should not modify the measurement
setup, as the measured bit errors do not represent the performance of your DUT
under real circumstances.
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The period of time can be set by manual start and stop commands, an
absolute time setting, or the time it takes to measure a specified number
of bits or bit errors. The accumulation period should be long enough to
make a statistically valid BER measurement. See “Test Times and
Confidence Levels” on page 27 for details.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.

Accumulated Measurements - Procedures

This section describes how to run accumulated measurements and how
to analyze the results:

How to Run Accumulated Measurements

To run accumulated measurements:

1 Ensure that the instrument is set up correctly and that the error
detector is already in synchronization.

2 Click the Accumulation Setup menu item from the ED Setup submenu
to check the settings made for the data accumulation.

See “Error Accumulation - Procedures” on page 208 for details.

3 To begin accumulation, press the Start Accum button on the front
panel.

This causes the following events:

• If Prompt for File Name has been selected during setup, you will be
asked to enter a name for the log file before accumulation begins.

• The data display in the Accumulated Results window is reset.

• The recording of data to the measurement log file is reset.
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How to Stop Accumulated Measurements

If you specified a single or repeat test, the test runs until the specified
end condition is reached. If you selected a manual test, it will run until
you stop it manually.

• Press the Stop Accum button on the front panel to stop the test
immediately.

N O T E Errors are only counted when the signal at the Gate In port is low.

How to View the Results

You can view data from accumulated measurements in several ways:

1 Click the Accumulated Results menu item from the Results submenu to
view the test results.

For easy comparison, the results of the current and previous
accumulation are listed here. See “Accumulated Measurements -
Reference” on page 372 for details on the reported values.

2 Examine the measurement log files on an external PC.

This allows to access all data for detailed processing and analysis on
a PC. Also, you can track the status of all indicators (such as DATA
LOSS and CLK LOSS) during the accumulation period. If you want
to view results from an accumulation period prior to the current and
previous test, you can view the respective log file, too.

How to Analyze the Results

Accumulated measurements can help you determine the cause of bit
errors. Bit errors can be caused by a variety of problems. In addition,
instrument settings can affect how errors are measured and displayed.
The sync mode setting has the greatest effect.

• Analyze the basic accumulated results and log files. Possible
observations that may occur are:

– Errors became constant (and remained constant for a period of
time) or number of errored 0's was greater than errored 1's, see
“Constant Errors (More Errored 0's than 1's)” on page 467.

– Errors were random, see “Random Errors” on page 468.

– Sync loss seconds were measured, see “Sync Loss Seconds” on
page 469.
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Accumulated Measurements - Reference

The Accumulated Results window presents data from the current and
previous accumulation period.

N O T E Data from the current and all previous accumulation periods is available in the
measurement log files, if correctly set up.

This window contains a graph and five tables:

Ratios Graph

This graph displays the delta errored 1's ratio, delta errored 0's ratio,
and total delta error ratio at data points over the entire accumulation
period. The error ratios on the y-axis are set to a range of 1E+0 (100 %
errors) to 1E-12. The accumulation period is on the x-axis.

During accumulation, data will appear to move from left to right on the
ratios graph. When the graph is completely filling the display, the x-axis
time scale will double. The data graph is then occupying only half of the
display and will continue to move to the right again. This will repeat
until the accumulation period has ended.

This graph can accumulate a large amount of data. You can click any
point on this graph to zoom into an area of BER data. You can continue
to click on the graph until you have zoomed to the maximum. The point
you click will appear in the middle of graph. You can press the back
button (left arrow) to zoom out again.
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N O T E The zooming function cannot be used before the accumulation period has ended.

N O T E To view precise BER data for every point in time, view the measurement log file.

While zoomed in, you can move data left or right by dragging the graph
or by using the front panel knob.

You can also zoom vertically by dragging the top and bottom sizing
handles. The current view can be moved vertically if you click between
the handles and drag them up or down.
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Accumulated Results

In the Accumulated Results table, the following values are listed:

• Bit Count

The number of bits considered for the accumulation period is
displayed here. This may not equal the total number of bits sent from
the PG.

• Error Ratio

The ratio of the error count to the bit count is displayed here to 4
significant digits.

• Error Count

The number of errored bits measured during the accumulation
period is displayed here.

• Errored 1's Ratio

The ratio of the errored 1's count to the bit count is displayed here
to 4 significant digits.

• Errored 1's Count

The number of logic 1's measured as logic 0's during the
accumulation period is displayed here.

• Errored 0's Ratio

The ratio of the errored 0's count to the bit count is displayed here
to 4 significant digits.

• Errored 0's Count

The number of logic 0's measured as logic 1's during the
accumulation period is displayed here.

G.821 Measurements

• Availability

The ratio of the available seconds to the total gating period expressed
as a percentage.

• Unavailability

The error ratio is calculated over 1 second timed intervals during the
gating period. An unavailable period begins when the error ratio is
worse than 1 x 10-3 for 10 consecutive seconds. These 10 seconds are
considered part of the unavailable time. The unavailable period ends
when the error ratio is better than 1 x 10-3 for 10 consecutive
seconds. These 10 seconds are considered part of the available time.
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Percent (%) Unavailability is the ratio of the unavailable seconds to
the total gating period expressed as a percentage.

• Severely Errored Seconds

The ratio of the total number of available seconds with an error ratio
worse than 1 x 10-3 to the total number of available seconds,
expressed as a percentage.

• Degraded Minutes

Severely errored seconds are discarded from the available time and
the remaining seconds are grouped into blocks of 60 seconds. Blocks
which have an error ratio worse than 1 x 10-6 are called Degraded
Minutes and Percent (%) Degraded Minutes is the ratio of the total
number of degraded minutes to the total number of 60 second blocks
in the available time expressed as a percentage. Incomplete blocks
of less than 60 seconds are treated as complete blocks of 60 seconds.

• Errored Seconds

The ratio of the errored seconds in the available time to the total
number of seconds in the available time, expressed as a percentage.

Interval Results

• Error Free Seconds

The number of seconds in which no errors were measured is
displayed here.

• Error Free Deciseconds

The number of deciseconds in which no errors were measured is
displayed here.

• Error Free Centiseconds

The number of centiseconds in which no errors were measured is
displayed here.

• Error Free Milliseconds

The number of milliseconds in which no errors were measured is
displayed here.

• Errored Seconds

The number of seconds in which errors were measured is displayed
here.

• Errored Deciseconds

The number of deciseconds in which errors were measured is
displayed here.

• Errored Centiseconds
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The number of centiseconds in which errors were measured is
displayed here.

• Errored Milliseconds

The number of milliseconds in which errors were measured is
displayed here.

• Sync Loss Seconds

The number of seconds in which the error ratio was greater than the
sync threshold is displayed here.

Accumulation Parameters

• Elapsed Time

The time elapsed during the accumulation period is displayed here.

• Percent Complete

For single and repeat accumulation modes, the percentage of the
accumulation period completed is displayed here to one decimal
place. For repeat mode, this percentage is recalculated each time the
accumulation period repeats.

• Accumulation Mode

The type of accumulation mode is displayed here. The mode can be
Manual, Single, or Repeat.

• Accumulation Period

For single and repeat accumulation modes, the accumulation period
is displayed here. The period will be displayed in elapsed seconds,
error count, or bit count, depending on the selected method.

Burst Results

The recommended application for burst mode is to measure multiple
data bursts in quick succession. In this way, you can accumulate data
for all bursts together. You may wish to accumulate the number of bits
necessary for a statistically valid BER measurement. Refer to
“Introduction to Burst Sync Mode” on page 198 and “Test Times and
Confidence Levels” on page 27 for details.

When the accumulation period lasts for the duration of all bursts, the
gaps in error counting (while the Gate In signal was high) will not be
included in BER calculations. The gaps in error counting will not be
considered error-free periods.
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N O T E If the gaps between data bursts are greater than 1 second (or 100 ms in the
measurement log file), they may be visible in the accumulated results graph.

• Burst Status

The following states may be returned:

– No Error

No burst errors have occurred (any of those listed below).

– Gate Signal Too Long

This error can occur if there are too many bits within a burst. The
limit is 4 Gbit. At 13 Gb/s, this occurs roughly after 0.3 s (slower
frequencies have a higher gate-in period). This error has a higher
priority than "no unique 48bits".

– No Unique 48 Bits Found

For reliable synchronization, a pattern must contain a unique 48-
bit pattern (the detect word). If the current pattern does not have
a detect word, this error occurs.

If this status occurs, the synchronization may be incorrect, as
could also the measured bit error rate. There are standard
patterns that may contain more than one instance of the used
detect word. Statistically, every other burst would be correctly
synchronized.

In this case, it is recommended that you redefine the pattern. This
error can only occur with memory-based patterns.

– Unknown

The status is unknown. This can occur if accumulation has not
been started, or if Burst Sync mode has not been activated.

• Burst Sync Ratio

Percentage of time in burst (while the Gate In signal is low) that
patterns are in sync and error counting is active. A higher percentage
is desirable, because it indicates that more data is measured during
each burst.

• Total Burst Count

Total number of bursts received while in burst mode during the
accumulation period.

• Bad Burst Count
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Total number of bursts where sync is never achieved during the
accumulation period.

• Bit Count

The number of bits considered for the accumulation period is
displayed here. This may not equal the total number of bits sent from
the PG.

Accumulated Measurements for 8B/10B Comparison

The Accumulated Results window for 8B/10B Comparison contains a
graph and two tables:

N O T E The Accumulated Results window for 8B/10B Comparison does not contain tables
for G.821Measurement, Internal Results and Burst Results.

Ratio Graph

This graph displays the delta symbol errored 1's ratio, delta symbol
errored 0's ratio, and total delta symbol error ratio at data points over
the entire accumulation period. For more information, see “Ratios
Graph” on page 372.

Accumulated Results

In the 8B/10B Comparison Accumulated Results table, the following
values are listed:

N O T E If the Block Length is equal to zero, then use Frame Count instead of Pattern Count
for calculating Accumulated Results.

• Calc Bit Count

7 Evaluating Results

378 Agilent J-BERT N4903B High-Performance Serial BERT



The total number of calculated bits considered for the accumulation
period is displayed here.

Calculated Bit Count, Error Count, Error Ratio is dependent on
cBER configuration mode SER|FER|ISR|DER|FSR.

If cBER is based on SER then:

Where,

Block Length is equivalent to Pattern Length in All Bits mode and
specified Block Length in Block mode with filler symbols

Block Length is equivalent to Pattern length in All Bits mode and
specified Block Length in Block mode without filler symbols

Pattern Count is equivalent to Pattern Count = Symbol Counter /
Block Length

Conversion factor is equivalent to 10 in case of SER/ISR/DSR in
Auto and User mode and Block length in case of FER/FSR

• Calc Bit Error Ratio (cBER)

The cBER is based on i.e. SER, FER, DER, ISR, FSR is displayed here.

The following is the expression used to calculate the Calc Bit Error
Ratio:

• Calc Bit Error Count

The Calc Bit Error Count is is displayed here which is equal to
Symbol Error Count.

• Compared Symbol Count (Symbol counter)

The number of compared symbols considered for the accumulation
period is displayed here. This may not be equal to the total number
of symbols sent from the Pattern Generator. Compared Symbol count
excludes any filler symbols (i.e. K28.1,K28.1 for USB 3.0) and
considers block length in Block Mode or Pattern length in All Bits
mode during comparision with Expected Data.

• Symbol Error Count (Symbol error counter)

The number of errored symbols measured during the accumulation
period is displayed here. Comparision results between incoming
Compared Symbols Count with Expected Symbol Count. Both
Compared Symbols and expected Symbols excludes Fillers Symbols
and compares only the Block Length in Block Mode or Pattern Length
in All Bits mode.
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• Symbol Error Ratio (SER)

The ratio of the error symbol to the symbol count is displayed here
to 4 significant digits.

The following is the expression used to calculate the Symbol Error
Ratio:

• Received Frame Count (Frame counter)

The number of received frames considered for the accumulation
period is displayed here. This may not equal the total number of
frames sent from the Pattern Generator.

• Frame Error Count (Frame error counter)

The total number of error frames received in a time interval is
displayed here.

• Frame Error Ratio (FER)

The ratio of the number of frame errors to the number of frames
received in the current (or last completed) accumulation period,
specified by the gate period isdisplayed here.

The following is the expression used to calculate the Frame Error
Ratio:

• Illegal Disparity Change Count (Wrong disparity counter)

The total number of illegal disparity change count (wrong disparity
count) received in a time interval is displayed here.

• Filler Symbol Count (Filler symbol counter)

The total number of filler symbol count received in a time interval is
displayed here.

The following is the expression used to calculate the Filler Symbol
Count:

• Illegal Symbol Count (Illegal symbol counter)

The total number of illegal symbol count received in a time interval
is displayed here.

• Disparity Error Ratio (DER)
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The ratio of the number of illegal disparity change count to the
number of symbols received in the current (or last completed)
accumulation period, specified by the gate period is displayed here.

The following is the expression used to calculate the Disparity Error
Ratio:

• Filler Symbol Ratio (FSR)

The ratio of the number of filler symbol count to the number of
symbols received in the current (or last completed) accumulation
period, specified by the gate period is displayed here.

The following is the expression used to calculate the Filler Symbol
Ratio:

• Illegal Symbol Ratio (ISR)

The ratio of the number of Illegal Symbol count to the number of
symbols received in the current (or last completed) accumulation
period, specified by the gate period is displayed here. Illegal Symbol
are invalid K and D symbols i.e. 0000000000 it does not belong to any
valid K or D symbols.

The following is the expression used to calculate the Illegal Symbol
Ratio:

• Expected Filler Symbol Count

The total number of Expected Filler Symbol Count received in a time
interval is displayed here.

The following is the expression used to calculate the Expected Filler
Symbol Count:

• Data Rate Ratio

The ratio of the number of filler symbol count to the expected filler
symbol count received in the current (or last completed)
accumulation period, specified by the gate period is displayed here.

The raw number of received symbols by the error detector equals the
sum of filler primitives (which are being dropped before
comparison) and the actually expected symbols. The actually

Evaluating Results 7

Agilent J-BERT N4903B High-Performance Serial BERT 381



expected symbols may be further distinguished into compared
symbols and not compared symbols when using block mode. The
number of filler primitives is a key indicator for DUT behavior. This
number must also visible if there is NO pattern lock. Furthermore
number of filler primitives that were contained in the expected
memory before it was loaded to the error detector is also shown in
"Accumulated Results" window.

1 If the filler primitive counter remains zero, this indicates that a
USB3 or SATA product is in the wrong test mode.

2 If the number of filler primitives is higher than the filler
primitives contained in the original test pattern, this indicates
that the DUT clock is faster than the PG clock.

3 If the number of filler primitives is lower than the filler primitives
contained in the original test pattern, this indicates that the DUT
clock is slower than the PG clock.

4 If the number of filler primitives matches the number of filler
primitives contained in the original test pattern, the DUT is likely
a tracking device that doesn’t do any re-timing. It also likely
passes all jitter that is imposed to its receiver to its transmitter
and the test may be impacted by the Error Detector’s Jitter
Tolerance.

The following is the expression used to calculate the Data Rate Ratio:

Where,

Expected Symbol Count = Pattern Count X Block Length with Filler
Symbols

• Received Symbol Count

The total number of Received Symbol Count (all incoming symbols
including incoming filler symbols) received in a time interval is
displayed here.

The following is the expression used to calculate the Received
Symbol Count:

Where,

Expected Pattern Length is without Filler Symbols

Pattern Count = Symbol Counter / Block Length without Filler
Symbols

• Auto Resync Counter
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The total number of Auto Re-Sync Count received in a time interval
is displayed here.

Comparing SATA FER counter with the Serial BERT shows that due
to errors at the receiver input, DUTs may drop a complete symbol.
In such situation, a protocol analyzer which only calculates CRC
(Cyclic Redundency Check) reports one single frame error. In
contrast to this, the Serial BERT loses pattern synchronization and
must re-synch before the test can be continued. Currently, the
detection mechanism for loss of synchronization is a high error ratio.
This causes the Serial BERT to show many errors in the
"Accumulated Results" window though there was only one single
error. The serial BERT shows with such DUTs high error number,
the number is not accurate. The Auto Resync Counter events are
shown in the Accumulated Results window and the same are logged
in file. Log settings can be changed in Error Detector's Accumulation
Setup dialog.

Accumulation Parameters for 8B/10B Comparison

For detailed information on 8B/10B Comparison accumulation
parameters, see “Accumulation Parameters” on page 376.

Eye Measurements

Eye Measurements - Concepts

The purpose of eye measurements is to measure the eye height and
width of the incoming data signal at specific alignment BER thresholds.
This information is displayed on a representation of an eye diagram.

Eye Measurements - Procedures

Eye measurements are made each time the Auto Align, Clock/Data
Center, or 0/1 Threshold Center functions are used.

To analyze the results:

1 View the graph and table in the Eye Results window.
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This window provides detailed information on the calculated eye.
See “Eye Measurements - Reference” on page 384.

2 Analyze the results by observing changes in the eye results due to
the following adjustments:

– Make changes to your device or measurement setup.

– Run auto-search functions at different BER thresholds.

This will allow you to see the eye margin at specific BERs and
construct basic eye contour information.

3 Change the sampling point in the Sampling Point Setup window. See
“Sampling Point Display” on page 189 for details.

Eye Measurements - Reference

Eye results are displayed for the Current Align and Previous Align process.
They are also graphically displayed on a representation of an eye
diagram.

Eye Width and Height

Eye width is the inside horizontal opening of the data eye in an eye
diagram. This measurement is made by the error detector after an Auto
Align or Data Center. The eye width at the current 0/1 decision threshold
is displayed on a simulated eye diagram. The left and right eye edges
are determined by the user-defined BER threshold. Different BER
thresholds will produce different eye width results.

Eye
width

Left eye
edge

Right eye
edge

Eye height is the inside vertical opening of a data eye in an eye diagram.
This measurement is made by the error detector after an auto align or
0/1 threshold center. The eye height at the current data input delay
point is displayed on a simulated eye diagram. The upper and lower eye
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edges are determined by the user-defined BER threshold. Different BER
thresholds will produce different eye height results.

Eye height

Upper eye
edge

Lower eye
edge

N O T E Most oscilloscopes measure eyes differently, using statistical data. Therefore, the
eye results of a Serial BERT and an oscilloscope may be different.

The table in the top half of the Eye Results window additionally lists the
following values:

• Eye Voltage Center

One of two components of the sampling point, the 0/1 decision
threshold (eye voltage center) is displayed here.

• Eye Data Input Delay

One of two components of the sampling point, the data input delay
is displayed here.

• Alignment Threshold

The alignment BER threshold is displayed here. This threshold was
used to define the eye edges and the above eye results.

• Delta Error Ratio

The BER measured during the previous 200 ms is displayed here.
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8 
Jitter Tolerance Tests

Jitter Tolerance Tests - Concepts

N O T E This chapter refers only to Serial BERT instruments on which the calibrated and
integrated jitter injection option J10 is installed.

A jitter tolerance measurement is used to determine the ability of a
device or system to maintain communication quality in the presence of
jitter. It comes in two varieties:

• Jitter Tolerance Characterization determines the jitter levels where
the device under test can no longer maintain a desired bit error ratio
(BER).

• Jitter Tolerance Compliance verifies that the device under test is
able to maintain a BER level at pre-defined jitter levels and jitter
frequencies, as defined by a standard.

The basic setup of a jitter tolerance test is illustrated below:
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Understanding Jitter Tolerance

The behavior and the passed/failed classification of data receiving
devices or circuits are determined by their ability to withstand

• Jitter

• Intersymbol interference

• Level noise

This refers particularly to the performance of phase-locked loops (PLLs)
or clock data recovery circuits (CDR).

Jitter tolerance can be measured by applying a distorted data signal to
the DUT and measuring the resulting bit error ratio. To make jitter
tolerance tests reproducible, the signal distortion must also be
reproducible. This requires some definitions.

Jitter

Receivers react differently on

• different types of jitter

• the jitter composition

• the jitter frequency spectrum

• the combination of jitter frequencies and data rate

Various test standards specify the jitter composition to be used for jitter
tolerance tests.

The Serial BERT provides the following means for generating artificial
(reproducible) jitter:

• Two types of voltage-controlled signal delay lines

• A phase shifter for modulating the generated clock

For more information see

• “Understanding the Types of Jitter” on page 389

• “How the N4903 Generates Jitter” on page 393

Intersymbol Interference

Conductors on PC boards have a limited bandwidth. This causes
intersymbol interference which changes the shape of the received eye
opening. The eye becomes unsymmetrical.

The Serial BERT provides the Interference Channel option J20 to
simulate ISI.
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For more information see

• “Intersymbol Interference” on page 392

Level Noise

Level noise affects the voltage amplitude of the eye opening.

The Serial BERT provides the Interference Channel option J20 to
simulate level variations by adding sinusoidal interference.

For more information see

• “Crosstalk” on page 393

PLL Performance Test

Testing a PLL (or CDR) is not complete until the entire frequency range
of the PLL has been checked under worst-case conditions.

For this purpose, the Serial BERT provides the Jitter Tolerance
Characterization measurement.

For more information see

• “Jitter Tolerance Characterization - Concepts” on page 427

PLL Standards and Compliance Tests

The Optical Internetworking Forum (OIF) as well as other institutions
have proposed standards for testing the performance of data receivers
and receiver circuits in the presence of jitter.

For this purpose, the Serial BERT provides the Jitter Tolerance
Compliance measurement. This measurement is available as an option
(option J12) which can be ordered together with the instrument or
retrofitted.

For more information see

• “Jitter Tolerance Compliance - Concepts” on page 440

Understanding the Types of Jitter

The standards for jitter tolerance tests prescribe combinations of
certain jitter types. This section gives an overview of these types.
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Random Jitter

Random jitter (RJ) is always present. Resistors, transistors, and other
components generate noise that impacts transmitters and receivers.
This kind of jitter has a Gaussian distribution over time.

Theoretically, the Gaussian distribution stretches from -∞ to +∞. In
practice, the amplitude is defined by the crest factor (p-p amplitude =
sigma × crest factor)

Bounded Uncorrelated Jitter

Similar to random jitter, bounded uncorrelated jitter (BUJ) has also a
Gaussian distribution, but this distribution is cut (bounded) at both
sides.

This kind of jitter can be caused, for example, by crosstalk on a parallel
bus or by intersymbol interference of random or long pseudo random
binary bit sequences.

To simulate bounded uncorrelated jitter for jitter tolerance tests, it can
be generated from a filtered (frequency-limited) PRBS.

Periodic Jitter

Periodic jitter (PJ) is generally picked up from other periodic sources.

Rectangular jitter may be caused, for example, by a switching power
supply. It has a distribution as shown below.
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The jitter amplitude is usually specified in UI. One UI (Unit Interval) is
always the reciprocal of the present data rate. For example, if the data
rate is set to 2 Gbit/s, one UI corresponds to 500ps.

This kind of jitter can be picked up from any adjacent signal or clock.
The jitter histogram has a U-shape.

Triangular jitter is always generated by a spread spectrum clock but can
also be caused by other periodic sources. Triangular jitter has a uniform
jitter distribution.
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Intersymbol Interference

Intersymbol interference (ISI) is caused by bandwidth limitations of
cables and backplanes. It cuts off higher frequencies and hence changes
the shape of the eye opening.

Intersymbol interference can be simulated by inserting a defined
transmission path between the pattern generator and the DUT.
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Crosstalk

Crosstalk between adjacent signal paths modulates the vertical eye
amplitude. This narrows the voltage range of the receiver needed for
capturing data correctly.

For jitter tolerance tests, amplitude modulation is most often simulated
by modulating the data output with a sinewave signal. This is called 
Sinusoidal Interference (SI).

Total Jitter

Total jitter is the sum of all kinds of jitter.

Edge, level, and shape variations impact width, height, and symmetry
of the eye opening. An example is shown below:

How the N4903 Generates Jitter

An Serial BERT on which the calibrated and integrated jitter injection
option J10 and the interference channel option J20 are installed,
combines all the necessary jitter sources in one instrument.

Jitter Tolerance Tests 8

Agilent J-BERT N4903B High-Performance Serial BERT 393



Jitter Generation Block Diagram

To support all present test standards, the pattern generator of the Serial
BERT has the following hardware architecture:

sRJ

PJ1

Clock 
Modulator

Delay Modulation 
(220ps)

Delay Modulation 
(220ps)

RJ

BUJ

ExternalExternal Delay

+

+

+

220ps Data & Aux Data on

220ps Forwarded Clock on

Clock

Trigger / Ref Clock

Data

Aux Data

Delay Modulation 
(610ps)

Clock & Data

Modulation Signal

Functional Coupling

Jitter Delay

SSC

rSSC

SJ

PJ2

Internal Clock 
Oscillator

PLL

6.75Gb/ … 12.5Gb/s

External Clock 150Mb/s … 12.5Gb/s

620Mb/s … 12.5Gb/s

Clock source selection

x÷y

1÷z

Aux Clock

÷1 or ÷2

÷n

+

The clock can be generated from the internal oscillator or an external
source.

The instrument has internal sources for spread spectrum clocking
(SSC), residual Spread Spectrum Clock (rSSC), sinusoidal jitter (SJ),
two periodic jitter sources (PJ-1 and PJ-2), bounded uncorrelated jitter
(BUJ), Random Jitter (RJ) and spectrally distributed Random Jitter
(sRJ), which is composed by using the BUJ and the RJ sources, i.e. BUJ
and RJ are mutually exclusive with sRJ. In addition, an external jitter
signal can be applied at the Delay Ctrl Input.

Note that all these sources can be individually switched on or off.

This is a special modulator that modulates the generated clock with a
low-frequency signal. The resulting jitter superimposes all other jitter
components.

Three sources are provided for modulating the clock: Spread Spectrum
(triangular), residual Spread Spectrum and sinusoidal. Residual Spread
Spectrum and sinusoidal can not be used simultaneously.

Two delay lines are provided for generating data jitter, a 610ps delay
line and a 220ps delay line. Considering the data output, they are
connected in series.

The 610ps delay line is provided for generating large jitter amplitudes
at low bit rates. It cannot be used for bit rates higher than 3.37Gbit/s.

The source for periodic jitter (PJ-1 and PJ-2) and BUJ can be connected
to the 610ps delay line or to the 220ps delay line.

All other sources can only be connected to the 220ps delay line.
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One 220ps delay line is provided for generating clock jitter. This delay
line can be used like the corresponding one in the data path.

N O T E The two 220ps delay lines in the Clock and Data path can be enabled independently,
however they share the same jitter sources. If the jitter sources are routed to the
220ps delay lines, then at least on of them has to be enabled.

N O T E The Aux Data Output always follows the data output. Any jitter that is applied on
the data path will always occur on the Data and Aux Data path.

Interference Channel

The option J20 Interference Channel is available for simulating
intersymbol interference (ISI) with or without sinusoidal interference
(SI).

This is a hardware module that can be plugged into the instrument. It
has two ports, P1/P1 and P2/P2. Both can be connected single-ended or
differentially.

The Interference Channel provides a switchable signal path with Nelco
4000-6 FR4 characteristics. This path can be connected between the
pattern generator's Data Out port and the DUT. For instructions refer
to “Connecting the J20 Option” on page 524.

The Interference Channel provides also a sinewave generator and a
resistive combiner. This makes it possible to add sinusoidal interference
(amplitude modulation) to the data signal.

The Interference Channel is built up as shown in the following figure.
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The figure above shows the connections for a single trace segment
combined with sinusoidal interference.

N O T E Note that all these relays and traces exist twice to support single-ended and
differential operation.

When intersymbol interference is switched off, there is a minimum trace
length between P1 and P2.

ISI must be enabled if sinusoidal interference shall be added to the
signal. In this case, the minimum trace is longer (refer to the technical
specifications).

Data can be input by connecting the pattern generator's Data Out port
to either P1 or P2.

If P1 is used as input, sinusoidal interference is (or can be) added after
the signal has passed the chosen trace. Seen from the DUT, this is called
"near end" injection. If P2 is used as input, sinusoidal interference is (or
can be) added at the beginning of the trace. This is called "far end"
injection.
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Jitter Setup

Jitter Setup - Concepts

The Jitter Setup function is used for composing the total jitter in a defined
and calibrated way.

This function reflects the present setup of the Serial BERT's internal
jitter generation hardware (see also “Jitter Generation Block Diagram”
on page 394).

The Jitter Setup display is divided into the following four sections:

• Jitter on/off button and delay line status area

• Jitter configuration area

• Jitter setup area

• Jitter switch area

Jitter On/Off Button and Delay Line Status Area

The Jitter On/Off button allows you to globally enable or disable the jitter
generation.

The delay lines show markers which indicate the used and the
remaining jitter amplitude in UI. Colored bars allow you to judge the
impact of each jitter component on the total jitter.

UI is the acronym for Unit Interval. One UI is the present clock period.

Sinusoidal Jitter is not generated by a delay line but by modulating the
clock. Sinusoidal Jitter and Spread Spectrum Clock cannot be used
together with residual Spread Spectrum Clock because they share the
same modulator.

N O T E The delay line display for SJ/SSC/rSSC is set accordingly with the selected
configuration.
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Jitter Configuration Area

The Jitter Configuration area allows you to select between the following
jitter configurations (the corresponding jitter sources are mutually
exclusive):

• Spread Spectrum Clock (SSC) or residual Spread Spectrum Clock
(rSSC)

N O T E That SSC and rSSC are licensed options (J11).

• Spectrally distributed Random Jitter (sRJ), or Random Jitter (RJ)
and Bounded Uncorrelated (BUJ)

Jitter Setup Area

The Jitter Setup area consists of seven colored rows that keep you
informed about the present jitter composition of:

• Sinusoidal Jitter

• Spread Spectrum Clock

• Residual Spread Spectrum Clock

• Periodic Jitter 1

• Periodic Jitter 2

• Bounded Uncorrelated Jitter

• Random Jitter

• Spectrally Distributed Random Jitter

• External Jitter Source (Connected to the Delay Ctrl input)

It depends on the jitter configuration which seven out of these nine jitter
sources are displayed.
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Each jitter type can be separately turned on or off by clicking the LED
button on the left side. The corresponding jitter source is enabled if the
LED is on.

The Jitter Setup area allows you to directly change the most commonly
used parameters. The Advanced Edit Panel allows you to change all jitter
parameters available for the corresponding jitter source. It is opened
by pressing the Edit button.

Jitter Distribution Area

The Jitter Distribution area allows to:

• Define whether the corresponding jitter source is applied to the data
and/or the clock output.

N O T E It is not possible to disconnect the jitter sources from both outputs. However, it can
be done by disabling the corresponding jitter sources.

• Specify which delay line (220ps or 610ps) is used for the generation
of PJ and BUJ.
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N O T E If the 610ps delay line is selected and has any jitter source connected to it, then, it
is not possible to disable SJ/SSC/rSSC on the data output.

• Specify the delay between 220ps jitter on Clock and Data.

Jitter Setup - Procedures

Do the following to compose the desired jitter:

1 Click Jitter Setup from the Jitter submenu.

This opens the Jitter Setup window.

2 Enable jitter generation by pressing Jitter On/Off button. When this
button is enabled, the LED on the button turns green indicating the
jitter active state.

When this button is disabled, no jitter is generated. This refers to all
the jitter types shown on the screen, even if they seem to be
connected. The LED on the buttons will turn orange to indicate this.

N O T E The Jitter On/Off button has no impact on SSC. If spread spectrum clocking is
enabled, it continues, even if the Jitter On/Off button is off.

Set Jitter Configuration

Use Jitter Configuration area to specify whether you want to use:
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• SSC or rSSC

• RJ and BUJ or sRJ

Set Jitter Distribution

1 Specify whether the corresponding jitter source is applied to the data
and/or the clock output by clicking the corresponding LED button.

2 Specify the delay line (220ps or 610ps) used for the generation of PJ
and BUJ.

3 Define the delay between 220ps delay line jitter on Clock and Data.

N O T E The delay has to be defined in steps of 100ps. The given value will automatically
round to the next valid value.

Select the Delay Line

To select the delay line for (sinusoidal) periodic jitter 1 and 2 and BUJ,
press 610ps button. The LED will turn green if the 610ps delay line is
selected.
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Note that sRJ can not be enabled if the 610ps delay line is selected.

N O T E The 610ps delay line cannot be used for bit rates above 3.37 GHz.

Specify the Jitter Components

In this section, an example of periodic jitter 1 is shown to specify the
jitter components.

To specify the jitter components:

1 Activate a jitter source (press the corresponding button).

2 Set the most commonly used parameter (typically Amplitude and
Frequency) directly.

3 Press Edit button to access all parameters of the corresponding jitter
type.

This opens a window which allows you to set all parameters available
for the given jitter type.
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A parameter that must be set for any jitter type is Amplitude. This
defines the timely width of the jitter component.

4 Observe the consumption of delay line capacity indicated by the
delay line markers. Ensure that the total jitter remains within the
margins of the chosen delay line.

5 Return to the overview display by pressing either the Close button,
the Edit button of this jitter source or the Edit button of the next jitter
source you want to change

6 Proceed with the next jitter type you wish to add.

N O T E When you activate an External jitter source you will find that this apparently
consumes the whole free capacity of the delay line (at the right-hand side of the red
bar).

But this is just an indication. You can still add or change internal jitter components.
The external jitter range is automatically updated when you add, change, or switch
off one of the internal sources.

Specify the Jitter Components for PJ Sweep

This section shows you how to specify the Jitter components for PJ
Sweep.

N O T E You will not see the parameter (Amplitude and Frequency) in case the PJ Sweep is
already on.
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To specify the jitter components:

1 Activate a jitter source (press the corresponding button).

2 Press Edit button to access all parameters of the corresponding jitter
type.

If you want to specify the jitter components for Constant Amplitude
Sweep, skip steps 5 to 6.

However, if you want to specify the jitter components for Variable
Amplitude Sweep, skip steps 3 to 4 and go to step 5.

3 Activate Constant Amplitude Sweep (press Constant Amplitude
Sweep button).

This opens a window which allows you to set all parameters available
for the given jitter type.

4 Specify the following parameters:

– Amplitude

– Frequency Range

– Sweep Time

– Nr. of Steps

For more information on parameters, see “Periodic Jitter 2 –
Constant Amplitude Sweep Parameters” on page 417.
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5 Activate Variable Amplitude Sweep (press Variable Amplitude Sweep
button).

This opens a window which allows you to set all parameters available
for the given jitter type.

6 Specify the following parameters:

– Standard

– Sweep Time

– Nr. of Steps

– Step Distance

For more information on parameters, see “Periodic Jitter 2 –
Variable Amplitude Sweep Parameters” on page 418.

7 Observe the consumption of delay line capacity indicated by the
delay line markers. Ensure that the total jitter remains within the
margins of the chosen delay line.

8 Return to the overview display by pressing either the Close button,
the Edit button of this jitter source or the Edit button of the next jitter
source you want to change

9 Proceed with the next jitter type you wish to add.
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N O T E When you activate an External jitter source you will find that this apparently
consumes the whole free capacity of the delay line (at the right-hand side of the red
bar).

But this is just an indication. You can still add or change internal jitter components.
The external jitter range is automatically updated when you add, change, or switch
off one of the internal sources.

Jitter Setup - Reference

The Jitter Setup function is used for composing the total jitter in a defined
and calibrated way.

Jitter Enable

The Jitter On/Off button is used enable or disable jitter generation.

When this button is disabled, no jitter is generated. This refers to the
whole composition shown on the screen. When this button is enabled,
the present status becomes active.

N O T E The Jitter On/Off button has no impact on SSC. If spread spectrum clocking is
enabled, it continues, even if the Jitter On/Off button is off.

Jitter Configuration

Use these radio buttons to select:

• SSC or rSSC

• RJ and BUJ or sRJ
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Jitter Distribution

Use these switches to define whether the jitter shall be applied to clock
and/or data.

Defining Jitter Delay on Clock and Data

Use this entry to define the delay between 220ps jitter on clock and data.

Delay Line Switch

This switch can be pressed to switch the source of periodic jitter (1 and
2) and BUJ to either the 610ps or the 220ps delay line.
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N O T E The 610ps delay line cannot be used for data rates above 3.37 GHz.

Delay Line Display

The delay line display shows red markers that indicate the consumption
of delay line capacity by the present jitter setup.

Colored bars indicate the consumption by the various jitter
components.

The consumption is shown in UI (Unit Intervals) and is calculated from
the present data rate. Because the delay lines have a fixed time capacity,
the scales change when the bit rate is changed.

N O T E • The total consumption of the delay line in UI is indicated on top of the delay line
display.

• The delay line display for SSC/SJ shows the usage of the modulator in percent.

Jitter Setup Area

The Jitter Setup area shows the present jitter composition.
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To become active, jitter sources must be switched on (by enabling the
corresponding button) and must at least have an Amplitude greater than
zero.

The Jitter Setup area allows you to enable a jitter source, to change its
most commonly used jitter parameters directly or to go into advanced
edit mode by pressing the corresponding Edit button.

Spread Spectrum Clock

The Spread Spectrum Clocking setting controls the pattern generator's
spread spectrum (SSC) clocking feature. When the SSC is enabled, it
impacts the Data Out, Clock Out, Aux Data Out, and Trigger/Ref Clock
Out ports.

The spread spectrum clock is characterized by:

• Deviation

• Frequency

• Type

• Profile

If the deviation type centerspread is selected, the deviation can be
changed in two different ways:
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• Change the ‘centerspread’value: the bitrate remains unchanged,
while the upper and lower frequency changes according to the
selected deviation. The deviation value specifies ½ p-p value.

• Change the ‘downspread’ value: the upper frequency remains
unchanged, while the bitrate is adjusted. The deviation value
specifies the p-p value.

For some setups, the I/Q modulator’s range limitations require to use
centerspread instead of downspread and adjust the bitrate (and
deviation) accordingly. To ease the handling of this setup, the SSC
Advanced Edit Panel allows to edit the upper, center, and lower frequency.

If the upper or lower frequency is change, the bitrate will be adjusted
according to the selected deviation. The center frequency corresponds
to the configured bitrate.

The adjust buttons allow to adjust the corresponding frequency by the
specified ppm-value.

Please note that both the upper and lower frequency and the frequency
adjustment of all three frequencies are not reflected in the firmware.
The GUI just calculates the resulting bitrate and writes it to the
firmware.

The Deviation of the clock rate. The range of SSC deviation are as
following:

• Downspread with deviation of 0% … 0.5 %

• Centerspread with deviation of 0% … ± 0.5 %

• Upspread with deviation of 0% … 0.5 %
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N O T E The deviation in Upspread and Downspread is the p-p value while in Centerspread
it is 1/2p-p.

The deviation Frequency. The SCC provides the frequency range of 10
kHz – 100 kHz.

You can click on the corrosponding button to choose among
Downspread, Centerspread and Upspread deviation type. The green
LED on the button indicates the currently selected deviation type.

The selected deviation type is also indicated in the jitter composition
shown in the Jiter Setup  area. The following are the deviation type
indications:

• Downsperad:

• Centerspread:

• Upspread:

• Arbitary:

You can click on the corrosponding button to choose between the
Triangular and Arbitrary profile. The green LED on the button indicates
the currently selected profile.
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For Arbitary profile, you need to specify the Arbitary Waveform file. To
do so, click on the Browse button and select the file from the shown list.

Residual Spread Spectrum Clock

The Residual Spread Spectrum Clock (rSSC) is generated by modulating
the clock that is used for data generation. It can therefore not be enabled
if SJ or SSC is active.

Residual Spread Spectrum Clock is characterized by:

• Amplitude (peak-to-peak)

• Frequency

There is a dependency between frequency and acceptable amplitude. A
graph indicates whether the chosen setting of frequency and amplitude
is acceptable.
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The maximum peak-to-peak Amplitude is limited by the chosen
frequency.

The maximum Frequency of the rSSC jitter source depends on the
amplitude.

Sinusoidal Jitter Parameters

Sinusoidal jitter (SJ) is independent from periodic jitter. It is generated
by modulating the clock that is used for data generation. It can therefore
not be enabled, if SSC or rSSC is active.

Sinusoidal jitter is characterized by

• Amplitude (peak-to-peak)

• Frequency

There is a dependency between frequency and acceptable amplitude. A
graph indicates whether the chosen setting of frequency and amplitude
is acceptable.
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The maximum peak-to-peak Amplitude is limited by the chosen jitter
frequency.

Note that high-frequency sinusoidal data jitter can be generated by the
Periodic Jitter function or by applying an External jitter source.

Periodic Jitter 1 Parameters

The Periodic Jitter is characterized by:

• Amplitude

• Frequency

• Waveform

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.
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The maximum peak-to-peak Amplitude is limited by the free capacity of
the chosen delay line.

The maximum Frequency of the periodic jitter source depends on the
chosen waveform. Refer to the technical specifications.

You can switch between sine, rectangular, or triangular jitter source
waveforms.

Periodic Jitter 2 Parameters

The Periodic Jitter 2 has the following modes:

• Periodic Jitter 2 – Constant Jitter

• Periodic Jitter 2 – Constant Amplitude Sweep

• Periodic Jitter 2 – Variable Amplitude Sweep

You can click on the corrosponding button to choose among the
different modes of Periodic Jitter 2. The green LED on the button
indicates the currently selected mode of Periodic Jitter 2.

The ability of sweeping the PJ settings supports testing DUTs according
to the PCIe 2.0 and PCIe 3.0 standard without the need of providing a
jitter modulation signal externally.
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Periodic Jitter 2 – Constant Jitter Parameters

The Periodic Jitter 2 – Constant Jitter is characterized by:

• Amplitude

• Frequency

• Waveform

N O T E You will not see the parameter (Amplitude and Frequency) in case the PJ Sweep is
enabled.

N O T E The setting for the jitter Amplitude is shared with the Constant Amplitude Sweep
mode.

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.

The maximum peak-to-peak Amplitude is limited by the free capacity of
the chosen delay line.

The maximum Frequency of the periodic jitter source depends on the
chosen waveform. Refer to the technical specifications.

You can switch between sine, rectangular, or triangular jitter source
waveforms.
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Periodic Jitter 2 – Constant Amplitude Sweep Parameters

The Periodic Jitter 2 – Constant Amplitude Sweep is characterized by:

• Amplitude

• Frequency Range

• Waveform

• Sweep Time

• Nr. of Steps

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.

The maximum peak-to-peak Amplitude is limited by the free capacity of
the chosen delay line.

The stop frequency has to be higher than start frequency and the range
should be in accordance with the selected waveform.

You can switch between sine, rectangular, or triangular jitter source
waveforms.

You can specify the duration for sweeping the specified frequency range
once.
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You can specify the number of steps to fulfill a complete sweep. The
start and stop values are included. The valid range is between 2 to 100.

N O T E The setting for the jitter Amplitude is shared with the Constant Jitter mode.

Periodic Jitter 2 – Variable Amplitude Sweep Parameters

The Periodic Jitter 2 – Variable Amplitude Sweep is characterized by:

• Standard

• Waveform

• Sweep Time

• Nr. of Steps

• Step Distance

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.

You can use this drop-down list to specify whether you want to select a
pre-defined standard or a user-defined standard. All the available pre-
defined standards will be shown in this list. However, if you select the
user-defined standard, press Load button to locate the Jitter Tolerance
standard. The user-defined standard uses the same file format like the
Jitter Tolerance Compliance measurement. See “Jitter Tolerance
Compliance - Concepts” on page 440.
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N O T E Selecting the Standard does allocate the required amount of jitter modulation on
the delay line being used. To avoid errors when changing the selection, it is
recomended to either select the corresponding bit rate first, or enable the PJ2 source
after setting the correct bit rate.

You can switch between sine, rectangular, or triangular jitter source
waveforms.

You can specify the duration for sweeping the selected jitter profile/
standard once.

You can specify the number of steps to fulfill a complete sweep. The
start and stop values are included. The valid range is between 2 to 100.

You can use this drop-down list to specify whether the frequency steps
are log equidistant (EQUidistant) along the periodic jitter curve or a
frequency step matches a corner frequency on the periodic jitter curve.

Bounded Uncorrelated Jitter Parameters

Bounded uncorrelated jitter is characterized by

• Data rate

• Amplitude

• PRBS polynomial

• Low pass filter

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.
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You can specify your own setup or choose one of the predefined settings.

You can choose one of four predefined settings:

• CUSTom: The individual parameter values apply.

• CEI6G: Meant for CEI 6 Gbit/s tests: PRBS data rate is 1.1 Gbit/s, the
PRBS polynomial is 29-1, the low-pass filter is 100 MHz.

• CEI11G: Meant for CEI 11 Gbit/s tests: PRBS data rate is 2 Gbit/s,
the PRBS polynomial is 211-1, the low-pass filter is 200 MHz.

• Gaussian: Preset values for Gaussian distribution: PRBS data rate is
2 Gbit/s, the PRBS polynomial is 231-1, the low-pass filter is 100 MHz.

Enter an appropriate Data Rate. Refer to the technical specifications.

The maximum peak-to-peak Amplitude is limited by the free capacity of
the 20 ps delay line.

The PRBS polynomial can be chosen from a list. Available are eight
polynomials, from 27-1 up to 231-1.

The bounded uncorrelated jitter source is equipped with three low-pass
filters with cut-off frequencies at 50, 100, and 200 MHz. One of these
filters is always active.

Random Jitter Parameters

Random Jitter is characterized by:
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• Amplitude

• Filter Settings

The graph shows the possible and the current jitter spectrum, which is
defined by filter settings.

The random jitter Amplitude must be entered as an rms (root mean
square) value. The rms value corresponds to the sigma factor σ of the
bell-shaped Gauss distribution curve (see also “The Gaussian Marker”
on page 225).

To modify the value, click inside the text field and enter the desired
value directly with the numeric keyboard, or use the knob close to the
numeric keyboard to fine-tune the value.

The peak-to-peak amplitude is calculated by multiplying the rms value
with the crest factor (which is currently fixed to 14). The

Amplitude p-p box shows how much of delay line capacity the setting
consumes.

The random jitter source is equipped with a 10 MHz high pass and a
100 MHz and 500 MHz low pass filter to limit the spectral range. All
these filters can be disabled or enabled by pressing the respective
buttons.
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Spectrally Distributed Random Jitter

Spectrally distributed random jitter is composed of two jitter sources:
low frequency jitter and high frequency jitter. It is characterized by the
amplitudes of the low and the high frequency jitter.

Spectral random jitter is characterized by

• Amplitude LF

• Amplitude HF

The filter settings graph shows the actual and the possible jitter
spectrum. In addition the total sRJ amplitude as rms value is displayed
in UI and in ps. It is calculated using following formula:
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This is the low frequency jitter amplitude as rms value

This is the high frequency jitter amplitude as rms value

The Spectrally Distributed Random Jitter is equipped with a 100MHz
Low Pass filter to limit the spectral range, which can be enabled by
pressing the corresponding button.

External Jitter Source Parameters

When you enable the External Jitter the Jitter Setup function reserves the
remaining free capacity of the 220ps delay line for the signal applied to
the Delay Ctrl Input.

The parameter window informs you about

• Amplitude (max)

• Voltage (max)

• Slope

N O T E Even if the External jitter source is enabled, you can still add or change internal
jitter components. The range of the external jitter source is automatically updated
when you add, change, or turn off one of the internal sources.
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This is the maximum jitter Amplitude that can be generated.

This is the maximum voltage that can be accepted. It would generate the
maximum jitter amplitude. Before connecting an external jitter signal,
always ensure that this signal does not exceed the maximum voltage.

N O T E The Delay Control Input has an overvoltage protection. For details see “Delay Control
Input - Concepts” on page 142.

The Slope indicates the present relation between the voltage applied and
the resulting delay.

Interference Channel Setup

Interference Channel Setup - Concepts

The optional Interference Channel module can be plugged into the
instrument. For an introduction please refer to “Interference Channel”
on page 395.

This module is to be connected between the pattern generator's Data
Out port and the DUT. For installation instructions refer to “Installing
Hardware Options - Procedures” on page 523.

The Interference Channel simulates intersymbol interference (ISI). It
has backplane traces that conform to the Nelco 4000-6 FR4
specification.

The trace length can be set. According to the chosen length, the module
generates a reproducible amount of intersymbol interference.

The Interference Channel provides also a sinewave generator and a
modulator. If sinusoidal interference (amplitude modulation) is
enabled, a minimum trace length is used.

Data can be input at P1 or P2 by connecting the pattern generator's Data
Out to P1 or P2, respectively.

The output is meant to be connected to the input of the DUT.

8 Jitter Tolerance Tests

424 Agilent J-BERT N4903B High-Performance Serial BERT

Amplitude

Voltage

Slope



C A U T I O N The module has golden 2.4 mm connectors. Be sure to use the specific cables or
adapters. Improper connection can damage the module.

Interference Channel Setup - Procedures

To set up the Interference Channel module, click Interference Channel
from the  Jitter submenu.

To use the Interference Channel module:

1 Click the checkbox that enables the module.

2 Select a trace (refer to the technical specifications for details)

3 If desired, enable sinusoidal interference.

If you have enabled sinusoidal interference, enter appropriate values
for Frequency, Amplitude, and Mode.

Interference Channel Setup - Reference

The Interference Channel module must be enabled before it can be used.
This is done by clicking the corresponding button.
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When the Interference Channel is disabled, it establishes an almost
direct connection between P1 and P2. For details about the minimum
trace length refer to the technical specifications.

Trace Number

To specify the degree of intersymbol interference, select a suitable trace
length.

The user interface provides numbers from 1 to 9. The greater the
number, the longer is the trace.

Sinusoidal Interference

To enable the addition of sinusoidal interference, press the
corresponding button.

Set the parameters to desired values:

The peak-to-peak amplitude of sinusoidal interference must not exceed
a certain level (see the technical specifications).

The frequency range of sinusoidal interference is limited (see the
technical specifications).

One of four modes can be chosen for sinusoidal interference:

• Common: Requires that a differential data signal is generated and
connected to P1/P1 or P2/P2 of the Interference Channel.

In common mode, both components of the differential data signal
are amplitude-modulated with the same sinewave. This adds
common mode noise.

• Differential: Requires that a differential data signal is generated and
connected to P1/P1 or P2/P2 of the Interference Channel.

In differential mode, both components of the differential data signal
are amplitude-modulated, one with the normal sinewave, the other
with the inverted sinewave. This adds differential noise.

• Single-ended normal: Modulates the data signal that is connected to P1
or P2 of the Interference Channel.

• Single-ended complement: Modulates the data signal that is connected
to P1 or P2 of the Interference Channel.
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Jitter Tolerance Characterization

Jitter Tolerance Characterization - Concepts

During a jitter tolerance characterization test, jitter is applied
sequentially at a number of frequency points in the frequency range of
interest.

The receiver checks for the onset of transmission errors and
increments/decrements the jitter amplitude using a control algorithm,
re-testing for errors at one frequency point until the target BER
threshold is found. This is repeated for each subsequent jitter frequency
step to provide a plot of the DUT tolerance.

Green points (BER below limit) and red crosses (BER above limit) are
used to display the results.

After a measurement has exceeded the target BER or when moving to
the next frequency point, a measurement settling or relax time can be
applied. This allows the DUT to settle after changes and before the next
measurement; this is important because some devices may need time to
recover from error conditions caused by jitter exceeding the margin
during the search for the threshold.

The maximum jitter amplitude the Serial BERT can generate is also
frequency dependent, as illustrated below.
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Sinusoidal jitter (SJ) and periodic jitter (PJ) with sinusoidal
characteristic are used for the test. Whether SJ or PJ is used depends
on the jitter frequency. SJ supports wide amplitude variations up to
some MHz. PJ supports narrow amplitude variations over a wide
frequency range. The measurement switches automatically between the
two sources.

When the measurement has finished, the jitter composition shown in
the Jitter Setup window is restored.

Target BER

The target bit error ratio must be specified.

The condition for moving from one jitter amplitude step to the next can
be set to

• numbers of received bits and errors

• a confidence level

Additionally, a relax time can be specified.

Number of received bits or errors

When numbers of received bits or errors are enabled, the measurement
proceeds with the next amplitude as soon as one of the two numbers is
reached.

But we are often dealing with very small tolerable bit error ratios,
10-12 and below. Measuring such a bit error ratio precisely (and just for
one single point) takes time.
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Confidence level

The Jitter Tolerance Characterization measurement offers therefore the
option to set a level of confidence. This approach is based on statistics.

Statistics tell us, for example, that if we receive 3 × 1012 bits without any
error, the probability that the BER is below 10-12 is higher than 95 %. If
an error occurred, more bits must be compared to achieve the same
confidence level. For details see “Explanation of the Fast Total Jitter
Measurement” on page 234.

The measurement proceeds with the next amplitude as soon as the
desired level of confidence is reached. Setting a confidence level ensures
that neither too few nor too many bits are captured.

Relax time

If the measured BER is higher than the target bit error ratio, the device
under test may have lost synchronization. For devices that need some
time to recover from the situation, a relax time can be specified. This
time takes effect each time the BER limit has been exceeded. The next
BER measurement starts after this time has elapsed.

Vertical Search Methods

You can specify that the jitter amplitude changes in linear steps from
maximum to minimum or vice versa. The step size is adjustable.

You can also specify that the jitter amplitude changes in logarithmic
steps from maximum to minimum or vice versa. Minimum and ratio are
adjustable.

Alternatively, you can also specify one of two dynamic (binary) search
methods.

Searching Down/Up

Both search directions, upwards and downwards, are supported. This
helps to find out whether the device exhibits some degree of hysteresis.
The BER measured at a specific jitter amplitude may be different if this
amplitude is approached downwards or upwards.

When you search in downward direction (from maximum to minimum),
the test for one frequency stops as soon as the measured BER falls below
the target bit error ratio.

The following figure shows an example of a logarithmic search
downwards.
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The maximum amplitude (indicated by the dotted blue line) is given by
the capability of the instrument.

Searching downwards is usually faster than searching upwards,
because the measurement of a single point is finished as soon as the
BER is found to be above the limit.

When you search in upward direction (from minimum to maximum),
the test for one frequency stops as soon as the measured BER exceeds
the target bit error ratio.

Dynamic Search

If you perform the measurement over a wider frequency range, you
measure many useless points with the downwards/upwards methods.
To construct the tolerance curve, we actually need only the two points
between which the measured result turns from green to red.

To reduce the measurement time without sacrificing precision, the
Jitter Tolerance Characterization measurement offers two additional
search methods:

When binary search is enabled, the measurement starts with the
maximum jitter amplitude (100 %).

If the result is red (measured BER higher than target BER), the search
goes downwards. The next amplitude is set to 50 %.
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If the new result is still red, the next amplitude is set to 25 %. But if the
new result is green, the search goes upwards, and the next amplitude is
set to 75 %.

Depending on the result, the search algorithm changes the direction and
continually halves the step size.

This continues until the specified accuracy (the final step size) is
reached.

Binary is the fastest search method. It approaches the amplitude of
interest from both sides. However, binary search can lead to incorrect
results if the device to be tested shows hysteresis.

This algorithm combines binary with linear downward search.

Extended binary search starts like the binary search. Depending on the
result, the search algorithm changes the direction and continually
halves the step size.

This continues until the specified coarse step size is reached. Then, the
coarse step size is maintained until a transition from green to red is
found. After that has happened, the algorithm changes the direction and
uses fine linear downward steps of specified size to localize the
transition precisely.

Extended binary search takes more time than binary search but leads
to reproducible results for devices with hysteresis.

Jitter Tolerance Characterization - Procedures

To access the Jitter Tolerance Characterization measurement, press the
corresponding menu item from the Jitter submenu.

To set up a Jitter Tolerance Characterization test, press the Properties
button.

This opens the Jitter Tolerance Properties dialog.

Setting the Frequency Range

Choose Auto or Manual mode.
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In Auto mode, the jitter frequencies are automatically calculated:

1 Enter the Start Frequency.

2 Enter the Stop Frequency.

Start and stop frequency define the measurement's frequency range.

3 Set the Number of Steps between start and stop.

The Number of Steps yields a set of logarithmically equidistant
frequencies.

In Manual mode, the automatically calculated jitter frequencies can be
edited. You can also enter your own comma-separated list of
frequencies.

The Sequence Advance checkbox advances the PG sequence during jitter
tolerance characterization. It will be enabled only if the sequence is send
to the PG.

The Show Compliance Curve checkbox enables the compliance curve on
the Jitter Tolerance Characterization graph. This feature is available
only if the compliance jitter measurement option is installed. The
standard is taken from the compliance measurement.
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Setting the BER Limit

1 Set the Target Bit Error Ratio.

This defines whether a measured point is flagged green or red.

2 Choose the Verification Method.

Setting a Confidence Level is generally recommended. See also “Target
BER” on page 428.

If you enable Absolute Bits/Errors, the measurement proceeds with the
next amplitude as soon as one of the two numbers is reached.

3 If desired, set a Relax Time.

For details see “Relax time” on page 429.

Setting the Search Mode

1 Choose one of six search modes:

– Downwards linear

– Downwards logarithmic

– Upwards linear

– Upwards logarithmic

– Binary search
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– Extended binary

For details refer to “Vertical Search Methods” on page 429.

2 If desired, change the related parameters.

3 Check the Minimum Jitter Curve and Maximum Jitter Curve checkboxs.

For details see “Minimum and Maximum Jitter Curve” on page 440.

4 Press the respective Load... buttons to load your own defined
minimum and maximum jitter curve, stored in a text file.

This opens a dialog box which allows you to load a file. By default,
the browser searches for files with the suffix .jcs, but you can load
any file.

N O T E The required file format is described in detail in “User-Defined Standards” on page
445.

5 Check the Show Jitter Curve checkbox. It shows the jitter curve on the
Jitter Tolerance Characterization graph.

Before Running the Test

For DUTs that require a training sequence it is essential to prevent clock
loss at the beginning or end of the test. To avoid clock loss, the sinusoidal
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jitter component has to be enabled. Since the sinusoidal jitter for the
test is generated internally, the jitter amplitude must be set to zero:

1 Click the Jitter Setup menu item from the Jitter submenu.

This opens the Jitter Setup window.

2 Enable jitter generation. Press the respective checkbox.

3 Activate Sinusoidal jitter.

4 Activate Periodic jitter

5 Set the jitter amplitude to 0 UI for both Sinusoidal jitter and Periodic
jitter.

Running the Test

Once you have specified the Frequency, BER, and Search criteria, press
the Start button to run the test.

The bar in the lower right-hand corner of the screen shows the progress.

You can also abort the test at any time by pressing the Abort button.

Once the measurement has finished, the jitter composition shown in the
Jitter Setup window is restored.

When the measurement is either completed or aborted, you can obtain
a list of measured points by clicking the following tab which appears
once the measurement is stopped.

Clicking on the above tab you get the list of measured points.
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Selecting a point, and clicking on 'Set', updates the Jitter Setup page
with the jitter setting of that point.

Generate HTML Report

The measurement results can be saved as HTML file. To generate the
HTML report:

1 Click Jitter menu from list of menu option provided on the drop down
menu. The following submenu will appear.

2 Select 'Generate HTML report'.
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3 Select the folder where you want to save the report, name the file,
and save it.

Jitter Tolerance Characterization - Reference

Jitter tolerance characterization determines the actual jitter levels
where the device under test can no longer maintain a desired BER.

Frequency Specification

You can choose Auto or Manual mode.

In Auto mode, the jitter frequency is automatically swept from Start
Frequency to Stop Frequency.

• Start Frequency: This is the minimum and first jitter frequency to be
generated. It determines the left-hand border of the graphical result
display.

• Stop Frequency: This is the maximum and last jitter frequency to be
generated. It determines the right-hand border of the graphical
result display.

The measurement always includes the start and stop frequencies.
The frequency scale is logarithmic.

• Number of Steps: The Number of Steps between start and stop defines
the test frequencies.

To determine the individual test frequencies, an algorithm divides
the horizontal logarithmic scale into a set of logarithmically
equidistant frequencies.

In Manual mode, you can edit the automatically calculated frequencies.
You can also enter your own list of frequencies, with a minimum of two
frequencies specified. For example, you can jump between low and high
jitter frequencies.

Enter the frequencies in Hz, separated by commas, for example:

2e4, 1.75e6, 6.334e5, ...

Enabling this compliance curve helps in ensuring that the device under
test complies with a certain standard. This feature is available only if
the compliance jitter measurement option is installed. The standard is
taken from the compliance measurement.
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BER Specification

The Target Bit Error Ratio defines the required BER. The jitter tolerance
curve is constructed from the points where the measured BER crosses
the Target Bit Error Ratio.

The Verification Method defines under which circumstances the
measurement proceeds from one jitter amplitude to the next. You can
choose between two Verification Methods:

Setting a Confidence Level is generally recommended. This ensures that
neither too few nor too many bits are captured. See also “Target BER”
on page 428.

If you enable Absolute Bits/Errors, the measurement proceeds to the next
jitter amplitude as soon as either the number of received bits or the
number of errors is reached.

N O T E Ensure that you capture a number of bits that suffices to verify (with the desired
probability) that a measured point has a BER below the Target Bit Error Ratio.

This is the wait time that takes effect after the measured BER is higher
than the target BER. It allows the DUT to recover from the situation.
The unit is seconds. The next measurement starts after that time.

Search Specification

On this page of the Jitter Tolerance Properties dialog, you specify how the
measurement proceeds upwards or downwards from one measured
point to the next. The chosen method impacts the measurement
duration. The specified parameters influence both measurement
duration and precision.

You can choose one of six search methods:

• Downwards linear

• Downwards logarithmic

• Upwards linear

• Upwards logarithmic

• Binary search

• Extended binary
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For a description of these methods refer to “Vertical Search Methods”
on page 429.

For linear search, you can set the step size.

• Downwards linear starts from the maximum (which depends on the
jitter frequency). A step size of 100 mUI, for example, may result in
a sequence of 1000 UI, 999.9 UI, 999.8 UI, and so on.

The test for one frequency stops when the BER limit is met or zero
amplitude is reached.

• Upwards linear starts from the minimum. A step size of 100 mUI, for
example, will result in a sequence of 0.1 UI, 0.2 UI, 0.3 UI, and so on.

The test for one frequency stops when the BER limit is exceeded or
the maximum amplitude is reached.

For logarithmic search, you can set the minimum amplitude and the
ratio. The ratio is the factor by which the present amplitude value is
multiplied to calculate the next amplitude.

• Downwards logarithmic starts from the maximum (which depends on
the jitter frequency). A ratio of 0.666, for example, may result in a
sequence of 1000 UI, 666 UI, 444 UI, and so on.

The test for one frequency stops when the BER limit is met or the
specified minimum amplitude is reached.

• Upwards logarithmic starts from the specified minimum amplitude. A
ratio of 1.5, for example, may result in a sequence of 0.1 UI, 0.15 UI,
0.225 UI, 0.3375 UI, and so on.

The test for one frequency stops when the BER limit is crossed or
the maximum amplitude (which depends on the jitter frequency) is
reached.

For binary search, you can set the accuracy.

This defines the minimum jitter amplitude step size. The test for one
frequency stops when this step size is reached.

For a description of this method refer to “Binary search” on page 430.

For extended binary search, you can set the coarse and fine accuracy.
The test for one frequency stops when the BER limit is crossed with fine
accuracy amplitude steps.

For a description of this method refer to “Extended binary search” on
page 431.
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The minimum and maximum jitter curves have been introduced to
speed up the jitter tolerance characterization measurement by
specifying lower and upper boundaries for the search. This reduces the
number of measurements needed. Instead of starting and stopping the
measurement at a fixed jitter level for all the frequencies, it is possible
to specify minimum and maximum jitter curves at which the
measurement starts and stops depending on the search algorithm. This
avoids measuring points where the DUT is known to operate. If for a
particular frequency the starting point fails, then the search algorithm
reverts to the minimum jitter level to start the search for that frequency.
The next frequency step will start based on the minimum curve again.
This gives a complete picture of the jitter tolerance even if the start
values are not carefully selected.

The format used to specify the minimum and maximum jitter curves are
same as that of existing jitter compliance file. See “User-Defined
Standards” on page 445.

For details see “Optimal Measurement Setup” on page 460

For details see “Select Point” on page 460

For details see “HTML Report” on page 460

Jitter Tolerance Compliance

Jitter Tolerance Compliance - Concepts

The Jitter Tolerance Compliance test is used to ensure that the jitter
tolerance of the device under test complies with a certain standard.

N O T E The Jitter Tolerance Compliance measurement is a software option that requires a
license. For details on how to obtain and install such licenses refer to “Obtaining a
License” on page 521.
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Measurement Principle

The Optical Internetworking Forum (OIF) and other institutions have
proposed and published standards for testing the performance of data
receivers and receiver circuits in the presence of jitter.

These standards prescribe the required jitter tolerance over jitter
frequency. The jitter tolerance for each frequency point is defined by a
jitter amplitude (normalized to the bit rate and hence specified in Unit
Intervals – UI) and a BER threshold which must not be exceeded.

A simple example is shown in the figure below:

Some standards are more detailed, as illustrated in the following figure:

During a jitter tolerance compliance test, jitter with the specified jitter
amplitude is sequentially applied at a number of frequency points in the
frequency range of interest.

The receiver checks for transmission errors and measures the bit error
rate.
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The graphical display shows the results.

A green circle indicates that the BER at this point did not exceed the
target BER. A red cross indicates that the BER at this point exceeded
the target BER. If this happens, the test is marked as “failed”.

A table below the graph provides details about the measurement
conditions like date/time, data pattern, bit rate, and added jitter
components.

The measurement results for each point can also be exported as a
numerical list in text format.

The maximum jitter amplitude the Serial BERT can generate is also
frequency dependent, as illustrated below.
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The standards demand and the measurement generates jitter with
sinusoidal distribution.

In terms of the Serial BERT, sinusoidal jitter (SJ) and periodic jitter (PJ)
with sinusoidal characteristic are used for the test (see also “How the
N4903 Generates Jitter” on page 393).

Whether SJ or PJ is used depends on the jitter frequency. SJ supports
wide amplitude variations up to some MHz. PJ supports narrow
amplitude variations over a wide frequency range. The measurement
switches automatically between the two sources.

The measurement cannot be executed if jitter generation is totally
disabled. SJ and PJ may be enabled or disabled.

N O T E SJ and SSC are mutually exclusive to rSSC, so you can have SJ and SSC both on,
but rSSC only, if neither SSC nor SJ are on. If you run a Jitter Tolerance Measurement
while rSSC is active, PJ will be used to perform the measurement.

If desired, you can add additional jitter of random, external, periodic 2
or bounded uncorrelated origin to the automatically generated jitter.

When the measurement has finished, the jitter composition shown in
the Jitter Setup window is restored.

Target BER

The target bit error ratio must be specified.

The condition for moving from one jitter amplitude step to the next can
be set to

• numbers of received bits and errors

• a confidence level

Additionally, a relax time can be specified.

Number of Received Bits or Errors

When numbers of received bits or errors are enabled, the measurement
proceeds with the next frequency as soon as one of the two numbers is
reached.

But we are often dealing with very small tolerable bit error ratios, 10–

12 and below. Measuring such a bit error ratio precisely (and just for one
single point) takes time. Therefore, the measurement provides the
option to set a confidence level.
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Confidence Level

The Jitter Tolerance Compliance measurement offers the option to set
a level of confidence. This approach is based on statistics.

Statistics tell us, for example, that if we receive 3 × 1012 bits without any
error, the probability that the BER is below 10–12 is higher than 95 %. If
an error occurred, more bits must be compared to achieve the same
confidence level. For details see “Explanation of the Fast Total Jitter
Measurement” on page 234.

The measurement proceeds with the next frequency and jitter
amplitude as soon as the desired level of confidence is reached. Setting
a confidence level ensures that neither too few nor too many bits are
captured.

Relax Time

Before the measurement proceeds to the next frequency bin, a
measurement settling or relax time can be applied.

This allows the DUT to recover in case it has lost synchronization due
to an excessive high bit error rate. The next BER measurement starts
after this time has elapsed.

About Jitter Tolerance Standards

Every Jitter Tolerance Compliance test requires a standard. You can use
one of the predefined standards. Additionally, you can define and use
your own "user-defined" standard.

In terms of the Serial BERT, a standard is represented by a sequence of
paired numbers. Each pair consists of a frequency value (Hz) and the
associated jitter amplitude value (UI).

Also part of a standard specification are the standard’s name and
descriptive text.

Predefined Standards

The Jitter Tolerance Compliance option provides a number of
predefined standards.

Predefined standards specify:

• Jitter frequency range

The jitter frequency range may depend on the bandwidth of the
receiver being tested.
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• Bit rate range

Some standards define the jitter tolerance curve as a function of the
bit rate. If this is the case, the edges of the jitter tolerance curve are
shifted towards higher frequencies if the bit rate is increased, and
vice versa.

• Jitter amplitudes in defined sections of the jitter frequency range

The slopes between adjacent sections may be double logarithmic
(shown as straight lines in the double logarithmic display) or are
calculated according to certain algorithms.

• Data pattern to be used

This can be, for example, a certain PRBS-polynomial or a specific
test pattern.

• Signal voltage range

Most standards refer to specific devices.

• Jitter composition

A standard may prescribe that additional jitter components with
specific amplitudes have to be added.

The standards provided by Agilent can be chosen from a list of
predefined standards.

Every standard is accompanied by a description that states its specific
requirements, like applicable bit rates, patterns to be used, and so on.

N O T E Before running the test, set up the instrument to ensure that these requirements
are met. For details on the recommendations and their dependencies see
Description in the “Standard Specification” on page 457.

If a standard specifies a tolerance curve that is bit rate dependent, the
curve is automatically adapted to the present bit rate. If you change the
bit rate, the curve is automatically recalculated.

The standards provided by Agilent cannot be edited locally.

User-Defined Standards

You can create your own standard in a text file.

A user-defined standard consists of a paired list of numbers.

Each pair specifies a jitter frequency (Hz) and the associated jitter
amplitude (UI), for example:
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2e3, 110<cr><lf>
3.24e4, 50<cr><lf>
71.234e4, 10<cr><lf>
10.654e6, 0.2<cr><lf>
18.333e6, 0.2<cr><lf>

<cr><lf> stands for <carriage return><line feed> or just <Return>.

N O T E The list must be sorted according to the frequencies in ascending order. The jitter
amplitude for a given frequency must not exceed the instrument’s capability.

The list of predefined standards has a Browse option that allows you to
identify and load such a text file.

If you have selected a text file, you can append it to the list of predefined
standards. You can assign a name to your standard and add a
description. Then, your standard appears directly in the list like the
standards provided by Agilent, and you don’t have to browse any more.

Your standard is stored in a file with the suffix .jcs. This is still a text
file which can be edited. The directory is C:\<instrument model>
\JTolStandards.

User-defined standards are taken “as is”. That means, neither the bit
rate nor any other conditions are taken into account.

The instrument uses double logarithmic interpolation to generate the
jitter amplitudes between two successive amplitude values. This is
indicated by linear slopes in the double logarithmic graph.

Special Features

You can freely specify the jitter frequency range and the number of
points to be measured. You can also adjust the frequency range and the
point positions to the loaded standard.

In addition, you can add a margin to the standard.

Jitter Frequency Test Points

You can specify the jitter frequency range to be used for the test, from
1 kHz up to some hundred MHz. You can hence measure only a portion
of the standard or points outside the standard. Points outside the
standard will always pass the test.

If a standard prescribes a certain range, for example from 2 kHz to 20
MHz, you can select a checkbox to adjust the jitter frequency range to
the loaded standard.
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You can also specify the number of points to be measured. By default,
the measurement points are evenly distributed along the logarithmical
frequency axis.

You may wish to measure the BER exactly at those frequency points
where the specified jitter amplitude changes. By selecting a checkbox,
the distribution of the measurement points can be adapted to the loaded
standard, and the BER at the points of interest will be measured.

Margin

It is possible to increase the jitter amplitudes of any standard by adding
a margin. This increases the stress on the device under test.

The margin is set in percent. A margin of 25%, for example, has the effect
that each amplitude value is multiplied by 1.25.

The following figure shows an example of a measurement with a margin
of 50% and sample point adaptation.

Jitter Tolerance Compliance - Procedures

To access the Jitter Tolerance Compliance measurement, click Jitter
Compliance from the Jitter submenu.
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To set up a Jitter Tolerance Compliance test, press the Properties button.

This opens the Jitter Tolerance Properties dialog.

Setting the Standard

Select either a predefined standard or load a standard from a text file.

1 Switch to the Standard tab.

A preview and a short description of the selected standard are
displayed.

2 To load a different standard, open the list.
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The list contains all predefined standards, including user-defined
standards. User-defined standards are preceded by an asterisk (*).

3 Select one of the predefined standards.

or

Press Browse... to load your own standard, stored in a text file.

This opens a dialog box which allows you to load a file. By default,
the browser searches for files with the suffix .jcs, but you can access
any file.

N O T E The required file format is described in detail in “User-Defined Standards” on page
445.

4 Press OK to load the data temporarily. Use this option, for example,
if the jitter-frequency list of your standard is still subject to change.

or

Press Apply to Predefined Standards to load the data and add the
standard to the list of predefined standards. For details see “Adding
a User-Defined Standard” on page 455.

If you wish to increase the stress on the device under test, you can enter
a Margin.
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T I P With the Auto Frequencies checkbox, you can adjust the test frequencies
automatically to the selected standard. This is described belowin “Setting the
Frequency Range” on page 450.

Setting the Frequency Range

You can freely specify the jitter frequency range and the number of
points to be measured. By default, the test points are suitably
distributed within the frequency range – according to the loaded
standard. But you can change the distribution according to your needs.

1 Switch to the Frequency tab.

The measurement's frequency range and the list of test frequencies
are displayed.

If the Auto Frequencies checkbox on the Standard tab is selected, start
and stop frequency are by default set according to the selected
standard.

N O T E When you change the selection state of the Auto Frequencies checkbox, press
Apply on the Standard tab to accept the change and to update the frequency list.
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2 If desired, change the default values. For example, if only a certain
frequency range has to be tested:

Enter the Start Frequency and the Stop Frequency.

3 Set the Number of Steps between start and stop.

T I P When Auto Frequencies is activated, the Number of Steps can also be set on the
Standard tab.

The resulting frequency list depends on the setting of the Auto
Frequencies checkbox on the Standard tab:

• Checkbox is selected (default):

The list yields frequencies that are recommended for the selected
standard, for example the edge frequencies.

• Checkbox is not selected:

The list of frequencies yields a set of logarithmically equidistant
frequencies.

In Manual mode, the automatically calculated jitter frequencies can be
edited. You can also enter your own comma-separated list of
frequencies.

N O T E If the frequency list is edited in Manual mode, the Auto Frequencies checkbox on
the Standard tab is automatically deselected.

The Sequence Advance checkbox advances the PG sequence during jitter
tolerance compliance. It will be enabled only if the sequence is send to
the PG.

Setting the BER Limit

1 Set the Target Bit Error Ratio.

This defines whether a measured point is flagged green (test passed)
or red (test failed).
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2 Choose the Verification Method.

Setting a Confidence Level is generally recommended. See also “Target
BER” on page 443.

If you enable Absolute Bits/Errors, the measurement proceeds with the
next amplitude as soon as one of the two numbers is reached.

3 If desired, set a Relax Time.

For details see “Relax Time” on page 444.

Before Running the Test

Before running the test, set up the instrument to ensure that the
requirements of the selected standard are met. Recommended test
pattern and additional jitter are displayed in the standard's description
field on the Standard tab of the Jitter Tolerance Properties dialog.

For details on the recommendations and their dependencies see
Description in the “Standard Specification” on page 457.

For DUTs that require a training sequence it is essential to prevent clock
loss at the beginning or end of the test. To avoid clock loss, the sinusoidal
jitter component has to be enabled. Since the sinusoidal jitter for the
test is generated internally, the jitter amplitude must be set to zero:

1 Press Jitter Setup from the Jitter submenu.
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This opens the Jitter Setup window.

2 Enable jitter generation. Press the respective checkbox.

3 Activate Sinusoidal jitter.

4 Activate Periodic jitter

5 Set the jitter amplitude to 0 UI for both Sinusoidal jitter and Periodic
jitter.

N O T E When rSSC is enabled the measurement does not use SJ. The maximum available
jitter amplitude is reduced for the jitter tolerance measurement.

Running the Test

Once you have specified the Standard, Frequency, and BER, press the
Start button to run the test.

The bar in the lower right-hand corner of the screen shows the progress.

You can also abort the test at any time by pressing the Abort button.

When the measurement is either completed or aborted, you can obtain
a list of measured points by clicking the following tab which appears
once the measurement is stopped.

Clicking on the above tab you get the list of measured points.
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Selecting a point, and clicking on 'Set', updates the Sinusoidal and
Periodic jitter of that point on the Jitter Setup page.

Generate HTML Report

The measurement results can be saved as HTML file. To generate the
HTML report:

1 Click on the >> icon on the Jitter menu. The following submenu will
appear.

2 Select 'Generate HTML report'.
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3 Select the folder where you want to save the report, name the file,
and save it.

Managing User-Defined Standards

User-defined standards are saved in the folder C:\<instrument model>
\JTolStandards. The extension is .jcs.

To add a user-defined standard to the list:

1 Press the Properties button and switch to the Standard tab.

2 Select the last entry in the list: Browse….

This opens a dialog box which allows you to load a file.

N O T E The file must contain a comma-separated list of frequencies and jitter values. The
file format is described in detail in “User-Defined Standards” on page 445.

3 Select the desired file and press Open.

The Properties of Imported Standard dialog is displayed.

4 Enter a Name and Description for the standard.

5 Press Apply to Predefined Standards.

The standard is added to the list of predefined standards. In the list,
user-defined standards are preceded by a "*".

To delete a user-defined standard from the list:

• Delete the corresponding file in the C:\<instrument model>
\JTolStandards directory.

If you want to store the measurement results for later use, you can either
save them as an .jcp file (to be opened in the user interface) or as a .txt
file for spreadsheet applications.
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Saving Measurements

To save a measurement as an .jcp file for later use in the user interface:

1 After your measurement has finished and the results are displayed,
select Save Measurement from the File > Save menu.

2 Select a proper file name and location and press the Save button.

Exporting Measurement Results

To export the measurement results into a .txt file for later use in
external spreadsheet applications:

1 After your measurement has finished and the results are displayed,
select Export Data from the Analysis menu.

2 In the Save as dialog box, select the path and file name for the .txt
file.

3 Press Save to export the data to the specified destination.

Loading Measurements

To load previously saved measurements:

1 Select Open Measurement from the File > Open menu.

2 Use the file dialog box to locate the desired .jcp file and press Open
to load the measurement.

Accessing Comment and Condition Text

To access the comment or condition text of a measurement:

• Double-click Modify Comment below the graphical display.

This opens the Jitter Measurement Comment dialog box.

You can enter a comment. The condition is automatically added by the
system.

You can also read the full comment or condition in case only part of the
text is displayed in the result table.
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Jitter Tolerance Compliance - Reference

Jitter Tolerance Compliance determines whether a device under test
maintains a desired BER at defined jitter levels. The jitter levels can be
derived from predefined standards.

Standard Specification

The drop-down list contains all predefined standards, including user-
defined standards. The shape of the selected standard is shown in the
preview area. The frequency range and the jitter amplitude range of the
standard is given in the preview. A description is displayed at the
bottom of the Standard tab.

The last entry in the list is Browse…. Select this entry to load a file that
contains a user-defined standard. See “Setting the Standard” on page
448 for details.

To aggravate test conditions, the standard's test jitter amplitude can be
increased by Margin percent. The display shows a black line for the
standard and a green line for the new jitter amplitudes.

Select the Auto Frequencies checkbox to set frequencies that are
recommended for the selected standard. This list contains, for example,
the edge frequencies of the standard.

T I P You can change single frequency points. Press Apply to accept the selected Auto
Frequencies setting and switch to the Frequency tab. In Manual mode, you can
edit the automatically calculated frequencies. If you do so, the Auto Frequencies
checkbox is automatically deselected.

Enter the number of test frequencies (Number of Steps) either on this tab,
or on the Frequency tab.

This is the creator's description of the selected standard. Standards
provided by Agilent are described by the following items:

T I P Use the scroll bar if not all information is displayed.

• Document that describes the standard in detail. The document name
usually indicates the date or revision of the standard.
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• Recommended settings for the test pattern like Bit Rate range,
Pattern types and voltage level ranges:

– Voltage Level from Standard: This is the peak-to-peak differential
input level range for the DUT as given in the standard.

– Voltage Level at PG (recom): This is the recommended output level
at the pattern generator to achieve the minimum voltage Level
from Standard.

N O T E This recommendation depends on the simulated intersymbol interference (ISI): The
minimum voltage Level from Standard is only met if the trace to simulate the ISI is
selected as in the description item Additional Jitter. Other settings of the ISI can
change the DUT's input level up to four times.

Consider these recommendations when setting up the pattern
generator (see “Setting up the Pattern Generator - Concepts ” on page
113).

• Additional Jitter components you have to add for the compliance test
if the standard requires non-sinusoidal jitter components, such as
random jitter (RJ) or intersymbol interference (ISI).

N O T E The recommended ISI setting is only valid, if both pattern and bit rate are set
according to the standard's recommendation (see the corresponding description
items).

Consider these recommendations when composing the desired total
jitter (see “Jitter Setup - Procedures” on page 400). Note that the
sinusoidal jitter is automatically generated and no setup is required.

Frequency Specification

You can choose Auto or Manual mode.

In Auto mode, the jitter frequency is automatically swept from Start
Frequency to Stop Frequency.

• Start Frequency: This is the minimum and first jitter frequency to be
generated. It determines the left-hand border of the graphical result
display.

• Stop Frequency: This is the maximum and last jitter frequency to be
generated. It determines the right-hand border of the graphical
result display.

The measurement always includes the start and stop frequencies.
The frequency scale is logarithmic.
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• Number of Steps: The Number of Steps between start and stop defines
the test frequencies.

The location of the individual test frequencies depends on the setting
of the Auto Frequencies checkbox on the Standard tab:

– Checkbox is selected (default):

The list yields frequencies that are recommended for the selected
standard, for example, the edge frequencies.

– Checkbox is not selected:

The list of frequencies yields a set of logarithmically equidistant
frequencies.

N O T E Alternatively, you can set the Number of Steps on the Standard tab.

In Manual mode, you can edit the automatically calculated frequencies.
You can also enter your own list of frequencies, with a minimum of two
frequencies specified. For example, you can jump between low and high
jitter frequencies.

Enter the frequencies in Hz, separated by commas, for example:

2e4, 1.75e6, 6.334e5, ...

T I P Press Apply if you want to keep the setting of frequencies for the current test run,
but if you still want to change the standard or BER specification. If all properties are
set as desired, press OK.

BER Specification

The Target Bit Error Ratio defines the pass/fail criteria of the jitter
tolerance compliance test. For every test point along the standard curve,
the test is failed if the measured BER lies above the Target Bit Error
Ratio.

The Verification Method defines under which circumstances the
measurement proceeds from one frequency to the next. You can choose
between two Verification Methods:

Setting a Confidence Level is generally recommended. This ensures that
neither too few nor too many bits are captured. See also “Target BER”
on page 443.
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If you enable Absolute Bits/Errors, the measurement proceeds to the next
jitter frequency as soon as either the number of received bits or the
number of errors is reached.

N O T E Ensure that you capture a number of bits that suffices to verify (with the desired
probability) that a measured point has a BER below the Target Bit Error Ratio.

The relax time allows the DUT to recover in case it has lost
synchronization due to an excessive high bit error rate. The next BER
measurement starts after this time has elapsed.

To run the Jitter measurements you need to make sure that Global Jitter,
Sinusoidal Jitter and Periodic Jitter are enabled.

This displays the list of measured points. The list classifies the points
with their frequency, amplitude, and status. The status indicates
whether the test passed or failed at that point.

This contains the results as follows:

1 Test Configuration Details: gives the User Comments, Device Type,
Last Test Date, Model Number, Serial Number and Software Revision
number.

2 Conditions: Pattern, Data Rate, Output Level, ISI Trace Number,
Additional Jitter, SSC, Target BER, Confidence Level, Relax Time
and Margin.

3 Graph: Jitter Tolerance Graph.

4 Measured Points: List of points classified with their pass/fail status,
frequency, Periodic Jitter/Sinusoidal Jitter and Total Jitter without
ISI.

5 Recommended Settings (only in the Compliance Report):
Document, Note, Bit Rate, Pattern, Level from Standard, Level at PG
(recommended) and Additional Jitter.

Explanation of the Results

Additionally to the graphical results, the measurement provides some
information below the graph. You can also export the results to a .txt
file.

The following information helps you to interpret and document the test:
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• Result of the test (passed or failed).

• Date and Time when the test was finished.

• Margin that was set for the test.

• Further test Conditions like the selected test pattern and additional
jitter components.

• Double-click Modify Comment, to enter a Comment for every test.

T I P If not the whole information is displayed in the Condition/Comment column, this
is indicated by "…". Double-click Modify Comment to see the complete text in a
separate window.

If you want to use the measurement results with other applications, you
can export the data to a file via Analysis > Export Data....

The contents of the resulting file may look as follows:

Jitter Tolerance Measurement 4/10/2006 12:12:37 PM
Standard: XAUI
Margin: 0 %
Condition: 2^23-1 PRBS@2.488 Gb/s; 
Comment: 
Passed Points: (frequency; amplitude; number of bits; 
bit error rate; number of errors; result)
1000; 8.5; 3013355404; 0; 0; passed;
1790.61312892; 8.5; 3015843721; 0; 0; passed; 
3206.295377462; 8.5; 3015843721; 0; 0; passed; 
5741.234598079; 8.5; 3015843721; 0; 0; passed; 
10280.33004753; 8.5; 3015843725; 0; 0; passed; 
18408.09395274; 8.5; 3013355401; 0; 0; passed; 
22100; 8.5; 3015843721; 0; 0; passed; 
32961.77471018; 5.69902566387; 3015843724; 0; 0; passed; 
59021.78654856; 3.182723041524; 3015843725; 0; 0; passed; 
105685.1858862; 1.777448735363; 3013355405; 0; 0; passed; 
189241.2813802; 0.9926481084359; 3013355401; 0; 0; passed; 
338857.922973; 0.5543621301573; 3015843723; 0; 0; passed; 
606763.4457141; 0.3095934689654; 3015843724; 0; 0; passed; 
1086478.592045; 0.1728980224511; 3015843725; 0; 0; passed; 
1875000; 0.1; 3013355405; 0; 0; passed; 
1945462.831206; 0.1; 3015843721; 0; 0; passed; 
3483571.287383; 0.1; 3015843721; 0; 0; passed; 
6237728.482718; 0.1; 3015843722; 0; 0; passed; 
11169358.5158; 0.1; 3015843771; 0; 0; passed; 
20000000; 0.1; 3013355409; 0; 0; passed; 
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Failed Points: (frequency; amplitude; number of bits; 
bit error rate; number of errors; result)

This file can be imported into spreadsheet applications such as
Microsoft Excel, for example. Use the semicolons as delimiters for the
rows or columns.

T I P The comment can be entered with the Modify Comment button below the graphical
result view.
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9 
Solving Problems

Solving Problems - Concepts

This section provides information that can help you to troubleshoot the
Serial BERT in case any problems occur.

Setup Problems

Setup Problems - Concepts

You may run into the following problems when setting up the Serial
BERT.

Front Panel not Working

If the front panel is not working and a hardware wizard calls on you to
install the driver for an unknown USB device, cancel the hardware
wizard and reboot the instrument.

This might happen if the front panel controller is not initialized
correctly at boot up.

Incorrect Error Detector Input Voltages

The error detector's protection circuit disconnects the input amplifier
if the incoming signal does not lie within the defined input range. In this
case, a dialog box will open that lets you define the input range, sample
point 0/1 threshold, termination voltage and state. When you click OK,
the input amplifier will be reenabled.
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If the input signal is still out of range for any of these parameters, the
error detector will be immediately disconnected again.

Error Detector Does not Count Bits

If the analyzer does not count any bits, press Sync Now.

This might happen after the Error Detector had glitches at the clock
input.

DLL Alignment Failed

If an error message containing the text "... DLL alignment failed ..." is
displayed, increase or decrease the bit rate by 1bit/s.

See “Bit Rate - Procedures” on page 132 for details on setting the bit
rate.

The instrument provides several error indicators to help you identify
setup problems.

The following list contains possible causes for setup problems, sorted
from the most severe to the least severe:

PG CLK LOSS

This indicator turns red when no clock signal is detected at the PG Clock
In port.

• External Clock Input is selected and the external clock is off or not
connected.

• Your cables or the external clock is faulty.

ED CLK LOSS

This indicator turns red when no clock signal is detected at the ED Clock
In port.
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BERT connected looped back or to your device:

• The PG clock output is off or not connected.

• There is no connection to the ED clock input.

• Your cables are faulty.

BERT connected to your device:

• There is no clock signal from your device.

• Your device is faulty.

DATA LOSS

This indicator turns red when no data signal is detected at the ED Data
In port.

BERT connected looped back or to your device:

• The PG data output is off or not connected.

• There is no connection to the ED data input.

• The 0/1 threshold is not in the eye limits of the incoming data signal.
Use Auto Align or select Avg 0/1 Threshold.

• Your cables are faulty.

BERT connected to your device:

• There is no data signal from your device.

• Your device is faulty.

SYNC LOSS

This indicator turns red when the measured BER is higher than the sync
threshold.

BERT connected looped back or to your device:

• The sampling point is incorrect. Use Auto Align.

• The data pattern is inverted. Toggle Data Inverted or use Auto Align.

• The ED pattern does not match the incoming data pattern. Make the
ED track the PG pattern, or set ED and PG patterns independently
the same.

• Patterns have lost sync in manual sync mode. Use Auto Align, Sync
Now, or select Auto Sync mode.

BERT connected to your device:

• The data eye is very small. If Auto Align does not correct sync loss, set
the 0/1 threshold manually.
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• Your device has inverted the data pattern. Toggle Data Inverted or use
Auto Align.

• Your device has changed the data pattern. Set the ED and PG
patterns separately.

• If the fundamental BER of your device is higher than the sync
threshold BER, you can select a higher sync threshold BER.

Error

This indicator turns red when errors are detected. View the BER bar or
BER Results to see the nature of the errors.

BERT connected looped back or to your device:

• Stable errors caused by the error add function: Turn error add off.

• Stable errors caused by false sync: Select a lower sync threshold
BER.

• Variable and high errors may be caused by faulty connectors/cables.

BERT connected to your device:

• Stable or variable errors can also be caused by your device. Correct
the problems with your device.

• If the problems are not clear, then accumulate measurement data
and analyze results.

Measurement Problems

Measurement Problems - Concepts

Accumulated measurements can help you determine the cause of bit
errors. Bit errors can be caused by a variety of problems. In addition,
instrument settings can affect how errors are measured and displayed.
The sync mode setting has the greatest effect.
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Some phenomenon you might observe with the possible causes are
listed below:

Constant Errors (More Errored 0's than 1's)

A hardware failure may have occurred in your device. The errors
became constant at the point of failure.

Digital circuitry often has parallel architecture in which data lines are
multiplexed in stages into one serial data line. This example assumed
that a PRBS pattern was going through digital circuitry that had a total
multiplexing ratio of 256:1. The constant errors were produced from
one data line that became "stuck" high in the first stage of multiplexing.

The data line that was "stuck" high produced errored 0's 50% of the time
with the PRBS pattern. Therefore, at the serial rate, one out of every
512 bits was measured as an errored 0 (1/256 * 50% = 1/512). In addition,
the inverse of the error ratio was a multiple of 2.

In this example, the analyzer could have been in manual sync or auto
sync mode with 1E-2 as the sync threshold BER. If the sync mode
settings were different, the results would not have been measured and
displayed in the same way.

The BER in this example (approx. 2E-3) was greater than the default
sync threshold BER (1E-3). If the analyzer was in the default auto sync
mode, it would have activated the synchronization functions and
continually shifted the position of the reference pattern in an attempt
to find a lower BER.
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N O T E The accumulated results table displays the total accumulated error ratio. Look in
the measurement log file to see the error ratio during the period of constant errors.

The error ratio during periods of constant errors was 0.00195313. This
corresponds to 1.953E-3.

Random Errors

Random errors may have been caused by a noisy waveform. Noise can
be caused by bad cables or connectors.

The output of your device may contain errors due to noise, although a
noisy waveform is not present at the output. The noise may originate
somewhere else within your device or system, causing random bit errors
to be passed on to other components. Therefore, your device may have
a good output waveform and still transmit random bit errors.
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Sync Loss Seconds

The sync loss seconds in this example may have been caused by high
bursts of errors or momentary clock loss. The clock signal from a clock
recovery module may have momentarily ceased. To confirm periods of
momentary clock loss, check the measurement log file.

In this example, the analyzer was in auto sync mode. If the analyzer was
in manual sync mode, the results would not have been measured and
displayed in the same way.

When the clock signal resumed, the received and ED reference patterns
could only be aligned if the synchronization functions were activated.
In manual sync mode, this would not have happened because
synchronization functions are only activated manually.

In manual sync mode, sync loss and high BER would have been
measured from the start of the momentary clock loss to the end of the
accumulation period.

Data in this measurement log file confirms that there were periods of
momentary clock loss.
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Using the Measurement Log to Identify Problems

Measurement Logs are saved as CSV (comma separated variable) files.
Follow the steps below to view results in a measurement log file:

1 Copy the measurement log file from the analyzer to your PC. By
default, log files are saved in the folder C:\<instrument model>
\log.

2 Open a spreadsheet application on your PC.

3 Import the measurement log file. If your application has an import
wizard, you may need to indicate that data is delimited with commas.

4 Once the file has been imported, you may need to resize columns.
The imported log file should appear similar to the following example.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.

You can view and analyze the following information in the measurement
log file:

9 Solving Problems

470 Agilent J-BERT N4903B High-Performance Serial BERT



Table 31

Instantaneous Cumulative

BIT COUNT BIT COUNT Cumulative

ERROR COUNT ERROR COUNT Cumulative

ERROR RATIO ERROR RATIO Cumulative

ERRORED 0 COUNT ERRORED 0 COUNT Cumulative

ERRORED 0 RATIO ERRORED 0 RATIO Cumulative

ERRORED 1 COUNT ERRORED 1 COUNT Cumulative

ERRORED 1 RATIO ERRORED 1 RATIO Cumulative

SYNC LOSS ERROR SECONDS Cumulative

PG CLOCK LOSS ERROR FREE SECONDS Cumulative

ED CLOCK LOSS ERROR DECISECONDS Cumulative

DATA LOSS ERROR FREE DECISECONDS Cumulative

SYNC LOSS SECONDS Cumulative

BURST STATUS Cumulative

BURST SYNC RATIO Cumulative

TOTAL BURST COUNT Cumulative

BAD BURST COUNT Cumulative
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Other Messages

Other Messages - Concepts

This section covers additional error messages that may occure when
working with the Serial BERT.

Overheat Protection

The Serial BERT is equipped with an overheat protection function to
prevent it from overheat damage.

If the temperature of the error detector or pattern generator exceeds a
certain threshold, the Serial BERT displays the following warning
message, respectively:

N O T E The temperature level is not yet critical. However, the Serial BERT may be damaged
if operation is continued. The message is intended to inform you to take the
appropriate measures. Save your current instrument settings, shut down the Serial
BERT and let it cool down before operating it again.

If the Serial BERT is operated at this state for a longer time, the
temperature may reach a critical level. In this case, the following
message is displayed:
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The Serial BERT will be shut down, your instrument settings will not be
saved.

If the Serial BERT has indicated overheating, do the following:

• Shut down the instrument and let it cool (45minutes to 1hour).

• Reduce the environmental temperature.

• Make sure that the fans are running and the ventilation holes are not
blocked.

• If the problem continuously recurs, contact Agilent support.

C A U T I O N Do not operate the Serial BERT before it has cooled down again. Otherwise your
instrument may get damaged.

When you are switching on the Serial BERT after it was shut down due
to a temperature error, you will see a message box that informs you
about which module caused the problem.
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N4916B System Setup Calibration

N4916B System Setup Calibration

The input timing of the N4916B has to be calibrated to ensure error free
operation for all data rates. This calibration is required once for a
dedicated setup of N4903B, N4916B and the cable kit being used, and
has to be repeated whenever one of these are changed in the setup.

N O T E The Input Timing setting that is determined during this calibration is only valid for
all data rates when using the N4915A-010 cable kit.

For all other cables, this calibration has to be done for each data rate that has to be
set using the N4916B De-Emphasis Signal Converter.

Maintaining a list of proper Input Timing Settings to data rates and use of the correct
setting for a dedicated data rate is up to the user when not using the cable kit.

Loading Calibration Settings

Follow the given steps to load the calibration setting:

1 From the Navigation Menu, select External Instrument(s) and then click
Config sub-menu. The Config window shows a list of all instruments
connected to the N4903B.

2 Select the external instrument from the given list. For example, here
you will select N4916B.

3 Use the drop down list to provide the Input Timing Setup.

4 Click Load Calibration Settings to continue. A message will pop up
which warns you to save the instrument settings before continuing
the calibration.
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W A R N I N G The instrument settings will be lost once you start the calibration process. It is
recommended to save the instrument settings before you start the calibration
process.

5 Click Yes to continue if you have already saved the settings.

Calibration Procedure

The following steps explain the calibration prodecure:

1 Store current instrument setting if the current setting is required
after the calibration is done

2 Load the calibration setting. For more details, refer “Loading
Calibration Settings” on page 474.

3 Depending on if an error detector available or not, we have 2 cases:

Case -1 (Calibration using an Error Detector)

– Connect Data Out of N4916B to Data In of Error Detector.

– Terminate Data Out of N4916B and Data In of Error Detector with
50 Ohm termination resistor.

– Connect Clock Out of Pattern Generator with Clock In of Error
Detector.

– Terminate Clock Out of Pattern Generator with 50 Ohm
termination resistor

– For each of the 6 timing settings do a BER measurement using
the following accumulation setting
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– Press the Auto Align key on the front panel

– Switch to the Accumulated Results Screen

– Press the Start Accum key on the front panel to start the BER
measurement

– For each measurement write down the number of errors at the
end of the measurement

– The correct Input Timing is selected by the following rule:

Look for the BER measurement that produced no error, and that
has the biggest distance to a measurement with errors and select
the Input Timing setting that was used in this measurement.

Example: Input Timing Setting 2 has the biggest ‘distance’ to a
setting that produced errors, no matter if checking in ‘forward’
or ‘backward’ direction through the table. So this is the setting
that has to be used.
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Table 32

Input
Timing

Errors Forward
distance
to ‘bad’
setting

Backwar
d
distance
to ‘bad’
setting

1 0 3 1

2 0 2 2

3 0 1 3

4 50 0 0

5 1000 0 0

6 100 0 0

Case-2 (Calibration using an Oscilloscope)

– Connect Data-Out of N4916B to the oscilloscope.

– Terminate Data-/Out of N4916B.

– Connect Trigger-Out of PG with Trigger-In of oscilloscope.

– Terminate Trigger-/Out of PG with 50Ohm termination resistor.

– Select each of the 6 Input Timing Settings and measure the output
of the N4916B with the oscilloscope.

– Measurement has to be done checking for erroneous sampled bits,
so the oscilloscope has to be adjusted to measure at a xx0 to 111
transition of the pattern.

– The oscilloscope has to be configured to display every measured
sample infinitely.

– Measurement time has to be at least long enough for the required
target BER (e.g. 1^-12 at a confidence level of 95%).

– A measurement is considered ‘error free’ when there are no
samples taken ‘outside’ the regular signal trace.

– Selection of the optimum Input Timing setting is done as shown
above for the BER measurement.

4 Selection of the optimum Input Timing setting is done as shown
above for the BER measurement.

5 Optionally reload the previously stored instrument state
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How to Create the Calibration Settings

Use the following calibration settings:

• Preset Instrument State

• Enable De-Emphasis

• Set all cursors to 0dB

• Set Output Offset at N4916B => 0V

• Set Output Amplitude at N4916B => 400mV

• Set Data rate to the maximum possible data rate of your setup. This
depends on the maximum data rate of the PG, ED and N4916B. Note
that a N4916B that is specified for 10.5Gb/s should be calibrated at
12.5Gb/s (this makes selecting the optimum input timing setting
easier). A N4916B that is specified up to 14.2Gb/s shall bei either
calibrated at the ED's maximum data rate (12.5Gb/s) or the PG's
maximum data rate (7Gb/s, 13.5Gb's or 14.2Gb/s).Use either the PG's
or ED's maximum data rate (whatever is less). If calibrating using an
oscilloscope, then use either 7Gb/s, 12.5Gb/s or 14.2Gb/s, depending
on the maximum data rate of the PG and the N4916B.

• Set Trigger Out: Pattern Trigger at Bit Position 0 (for the scope
measurement)

• Set Trigger Out: Offset 0V

• Set Pattern: PRBS 2^7-1 for PG and ED

• Set Error Detector: Alignment BER Threshold 1E-1

• Set Error Detector: Nomal Input, Single Ended

• Set Error Detector: Pattern Sync Normal + Manual

Example Calibration Using a Sampling Oscilloscope

The following example shows the Input Timing Calibration for a target
BER of 10-3 and a confidence level of 95%. Lower target BER values will
lead to more reliable results for the settings that are close to the ‘worst’
Input Timing Setting. But lower target BER values also lead to
significantly longer measurement times. Please refer to the notes at the
end of the example for details about the required measurement time at
different target BER values.

The example is using the following instruments:

1 N4903B with option D14

2 N4916B specified for up to 14.2Gb/s

3 Infiniium DCA 86100A with a 83484A module
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• Connect the N4916B with the N4903B using the N4915A-010
matched cable pair

• Connect the N4903B’s Trigger Output with the oscilloscope’s Front
panel Trigger input

• Connect the N4916B’s Data Output with channel 1 of the oscilloscope

• Terminate the N4916B’s complement output using a 50Ohm
termination resistor

1 N4903B

a Open the configuration page for external instruments

b Enable the De-Emphasis function

c Click the Load Calibration Setting… button

d Set the PG’s data rate to 14.2 Gb/s

e Open the external instruments configuration screen again

2 86100A

a Enable Channel 1, set the vertical scale to 100 mV/div and the
offset voltage to 0 V

b Select the appropriate trigger input and set the threshold voltage
to 0 V. Select Trigger Mode ‘Normal’ (DC – 2.5 GHz)

c Set the time base to 28.2 ps

d Adjust the Delay to show the start of the 27-1 PRBS at the center
of the screen (0000001111111 bit sequence)

e Set the Waveform Persistence to infinite

f Enable Eye Mask Mode

For each Input Timing Setting (1 to 6) execute the following steps:

• Set the Input Timing on the N4903B

• Clear the oscilloscope’s display

• Wait for waveforms to accumulate for approximately 6 minutes

• Check the waveform on the oscilloscope for erroneous
measurements that indicate a timing violation at the input of the
N4916B

When all 6 settings have been measured, select the optimum input
timing setting (keep in mind that one erroneous sample on the screen
has to be treated as an error).
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Example screen shots

• Input Timing Setup = 1

• Input Timing Setup = 2

• Input Timing Setup = 3

9 Solving Problems

480 Agilent J-BERT N4903B High-Performance Serial BERT



• Input Timing Setup = 4

• Input Timing Setup = 5
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• Input Timing Setup = 6

Input Timing Setup #1 shows timing violations at the input of the
N4916B. All other measurements do not show any violations during the
measurement interval (6 minutes).
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The example above was done for a target BER measurement of 10-3 and
a confidence level of 95%. As a rule of thumb, this requires to measure
approximately 3 times the number of bits given by the target BER.

The sampling frequency of the 86100A is specified with 40kHz, which
gives a sampling period of:

The timing interval resolution is given as:

The time base needs to be set to:

The number of waveforms that are required to be measured for
achieving the confidence level of 95% is:

Each measured waveform contains the following number of samples:

The overall required measurement time can be estimated as:

The above formula shows that choosing

as 62.5fs leads do longer measurement times than required. So it is safe
to assume the highest possible resolution for this estimation.

In the example above the following values have been used:

• #bits = 4

• Target BER = 10-3

• Data Rate = 14.2 Gb/s
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This gives a time base setting of 28.2ps and a measurement time of 338
seconds.

When using lower target BER values, the required measurement time
per Input Timing Setting is getting longer very quickly.

The required measurement time for a target BER of 10-9 is
approximately 338e6 seconds per Input Timing Setting, which is not
practicable in a real measurement setup.

N4876A System Setup Adjustment

N4876A System Setup Adjustment

The N4876A has to be adjusted to ensure error free operation for all
data rates. This adjustment is required once for a dedicated setup of
N4903B, N4876A and the cable kit being used, and has to be repeated
whenever one of these are changed in the setup or the operating
temperature is changed by more than 5o Celsius, compared to the
previous adjustment.

Performing System Setup Adjustment Setting

Follow the given steps to perform system setup adjustment setting:

1 From the Navigation Menu, select External Instrument(s) and then click
Config sub-menu. The Config window shows a list of all instruments
connected to the N4903B.

2 Select the external instrument from the given list. For example, here
you will select N4876A.

3 Click Adjustment... to continue.

A message will pop up which warns you to save the instrument
settings before continuing the auto adjustment process.
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4 Click Yes to continue if you have already saved the settings. Once the
auto adjustment starts, you will see the adjustment progress in the
following screen:

N O T E The adjustment process may take several minutes for completion.

The following message will pop up after the successful completion
of adjustment process.
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Problems with the N4916A

Problems with the N4916A - Concepts

When you have opened the External Instrument(s) - Config window and
have selected N4916A from the external instruments, select De-
emphasis under Enable Function column in the list, the N4916A
Connection window appears.

Cannot-Connect Problems

An error message may appear when you now press Enable.

If this happens, ensure that the N4916A has been correctly installed (see
“Installing the N4916A/B - Procedure” on page 525).

Check the Power Supply

Ensure that the power cord is connected.

The green LED close to the power switch must be illuminated when the
unit is turned on.

Check the USB Communication

Ensure that the USB cable is connected between the USB port at the
rear of the N4916A and one of the USB ports at the rear of the Serial
BERT.

1 Open the Utility menu and click Minimize GUI to gain access to the
Windows operating system.

2 In the Windows task bar, click the Agilent IO Control icon.
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3 From the Agilent IO Control menu, open the VISA Assistant.

4 If no VISA alias name has been assigned so far, the VISA Assistant
should indicate an instrument named "UsbDevice1". If the N4916A
has been installed correctly, the VISA Assistant should indicate an
instrument named "D4916". Click UsbDevice1 or D4916.

5 Click the Formatted I/O tab.

6 In the Instr. Lang. box (Instrument Language), enable SCPI.
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7 Click the *IDN? button. This generates the identification query in
SCPI format. The instrument should return "Agilent Technologies,
N4916A,," and the software revision.

If you could proceed until here, the N4916A power supply and the
processor are fully functional. If not, the N4916A is probably defective.

Ensure that the User Software can Access the N4916A

1 From the Windows task bar, restore the user interface – click GUI
Agilent 4900 Series.

2 Press the green Preset key close to the front USB connector of the
Serial BERT or from the menu bar select File – Preset Instrument
State.

3 Connect the Data Out of the Serial BERT to the Input of the N4916A.

4 From the Navigation Menu, select External Instrument(s) and then click
Config sub-menu. The Config window shows a list of all instruments
connected to the Serial BERT. Confirm the presence of N4916A enrty
in that list.

5 Corrosponding to N4916A entry, select the De-Emphasis function
check box from the given options under Enable Function column. It
opens the De-emphasis Signal Converter Connection dialog.

6 Click Enable button. It enables N4916A De-emphasis signal converter
that is connected between data out of Serial BERT and the DUT.
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Once the de-emphasis function is enabled you can see the de-
emphasis parameters in the PG Output screen.

7 Again, from the Config window, corrosponding to N4916A, clear the
De-Emphasis function check box. It will disable the de-emphasis
function.

If you could proceed until here, the connection of the user software to
the N4916A is ok.

Check the Output of the N4916A Using a Scope

1 Set the Data offset to 0 V and the amplitude to 1 V. Set the De-
Emphasis to 6 dB.

2 Connect the Output of the N4916A to an oscilloscope.

3 Connect the trigger output of the Serial BERT to the trigger input of
the oscilloscope.

Then the oscilloscope should show an output eye like the following:

If you see a display like above everything is ok.
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If you see merely one fixed level, either the N4916A or the output of the
Serial BERT is defective.

Check the Output of the N4916A Using the Error Detector

If you have connected the N4916A to a Serial BERT and have no
oscilloscope at hand, you can use the error detector for checking the
output of the N4916A.

1 Set up the pattern generator as described above: Set the Data Offset
to 0 V and the Amplitude to 1 V. Set the De-Emphasis to 6 dB.

2 Press ED Setup and open the Sampling Point Setup page.

3 Set up the error detector:

– Press the Edit button to enter the ED Input Setup Dialog.

– Set the Input to "Normal".

– Set the Input Range to –1 V to +1 V.

– Set the Threshold to "Averaging".

– Set the Termination to 0 V.

4 Connect the Output of the N4916A to the Data Input of the error
detector.

5 Ensure that the error detector follows the generated pattern.

– Press the Auto Align button.
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– From the Analysis panel select the Eye Diagram page.

– Press the Start button.

The eye diagram should look like this after some seconds:

Note that a de-emphasis value of 6 dB causes a 50 percent amplitude
reduction.

Check the Output of the Pattern Generator with a Scope

If the N4916A does not produce a signal, check the Data Out of the Serial
BERT.

• Connect the Data Output of the pattern generator to an oscilloscope.

N O T E As long as the N4916A is in "connected" state (after pressing the Connect button),
the pattern generator's output is programmed to a fixed level. The amplitude is set
to 1.2 V, the offset to 0. This yields a signal of ±0.6 V.
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The oscilloscope should show the following picture:

If you see only a straight line, ensure that the pattern generator is not
disabled and that it is set up to generate a pattern (e.g. PRBS).

Check the Output of the Pattern Generator with the Error Detector

If you have connected the N4916A to a Serial BERT you can of course
check the output of the pattern generator by means of the error detector.

1 Set up the pattern generator as described above: Set the Data Offset
to 0 V and the Amplitude to 1 V.

2 Set up the error detector as described above.

3 Connect the Data Output of the Serial BERT to the Data Input of the
error detector.

4 Ensure that the error detector follows the generated pattern.

– Press the Auto Align button.

– From the Analysis panel select the Eye Diagram page.

– Press the Start button.
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After some seconds, you should see an eye diagram like the following:

This is the eye of a non-distorted pattern.

Problems with the N4916B

Problems with the N4916B - Concepts

When you have opened the External Instrument(s) - Config window and
have selected N4916B from the external instruments, select De-
emphasis under Enable Function column in the list, the N4916B
Connection window appears.

Cannot-Connect Problems

An error message may appear when you now press Enable.

If this happens, ensure that the N4916B has been correctly installed (see
“Installing the N4916A/B - Procedure” on page 525).
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Check the Power Supply

Ensure that the power cord is connected.

The green LED close to the power switch must be illuminated when the
unit is turned on.

Check the USB Communication

Ensure that the USB cable is connected between the USB port at the
rear of the N4916B and one of the USB ports at the rear of the Serial
BERT.

1 Open the Utility menu and click Minimize GUI to gain access to the
Windows operating system.

2 In the Windows task bar, click the Agilent IO Control icon.

3 From the Agilent IO Control menu, open the VISA Assistant.

4 If no VISA alias name has been assigned so far, the VISA Assistant
should indicate an instrument named "UsbInstrument1". If the
N4916B has been installed correctly, the VISA Assistant should
indicate an instrument named "DATA_OUT". Click UsbInstrument1 or
DATA_OUT.
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5 Click the Formatted I/O tab.

6 In the Instr. Lang. box (Instrument Language), enable SCPI.

7 Click the *IDN? button. This generates the identification query in
SCPI format. The instrument should return "Agilent Technologies,
N4916B,," and the software revision.

If you could proceed until here, the N4916B power supply and the
processor are fully functional. If not, the N4916B is probably defective.

Ensure that the User Software can Access the N4916B

1 From the Windows task bar, restore the user interface – click GUI
Agilent 4900 Series.

2 Press the green Preset key close to the front USB connector of the
Serial BERT or from the menu bar select File – Preset Instrument
State.

3 Connect the Data Out of the Serial BERT to the Input of the N4916B.
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4 From the Navigation Menu, select External Instrument(s) and then click
Config sub-menu. The Config window shows a list of all instruments
connected to the Serial BERT. Confirm the presence of N4916B enrty
in that list.

5 Corrosponding to N4916B entry, select the De-Emphasis function
check box from the given options under Enable Function column. It
opens the De-emphasis Signal Converter Connection dialog.

6 Click Enable button. It enables N4916B De-emphasis signal converter
that is connected between data out of Serial BERT and the DUT.

Once the de-emphasis function is enabled you can see the de-
emphasis parameters in the PG Output screen.

7 Again, from the Config window, corrosponding to N4916B, clear the
De-Emphasis function check box. It will disable the de-emphasis
function.

If you could proceed until here, the connection of the user software to
the N4916B is ok.

Settings for De-Emphasis Tests

The following are the settings to test the output of the de-emphasis:

• Preset Instrument State

• Set the PRBS 2^7-1

• Set the Data Rate to 3GB/s

• Set the Data Offset to 0V

• Set Data Amplitude to 400mV

• Enable De-Emphasis in the Config window

• Set Pre Cursor to +12dB

• Set Post Cursor 1 to: -6dB

• Set Post Cursor 2 to: -3dB

Check the Output of the N4916B (De-Emphasis Part) Using a Scope

1 Connect the scope Data out of N4916B
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2 Connect the Trigger In of Scope to Trigger Out of PG

3 Terminate N4916B Data /Out with 50Ohm

4 Terminate PG Trigger/Out with 50Ohm

5 Terminate PG Data/Out with 50Ohm

Then the oscilloscope should show an output eye like the following:

If you see a display like above everything is ok.

If you see merely one fixed level, either the N4916B or the output of the
Serial BERT is defective.

Check the Output of the N4916B (De-Emphasis Part) Using the Error
Detector

If you have connected the N4916B to a Serial BERT and have no
oscilloscope at hand, you can use the error detector for checking the
output of the N4916B.

1 Connect the ED Data-In to the Data Out of N4916B

2 Connect the ED Clock In to the PG Clock Out

3 Terminate PG Data Out with 50Ohm

4 Terminate PG Clock Out with 50Ohm

5 Ensure that the error detector follows the generated pattern.

– Press the Auto Align button.
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– From the Analysis panel select the Eye Diagram page.

– Press the Start button.

The eye diagram should look like this after some seconds:

Check the Output of the Pattern Generator with a Scope

If the N4916B does not produce a signal, check the Data Out of the Serial
BERT.

• Connect the Data Output of the pattern generator to an oscilloscope.

N O T E As long as the N4916B is in "connected" state (after pressing the Enable button),
the pattern generator's output is programmed to a fixed level. The amplitude is set
to 1.2 V, the offset to 0. This yields a signal of ±0.6 V.
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The oscilloscope should show the following picture:

If you see only a straight line, ensure that the pattern generator is not
disabled and that it is set up to generate a pattern (e.g. PRBS).

Settings for Clock Multiplier Test

Following are the settings to test the output of the clock multiplier:

• Preset Instrument State

• Set Data Rate to 3GB/s

• Set Clock Offset to 0V

• Set Clock Out Amplitude to 400mV

• Set PG Trigger Out Offset to 0V

• Enable Clock Multiplier in the Config window

• Set the following for Clock Multiplier:

• Input Frequency 3GHz

• Termination ON at 0V

Check the Output of the N4916B (Clock Multiplier Part) Using a
Scope ( Clock Multiplier 1)

Following are the steps to test clock multiplier 1 using a scope:
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1 Connect PG Clock Out to Clock Multiplier Clock In

2 Terminate PG Clock Out with 50 Ohm

3 Termiate PG Trigger Out with 50 Ohm

4 Terminate Clock Multiplier Clock In with 50 Ohm

5 Set Clock Multipiler to 1

6 Measure the signal on scope. It will show an output like the following:

9 Solving Problems

500 Agilent J-BERT N4903B High-Performance Serial BERT



Check the Output of the N4916B (Clock Multiplier Part) Using a
Scope ( Clock Multiplier 2)

Following are the steps to test clock multiplier 2 using a scope:

1 Connect PG Clock Out to Clock Multiplier Clock In

2 Terminate PG Clock Out with 50 Ohm

3 Termiate PG Trigger Out with 50 Ohm

4 Terminate Clock Multiplier Clock In with 50 Ohm

5 Set Clock Multipiler to 2

6 Measure the signal on scope. It will show an output like the following:
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N4916B Status LEDs

This following section explains about the different LEDs that are
available on the front panel of the N4916B De-Emphasis Signal
Converter.

Table 33

LED Name Description

Activity Flashes green when instrument is
accessed on the remote interfaces

Constantly orange during boot phase of
the instrument

LAN Constantly green when LAN is operable

Constantly red when LAN is not operable

Flashing green when device
identification is enabled

POWER Constantly red when instrument is OFF
(in power standby mode)

Constantly green when instrument is ON
(powered)
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Problems with the N4876A

Problems with the N4876A - Concepts

When you have opened the External Instrument(s) - Config window and
have selected N4876A from the external instruments, select
Multiplexer under Enable Function column in the list, the Multiplexer
Connection dialog appears.

Cannot-Connect Problems

An error message may appear when you now press Enable.

If this happens, ensure that the N4876A has been correctly installed (see
“Installing the N4876A - Procedure” on page 531).

Check the Power Supply

Ensure that the power cord is connected.

The green LED close to the power switch must be illuminated when the
unit is turned on.

Check the USB Communication

Ensure that the USB cable is connected between the USB port at the
rear of the N4876A and one of the USB ports at the rear of the Serial
BERT.

1 Open the Utility menu and click Minimize GUI to gain access to the
Windows operating system.

2 In the Windows task bar, click the Agilent IO Control icon.
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3 From the Agilent IO Control menu, open the VISA Assistant.

4 If no VISA alias name has been assigned so far, the VISA Assistant
should indicate an instrument named "UsbInstrument1". If the
N4876A has been installed correctly, the VISA Assistant should
indicate an instrument named "N4876A". Click UsbInstrument1 or
N4876A.

5 Click the Formatted I/O tab.

6 In the Instr. Lang. box (Instrument Language), enable SCPI.
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7 Click the *IDN? button. This generates the identification query in
SCPI format. The instrument should return "Agilent Technologies,
N4876A," and the software revision.

If you could proceed until here, the N4876A power supply and the
processor are fully functional. If not, the N4876A is probably defective.

Ensure that the User Software can Access the N4876A

1 From the Windows task bar, restore the user interface – click GUI
Agilent 4900 Series.

2 Press the green Preset key close to the front USB connector of the
Serial BERT or from the menu bar select File – Preset Instrument
State.

3 Disable the outputs of N4903B and use the cable kit to connect the
pattern generator to the N4876A. Connect the Data Out, Aux Data
Out and Aux Clk Out of the Serial BERT to Data In, Aux Data In and
Aux Clk In of the N4876A, respectively.

4 From the Navigation Menu, select External Instrument(s) and then click
Config sub-menu. The Config window shows a list of all instruments
connected to the Serial BERT. Confirm the presence of N4876A enrty
in that list.

5 Corresponding to N4876A entry, select the Multiplexer function check
box from the given options under Enable Function column. It opens
the Multiplexer Connection dialog.
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6 Click Enable button. It enables N4876A 28 Gb/s Multiplexer 2:1 that
is connected between data out of Serial BERT and the DUT.

Once the output levels of Data Out that you set on the PG Output
screen will control the output levels of the N4876A's Data Output.
The level setting of Aux Data will be disabled on the PG Output
screen when the multiplexer function is enabled.

7 Again, from the Config window, corrosponding to N4876A, clear the
Multiplexer function check box. It will disable the multiplexer
function, and the PG Output screen will allow to control the output
levels of Data and Aux Data at the connectors of the PG again.

If you could proceed until here, the connection of the user software to
the N4876A is OK.

Settings for Multiplexer Tests

The following are the settings to test the output of the N4876A 28 Gb/s
Multiplexer:

• Preset Instrument State

• Set the PRBS 2^7-1

• Set the Data Rate to 3GB/s

• Set the Data Offset to 0V

• Set Data Amplitude to 400mV

• Enable Multiplexer in the Config window

Check the Output of the N4876A Multiplexer Using a Scope

1 Connect the Scope to Data Out of N4876A

2 Connect the Trigger-In of Scope to Trigger-Out of PG

3 Terminate N4876A Data /Out with 50Ohm

4 Terminate PG Trigger-/Out with 50Ohm

5 Terminate PG Data /Out and Aux /Data Out with 50Ohm
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Then the oscilloscope should show an output eye like the following:

If you see a display like above everything is OK.

If you cannot see a clear eye diagram, then check if the N4876A is
connected properly to the Serial BERT. The N4876A must be connected
to Data Out, Aux Data Out and Aux Clk Out to work properly.

If the connection to the Serial BERT is setup correctly, then check the
output signal of the Serial BERT at the Data Out, Aux Data Out (both
should show a eye diagram with an offset of -400mV and a amplitude of
800mV). Check the output signal of Aux Clk Out, it should give a clock
signal of set set data rate with an offset of 0V and an amplitude of
400mV. if one of the used Serial BERT outputs is not providing the
expected signal, then the Serial BERT is defective.

If the Serial BERT is providing the correct signals, then connect the
N4876A again and run the adjustment procedure from the Config screen.
Check the output of the N4876A again after the adjustment has been
done.

If the adjustement does not fix the problems, then the N4876A is
defective.

Check the Output of the N4876A Multiplexer Using the Error
Detector

If you have connected the N4876A to a Serial BERT and have no
oscilloscope at hand, you can use the error detector for checking the
output of the N4876A.
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1 Connect the ED Data-In to the Data-Out of N4876A

2 Connect the ED CLK-In to the PG-CLK Out

3 Terminate PG Data /Out with 50Ohm

4 Terminate PG Clock /Out with 50Ohm

5 Ensure that the error detector follows the generated pattern.

– Press the Auto Align button.

– The error detector should finish the auto alignment successfully
and report a BER of 0.000.

– Manually adjust the ED sample delay by 166 ps.

– Press Sync Now.

– The error detector should report a BER of 0.000.

Check the Output of the Pattern Generator with a Scope

If the N4876A does not produce a signal, check the Data Out of the Serial
BERT.

• Connect the Data Output of the pattern generator to an oscilloscope.

N O T E As long as the N4876A is in "connected" state (after pressing the Enable button),
the pattern generator's output is programmed to a fixed level. The amplitude is set
to 0.8 V, the offset to -0.4 V.
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The oscilloscope should show the following picture for Data Out as well
as for Aux Data Out:

If you see only a straight line, ensure that the pattern generator is not
disabled and that it is set up to generate a pattern (e.g. PRBS).

N4876A Status LEDs

This following section explains about the different LEDs that are
available on the front panel of the N4876A 28 Gb/s Multiplexer 2:1.
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Table 34

LED Name Description

Output Signals the state of the output amplifier

Constantly off when output is disabled
(0.0V)

Constantly green when output is enabled
(user defined levels)

Flashing orange when an overload
condition has been detected

Constantly orange during boot phase of
the instrument

Activity Flashes green when instrument is
accessed on the remote interfaces

Constantly orange during boot phase of
the instrument

LAN Constantly green when LAN is operable

Constantly red when LAN is not operable

Flashing green when device
identification is enabled

Constantly orange during boot phase of
the instrument

Power Constantly orange when instrument is
OFF (in power standby mode)

Constantly green when instrument is ON
(powered)
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10 
Customizing the Instrument

Customizing the Instrument - Concepts

The Serial BERT provides various utilities for adjusting the instrument
to your personal preferences.

Restoring the System

Agilent Recovery System - Procedures

The Agilent Recovery System can be used to repair the system in case of
serious malfunction.

C A U T I O N When the operating system is restored, all personal settings, programs and user
data will be lost. Make sure that important data is saved to external media before
restoring the system.

The Agilent Recovery System requires the following steps:

• “How to Create the Agilent Recovery Partition” on page 512

• “How to Boot from the Agilent Recovery System” on page 512

• “How to Recover the System from the Hard Disk” on page 513
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How to Create the Agilent Recovery Partition

When booting the instrument for the first time, the Agilent Recovery
System will automatically set up the recovery partition. This process is
indicated by a small window that pops up on first boot and will take
less than one minute to complete.

How to Boot from the Agilent Recovery System

The following steps will guide you to boot from the Agilent Recovery
System.

1 Plug in a keyboard and reboot the instrument.

2 From the boot screen, select Agilent Recovery System boot option.

N O T E This screen will be shown only for few seconds.

You will be now able to see the Agilent Recovery System user interface.
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This user interface provides the following options:

Table 35

Options Description

Run CHKDSK to resolve Disk Issues If you encounter any malfunctions you
should always try this option first.
CHKDSK won’t delete any of your user
generated data but try to recover the disk
issues. The CHKDSK process may take
more than 2 hours.

Restore Factory Settings Use this option only if CHKDSK could not
repair the system. This option will restore
the originally installed operating system
and software. Remember, the entire user
generated data and settings will be lost
and there will be no chance of recovering
this data afterwards. See “How to
Recover the System from the Hard Disk”
on page 513 for details.

Exit This option quits the user interface and
reboots the instrument.

How to Recover the System from the Hard Disk

You can use the Agilent Recovery System to restore the system to its
factory setting in case of a serious malfunction, caused by corrupted or
inadvertently deleted files on the system's primary C: partition.

The following steps will guide you to recover the system from the hard
disk.

1 Boot the instrument from the Agilent Recovery System. See “How to
Boot from the Agilent Recovery System” on page 512.

2 From the Agilent Recovery System user interface, choose Restore Factory
Setting option.

W A R N I N G Remember, with this option, the entire user generated data and settings will be
lost and there will be no chance of recovering this data afterwards.

3 Follow the on screen instructions to continue the restore process
from hard disk.
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The Agilent Recovery System will now restore the factory settings. You
must not turn off the instrument or remove the power before the process
completes. Doing so may result in system corruption and the application
may not operate.

Configuring the Instrument

Configuring the Instrument - Concepts

This section covers information on the configuration of the Serial
BERT.

Updating the Software

New software features are offered for the Serial BERT from time to time;
you may be able to enhance the capabilities of your instrument by
updating the software.

See the Agilent Serial BERT web site to see if updates are available for
your instrument:

http://www.agilent.com/find/SerialBERT

Besides the latest versions of the user interface and firmware server,
you will also find instructions for the update process.

C A U T I O N Before you update the instrument's software, make sure that the software matches
the instrument's hardware. An update can be carried out, even if the software does
not match the hardware. In this case the instrument may go into a corrupt state or
not all features may be available.

The applicable hardware versions are listed with the software update version. You
can find the instrument's hardware version on a label at the rear panel.

When updating the firmware server on the instrument, make sure you
select the Hardware installation option.

After the firmware server has been updated, you are prompted to start
a BIOS update. Allow the BIOS to be updated (the firmware server
requires the modifications). Do not interrupt the BIOS update.
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Note that you must reboot the instrument after updating the firmware.
If you do not reboot the instrument, the firmware may not have access
to the instrument's hardware.

Configuring the Instrument - Procedures

Follow the instructions below to configure the instrument according to
your personal needs:

Setting Date and Time

Your instrument uses the date and time when:

• Saving files

• Saving self test information

• Saving calibration information

To set the date and time of your instrument, do the following:

1 On the Utilities menu, click Set Time and Date... This opens the Date/
Time Properties dialog box.

2 Set the date and time.

3 Click OK.

Setting the GPIB Address

Your instrument is set to a default GPIB (General Purpose Interface
Bus) address. You can change this address by doing the following:

1 On the Utilities menu, click Change GPIB Address.... This starts the GPIB
Address Change dialog box.

2 Select an address in the New GPIB Address list.

3 Click OK. The new address will be applied and the dialog box will
close.

Each instrument must be set to a unique GPIB address to avoid multiple
instruments transferring data at the same time.

N O T E The default address is 14; however, addresses from 0 to 31 may be used if the default
address is the same as another instrument's GPIB address. Address 21 is usually
reserved for the computer interface Talk/Listen address and should not be used
as the instrument address.
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Connecting Peripherals

You can connect an external monitor, mouse and keyboard to the
instrument on the Serial BERT's rear panel. To connect a mouse or a
keyboard, you can use either the USB ports or the PS/2 ports.

For more details refer to “Using an External Monitor ” on page 519
and “Using the On-Screen Keyboard” on page 519.

N O T E If the touchscreen is disabled, the external keyboard and mouse are also disabled.
See “Turning the Touchscreen Off/On” on page 518 on how to enable/disable
the touchscreen.

N O T E If caps lock is pressed on the keyboard, this will also affect the frontpanel keys, i.e.
M(ega) and m(illi) will be exchanged!

Enabling the LAN Connectors

You can enable the LAN connection on your Serial BERT. This will allow
you to connect to network printers and remote servers with access to
shared folders and files.

The Serial BERT has two RJ-45 LAN connectors on the rear panel. They
support 10 Base-T and 100 Base-T Ethernet networks using TCP/IP and
other Microsoft supported networking protocols. The Serial BERT uses
Microsoft® XP Pro.

For detailed instructions on how to enable the LAN connectors, please
refer to the Microsoft® XP Pro manual.

C A U T I O N Because your network settings are unique to your IT infrastructure, Agilent
Technologies will not be able to assist you with connecting your instrument to your
network. Please contact your network administrator or IT department for
assistance. For more information, refer to the MS Windows resource kit (available
from Microsoft) that is appropriate for your computer system.

C A U T I O N Do not connect the Serial BERT to a network that is configured to automatically
install software on network devices. Installing or overwriting files on the Serial
BERT computer system may impact the operation of the instrument. Please contact
your network administrator or IT department to find out whether you have this type
of network.
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Configuring the Instrument - Reference

The Serial BERT has the following utilities for configuring the
instrument:

Set Date/Time Dialog Box

This function opens the Date/Time Properties dialog box of Windows®.
Use this dialog box to set the date and time as well as the time zone of
your location.

GPIB Address Change Dialog Box

Your instrument is set to a default GPIB (General Purpose Interface
Bus) address. You can change this address by doing the following:

1 On the Utilities menu, click Change GPIB Address... This starts the GPIB
Address Change dialog box.

2 Select an address from the New GPIB Address list.

3 Click OK. The new address will be applied and the dialog box will
close.

Each instrument must be set to a unique GPIB address to avoid multiple
instruments transferring data at the same time.

N O T E The default address is 14; however, addresses from 0 to 31 may be used if the default
address is the same as another instrument's GPIB address. Address 21 is usually
reserved for the computer interface Talk/Listen address and should not be used
as the instrument address.

Configuring the Touchscreen

Configuring the Touchscreen - Procedures

The following procedures help you to configure the touchscreen
according to your personal needs:
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Turning the Touchscreen Off/On

This function disables the instrument touchscreen, external keyboard,
and mouse.

1 On the Utilities menu, click Touchscreen Off. The Enable Touchscreen
icon is placed in the upper right hand corner of the instrument
display.

2 Click the Enable Touchscreen icon to enable the touchscreen,
keyboard, and mouse again.

Calibrating the Touchscreen

In normal usage, you should not need to calibrate the touchscreen
display. But, if you feel that it needs to be realigned with the video
display, do the following:

1 If the title bar of the Serial BERT user interface is not visible, select
Title Bar from the Utility menu.

2 Minimize the Serial BERT user interface window.

3 In the system tray, next to the clock in the lower right corner, right-
click the Touchscreen Settingsicon to open the menu with the available
options.

4 Select Calibrate, then Device 1, and Normal. A blank screen with a
target appears.

5 Click the target to start the calibration. When the calibration is
complete, the calibration window will close.

Configuring the Double Click

You can adjust the behavior of the touchscreen display to simulate the
double-click action of a typical personal computer or trackball. To
configure the touch settings:

1 Select Display Utility from the Utility menu. This opens the Configuration
Utilities dialog box.

2 Click Display to open the Display Area Configuration dialog box.
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3 Click the Timed Double Touch slide bar to adjust the amount of time
that can pass as you touch the display screen. You can preview your
adjustment by clicking/touching the Test Box.

Using the On-Screen Keyboard

You can use the on-screen keyboard to enter text in any text field. It can
be used along with the standard keyboard or keypad.

1 Click in a text field to position the cursor in it.

2 Press the On-Screen Keyboard button to open the on-screen keyboard.

3 Click letters or numbers as desired. For numbers, you must add the
unit by pressing the G/n, k/m, M/µ, or x1 front panel button.

4 Press the On-Screen Keyboard button again to close the on-screen
keyboard.

5 Continue with your work.

N O T E You can also access the on-screen keyboard from the Utilities menu. A check mark
appears next to the menu entry, indicating that it has been selected.

Using an External Monitor

To switch between the Serial BERT's built-in display and an external
monitor, do the following:

1 Connect the external monitor with an appropriate power supply and
with the VGA connector on the Serial BERT's rear panel.

2 If the title bar of the Serial BERT user interface is not visible, select
Title Bar from the Utility menu.

3 Minimize the Serial BERT user interface window.

4 In the system tray, next to the clock in the lower right corner, right-
click the Displayicon to open the menu with the available options.

5 Select Graphics Options, then Output To, and the desired output device:

– Monitor for an external monitor

– Notebook for the built-in display

Use the same procedure to switch back to the built-in display.
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Configuring the Touchscreen - Reference

This section describes the options of the on-screen keyboard:

Click Set to access the Options menu:

• Move OSK Window

Click this to enable the arrow keys on your actual keyboard. They
can then move the software keyboard.

T I P You can always move the On-Screen Keyboard window by clicking its title bar and
dragging it.

Additionally, you can switch between different views of the on-screen
keyboard. The following table lists the displayed buttons for the
different views:

Table 36

Softkeys Letters Numeric Characters

Qwerty Full X X X X

Qwerty Simple X X X

Qwerty
Minimum

X X

Block Full X X X X

Block Simple X X X

Block
Minimum

X X

Minimum X

N O T E Qwerty options mimic the layout of an actual keyboard. Block options present the
letter characters in alphabetical order.
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T I P If you select one of the larger on screen keyboard displays, such as Qwerty Full or
Block Full, the keyboard may cover most of the instrument display. If this occurs,
continue to make your keyboard entry, then either close the on screen keyboard or
change to a smaller display.

Installing Software Licenses

Installing Software Licenses - Procedures

The Serial BERT has optional features that require a license. The
following procedures explain how to obtain and install a license:

Obtaining a License

To obtain a license:

1 In the Utilities menu, click Licenses. The Licenses dialog informs you
about the options that require a license.

2 Record the HOST ID / MAC Addr shown in the window. This is the
MAC Address of the Serial BERT.

3 Contact your Agilent representative and purchase a Software
Entitlement Certificate.

4 Visit the website .

5 Follow the instructions on the website. You will need the certificate
and the MAC Address.

6 You will receive a licence file over the web. The file has the
suffix .lic.

Installing a License

To install a license:

1 Copy the licence file to the Serial BERT.

2 In the Utilities menu, click Licenses.

3 Double-click the feature you wish to enable.

4 Follow the instructions in the window.
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Installing Software Licenses - Reference

This section explains the options for installing a license.

Licenses Dialog

The Licenses dialog informs you about the options that require a license.

The HOST ID / MAC Addr shown in the window is the MAC Address of
your Serial BERT. You will be asked for this address when you request
a license file for an option from Agilent.

N O T E The MAC Address is used for generating the license key code. That means, the key
stored in the license file refers to just one instrument. If you wish to enable a licensed
feature on a different instrument, you need another license file.

N O T E License handling is only available if both NIC (Network Interface Card/Adapter) are
enabled.

Install License

The Install License dialog is used for installing a license.

It indicates the feature that has been selected before opening the
window and allows you to browse for the associated license file.

The suffix of a license file is .lic.

If the license file has not been copied to the Serial BERT and is not
accessible via LAN, click the Enter button.

Enter License Key

This dialog allows you to enter the license key manually.

That means, you need to read (and probably print) the license file with
a text editor and type the key code.
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Installing Hardware Options

Installing Hardware Options - Procedures

The Serial BERT has a slot for installing optional hardware.

At the present time, the J20 Interference Channel is available. This
module can be used for adding intersymbol interference and sinusoidal
interference to the signal generated by the Pattern Generator.

Installing the J20 Option

To install the J20 Interference Channel:

1 Perform the regular shutdown procedure provided by the operating
system.

2 Disconnect the instrument from mains.

C A U T I O N Never plug in or remove a module while the instrument is connected to mains power.

3 Unscrew and remove the slot cover.

4 Insert the module into the slot.

5 Press the lever until the module rests firmly in place, the front plate
aligned with the Error Detector's front panel.

6 Insert and tighten the fixing screw.

7 Power up the instrument. The software will automatically recognize
the new component and provide the Interference Channel Icon and
according setup functions in the Jitter window.
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Connecting the J20 Option

The J20 Interference Channel has two ports, P1 and P2. They can be
connected single-ended or differentially. For a description see
“Interference Channel” on page 395

If you connect P1 to the Data Out of the Pattern Generator, P2 provides
the output that is meant to be connected to the DUT. This is ilustrated
in the following figure.

If you connect P2 to the Data Out of the Pattern Generator, P1 provides
the output.

C A U T I O N The module has golden 2.4 mm connectors. Be sure to use the specific cables or
adapters for the connections. Improper connection can damage the module.

Installing External Instrument(s)

Installing External Instrument(s) - Concepts

This section describes the procedure to install the external instruments
with the Serial BERT.

The following external instruments can be connected to Serial BERT:

• N4916A/B De-Emphasis Signal Converter

To install N4916A/B De-Emphasis Signal Converter with Serial
BERT, see “Installing the N4916A/B - Procedure” on page 525

• N4876A 28Gb/s Multiplexer
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To install N4876A 28Gb/s Multiplexer with Serial BERT, see
“Installing the N4876A - Procedure” on page 531

Installing the N4916A/B - Procedure

The N4916A/B De-Emphasis Signal Converter is an optional instrument
that can be connected to the Serial BERT. For general information see
“Understanding the De-Emphasis Signal Converter” on page 35. 

When you install the N4916A/B for the first time, you need to configure
the USB interface of the Serial BERT.

For this configuration, you may wish to connect a keyboard and a mouse
to the Serial BERT (see “Connecting Peripherals” on page 516). This is
not mandatory but convenient – the keys provided by the instrument
can be used as well for entering the required information. You can
remove keyboard and mouse when you are done.

Checking the Serial BERT Software Revision

The Serial BERT software supports the N4916A on from revision 4.8
and N4916B on from revision 6.5.

1 Switch on the Serial BERT.

2 In the Help menu, click About.

3 If the software revision is below 4.8, you need to update the software
(see “Updating the Software” on page 514).

Checking the Agilent IO Libraries Revision

New Serial BERT instruments are delivered with Agilent IO Libraries
Suite Revision 15.5 or later installed.

1 In the Utility menu, click Minimize GUI to access the Windows
operating system.

2 Click the Agilent IO Control icon in the Windows task bar to open the
IO Control menu.

You will see the menu item Agilent Connection Expert in the Windows
task bar.
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3 Click the About item to check the details.

If you wish to update the Agilent IO Libraries Suite, you can download
the software from

http://www.agilent.com/find/iolib.

Installation instructions are given in the associated Readme file.

Connecting the N4916A/B via USB

The N4916A/B is controlled by the Serial BERT via USB.

1 Connect mains power to the N4916A/B and switch the instrument
on.

N O T E When you connect the N4916A/B via USB, it is important that the N4916A/B is
switched on. Otherwise, it may not be identified correctly by the operating system.

2 Connect the USB cable between the USB ports at the rear sides of
the N4916A/B and the Serial BERT. You can use any rear port of the
Serial BERT.

3 The Found New Hardware Wizard will pop up and ask whether he
should connect to Windows Update.

4 Click No, not this time.
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5 Click Next and let the Wizard locate the appropriate driver. The USB
driver is part of the Agilent IO Libraries Suite.

6 Step through the Wizard by clicking Next. The Wizard will finally set
up a USB device named "USB Test and Measurement Device".
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Assigning a VISA Alias Name

Assigning a unique VISA alias name to the N4916A/B simplifies remote
programming and helps to make programs portable. The Serial BERT
software requires a specific VISA alias name to access the N4916A/B.

The Agilent Connection Expert is available on from revision 14.0 of the
Agilent IO Libraries Suite.

1 If the Agilent Connection Expert does not pop up automatically, click
the Agilent IO Control icon in the task bar and open it from the menu.

2 In the Instrument I/O panel, For N4916, click UsbDevice1. "UsbDevice1"
is the default alias name for N4916A. For N4916B, click
UsbInstrument1 "UsbInstrument1" is the default alias name for
N4916B.

3 Click Change Properties and change the alias name. For N4916A,
change the alias name to D4916.

"D4916" is the alias used by the software.

For N4916B, change the alias name to DATA_OUT/AUXDATA_OUT
depending on the channel (Data Out and Aux Data Out) used.
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"DATA_OUT"/"AUXDATA_OUT" is the alias used by the software.

4 Click OK.

The Agilent Connection Expert for N4916A shows a window like the
following:

The Agilent Connection Expert for N4916B shows a window like the
following:

For detailed instructions refer to the Connectivity Guide which is part
of the Agilent IO Libraries Suite Documentation.
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Connecting to Pattern Generator and DUT (N4916A)

After the USB port has been configured, you can remove keyboard and
mouse and make the signal connections.

1 Use the N4915A-004 cable or a 2.4 mm cable (m-m) longer than 350
mm and connect the pattern generator's Data Out port to the Input
port of the N4916A.

2 Mount the SMA 50 Ohm termination on the unused Data Out port of
the pattern generator using the SMA to 2.4 mm adapter.

3 Enable the De-Emphasis Signal Converter as described in “How to
Enable/Disable De-Emphasis Function” on page 42 and set the levels
such that the DUT will not be damaged.

4 Use a matched pair of 2.4 mm cables to connect the differential
outputs of the N4916A to the DUT. If only one output of the de-
emphasis signal converter is needed, connect a 2.4 mm 50 Ohm
termination to the unused output.

Connecting to Pattern Generator and DUT (N4916B)

After the USB port has been configured, you can remove keyboard and
mouse and make the signal connections.

1 Use the N4915A-010 matched cable pair (1x 2.4 mm to SMA for data,
1x SAM-to-SMA for clock) longer than 350 mm.

2 Connect the pattern generator’s Data Out port to the Data Input of
N4916B and the pattern generator’s Aux Clk Out to the Clock In of
N4916B.

3 Mount the SMA 50 Ohm termination on the unused Data Out port of
the pattern generator using the SMA to 2.4 mm adapter.

4 Enable the De-Emphasis Signal Converter as described in “How to
Enable/Disable De-Emphasis Function” on page 42 and set the levels
such that the DUT will not be damaged.

5 Use a matched pair of 2.4 mm cables to connect the differential
outputs of the N4916B to the DUT. If only one output of the de-
emphasis signal converter is needed, connect a 2.4 mm 50 Ohm
termination to the unused output.
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Installing the N4876A - Procedure

The N4876A 28 Gb/s Multiplexer 2:1 is an optional instrument that can
be connected to the Serial BERT. For general information see “N4876A
28 Gb/s Multiplexer 2:1” on page 17. 

When you install the N4876A for the first time, you need to configure
the USB interface of the Serial BERT.

For this configuration, you may wish to connect a keyboard and a mouse
to the Serial BERT (see “Connecting Peripherals” on page 516). This is
not mandatory but convenient – the keys provided by the instrument
can be used as well for entering the required information. You can
remove keyboard and mouse when you are done.

Checking the Serial BERT Software Revision

The Serial BERT software supports the N4876A on from revision 6.7 or
later.

1 Switch on the Serial BERT.

2 In the Help menu, click About.

3 If the software revision is below 6.7, you need to update the software
(see “Updating the Software” on page 514).

Checking the Agilent IO Libraries Revision

New Serial BERT instruments are delivered with Agilent IO Libraries
Suite Revision 15.5 or later installed.

1 In the Utility menu, click Minimize GUI to access the Windows
operating system.

2 Click the Agilent IO Control icon in the Windows task bar to open the
IO Control menu.

You see the menu item Agilent Connection Expert in the Windows task
bar.

Customizing the Instrument 10

Agilent J-BERT N4903B High-Performance Serial BERT 531



3 Click the About item to check the details.

If you wish to update the Agilent IO Libraries Suite, you can download
the software from

http://www.agilent.com/find/iolib.

Installation instructions are given in the associated Readme file.

Connecting the N4876A via USB

The N4876A is controlled by the Serial BERT via USB.

1 Connect mains power to the N4876A and switch the instrument on.

N O T E When you connect the N4876A via USB, it is important that the N4876A is switched
on. Otherwise, it may not be identified correctly by the operating system.

2 Connect the USB cable between the USB ports at the rear sides of
the N4876A and the Serial BERT. You can use any rear port of the
Serial BERT.

3 The Found New Hardware Wizard will pop up and ask whether he
should connect to Windows Update.

4 Click No, not this time.
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5 Click Next and let the Wizard locate the appropriate driver. The USB
driver is part of the Agilent IO Libraries Suite.

6 Step through the Wizard by clicking Next. The Wizard will finally set
up a USB device named "USB Test and Measurement Device".
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Assigning a VISA Alias Name

Assigning a unique VISA alias name to the N4876A simplifies remote
programming and helps to make programs portable. The Serial BERT
software requires a specific VISA alias name to access the N4876A.

The Agilent Connection Expert is available on from revision 15.5 of the
Agilent IO Libraries Suite.

1 If the Agilent Connection Expert does not pop up automatically, click
the Agilent IO Control icon in the task bar and open it from the menu.

2 In the Instrument I/O panel, For N4876A, click UsbInstrument1.
"UsbInstrument1" is the default alias name for N4876A.

3 Click Change Properties and change the alias name. For N4876A,
change the alias name to "N4876A".

"N4876A" is the alias used by the software.

4 Click OK.

The Agilent Connection Expert for N4876A shows a window like the
following:
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For detailed instructions refer to the Connectivity Guide which is part
of the Agilent IO Libraries Suite Documentation.

Connecting to Pattern Generator and DUT

After the USB port has been configured, you can remove keyboard and
mouse and make the signal connections.

1 Disable the outputs of N4903B and use the matched cable kit (2x 2.4
mm to SMA for data, 1x SMA-to-SMA for clock) with the part number
N4915A-001 to connect the pattern generator to the N4876A. Make
sure to connect Data Out to Data In, Aux Data Out to Aux Data In
and Aux Clk Out to Aux Clk In.

2 Mount the SMA 50 Ohm terminations on the unused Data Out and
Aux Data Out ports of the pattern generator using the SMA to 2.4
mm adapters.

3 Enable the N4876A as described in “How to Enable/Disable
Multiplexer Function” on page 44 and set the levels such that the
DUT will not be damaged.

4 Connect the differential outputs of the N4876A to the DUT. If only
one output of the N4876A is needed, connect a 2.4 mm 50 Ohm
termination to the unused output.
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Installing Webserver

Customizing the Web Server- Concept

What is a Web Server?

A web server is a program that operates by accepting HTTP requests
from the network, and providing an HTTP response to the requester.

Enabling a web server on an instrument allows it to accept and respond
to HTTP requests from clients. The web server is an industry standard
for providing information and functionality of an instrument over LAN.

The web enabled instruments are based on two technologies:

The first technology is the instrument itself. The typical user scenarios
for Web Enabled Instruments identify the user as being familiar with
the instrument involved. They normally use the instrument to gather
data, and make measurements.

The second technology is that of the World Wide Web, and the web
browser. User data gathered across target user groups support the
hypothesis that the great majority of Electrical Engineers, and
supporting technicians are familiar with the web and web browsers.
They frequently use one or more web browsers.

An Instrument-Embedded Web Page is defined as a web page that is
served up to a Web Browser from an instrument or product. The server
may reside either internally in the instrument or externally on a
computer that is connected to and interacts with the instrument.

A Web Enabled Instrument or product is defined as one that is enabled
to provide a Graphic User Interface (GUI) of the instrument or product
in a World Wide Web browser. The GUI provides the user an interface
to view and control the instrument or product remotely.

J-BERT provides the option of web server, and installing this program
enables users to access the instrument remotely over LAN.

The four basic steps to using a web browser:

1 Open the web browser and enter the URL for the target instrument

2 The instrument web server responds with the instrument’s
“Welcome Page”, as shown in the screen below.
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3 Click on the left-side link to control/monitor the instrument.

4 The browser returns the instrument display and control applet in
the main display frame which contains the instrument display and
the instrument-centric controls provided in the applet.

How to Install the Web Server

The following steps explain how to download, and install the Web
Server.

N O T E The current J-BERT instrument can be upgraded to the Web Server enabled
software.

Follow the steps below to install the web server on the instrument:

1 Find "webserver.zip" at the same location as the N4903 software, and
download it. To download it you can right click on the link and select
'save target as'.

2 Unzip the folder, because the installation can only be started from
an unzipped folder. Install the Web Server software. Follow the
instructions prompted by the installation process.

3 Launch N4903 software. Click on Utility menu item. The following
submenu will appear.
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The WebControl dialog provides the user with the current IP address
of the instrument. The IP address can be used on the internet
explorer to address the instrument. Additionally the WebServer
running on the instrument can be enabled/disabled, and a password
can be specified. Without a valid password you can not access the
instrument's GUI. The following screen displays the WebControl
dialog.
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4 On the web control dialogue shown above you can request for help
by pressing the 'Help' button on the lower right hand corner.

5 The instrument IP will be automatically generated in the space
labeled 'Instrument IP Address'. While adding the instrument on the
network the IP address will be defined. The DHCP protocol
automates the assignment of the IP addresses. The read only lable in
the WebControl dialog shows the current IP address of the
instrument, and this can be used to address the instrument on the
internet explorer by the web client. Enter a password which will be
used for authentication.

Follow the steps below to access the instrument through the web server:

N O T E • You need to know the instrument IP address and the password.

• Additional to the WebBrowser a JAVA runtime environment has to be installed
on the client computer. If the Java runtime environment is not installed on the
client computer you cannot access the GUI of the instrument.

1 Open a web browser, either Internet Explorer 4.0 or higher, or
Netscape 4.0 or higher.

2 Type in the instrument IP, and enter the password when it prompts
for it.

3 From this page you can access all the functionalities of the J-BERT.
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Printing

Printing - Procedures

This section provides information on setting up and using a printer:

Connecting a Printer to the Instrument

The instrument supports parallel and serial printers as well as USB and
LAN connected printers.

To connect your printer to the instrument:

1 Turn off power to the instrument and printer before connecting.

2 Connect the printer to the instrument with the cable that came with
your printer.

Once you have connected the printer to the instrument, you will need
to add the printer driver before you can use the printer.

Adding a Printer

Use the following procedure to add a printer to the instrument.

1 On the File menu, click Print Setup, then Add Printer... This opens the
Add Printer Wizard dialog box.

2 Click My Computer for a local printer installation, or click Network
printer server for a printer connected to another server.

N O T E Before you can add a network printer, you must connect to a Local Area Network
(LAN). In addition, your login must provide you with access to the network printers
that you wish to add. Please contact your network administrator or IT department
for assistance.

3 Follow the instructions in the Add Printer Wizard until you have
selected a local printer and configured the printer port.

4 If your printer is not in the list of available printers, you will need a
copy of the printer driver. Use the USB Stick to copy the printer
driver into the local drive of your system and click Have Disk button.

The instrument will then prompt you to locate the drive for printer
driver. Type the path where the printer driver is copied.
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5 Follow all other instructions on the screen to finish adding a printer.

Removing a Printer

When you disconnect a printer from the instrument and no longer
intend to use it, you can remove the printer driver and increase the free
disk space available on the instrument's internal hard disk drive.

To remove a printer driver:

1 On the File menu, click Print Setup, then Configure Printer.... This opens
the Printers dialog box.

2 Click the printer driver you want to remove.

3 In the File menu in the Printers dialog box, select Delete. A dialog box
will appear to confirm the removal of the printer driver.

4 Click Yes to confirm your selection.

Setting the Default Printer

You can set the printer you use most often as the default printer. Then
all printouts will be sent to the default printer unless you explicitly
select another printer.

To specify the default printer:

1 On the File menu, click Print Setup, then Configure Printer.... This opens
the Printers dialog box.

2 Choose one of the currently mapped printers. If the printer you want
to use is not yet included in this list, see “Adding a Printer” on page
540.

3 On the File menu in the Printers dialog box, click Set As Default.

4 Click Close. The default printer selection is applied and the dialog
box closes.

N O T E The printer capabilities will vary depending on the printer you have installed and
configured.

Printing a Hardcopy

N O T E Before you can print, you must first have the appropriate printer driver installed. The
printer properties and capabilities will vary depending on the printer you have
installed and configured for the instrument.

Customizing the Instrument 10

Agilent J-BERT N4903B High-Performance Serial BERT 541



To print a hardcopy of the instrument's display to the default printer:

• Click Print from the File menu on the main menu bar.

Configuring Printer Properties

You can change the properties of a selected printer:

1 On the File menu, click Print Setup

2 Click Configure Printer....

This opens the Printers dialog box

3 In the File menu in the Printers dialog box, select from the following
options:

– Server Properties

Click this option to change such items as printer margins, spooler
warnings and alarms, and port configurations.

– Properties

Click this option to change such items as pre-determined access
times, security items, and LAN protocols.

– Document Defaults

Click this option to change such items as pages per sheet, print
quality, paper select, and portrait vs. landscape layouts.

4 Select Close in the File menu of the Printers dialog box.

The new settings will are applied and the dialog box closes.

N O T E The printer properties and capabilities will vary depending on the printer you have
selected.

Printing Problems

You should check the following when your printer fails to print:

1 Check if the printer is turned on and the printer cable is securely
attached to both the printer and the instrument's printer connector.

2 Check if the printer driver for your printer is installed.

3 Check if the printer port is configured correctly.

For more information on printer problems, see the printer's operation
manual.
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File Management

File Management - Procedures

This section provides information on saving and recalling instrument
states, log files, patterns, and screenshots.

You can save the files on the local disk. Note that the local disk must not
be re-partitioned in a Windows 2000 environment.

You can also plug an USB stick into the rear of the instrument for saving
and recalling files. No driver is required because Windows has a built-
in driver that supports USB memory drives. In the file browser, you can
access the USB stick via the Removable Disk drive.

To avoid loss of data, stop the USB device and wait until the LED light
of the USB stick is off before unplugging the USB stick.

To avoid loss of data when removing the USB stick:

1 Minimize the GUI.

2 In the system tray, next to the clock in the lower right corner, right-
click the Safely Remove Hardware icon.

A window containing a list of the USB devices appears.

3 Click on the popup message Safely Remove Mass Storage Device.

4 Confirm the acknowledgement message Save to remove hardware....

5 Check that the LED light of the USB stick is off and unplug the USB
stick.

Saving Instrument States

Saving the current instrument state stores all the setup parameters for
the instrument's hardware and software.

To save the setup with the current filename and directory path, do the
following:

• In the File menu, click Save and then Save Instrument State.... The
current instrument state will be immediately saved.
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To save the setup with a new filename or directory path, do the
following:

• In the File menu, click Save and then Save Instrument State As.... This
opens a dialog box, which allows you to create subdirectories,
rename setup files, or overwrite existing setup files.

N O T E Ensure your instrument state files have the extension, *.btz. If you do not specify
an extension or use a different extension, the instrument may not recognize the file
as an instrument state file.

N O T E The default pathname for user defined instrument states is C:\<instrument
model>\Settings

The number of instrument states you can save is limited only by the
available space on the internal hard disk or floppy disk. Each
instrument state uses approximately 6 kB of disk space.

T I P Remember to always make a backup copy of your files. If your original files are
damaged or lost, you can restore the files from the backup copy.

Recalling Instrument States

Recalling the instrument state restores all the setup parameters for the
instrument hardware and software.

To recall the setup, do the following:

• In the File menu, click Open and then Open Instrument State.... This
opens a dialog box which allows you to select the setup file you want
to recall.

T I P Remember always to make a backup copy your setup files. If your original files are
damaged or lost, you can restore the files from your backup copy.

N O T E The default pathname for user defined instrument states is C:\<instrument
model>\Settings
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Saving and Recalling Measurement Logs

Measurement Logs are saved as CSV (comma-separated values) files.
Follow the steps below to view results in a measurement log file.

1 Copy the measurement log file from the Serial BERT to your PC. By
default, log files are saved in the folder C:\<instrument model>
\log.

2 Open a spreadsheet application on your PC.

3 Import the measurement log file. If your application has an import
wizard, you may need to indicate that data is delimited with commas.

4 Once the file has been imported, you may need to resize columns.
The imported log file should appear similar to the following example.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.

You can view and analyze the following information in the measurement
log file:

Table 37

Instantaneous Cumulative

BIT COUNT BIT COUNT Cumulative

ERROR COUNT ERROR COUNT Cumulative

ERROR RATIO ERROR RATIO Cumulative

ERRORED 0 COUNT ERRORED 0 COUNT Cumulative

ERRORED 0 RATIO ERRORED 0 RATIO Cumulative
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Table 37

Instantaneous Cumulative

ERRORED 1 COUNT ERRORED 1 COUNT Cumulative

ERRORED 1 RATIO ERRORED 1 RATIO Cumulative

SYNC LOSS ERROR SECONDS Cumulative

PG CLOCK LOSS ERROR FREE SECONDS Cumulative

ED CLOCK LOSS ERROR DECISECONDS Cumulative

DATA LOSS ERROR FREE DECISECONDS Cumulative

SYNC LOSS SECONDS Cumulative

BURST STATUS Cumulative

BURST SYNC RATIO Cumulative

TOTAL BURST COUNT Cumulative

BAD BURST COUNT Cumulative

Saving and Recalling Patterns

You can save your pattern in either of the following ways:

• Click the Save icon on the Pattern Editor toolbar.

If the pattern has not been saved earlier, a file dialog box opens that
allows you to navigate the file system and name your pattern.

Alternatively, you can use the following procedure:

1 From the File menu, select Save.

2 Then select Save Pattern in Editor.... to save the pattern with the current
filename. Or click Save Pattern in Editor as.... to open a file dialog box
that allows you to save the pattern with a new name.
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N O T E The default pathname for patterns is C:\<instrument model>\Patterns.

Saving and Recalling Screen Images

The instrument allows you to save an image of the current display
screen. You can save this image to the internal hard disk or a USB stick.
You can later print this file or import it to a word processing or graphics
editing program.

To save an image of the display screen, do the following:

1 In the File menu, select Save.

2 Select Save Screen Capture....

This opens a dialog box, which allows you to save the image as a
*.bmp (256 color bitmap file format) file.

Follow the steps below to view screen images on an external PC:

1 Copy the screen image file from the Serial BERT to your PC. By
default, image files are saved in the folder C:\<instrument model>
\User.

2 Open the file in Microsoft Paint or another graphics program.

Preset Instrument State

Preset Instrument State - Procedures

Steps to Preset Instrument State

To reset the instrument to the preset state select one of the following
options:

• Press the Preset button on the front panel.

or

• Select Preset in the File menu.

or

• Send an *RST command to the GPIB controller.
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Self Test

Self Test - Concepts

The self test checks specific hardware components for basic
functionality. At initialization, the following self tests are automatically
run:

• Pattern Generator Power Up Test

• Error Detector Power Up Test

N O T E The current system state is saved and the instrument is re-initialized before
performing the selected tests. The saved system state is restored upon completion
of the self test.

When Self Test is selected from the Utility menu, the Self Test Options dialog
box opens. In this dialog box, you can select additional self tests that
will run when you click Run Test.

N O T E During accumulation or while auto-search functions are in progress, Self Test is
not available.

The pass/fail results of the self test are displayed in the Self Test
Options dialog box. In case of failed tests, you can view detailed error
messages in a separate window.

N O T E If a self test is started remotely, the GUI is not able to inform the user about that,
most likely it will not even show that it is in remote state, but will be blocked until
the self test is finished.

Self Test - Procedures

Running Self Test

To run a self test:

1 Select Self Test from the Utility menu.
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This opens the Self Test Options dialog box.

2 Select the desired tests and click the Run Test button.

3 After the self test has finished, the results are displayed next to each
selected test.

4 If a test failed, you can view detailed error messages by clicking the
respective Message button.

Self Test - Reference

This section contains information about the Self Test Options dialog box
used for setting up and running a self test and for viewing the results.

Self Test Options

The Self Test Options dialog box offers to select the following tests:

• Pattern Generator Bios Self Test

This test is checking all the modules, chips, and registers of the
pattern generator more thoroughly than the Power Up test. It may
take about 5 minutes to complete.

• Pattern Generator Power Up Messages

This test is automatically run after switching on the instrument. It
mainly checks if all important modules, chips, and registers of the
pattern generator are available and accessible.

• Pattern Generator Auto Calibration

This test runs a timing calibration that calibrates the clock to data
alignment of the pattern generator. It may take about 45 minutes to
complete.

• Error Detector Bios Self Test

This test is checking all the modules, chips, and registers of the error
detector more thoroughly than the Power Up test. It may take about
5 minutes to complete.

• Error Detector Power Up Messages

This test is automatically run after switching on the instrument. It
mainly checks if all important modules, chips, and registers of the
error detector are available and accessible.

• Error Detector Auto Calibration

Customizing the Instrument 10

Agilent J-BERT N4903B High-Performance Serial BERT 549



This test runs a timing calibration that calibrates the clock to data
alignment of the error detector. It may take about 45 minutes to
complete.

Select All/Unselect All

Use the Select All button to select all tests in the Self Test Options dialog
box. After clicking the button, it becomes the Unselect All button. Clicking
the button again will then unselect all tests and display the Select All
button again.

Run Test

After selecting at least one test, use this button to start the test. If you
selected tests, that need a longer time to complete, a message box opens.
Confirm your selection by clicking OK. A second message box is
informing you while the test is still running and closes when finished.

Message Buttons

After the self test has finished, the results (Success or Failed) are
displayed next to each test. If a test has failed, you can use the
Message button to open the BIOS Messages window with detailed error
messages explaining the failure reason.
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Random Errors, 468
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